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保証
本書の内容は「現状のまま」で提供され
ており、改訂版では断りなく変更される
場合があります。また、キーサイトは、
法律の許す限りにおいて、本書およびこ
こに記載されているすべての情報に関し
て、特定用途への適合性や市場商品力の
黙示的保証に限らず、一切の明示的保証
も黙示的保証もいたしません。キーサイ
トは本書または本書に記載された情報の
適用、実行、使用に関連して生じるエ
ラー、間接的および付随的損害について
責任を負いません。キーサイトとユーザ
が別途に締結した書面による契約の中で
本書の情報に適用される保証条件が、こ
れらの条件と矛盾する場合、別途契約の
保証条件が優先されます。

テクノロジー・
ライセンス 

本書に記載されたハードウエアおよびソ
フトウエア製品は、ライセンス契約
条件に基づき提供されるものであり、そ
のライセンス契約条件の範囲でのみ使用
し、または複製することができます。

権利の制限について
本ソフトウェアが米国政府の主契約者ま
たは下請業者によって使用される場合
は、本ソフトウェアは DFAR 
252.227-7014（1995年 6月）に定めら
れた “Commercial computer software”、
または FAR  2.101(a)に定められた
“commercial item”として、または FAR 
52.227-19（1987年 6月）またはそれに
相当するの政府機関の規則または契約条
項に定められた “Restricted computer 
software”として提供され、ライセンス
されます。本ソフトウェアの使用、複
製、公開は、キーサイト・テクノロジー
の標準商用ライセンス条件に従い、米国
政府の国防省以外の機関が受ける権利
は、FAR 52.227-19(c)(1-2)（1987年 6
月）に定義された Restricted Rightsを超
えることはありません。技術データに関
して米国政府のユーザが受ける権利は、
FAR 52.227-14（1987年 6月）または
DFAR 252.227-7015 (b)(2)（1995年 11
月）に定義された Limited Rightsを超え
ることはありません。

安全に関する注意事項

注意
注意の表示は、危険を表します。
ここに示す操作手順や規則などを
正しく実行または遵守しないと、
製品の損傷または重要なデータの
損失を招くおそれがあります。指
定された条件を完全に理解し、そ
れが満たされていることを確認す
るまで、注意の指示より先に進ま
ないでください。

警告
警告の表示は、危険を表します。
ここに示す操作手順や規則などを
正しく実行または遵守しないと、
怪我または死亡のおそれがありま
す。指定された条件を完全に理解
し、それが満たされていることを
確認するまで、警告の指示より先
に進まないでください。



安全記号
測定器およびマニュアルに記載された以下の記号は、本器を安全に操作するために守る
べき注意事項を示します。

直流（DC） 交流（AC）

オフ（主電源） オン（主電源）

注意：感電の危険あり 注意：危険あり（具体的な警告／注意
情報については本書を参照）

グランド端子 フレームまたはシャーシ（グランド）
端子

感電防止用アース端子 二重絶縁または強化絶縁で保護された
機器。
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安全に関する注意事項
本器を使用する前に、以下の内容をお読みください。 

以下の安全に関する一般的な注意事項は、本器の操作、サービス、修理のあらゆる段階
において遵守する必要があります。これらの注意事項や、本書の他の部分に記載された
具体的な警告を守らないと、本器の設計、製造、想定される用途に関する安全基準に違
反します。Keysight Technologiesは、お客様がこれらの要件を守らない場合について、
いかなる責任も負いません。

警告 – 機器に損傷がある場合は、機器を使用しないでください。機器を使用する前に、ケー
スを検査します。ひびがないか、プラスチックが欠けていないか調べてください。爆
発の危険性のあるガス、蒸気、粉塵のある場所で機器を使用しないでください。

– 機器は必ず付属のケーブルと一緒に使用してください。

– 接続の前に、機器のすべてのマークを確認してください。

– I/O端子に接続する前に、機器とアプリケーション・システムの電源をオフにして
ください。

– 機器のサービスの際には、必ず指定された交換部品を使用してください。

– カバーが取り外された状態、またはきちんと固定されていない状態で機器を使用し
ないでください。

– 思わぬ危険を回避するため、必ずメーカが供給する電源アダプタを使用してくだ
さい。

– 本器は以下の測定カテゴリに属しています。
ケーブルを主電源に接続しないでください。

最大使用電圧：200 Vp（最高高度 3000 m）
最大過渡電圧：1210 V

– 定格電圧（機器に記載）を超える測定を行わないでください。

注意 – 機器をメーカの指示どおりに使用しないと、機器の安全機能が損なわれる可能性が
あります。

– 機器の清掃には、必ず乾いた布を使用してください。機器の清掃にエチル・アル
コールなどの揮発性の液体を使用しないでください。

– 機器の通気口をふさがないでください。
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環境条件
U8903Bは屋内の結露が少ない場所で使用するように設計されています。下の表に、本
器の一般的な環境条件を示します。

規制情報
U8903Bは、下記の安全規格と電磁環境適合性（EMC）規格に準拠します。

安全規格

– IEC 61010-1:2010/EN 61010-1:2010

– カナダ：CAN/CSA-C22.2 No. 61010-1-12

– 米国：ANSI/UL Std. No. 61010-1（第 3版）

EMC規格

– IEC 61326-1:2005/EN 61326-1:2006

– カナダ：ICES-001:2004

– オーストラリア／ニュージーランド：AS/NZS CISPR11:2004

環境条件 要件

温度

動作条件
– 0 ℃～ 55 ℃
保管条件
– － 40 ℃～ 70 ℃

湿度

動作条件
– 50～ 95 ％の相対湿度（40 ℃、非結露）
保管条件
– 最大 95 ％の相対湿度（40 ℃、非結露）

高度 最大 3000 m

汚染度 2

インストール・カテゴリ II

測定カテゴリ I（「測定カテゴリ」（ページ）392を参照）
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規制マーク

CEマークは、欧州共同体の登録商標
です。この CEマークは、製品が関連
するすべての欧州の法指令に適合する
ことを示します。ICES/NMB-001は、
この ISM機器がカナダの ICES-001に
適合していることを示します。
Cet appareil ISM est conforme a la 
norme NMB-001 du Canada.

CSAマークは、カナダ規格協会の登録
商標です。

本器は、WEEE指令（2002/96/EC）の
マーキング要件に適合します。貼付さ
れた製品ラベルは、本電気／電子製品
を家庭ゴミとして廃棄してはならない
ことを示します。

RCMマークは、オーストラリアのス
ペクトラム管理局の登録商標です。こ
れは、オーストラリアの Radio 
Communication Act（1992）の条項に
基づく EMCフレームワーク規制への
適合を示します。

EMC規制に対する韓国の認証マークで
す。専門的な用途および家庭用以外の
電磁界環境での使用に適した Class A
の機器です。

この記号は、通常使用時に危険物質ま
たは有害物質が漏れ出すことがないと
考えられる期間の長さを示します。製
品の期待寿命は 40年間です。MSIP-REM-ATI-

WCAUD8903B
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Waste Electrical and Electronic Equipment（WEEE）
指令 2002/96/EC

本器は、WEEE指令（2002/96/EC）のマーキング要件に適合します。貼付された製品
ラベルは、本電気／電子製品を家庭ゴミとして廃棄してはならないことを示します。 

製品カテゴリ：

WEEE指令付録 1の機器タイプに基づいて、本器は “Monitoring and Control Instrument”
製品に分類されます。

製品に貼付されるラベルを下に示します。

家庭ゴミとして廃棄しないでください。

不要になった測定器を返送する場合は、最寄りの Keysightサービス・センタにお問い
合わせになるか、www.keysight.co.jp/environment/productで詳細をご確認ください。
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Declaration of Conformity（DoC）

この測定器の Declaration of Conformity（DoC）は KeysightのWebサイトで入手できま
す。下記のWebアドレスで、製品モデルまたは記述から DoCを検索できます。

http://www.keysight.co.jp/go/conformity

注 該当する DoCを検索できない場合は、Keysight計測お客様窓口までお問い合わせくだ
さい。
8 Keysight U8903B ユーザーズ・ガイド



目次

安全記号 3

安全に関する注意事項 4

環境条件 5

規制情報 5

安全規格 5
EMC規格 5

規制マーク 6

Waste Electrical and Electronic Equipment（WEEE）
指令 2002/96/EC 7

製品カテゴリ： 7

Declaration of Conformity（DoC） 8

1 測定前の準備
はじめに 30

LXI Standard 1.4準拠オーディオ・アナライザ 30

インストールと設定 31

受入れ検査 31
通気 31
ラック・マウント 31

標準付属品 32

オプションのアクセサリ 32

U8903Bオプション 33

製品の外観 34

フロント・パネル 34
リア・パネル 36
LCDディスプレイ 38

使用前の準備 40

U8903Bの電源投入 40
U8903Bのプリセット 40
ヘルプ・モードへのアクセス 41
U8903Bのアップデート 42
セルフテストの実行 44
U8903Bオプションの追加／削除 45

2 動作と機能
テスト機能 48

U8903Bのブロック図 49
Keysight U8903B ユーザーズ・ガイド 9



アナログ・オーディオ・インタフェース 49
デジタル・オーディオ・インタフェース 51

ナビゲーション /DATA ENTRYパネル 52

メニュー・キー 54

標準ビュー 55
テスト・シーケンス・アプリケーション（Test Seq App） 56
HP 8903B 56

FUNCTIONパネル 57

Full screen 58
Dispalyモード 59

GRAPHパネル 61

Peak Search 62
Marker 64
Scale 68
Zoom 69
Edit zoom 70

SYSTEMパネル 71

Preset 72
Utility 73
System 75

RUN CONTROLパネル 85

Saveおよび Recall 86

Save 86
Recall 87

3 オーディオ・ジェネレータの機能
オーディオ・ジェネレータ 90

波形設定 92

正弦波波形 92
可変位相波形 94
デュアル波形 96
SMPTE IMD波形（1:1/4:1/10:1） 98
DFD IEC波形（IEC 60118/IEC 60268） 100
ガウシアン雑音 103
方形雑音（一様雑音） 105
三角雑音 107
ピンク雑音 108
方形波波形 110
DC信号 112
正弦波バースト波形 113
ステレオ波形 114
単調波形 115
10 Keysight U8903B ユーザーズ・ガイド



一定値波形 116
ウォーキング・ゼロ 117
ウォーキング・ワン 118
任意波形 119
マルチトーン波形 121
デュアル・トーン・マルチ周波数（DTMF） 125

出力設定（アナログ・ジェネレータ） 128

出力設定（デジタル・ジェネレータ） 130

DSI出力設定（デジタル・ジェネレータ） 133

AES3/SPDIF出力設定（デジタル・ジェネレータ） 135

ビットの編集（コンシューマ・フォーマット） 136
ビットの編集（プロフェッショナル・フォーマット） 141

基準（アナログ・ジェネレータ） 147

基準（デジタル・ジェネレータ） 148

4 オーディオ・アナライザの測定機能
オーディオ・アナライザ 150

測定モード 153

機能 155

測定機能 157

周波数測定 157
AC電圧レベル測定 159
DC電圧レベル測定 162
THD＋ N比測定と THD＋ Nレベル測定 164
SINAD測定 169
THD比測定と THDレベル測定 171
SMPTE IMD測定 177
DFD測定 180
SNR測定 182
SNR（高速モード）測定 184
ジッタ・テスト測定 186
正ピーク測定 187
負ピーク測定 189

位相測定 191

クロストーク測定 194

フィルタ設定（アナログ・アナライザ） 197

Notch Filter 199

フィルタ設定（デジタル・アナライザ） 200

測定設定（アナログ・アナライザ） 202

測定設定（デジタル l・アナライザ） 204

Trigger 205
Keysight U8903B ユーザーズ・ガイド 11



入力設定（アナログ・アナライザ） 206

入力設定（デジタル・アナライザ） 208

DSI入力設定（デジタル・アナライザ） 210

AES/SPDIF入力設定（デジタル・アナライザ） 212

ビット解析（デジタル・アナライザ） 213

波形ファイル（アナログ・アナライザ） 214

Statistics 215

5 グラフ解析
グラフ解析 218

Graph Settings 220

軸設定 222

トレース設定 224

Memory 226
Math 227
Persistence 228

表示オプション 229

グラフ 229
データ・テーブル 230
マーカ・テーブル 230
統計 231
高調波 231
信号解析 233

測定設定 234

測定 1/測定 2 235

6 掃引機能
掃引パラメータ 238

群遅延 240
ポイント設定 241
掃引チャネル 242

Plot View 243

軸設定 244
プロット設定 245

ポイント編集 246

7 テスト・シーケンス・アプリケーション
テスト・シーケンス・アプリケーション 249

Project 251
12 Keysight U8903B ユーザーズ・ガイド



Properties 252

テスト・シーケンス 253

IO設定 254

Settings 255
Properties 259

Sub-Steps 260

Prompt Sub-Steps設定 261
Send SCPIサブステップ設定 262

測定 263

Properties 265
AC level 266
Frequency 269
Phase 272
SNR 275
THD＋ N 280
DC level 284
Crosstalk 287
SMPTE IMD 290
DFD IMD 293
Multitone analyzer 296
Stepped frequency sweep 299
SMPTE frequency sweep 304
DFD frequency sweep 307
外部周波数掃引 311
Stepped level sweep 316
SMPTE level sweep 321
DFD level sweep 325
DC level sweep 329
Receiver sensitivity 333
External level sweep 338
Measurement recorder 343
Voice quality 348

Measurement Results 352

Report 356

Properties 357

8 HP 8903B

HP 8903B 360

Measurement 362
Generator 364
Sweep 365
スペシャル・ファンクション・コード・リスト 366
SPCL 368
Keysight U8903B ユーザーズ・ガイド 13



9 特性と仕様
製品の特性 370

仕様 371

アナログ・ジェネレータ仕様 371
アナログ・アナライザ仕様 375
デジタル・ジェネレータ仕様 378
デジタル・アナライザ仕様 380
AES3/SPDIFインタフェース出力仕様 382
AES3/SPDIFインタフェース入力仕様 384
DSI出力仕様 385
DSI入力仕様 386
アナログ・オーディオ・フィルタ 387
デジタル・オーディオ・フィルタ 388
グラフ仕様 389
掃引仕様 389
オーディオ・モニタ仕様 390
1.5 MHz帯域幅（オプション N3431A）仕様 390
POLQA測定（オプション N3432A）仕様 391
PESQ測定（オプション N3433A）仕様 [1] 391

測定カテゴリ 392

測定カテゴリの定義 392

A 付録
付録 A: FUNCTIONパネル 395

付録 B: GRAPHパネルのメニュー・ツリー 396

付録 C: SYSTEMパネルのメニュー・ツリー 398

付録 D: アナログ・ジェネレータのメニュー・ツリー 402

付録 E: デジタル・ジェネレータのメニュー・ツリー 406

付録 F: アナログ・アナライザのメニュー・ツリー 417

付録 G: デジタル・アナライザのメニュー・ツリー 428

付録 H: Graph Analysisメニュー・ツリー 440

付録 I: 掃引機能のメニュー・ツリー 444

付録 J: Saveメニュー・ツリー 447

付録 K: Recallメニュー・ツリー 448

付録 L: テスト・シーケンスのメニュー・ツリー 449
測定設定 456
測定結果 502

付録 M: HP8903Bのメニュー・ツリー 506

付録 N: 測定機能の戻り値の単位 508
アナログ・アナライザ 508
14 Keysight U8903B ユーザーズ・ガイド



デジタル・アナライザ 509
デジタル・オーディオ測定の単位 511

付録 O: 任意波形ファイルのフォーマット 512

付録 P: ユーザ定義フィルタ・ファイルのフォーマット 514

付録 Q: DSI入力および出力インタフェース 517

付録 R: デジタル・システムのクロック分配ブロック図 518

付録 S: 代表的な DSIテスト構成 519
構成 1 519
構成 2 520
構成 3 521
構成 4 522
構成 5 523

付録 T: U8903B構成の例 524
例 1:デジタル・ジェネレータで正弦波波形を作成し、デジタル・アナライザでその
電圧を測定 524

例 2:システム・クロック基準設定の指定 526
例 3:デジタル・ジェネレータの DSI出力設定の指定 527

付録 U: デジタル波形パラメータとチャネルの関係 528

付録 V: DSIのワード長、サンプリング・レート、乗数 530

付録 W: マスタ・クロック入力のワード長、サンプリング・レート、乗数 536

付録 X: U8903Bデフォルト設定 542
アナログ・ジェネレータ 542
アナログ・アナライザ 543
Sweep 546
HP 8903B 547
System 547

付録 Y: ファイルの名前変更、コピー、移動、削除手順 548
ファイル名の変更 548
ファイルのコピー 548
ファイルの移動 548
ファイルの削除 548
Keysight U8903B ユーザーズ・ガイド 15



これは空白のページです。
16 Keysight U8903B ユーザーズ・ガイド



図一覧

図 1-1 U8903Bフロント・パネル 34
図 1-2 U8903Bリア・パネル 36
図 1-3 TOSLINKケーブルをまっすぐにコネクタに接続します。 37
図 1-4 U8903BLCDディスプレイ 38
図 1-5 ヘルプ・モード 41
図 1-6 System > Updateメニュー・ページ 42
図 1-7 ［Recall］メニュー・ページ 43
図 1-8 System > Service > Self-Testメニュー・ページ 44
図 1-9 System > Service > Optionsメニュー・ページ 45
図 1-10 ［Recall］メニュー・ページ 46
図 2-1 U8903Bアナログ・ジェネレータのブロック図 49
図 2-2 U8903Bアナログ・アナライザのブロック図 50
図 2-3 U8903Bデジタル・ジェネレータのブロック図 51
図 2-4 ナビゲーション /DATA ENTRYパネル 52
図 2-5 U8903Bモードの選択 54
図 2-6 フルスクリーン・グラフ表示 58
図 2-7 4パネル・ビュー 59
図 2-8 10パネル・ビュー 59
図 2-9 グラフ解析モードの 2パネル・ビュー 60
図 2-10 Peak Searchメニュー・ページ 62
図 2-11 Peak Search > Thresholdメニュー・ページ 63
図 2-12 Markerメニュー・ページ 1 64
図 2-13 Marker > Marker -メニュー・ページ 66
図 2-14 Marker > Harmonicsメニュー・ページ 67
図 2-15 Scaleメニュー・ページ 68
図 2-16 拡大グラフの表示 69
図 2-17 拡大グラフの表示 70
図 2-18 Presetメニュー・ページ 72
図 2-19 Utilityメニュー・ページ（ジェネレータ／アナライザ・モード） 73
図 2-20 Utilityメニュー・ページ（グラフ解析モード） 74
図 2-21 Systemメニュー・ページ 1 75
図 2-22 System > Error Infoメニュー・ページ（エラー） 76
図 2-23 System > I/Oメニュー・ページ 77
図 2-24 System > I/O > Lan Settingsメニュー・ページ 1 78
図 2-25 System > Serviceメニュー・ページ 79
図 2-26 System > Settingsメニュー・ページ 1 80
図 2-27 System > HP8903B Configメニュー・ページ 81
図 2-28 System > Fan & Temperatureメニュー・ページ 82
図 2-29 System > Aux Outputメニュー・ページ 83
図 2-30 System > Board Infoメニュー・ページ 84
図 2-31 RUN CONTROLパネル 85
図 2-32 Saveメニュー・ページ 86
図 2-33 ［Recall］メニュー・ページ 87
図 3-1 Analog Generatorメニュー・ページ 90
図 3-2 Digital Generatorメニュー・ページ 91
図 3-3 Analog Generator > Waveform Configメニュー・ページ（正弦波波形） 92
Keysight U8903B ユーザーズ・ガイド 17



図 3-4 Digital Generator > Waveform Configメニュー・ページ（正弦波波形） 92
図 3-5 Analog Generator > Waveform Configメニュー・ページ（可変位相

波形） 94
図 3-6 Digital Generator > Waveform Configメニュー・ページ（可変位相

波形） 94
図 3-7 Analog Generator > Waveform Configメニュー・ページ（デュアル

波形） 96
図 3-8 Digital Generator > Waveform Configメニュー・ページ（デュアル

波形） 96
図 3-9 Analog Generator > Waveform Configメニュー・ページ（SMPTE 1:1

波形） 98
図 3-10 Digital Generator > Waveform Configメニュー・ページ（SMPTE 1:1

波形） 98
図 3-11 Analog Generator > Waveform Configメニュー・ページ（IEC 60118

波形） 100
図 3-12 Digital Generator > Waveform Configメニュー・ページ（IEC 60118

波形） 100
図 3-13 Analog Generator > Waveform Configメニュー・ページ（IEC 60268

波形） 101
図 3-14 Digital Generator > Waveform Configメニュー・ページ（IEC 60268

波形） 102
図 3-15 Analog Generator > Waveform Configメニュー・ページ（ガウシアン

雑音） 103
図 3-16 Digital Generator > Waveform Configメニュー・ページ（ガウシアン

雑音） 103
図 3-17 Analog Generator > Waveform Configメニュー・ページ（方形雑音） 105
図 3-18 Digital Generator > Waveform Configメニュー・ページ（方形雑音） 105
図 3-19 Digital Generator > Waveform Configメニュー・ページ（三角雑音） 107
図 3-20 Analog Generator > Waveform Configメニュー・ページ（ピンク

雑音） 108
図 3-21 Digital Generator > Waveform Configメニュー・ページ（ピンク

雑音） 108
図 3-22 Analog Generator > Waveform Configメニュー・ページ（方形波

波形） 110
図 3-23 Digital Generator > Waveform Configメニュー・ページ（方形波

波形） 110
図 3-24 Analog Generator > Waveform Configメニュー・ページ（DC信号） 112
図 3-25 Digital Generator > Waveform Configメニュー・ページ（正弦波バー

スト） 113
図 3-26 Digital Generator > Waveform Configメニュー・ページ（ステレオ

波形） 114
図 3-27 Digital Generator > Waveform Configメニュー・ページ（単調波形） 115
図 3-28 Digital Generator > Waveform Configメニュー・ページ（一定値

波形） 116
図 3-29 Digital Generator > Waveform Configメニュー・ページ（ウォーキング・

ゼロ） 117
図 3-30 Digital Generator > Waveform Configメニュー・ページ（ウォーキング・

ワン） 118
図 3-31 Analog Generator > Waveform Configメニュー・ページ（任意波形） 119
図 3-32 Digital Generator > Waveform Configメニュー・ページ（任意波形） 119
18 Keysight U8903B ユーザーズ・ガイド



図 3-33 Analog Generator > Waveform Configメニュー・ページ 1（マルチトーン
波形） 121

図 3-34 Digital Generator > Waveform Configメニュー・ページ 1（マルチトーン
波形） 121

図 3-35 Analog Generator > Waveform Config > Customメニュー・ページ 1（マル
チトーン波形） 123

図 3-36 Digital Generator > Waveform Config > Customメニュー・ページ 1（マル
チトーン波形） 123

図 3-37 Analog Generator > Waveform Configメニュー・ページ 1（DTMF） 125
図 3-38 Dialメニュー・ページ 126
図 3-39 Analog Generator > Output Configメニュー・ページ 128
図 3-40 Digital Generator > Output Configメニュー・ページ 1 130
図 3-41 Digital Generator > Output Config > Ref Clockメニュー・ページ 131
図 3-42 Digital Generator > Output Config > Sync Clockメニュー・ページ 132
図 3-43 Digital Generator > DSI Configメニュー・ページ 1 133
図 3-44 Digital Generator > AES Configメニュー・ページ 1 135
図 3-45 Digital Generator > AES Config > Edit Bits（コンシューマ・フォーマット）

メニュー・ページ 1 136
図 3-46 Digital Generator > AES Config > Edit Bits（プロフェッショナル・フォー

マット）メニュー・ページ 1 141
図 3-47 Analog Generator > Referencesメニュー・ページ 147
図 3-48 Digital Generator > Referencesメニュー・ページ 148
図 4-1 Analog Analyzerメニュー・ページ 150
図 4-2 Digital Analyzerメニュー・ページ（標準測定モード） 151
図 4-3 Digital Analyzerメニュー・ページ（処理遅延測定モード） 153
図 4-4 Digital Analyzerメニュー・ページ（BERT測定モード） 154
図 4-5 Analog Analyzer > Functionsメニュー・ページ 1 155
図 4-6 Digital Analyzer > Functionsメニュー・ページ 1 155
図 4-7 Analog Analyzer > Functions > Frequencyメニュー・ページ 1 157
図 4-8 Digital Analyzer > Functions > Frequencyメニュー・ページ 1 158
図 4-9 Analog Analyzer > Functions > AC Voltageメニュー・ページ 1 159
図 4-10 Digital Analyzer > Functions > AC Voltageメニュー・ページ 1 160
図 4-11 Analog Analyzer > Functions > DC Voltageメニュー・ページ 1 162
図 4-12 Digital Analyzer > Functions > DC Voltageメニュー・ページ 1 163
図 4-13 Analog Analyzer > Functions > THD+N Ratioメニュー・ページ 1 164
図 4-14 Digital Analyzer > Functions > THD+N Ratioメニュー・ページ 1 165
図 4-15 Analog Analyzer > Functions > THD+N Levelメニュー・ページ 1 166
図 4-16 Digital Analyzer > Functions > THD+N Levelメニュー・ページ 1 167
図 4-17 Analog Analyzer > Functions > SINADメニュー・ページ 1 169
図 4-18 Digital Analyzer > Functions > SINADメニュー・ページ 1 169
図 4-19 Analog Analyzer > Functions > THD Ratioメニュー・ページ 1 171
図 4-20 Digital Analyzer > Functions > THD Ratioメニュー・ページ 1 172
図 4-21 Analog Analyzer > Functions > THD levelメニュー・ページ 1 173
図 4-22 Digital Analyzer > Functions > THD levelメニュー・ページ 1 174
図 4-23 Analog Analyzer > Functions > SMPTE IMDメニュー・ページ 1 177
図 4-24 Digital Analyzer > Functions > SMPTE IMDメニュー・ページ 1 178
図 4-25 Analog Analyzer > Functions > DFD 60268 2ndメニュー・ページ 1 180
図 4-26 Digital Analyzer > Functions > DFD 60268 2ndメニュー・ページ 1 180
図 4-27 Analog Analyzer > Functions > SNRメニュー・ページ 1 182
図 4-28 Analog Analyzer > Functions > SNR (Fast)メニュー・ページ 1 184
Keysight U8903B ユーザーズ・ガイド 19



図 4-29 Analog Analyzer > Functions > J-Testメニュー・ページ 186
図 4-30 Digital Analyzer > Functions > Positive Peakメニュー・ページ 187
図 4-31 Digital Analyzer > Functions > Negative Peakメニュー・ページ 189
図 4-32 Analog Analyzer > Functions > Phaseメニュー・ページ 192
図 4-33 Digital Analyzer > Functions > Phaseメニュー・ページ 192
図 4-34 Analog Analyzer > Functions > X-Talkメニュー・ページ 1 194
図 4-35 Digital Analyzer > Functions > X-Talkメニュー・ページ 1 195
図 4-36 Analog Analyzer > Filter Configメニュー・ページ 197
図 4-37 Analog Analyzer > Filter Config > Notch Filterメニュー・ページ 199
図 4-38 Digital Analyzer > Filter Configメニュー・ページ 200
図 4-39 Analog Analyzer > Meas Configメニュー・ページ 1 202
図 4-40 Digital Analyzer > Meas Configメニュー・ページ 204
図 4-41 Digital Analyzer > Meas Config > Triggerメニュー・ページ 205
図 4-42 Analog Analyzer > Input Configメニュー・ページ 206
図 4-43 Digital Analyzer > Input Configメニュー・ページ 208
図 4-44 Digital Analyzer > DSI Configメニュー・ページ 1 210
図 4-45 Digital Analyzer > AES Configメニュー・ページ 1 212
図 4-46 Digital Analyzer > Bits Analysisメニュー・ページ 1 213
図 4-47 Analog Analyzer > Wave Fileメニュー・ページ 214
図 4-48 Analog Analyzer > Statisticsメニュー・ページ 215
図 4-49 Digital Analyzer > Statisticsメニュー・ページ 215
図 5-1 Graph Analysisメニュー・ページ 218
図 5-2 Graph Analysis > Graph Settingsメニュー・ページ 220
図 5-3 Graph Analysis > Axis Settingsメニュー・ページ 1 222
図 5-4 Graph Analysis > Trace Settingsメニュー・ページ 1 224
図 5-5 Graph Analysis > Trace Settings > Memoryメニュー・ページ 226
図 5-6 Graph Analysis > Trace Settings > Mathメニュー・ページ 227
図 5-7 Graph Analysis > Trace Settings > Persistenceメニュー・ページ 228
図 5-8 Graph Analysis > Display Option > Graphメニュー・ページ 229
図 5-9 Graph Analysis > Display Option > Data Tableメニュー・ページ 230
図 5-10 Graph Analysis > Display Option > Marker Tableメニュー・ページ 230
図 5-11 Graph Analysis > Display Option > Statisticsメニュー・ページ 231
図 5-12 Graph Analysis > Display Option > Harmonicsメニュー・ページ 231
図 5-13 Graph Analysis > Harm Settingsメニュー・ページ（高調波表示） 232
図 5-14 Graph Analysis > Display Option > Signal Analysisメニュー・ページ 233
図 5-15 Graph Analysis > Measurementメニュー・ページ 234
図 5-16 Graph Analysis > Measurement > Measurement 1メニュー・ページ 235
図 6-1 Sweep Parameterメニュー・ページ 238
図 6-2 Sweep Parameter > App. Type > Group Delayメニュー・ページ 240
図 6-3 Sweep Parameter > Points Settingsメニュー・ページ 1 241
図 6-4 Sweep Parameter > Channelsメニュー・ページ 242
図 6-5 Sweep > Plot Viewメニュー・ページ 243
図 6-6 Sweep > Plot View > Axis Settingsメニュー・ページ 244
図 6-7 Sweep > Plot View > Plot Settingsメニュー・ページ 245
図 6-8 Sweep > Edit Pointsメニュー・ページ 1 246
図 7-1 TSA > Projectメニュー・ページ 249
図 7-2 Test Applicationメニュー・ページ 250
図 7-3 TSA > Projectメニュー・ページ 251
図 7-4 TSA > Project > Propertiesメニュー・ページ 252
図 7-5 TSA > Project > Testメニュー・ページ 253
20 Keysight U8903B ユーザーズ・ガイド



図 7-6 TSA > Project > Test > IO Configurationメニュー・ページ 254
図 7-7 TSA > Project > Test > IO Configuration > Output Configurationメニュー・

ページ 255
図 7-8 TSA > Project > Test > IO Configuration > Input Configurationメニュー・

ページ 257
図 7-9 Test > IO Configuration > Propertiesメニュー・ページ 259
図 7-10 Delay Sub-Stepsメニュー・ページ 260
図 7-11 Prompt Sub-Steps設定メニュー・ページ 261
図 7-12 Send SCPIサブステップ設定メニュー・ページ 262
図 7-13 TSA > Project > Test > AC Levelメニュー・ページ 263
図 7-14 TSA > Project > Test > AC Level > Propertiesメニュー・ページ 265
図 7-15 TSA > Project > Test > AC Level > Settings > Signal Generationメニュー・

ページ 266
図 7-16 TSA > Project > Test > AC Level > Settings > Signal Analysisメニュー・

ページ 267
図 7-17 Frequency > Signal Generation設定メニュー・ページ 269
図 7-18 Frequency > Signal Analysis設定メニュー・ページ 271
図 7-19 Phase > Signal Generation設定メニュー・ページ 272
図 7-20 Phase > Signal Analysis設定メニュー・ページ 274
図 7-21 SNR > Signal Generation設定メニュー・ページ 275
図 7-22 SNR > Signal Analysis設定メニュー・ページ 277
図 7-23 THD+N > Signal Generation設定メニュー・ページ 280
図 7-24 THD+N > Signal Analysis設定メニュー・ページ 281
図 7-25 DC Level > Signal Generation設定メニュー・ページ 284
図 7-26 DC Level > Signal Analysis設定メニュー・ページ 286
図 7-27 Crosstalk > Signal Generation設定メニュー・ページ 287
図 7-28 Crosstalk > Signal Analysis設定メニュー・ページ 288
図 7-29 SMPTE IMD > Signal Generation設定メニュー・ページ 290
図 7-30 SMPTE IMD > Signal Analysis設定メニュー・ページ 291
図 7-31 DFD IMD > Signal Generation設定メニュー・ページ 293
図 7-32 DFD IMD > Signal Analysis設定メニュー・ページ 294
図 7-33 Multitone Analyzer > Signal Generation設定メニュー・ページ 296
図 7-34 Multitone Analyzer > Signal Analysis設定メニュー・ページ 298
図 7-35 Stepped Frequency Sweep > Signal Generation設定メニュー・

ページ 299
図 7-36 Stepped Frequency Sweep > Signal Analysis設定メニュー・ページ 301
図 7-37 SMPTE Frequency Sweep > Signal Generation設定メニュー・ページ 304
図 7-38 SMPTE Frequency Sweep > Signal Analysis設定メニュー・ページ 306
図 7-39 DFD Frequency Sweep > Signal Generation設定メニュー・ページ 307
図 7-40 DFD Frequency Sweep > Signal Analysis設定メニュー・ページ 309
図 7-41 External Frequency Sweep > Signal Generation設定メニュー・

ページ 311
図 7-42 External Frequency Sweep > Signal Analysis設定メニュー・ページ 313
図 7-43 Stepped Level Sweep > Signal Generation設定メニュー・ページ 316
図 7-44 Stepped Level Sweep > Signal Analysis設定メニュー・ページ 318
図 7-45 SMPTE Level Sweep > Signal Generation設定メニュー・ページ 321
図 7-46 SMPTE Level Sweep > Signal Analysis設定メニュー・ページ 323
図 7-47 DFD Level Sweep > Signal Generation設定メニュー・ページ 325
図 7-48 DFD Level Sweep > Signal Analysis設定メニュー・ページ 327
図 7-49 DC Level Sweep > Signal Generation設定メニュー・ページ 329
Keysight U8903B ユーザーズ・ガイド 21



図 7-50 DC Level Sweep > Signal Analysis設定メニュー・ページ 330
図 7-51 レシーバ感度測定用の一般的なセットアップ 333
図 7-52 Receiver Sensitivity > Signal Generation設定メニュー・ページ 334
図 7-53 Receiver Sensitivity > Signal Analysis設定メニュー・ページ 335
図 7-54 External Level Sweep > Signal Generation設定メニュー・ページ 338
図 7-55 External Level Sweep > Signal Analysis設定メニュー・ページ 340
図 7-56 Measurement Recorder > Signal Generation設定メニュー・ページ 344
図 7-57 Measurement Recorder > Signal Analysis設定メニュー・ページ 345
図 7-58 Voice Quality > Signal Generation/Signal Analysis設定メニュー・

ページ 349
図 7-59 AC Level > Settings > Result (AC level)メニュー・ページ 352
図 7-60 Multitone Analyzer > Settings > Result (Spectrum)メニュー・ページ 353
図 7-61 TSA > Reportメニュー・ページ 356
図 7-62 TSA > Report > Propertiesメニュー・ページ 357
図 7-63 Select Pathメニュー・ページ 358
図 8-1 HP8903Bメニュー・ページ 360
図 8-2 HP8903B > Measurementメニュー・ページ 362
図 8-3 HP8903B > Generatorメニュー・ページ 364
図 8-4 HP8903B > Sweepメニュー・ページ 365
図 8-5 HP8903B > Code Listメニュー・ページ（Input Level Range (except DC 

Level)） 366
図 A-1 Analog Generator > Waveform Config > Infoメニュー・ページ（任意

波形） 512
図 A-2 25ピン D-SUB（メス）コネクタ 517
図 A-3 デジタル・システムのクロック分配ブロック図 518
図 A-4 DSIテスト構成 1 519
図 A-5 DSIテスト構成 2 520
図 A-6 DSIテスト構成 3 521
図 A-7 DSIテスト構成 4 522
図 A-8 DSIテスト構成 5 523
図 A-9 デジタル・ジェネレータでの正弦波波形の作成 524
図 A-10 デジタル・アナライザでの電圧測定 525
22 Keysight U8903B ユーザーズ・ガイド



表一覧

表 1-1 U8903Bオプションのアクセサリ 32
表 1-2 U8903Bオプション 33
表 1-3 U8903Bフロント・パネルの概要 34
表 1-4 U8903Bリア・パネルの概要 36
表 1-5 U8903B LCDディスプレイの概要 39
表 1-6 System > Updateメニュー・ページ 42
表 1-7 System > Service > Self-Testメニュー・ページ 44
表 1-8 System > Service > Optionsメニュー・ページ 45
表 2-1 ナビゲーション /DATA ENTRYパネルの概要 52
表 2-2 U8903Bのモードの概要 54
表 2-3 FUNCTIONパネルの概要 57
表 2-4 GRAPHパネルの概要 61
表 2-5 Saveメニューの概要 62
表 2-6 Peak Search > Thresholdメニューの概要 63
表 2-7 Markeメニューの概要 64
表 2-8 Marker > Marker -メニューの概要 66
表 2-9 Marker > Harmonicsメニューの概要 67
表 2-10 Scaleメニューの概要 68
表 2-11 SYSTEMパネルの概要 71
表 2-12 Presetメニュー・ページの概要 72
表 2-13 Utilityメニューの概要（ジェネレータ／アナライザ・モード） 73
表 2-14 Utilityメニューの概要（グラフ解析モード） 74
表 2-15 Error Infoメニューの概要 76
表 2-16 I/Oメニューの概要（ジェネレータ／アナライザ・モード） 77
表 2-17 System > I/O > LAN Settingsメニューの概要 78
表 2-18 System > Serviceメニューの概要 79
表 2-19 System > Settingsメニューの概要 80
表 2-20 System > HP8903B Configメニューの概要 81
表 2-21 System > Aux Outputメニューの概要 83
表 2-22 ナビゲーション /DATA ENTRYパネルの概要 85
表 2-23 Saveメニューの概要 86
表 2-24 Saveメニューの概要 87
表 3-1 Analog Generatorメニューの概要 90
表 3-2 Digital Generatorメニューの概要 91
表 3-3 Analog/Digital Generator > Waveform Configメニューの概要（正弦波

波形） 93
表 3-4 Analog/Digital Generator > Waveform Configメニューの概要（可変位相

波形） 95
表 3-5 Analog/Digital Generator > Waveform Configメニューの概要（デュアル

波形） 97
表 3-6 Analog/Digital Generator > Waveform Configメニューの概要（SMPTE IMD

波形） 99
表 3-7 Analog/Digital Generator > Waveform Configメニューの概要（IEC 60118

波形） 101
表 3-8 Analog/Digital Generator > Waveform Configメニューの概要（IEC 60268

波形） 102
Keysight U8903B ユーザーズ・ガイド 23



表 3-9 Analog/Digital Generator > Waveform Configメニューの概要（ガウシアン
雑音） 104

表 3-10 Analog/Digital Generator > Waveform Configメニューの概要（方形
雑音） 106

表 3-11 Digital Generator > Waveform Configメニューの概要（三角雑音） 107
表 3-12 Analog/Digital Generator > Waveform Configメニューの概要（ピンク

雑音） 109
表 3-13 Analog/Digital Generator > Waveform Configメニューの概要（方形波

波形） 111
表 3-14 Analog Generator > Waveform Configメニューの概要（DC信号） 112
表 3-15 Digital Generator > Waveform Configメニューの概要（正弦波バー

スト） 113
表 3-16 Digital Generator > Waveform Configメニューの概要（ステレオ

波形） 114
表 3-17 Digital Generator > Waveform Configメニューの概要（単調波形） 115
表 3-18 Digital Generator > Waveform Configメニューの概要（一定値波形） 116
表 3-19 Digital Generator > Waveform Configメニューの概要（ウォーキング・

ゼロ） 117
表 3-20 Digital Generator > Waveform Configメニューの概要（ウォーキング・

ワン） 118
表 3-21 Analog/Digital Generator > Waveform Configメニューの概要（任意

波形） 120
表 3-22 Analog/Digital Generator > Waveform Configメニューの概要（マルチト

ーン波形） 122
表 3-23 Analog Generator > Waveform Config > Customメニューの概要（マルチ

トーン波形） 124
表 3-24 Analog Generator > Waveform Configメニューの概要（DTMF） 126
表 3-25 Dialメニュー・ページの概要 127
表 3-26 DTMFトーン・マッピング 127
表 3-27 Analog Generator > Output Configメニューの概要 128
表 3-28 Digital Generator > Output Configメニューの概要 130
表 3-29 Digital Generator > Output Config > Ref Clockメニューの概要 131
表 3-30 Digital Generator > Output Config > Sync Clockメニューの概要 132
表 3-31 Digital Generator > DSI Output Configメニューの概要 133
表 3-32 Digital Generator > AES Configメニューの概要 135
表 3-33 Digital Generator > AES Config > Edit Bits（コンシューマ・フォーマット）

メニューの概要 136
表 3-34 AES3/SPDIFコンシューマ・モードのビットの概要 139
表 3-35 Digital Generator > AES Config > Edit Bits（プロフェッショナル・フォー

マット）メニューの概要 141
表 3-36 AES3/SPDIFプロフェッショナル・モードのビットの概要 144
表 3-37 Analog Generator > Referencesメニューの概要 147
表 3-38 Digital Generator > Referencesメニューの概要 148
表 4-1 Analog Analyzerメニューの概要 151
表 4-2 Digital Analyzerメニューの概要 152
表 4-3 Analog/Digital Analyzer > Functionsメニューの概要 156
表 4-4 Analog/Digital Analyzer > Functions > Frequencyメニューの概要 158
表 4-5 Analog/Digital Analyzer > Functions > AC Voltageメニューの概要 160
表 4-6 Analog/Digital Analyzer > Functions > DC Voltageメニューの概要 163
表 4-7 Analog/Digital Analyzer > Functions > THD+N Ratioメニューの概要 165
24 Keysight U8903B ユーザーズ・ガイド



表 4-8 Analog/Digital Analyzer > Functions > THD+N Levelメニューの概要 167
表 4-9 Analog/Digital Analyzer > Functions > SINADメニューの概要 170
表 4-10 Analog/Digital Analyzer > Functions > THD Ratioメニューの概要 172
表 4-11 Analog/Digital Analyzer > Functions > THD Levelメニューの概要 174
表 4-12 Analog/Digital Analyzer > Functions > SMPTE IMDメニューの概要 178
表 4-13 Analog/Digital Analyzer > Functions > DFD測定のメニューの概要 181
表 4-14 Analog Analyzer > Functions > SNRメニューの概要 183
表 4-15 Analog Analyzer > Functions > SNR (Fast)メニューの概要 185
表 4-16 Digital Analyzer > Functions > Positive Peakメニューの概要 187
表 4-17 Digital Analyzer > Functions > Negative Peakメニューの概要 189
表 4-18 Analog/Digital Analyzer > Functions > Phaseメニューの概要 193
表 4-19 Analog/Digital Analyzer > Functions > X-Talkメニューの概要 195
表 4-20 Analog Analyzer > Filter Configメニューの概要 197
表 4-21 Analog Analyzer > Filter Config > Notch Filterメニューの概要 199
表 4-22 Digital Analyzer > Filter Configメニューの概要 200
表 4-23 Analog Analyzer > Meas Configメニューの概要 202
表 4-24 Digital Analyzer > Meas Configメニューの概要 204
表 4-25 Digital Analyzer > Meas Config > Triggerメニューの概要 205
表 4-26 Analog Analyzer > Input Configメニューの概要 206
表 4-27 Digital Analyzer > Input Configメニューの概要 208
表 4-28 Digital Analyzer > DSI Configメニューの概要 210
表 4-29 Digital Analyzer > AES Configメニューの概要 212
表 4-30 Digital Analyzer > Bits Analysisメニューの概要 213
表 4-31 Analog Analyzer > Wave Fileメニューの概要 214
表 4-32 Analog/Digital Analyzer > Statisticsメニューの概要 216
表 5-1 Graph Analysisメニューの概要 219
表 5-2 Graph Analysis > Graph Settingsメニューの概要 220
表 5-3 Graph Analysis > Axis Settingsメニューの概要 222
表 5-4 Graph Analysis > Trace Settingsメニューの概要 224
表 5-5 Graph Analysis > Trace Settings > Memoryメニューの概要 226
表 5-6 Graph Analysis > Trace Settings > Mathメニューの概要 227
表 5-7 Graph Analysis > Trace Settings > Persistenceメニューの概要 228
表 5-8 Graph Analysis > Harm Settingsメニューの概要（高調波表示） 232
表 5-9 Graph Analysis > Measurementメニューの概要 234
表 5-10 Graph Analysis > Measurement > Measurement 1/Measurement 2メニュー

の概要 235
表 6-1 Sweep Parameterメニューの概要 239
表 6-2 Sweep Parameter > Points Settingsメニューの概要 241
表 6-3 Sweep Parameter > Channelsメニューの概要 242
表 6-4 Sweep > Plot Viewメニューの概要 243
表 6-5 Sweep > Plot View > Axis Settingsメニューの概要 244
表 6-6 Sweep > Plot View > Plot Settingsメニューの概要 245
表 6-7 Sweep > Edit Pointsメニューの概要 246
表 7-1 Test Applicationメニューの概要 250
表 7-2 TSA > Projectメニューの概要 251
表 7-3 TSA > Project > Propertiesメニューの概要 252
表 7-4 TSA > Project > Testメニューの概要 253
表 7-5 TSA > Project > Test > IO Configurationメニューの概要 254
表 7-6 TSA > Project > Test > IO Configuration > Output Configurationメニューの

概要 255
Keysight U8903B ユーザーズ・ガイド 25



表 7-7 TSA > Project > Test > IO Configuration > Input Configurationメニューの
概要 257

表 7-8 TSA > Project > Test > IO Configuration > Propertiesメニューの概要 259
表 7-9 Sub-stepsメニューの概要 260
表 7-10 Prompt Sub-Steps設定メニューの概要 261
表 7-11 Send SCPIサブステップ設定メニューの概要 262
表 7-12 TSA > Project > Test > Measurementメニューの概要 263
表 7-13 TSA > Project > Test > Measurement > Propertiesメニューの概要 265
表 7-14 TSA > Project > Test > AC Level > Settings > Signal Generationメニューの

概要 267
表 7-15 TSA > Project > Test > AC Level > Settings > Signal Analysisメニューの

概要 268
表 7-16 Frequency > Signal Generation設定メニューの概要 270
表 7-17 Frequency > Signal Analysis設定メニューの概要 271
表 7-18 Phase > Signal Generation設定メニューの概要 273
表 7-19 Phase > Signal Analysis設定メニューの概要 274
表 7-20 SNR > Signal Generation設定メニューの概要 276
表 7-21 SNR > Signal Analysis設定メニューの概要 277
表 7-22 THD+N > Signal Generation設定メニューの概要 281
表 7-23 THD+N > Signal Analysis設定メニューの概要 282
表 7-24 DC Level > Signal Generation設定メニューの概要 285
表 7-25 DC Level > Signal Analysis設定メニューの概要 286
表 7-26 Crosstalk > Signal Generation設定メニューの概要 288
表 7-27 Crosstalk > Signal Analysis設定メニューの概要 289
表 7-28 SMPTE IMD > Signal Generation設定メニューの概要 291
表 7-29 SMPTE IMD > Signal Analysis設定メニューの概要 292
表 7-30 DFD IMD > Signal Generation設定メニューの概要 294
表 7-31 DFD IMD > Signal Analysis設定メニューの概要 295
表 7-32 Multitone Analyzer > Signal Generation設定メニューの概要 297
表 7-33 Multitone Analyzer > Signal Analysis設定メニューの概要 298
表 7-34 Stepped Frequency Sweep > Signal Generation設定メニューの概要 300
表 7-35 Stepped Frequency Sweep > Signal Analysis設定メニューの概要 301
表 7-36 SMPTE Frequency Sweep > Signal Generation設定メニューの概要 305
表 7-37 SMPTE Frequency Sweep > Signal Analysis設定メニューの概要 306
表 7-38 DFD Frequency Sweep > Signal Generation設定メニューの概要 308
表 7-39 DFD Frequency Sweep > Signal Analysis設定メニューの概要 309
表 7-40 External Frequency Sweep > Signal Generation設定メニューの概要 311
表 7-41 External Frequency Sweep > Signal Analysis設定メニューの概要 313
表 7-42 Stepped Level Sweep > Signal Generation設定メニューの概要 317
表 7-43 Stepped Level Sweep > Signal Analysis設定メニューの概要 318
表 7-44 SMPTE Level Sweep > Signal Generation設定メニューの概要 322
表 7-45 SMPTE Level Sweep > Signal Analysis設定メニューの概要 323
表 7-46 DFD Level Sweep > Signal Generation設定メニューの概要 326
表 7-47 DFD Level Sweep > Signal Analysis設定メニューの概要 327
表 7-48 DC Level Sweep > Signal Generation設定メニューの概要 330
表 7-49 DC Level Sweep > Signal Analysis設定メニューの概要 331
表 7-50 Receiver Sensitivity > Signal Generation設定メニューの概要 334
表 7-51 Receiver Sensitivity > Signal Analysis設定メニューの概要 335
表 7-52 External Level Sweep > Signal Generation設定メニューの概要 338
表 7-53 External Level Sweep > Signal Analysis設定メニューの概要 340
26 Keysight U8903B ユーザーズ・ガイド



表 7-54 Measurement Recorder > Signal Generation設定メニューの概要 344
表 7-55 Measurement Recorder > Signal Analysis設定メニューの概要 345
表 7-56 Voice Quality > Signal Generation/Signal Analysis設定メニューの

概要 349
表 7-57 TSA > Project > Test > Measurement > Settings > Result（棒グラフ）

メニューの概要 352
表 7-58 TSA > Project > Test > Measurement > Settings > Result（グラフ）メニュー

の概要 354
表 7-59 TSA > Reportメニューの概要 356
表 7-60 TSA > Report > Propertiesメニューの概要 357
表 8-1 U8903B LCDディスプレイの概要 361
表 8-2 HP8903B > Measurementメニューの概要 362
表 8-3 HP8903Bの単位表 363
表 8-4 HP8903B > Generatorメニューの概要 364
表 8-5 HP8903B > Sweepメニューの概要 365
表 8-6 HP8903Bのスペシャル・ファンクション・コード・リストの概要 366
表 9-1 測定カテゴリの定義 392
表 A-1 FUNCTIONパネルの概要 395
表 A-2 GRAPHパネルのメニュー・ツリーの概要 396
表 A-3 SYSTEMパネルのメニュー・ツリーの概要 398
表 A-4 アナログ・ジェネレータのメニュー・ツリーの概要 402
表 A-5 デジタル・ジェネレータのメニュー・ツリーの概要 406
表 A-6 アナログ ・アナライザのメニュー・ツリーの概要 417
表 A-7 デジタル・アナライザのメニュー・ツリーの概要 428
表 A-8 Graph Analysisメニュー・ツリーの概要 440
表 A-9 掃引機能のメニュー・ツリーの概要 444
表 A-10 Saveメニュー・ツリーの概要 447
表 A-11 Recallメニュー・ツリーの概要 448
表 A-12 テスト・シーケンスのメニュー・ツリーの概要 449
表 A-13 Measurement settings > AC Levelメニュー・ツリーの概要 456
表 A-14 Measurement settings > Frequencyメニュー・ツリーの概要 458
表 A-15 Measurement settings > Phaseメニュー・ツリーの概要 459
表 A-16 Measurement settings > SNRメニュー・ツリーの概要 460
表 A-17 Measurement settings > THD+Nメニュー・ツリーの概要 463
表 A-18 Measurement settings > DC Levelメニュー・ツリーの概要 465
表 A-19 Measurement settings > Crosstalkメニュー・ツリーの概要 466
表 A-20 Measurement settings > SMPTE IMDメニュー・ツリーの概要 467
表 A-21 Measurement settings > DFD IMDメニュー・ツリーの概要 468
表 A-22 Measurement settings > Multitone Analyzerメニュー・ツリーの概要 469
表 A-23 Measurement settings > Stepped Frequency Sweepメニュー・ツリーの

概要 471
表 A-24 Measurement settings > SMPTE Frequency Sweepメニュー・ツリーの

概要 474
表 A-25 Measurement settings > DFD Frequency Sweepメニュー・ツリーの

概要 476
表 A-26 Measurement settings > External Frequency Sweepメニュー・ツリーの

概要 478
表 A-27 Measurement settings > Stepped Level Sweepメニュー・ツリーの

概要 481
表 A-28 Measurement settings > SMPTE Level Sweepメニュー・ツリーの

概要 484
Keysight U8903B ユーザーズ・ガイド 27



表 A-29 Measurement settings > DFD Level Sweepメニュー・ツリーの概要 486
表 A-30 Measurement settings > DC Level Sweepメニュー・ツリーの概要 488
表 A-31 Measurement settings > Receiver Sensitivityメニュー・ツリーの概要 490
表 A-32 Measurement settings > External Level Sweepメニュー・ツリーの

概要 493
表 A-33 Measurement settings > Measurement Recorderメニュー・ツリーの

概要 496
表 A-34 Measurement settings > Voice Qualityメニュー・ツリーの概要 499
表 A-35 Measurement Results > Bar chartメニュー・ツリーの概要 502
表 A-36 Measurement results > Graphメニュー・ツリーの概要 503
表 A-37 HP8903Bのメニュー・ツリーの概要 506
表 A-38 アナログ・アナライザの測定機能の戻り値の単位 508
表 A-39 デジタル・アナライザの測定機能の戻り値の単位 509
表 A-40 単位変換式 510
表 A-41 デジタル・オーディオ測定の単位 511
表 A-42 任意波形ファイル・パラメータの許容範囲 512
表 A-43 25ピン D-SUB（メス）コネクタのピン割り当て 517
表 A-44 デジタル波形パラメータとチャネルの関係 528
表 A-45 DSIのワード長、サンプリング・レート、乗数 530
表 A-46 マスタ・クロック入力のワード長、サンプリング・レート、乗数 536
表 A-47 アナログ・ジェネレータのデフォルト設定 542
表 A-48 アナログ・アナライザのデフォルト設定 543
表 A-49 Sweepデフォルト設定 546
表 A-50 HP8903Bデフォルト設定 547
表 A-51 Systemデフォルト設定 547
28 Keysight U8903B ユーザーズ・ガイド



Keysight U8903B
オーディオ・アナライザ
ユーザーズ・ガイド
1 測定前の準備

はじめに     30

LXI Standard 1.4準拠オーディオ・アナライザ     30

インストールと設定     31

受入れ検査     31

通気     31

ラック・マウント     31

標準付属品     32

オプションのアクセサリ     32

U8903Bオプション     33

製品の外観     34

フロント・パネル     34

リア・パネル     36

LCDディスプレイ     38

使用前の準備     40

U8903Bの電源投入     40

U8903Bのプリセット     40

ヘルプ・モードへのアクセス     41

U8903Bのアップデート     42

セルフテストの実行     44

U8903Bオプションの追加／削除     45

この章では、U8903Bを初めてセットアップするための手順を説明します。U8903Bの
すべての機能の概要も紹介します。



1 測定前の準備
はじめに
U8903Bは、デジタル信号処理（DSP）ベースのオーディオ測定システムで、周波数測
定範囲は 10 Hz～ 96 kHzまたは 1.5 MHz（インストールしているオプションに依存）
です。U8903Bの基本構成には、2チャネルのアナログ・オーディオ・ジェネレータと、
2チャネルのアナログ・オーディオ・アナライザが含まれます。

U8903Bオーディオ・アナライザ用の標準オプションは、オプション STDです。U8903B
は、アナログ・アナライザ・チャネルや、AES3、SPDIF、デジタル・シリアル・インタ
フェース（DSI）などのデジタル・オーディオ・インタフェースの追加により、さらに
拡張できます。使用可能な U8903Bオプションの詳細については、 「U8903Bオプショ
ン」（ページ）33を参照してください。

U8903Bは、アナログ・オ－ディオとデジタル・オーディオの両方のインタフェースの
さまざまなオーディオ・パラメータ測定が可能です。 アナログ・オーディオ・インタ
フェース上では、最大 4つの測定機能を同時に実行できます。測定機能は、アナログ・
オーディオ + AES3/SPDIF、アナログ・オーディオ + DSI、AES3/SPDIF + DSIなど、ア
ナログ・オ－ディオとデジタル・オーディオのインタフェース上で同時に実行できま
す。U8903Bはまた、GPIB、USB、LANなどの業界標準の測定器インタフェースをサ
ポートしています。さらに U8903Bは、周波数／位相／時間 /FFTグラフ解析機能や、
周波数／振幅掃引機能も備えています。

U8903Bでは、テスト・シーケンスを作成することもできます。詳細については、第 7
章、「テスト・シーケンス・アプリケーション」を参照してください。

U8903Bのファームウェア・アップデートの検索は Keysight、以下の U8903Bファーム
ウェア・アップデートWebサイトをご覧ください：www.keysight.co.jp/find/
audioanalyzer_firmware。

LXI Standard 1.4準拠オーディオ・アナライザ

U8903Bオーディオ・アナライザは、LXI（LAN eXtension for 
Instrumentation）規格 1.4に準拠した（標準コア）測定器で、
LXIテクノロジーを使用して開発されています。LXIは、イーサ
ネット（LAN）を主要な通信インタフェースとして使用するデ
バイスのための測定器標準です。

これにより、本器は使いやすくなり、特に内蔵Webブラウザによる測定器機能の設定
は便利です。
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測定前の準備 1
インストールと設定

受入れ検査

U8903Bを受領したら、ユニットに輸送中の損傷（端子の破損、シャーシのひび、欠け、
傷など）がないかどうか調べます。損傷が見つかった場合は、Keysight計測お客様窓口
まで直ちにご連絡ください。

納品時の梱包は、購入した U8903Bを Keysightに送り返す場合に備えて保管しておい
てください。U8903Bをサービスのために送る場合は、所有者とモデル番号を記載した
タグを添付してください。また、返送理由の簡単な説明を書いて同梱してください。

通気

U8903Bは、0 °C ～ 55 °Cの温度範囲で動作します。U8903Bは、U8903Bのフロントの側
面と底面から空気を引き込んでクーリングされ、U8903Bのリアの側面と上面の換気穴
から空気を放出します。 空気の循環を妨げないように、U8903Bは、上面、側面、背面
に十分な空間がある場所に設置してください。

ラック・マウント

U8903Bは標準の 19インチ・ラックにマウントできます。ラックマウント・キットは、
オプション 908として購入できます。 ラック・マウントにはサポート・レールも必要で
す。これは通常ラックに付属しているので、ラック・マウント・オプションには含まれ
ていません。

U8903Bの上に測定器をインストールする場合は、U8903Bの上部にある通気穴を測定器
がふさがないように注意する必要があります。必要な場合は、U8903Bの上にフィ
ラー・パネルを入れて、空気循環のための空間を確保します。
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1 測定前の準備
標準付属品
以下の付属品を受け取っていることを確認してください。欠品または損傷している付属
品がある場合は、Keysight計測お客様窓口までお問い合わせください。

– U8903Bオーディオ・アナライザ

– 電源ケーブル

– USBケーブル

– 校正証明書

– 安全に関する注意事項

オプションのアクセサリ
別売で以下のアクセサリが用意されています。

表 1-1 U8903Bオプションのアクセサリ

オプション 概要

U8903B-101 BNC（オス）－ BNC（オス）ケーブル（1.2 m）

U8903B-102 BNC（オス）－ RCA（オス）ケーブル（2 m）

U8903B-103 XLR（オス）－ XLR（メス）ケーブル（2 m）

U8903B-104 デジタル・シリアル・インタフェース・ケーブル

U8903B-105 デジタル・セルフテスト・キット、25ピン D-SUB

U8903B-106 XLR（オス）－ BNC（オス）ケーブル（0.26 m）

U8903B-107 XLR（メス）－ BNC（オス）ケーブル（0.26 m）

U8903B-108 BNCアクセサリ・キット

U8903B-109 ラックマウント・キット
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測定前の準備 1
U8903Bオプション

表 1-2 U8903Bオプション

オプション 概要

U8903B-STD
– 2チャネル（アナログ・ジェネレータ）
– 2チャネル（アナログ・アナライザ）

U8903B-AN4
– 2チャネル（アナログ・ジェネレータ）
– 4チャネル（アナログ・アナライザ）

U8903B-AN8
– 2チャネル（アナログ・ジェネレータ）
– 8チャネル（アナログ・アナライザ）

U8903B-DGT デジタル・オーディオ・カード

U8903B-AUX
– 2個のモニタ出力
– 1個の補助出力（DC）

N3431A
広帯域オプション：1.5 MHz（固定永久ライセンス）。
チャネル 1/チャネル 2アナログ・アナライザにのみ使用可能です。

N3432A POLQA（Perceptual Objective Listening Quality Analysis）測定ソフトウェア（固定永久ライセンス）。

N3433A POLQAおよび PESQ（Perceptual Evaluation of Speech Quality）測定ソフトウェア（固定永久ライ
センス）。

N3434A AES3/SPDIF/DSIデジタル・オーディオ・インタフェース（固定永久ライセンス）。

N3435A AES3/SPDIFデジタル・オーディオ・インタフェース（固定永久ライセンス）。

N3436A DSIデジタル・オーディオ・インタフェース（固定永久ライセンス）。
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1 測定前の準備
製品の外観

フロント・パネル

図 1-1 U8903Bフロント・パネル
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表 1-3 U8903Bフロント・パネルの概要

項目 概要

1 LCDディスプレイ
現在の機能に関する、ステータス・インジケータ、設定、エラー・メッセージなど
の情報を表示します。詳細については、「LCDディスプレイ」（ページ）38を参照
してください。

2 ソフトキー 1～ 7 各ソフトキーの左側の LCDディスプレイ上に表示されている機能をオンにします。

3 ナビゲーション /DATA ENTRYパネル
ナビゲーション /DATA ENTRYパネルには、矢印キー、Enterキー、ノブ、データ入力
キーがあります。詳細については、「ナビゲーション /DATA ENTRYパネル」（ペー
ジ）52を参照してください。

4 Menuキー

使用可能な U8903Bの動作モードを表示します。
– Standard View

– Test Seq App

– HP 8903B

5 FUNCTIONパネル U8903Bのメイン機能にアクセスします。

6 RUN CONTROLパネル

［On/Off］を押して、選択したジェネレータ・チャネルの信号発生またはアナライ
ザ・チャネルの測定をオン／オフします。
［On/Off］を押して、グラフの作成を開始／停止します。 
［On/Off］を押して、掃引を開始／停止します。
［On/Off］を押して、テスト・シーケンスを開始／停止します。
［Stop All］を押すと、すべてのジェネレータおよびテスト・シーケンスの動作が
停止します。
詳細については、「RUN CONTROLパネル」（ページ）85を参照してください。

7 GRAPHパネル U8903Bの頻繁に使用するグラフ機能にアクセスします。詳細については、「GRAPH
パネル」（ページ）61を参照してください。
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測定前の準備 1
8 SYSTEMパネル U8903Bのシステム機能にアクセスします。詳細については、「SYSTEMパネル」
（ページ）71を参照してください。

9 ヘッドフォン・ジャック
ヘッドフォン・ジャックは、ステレオ・モードまたはモノラル・モードで動作しま
す。詳細については、「入力設定（アナログ・アナライザ）」（ページ）206を参照
してください。

10 USBポート 外部 USBフラッシュ・メモリを U8903Bに接続します。

11 アナログ・アナライザ入力
平衡信号には XLR（メス）入力コネクタ、不平衡信号には BNC（メス）入力コネク
タを使用して、アナログ・オーディオ信号を受信します。各チャネルに対して、入
力コネクタが用意されています。

12 アナログ・ジェネレータ出力
平衡信号には XLR（オス）出力コネクタ、不平衡信号には BNC（メス）出力コネク
タを使用して、アナログ・オーディオ信号を出力します。各チャネルに対して、出
力コネクタが用意されています。

13 電源キー U8903Bの電源をオン／オフします。

表 1-3 U8903Bフロント・パネルの概要（続き）

項目 概要
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1 測定前の準備
リア・パネル

図 1-2 U8903Bリア・パネル

1 2 3 7 8 9

10111216 15

4 5 6

1314

表 1-4 U8903Bリア・パネルの概要

項目 概要

1 Monitor 1

オプション U8903B-AUX用です。
アナログ・アナライザ・チャネル 1/3/5/7の入力信号のスケーリングされた信
号を出力します。スケーリングされた信号はさらに、外部増幅器などの他の測
定器に接続することができます。

2 Monitor 2

オプション U8903B-AUX用です。
アナログ・アナライザ・チャネル 2/4/6/8の入力信号のスケーリングされた信
号を出力します。スケーリングされた信号はさらに、外部増幅器などの他の測
定器に接続することができます。

3 アナログ・アナライザ入力
（チャネル 3～ 8）

オプション U8903B-AN4および U8903B-AN6用です。
平衡入力には XLR（メス）入力コネクタ、不平衡入力には BNC（メス）入力コ
ネクタを使用して、アナログ・オーディオ信号を受信します。最大 6つのアナ
ログ入力チャネルを使用できます。各チャネルに対して、入力コネクタが用意
されています。

4 デジタル・アナライザ入力／出力（ES3）
オプション U8903B-DGT用です。
XLR（メス）入力コネクタと XLR（オス）出力コネクタを使用して、デジタル・
オーディオ信号を入力／出力します。

5 デジタル・アナライザ入力／出力
（SPDIF）

オプション U8903B-DGT用です。
TOSLINK入力コネクタと TOSLINK出力コネクタを使用して、デジタル・オー
ディオ信号を入力／出力します。

6 同期入力
オプション U8903B-DGT用です。
BNC（メス）入力コネクタ（デジタル・オーディオ専用）を使用して、クロッ
ク／フレーム信号の外部同期を受信します。

7 LANポート U8903Bを LANインタフェース経由でリモート制御するために使用します。

8 USBポート（タイプ B） U8903Bを USBインタフェース経由でリモート制御するために使用します。
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測定前の準備 1
図 1-3 TOSLINKケーブルをまっすぐにコネクタに接続します。

9 AC電源ポート AC電源ライン電圧に接続します。

10 VGAポート 外部モニタを U8903Bに接続します。

11 GPIBポート U8903Bを GPIB（General Purpose Interface Bus）インタフェース経由でリモート制
御するために使用します。

12 USBポート 外部 USBフラッシュ・メモリを U8903Bに接続します。

13 デジタル・アナライザ入力／出力
（AES3/SPDIF）

オプション U8903B-DGT用です。
BNC（メス）入力コネクタと BNC（メス）出力コネクタを使用して、デジタ
ル・オーディオ信号を入力／出力します。

14 デジタル・アナライザ入力／出力（DSI）
オプション U8903B-DGT用です。
25ピン D-SUB（メス）コネクタを使用して、デジタル・オーディオ信号を
入力／出力します。

15 AUXポート

オプション U8903B-AUX用です。
可変 DC電圧（0.5 V～ 5.1 V、最大 100 mA）を出力します。AUXポートは、テス
ト・デバイスに電源を供給するトリガとして、または外部ハードウェアを制御
するのに使用することができます。

16 トリガ入力 トリガ動作のために、BNC（メス）入力コネクタを使用して、外部 TTL信号を
受信します。トリガは立ち上がりまたは立ち下がりエッジで発生できます。

表 1-4 U8903Bリア・パネルの概要（続き）

項目 概要

注意 – TOSLINKケーブルをまっすぐに TOSLINKコネクタに接続します。

– ケーブルを押し付けたり斜めに接続しないでください。TOSLINKコネクタが損傷す
る可能性があります。 
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1 測定前の準備
LCDディスプレイ

図 1-4 U8903BLCDディスプレイ

2

3
1

4
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測定前の準備 1
表 1-5 U8903B LCDディスプレイの概要

項目 概要

1 メイン・ディスプレイ

使用可能な U8903Bのモードおよび機能が表示されます。
– AG1/AG2：アナログ・ジェネレータ・チャネル 1または 2。
– AA#：アナログ・アナライザ・チャネル（1、2、3、4、5、6、7または 8）。
– DG1/DG2：デジタル・ジェネレータ・チャネル 1または 2

– DA1/DA2：デジタル・アナライザ・チャネル 1または 2

2 タイトル・バー

– メイン・ディスプレイの現在アクティブなメニューの名前が表示されます。
– 以下のアイコンが表示されます。

–  LAN接続済み

–  LAN未接続

–  LAN接続済み（エラー発生）

–  LXIフロント・パネルがオン状態

–  外部 USBフラッシュ・メモリが接続状態

–  シフト機能

–  リモート制御モード

–  フロント・パネル・キーがロック状態

–  ヘルプ・モード

–  警告

–  ファン動作不良

–  メモリ・バッファ

3 ソフトキー・パネル 選択したパネルのソフトキー・メニュー・オプションが表示されます（最大
7個）。

4 ステータス・バー アクションのステータス（情報、警告、エラー・メッセージなど）が表示され
ます。

注 U8903Bのディスプレイ・レイアウトに関する詳細は、「Dispalyモード」（ページ）59を
参照してください。
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1 測定前の準備
使用前の準備

U8903Bの電源投入

電源コードの一方を U8903Bのリア・パネルにある AC電源ソケットに、もう一方を
AC電源ラインに接続します。U8903Bは、100 Vac～ 240 Vacの範囲の電源電圧に自動
的に調整されます。

U8903Bのプリセット

プリセットを実行すると、U8903Bはデフォルト状態に設定されます。I/O設定、校正
データ、システム設定（時刻、日付、モデル番号、シリアル番号）、ライセンス情報に
影響はありません。詳細については、「付録 Q：DSI入力および出力インタフェース」
（ページ）517を参照してください。

U8903Bをプリセットするには、以下のいずれかの手順を実行します。

– *RST、SYSTem:PRESet、SYSTem:PRESet:TYPE、SYSTem:RESet[:MODE]のい
ずれかの SCPIコマンドを、USB、GPIB、LANインタフェース経由で PCから送信し
ます。

– ［SYSTEM］パネルの を押します。Preset

注 プリセットの詳細については、「SYSTEMパネル」（ページ）71を参照してください。
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測定前の準備 1
ヘルプ・モードへのアクセス

U8903Bヘルプ・モードでは、フロント・パネル・キーや現在のソフトキーの説明を表
示して、操作方法をすばやく確認できます。

U8903Bヘルプ・モードをオン／オフするには、［DATA ENTRY］パネルの と

［SYSTEM］パネルの を押します。

ヘルプ・モードの例を図 1-5に示します。ヘルプ・モードを示すアイコンは、タイト
ル・バーの右上に表示されます。ヘルプ・モード・アイコンの詳細については、図 1-5
を参照してください。個々の情報を表示するには、フロント・パネル・キーまたは現在
のメニュー・ページのソフトキーを押してください。

図 1-5 ヘルプ・モード

Shift

Utility

Help

注 U8903Bヘルプ・モードがオンになっている場合は、フロント・パネル・キーを押して
も通常の機能は実行されません。
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1 測定前の準備
U8903Bのアップデート

U8903Bファームウェア・アップデート・ファイルは、Keysight U8903Bファームウェ
ア・アップデートWebサイト（www.keysight.co.jp/find/audioanalyzer_firmware）から
入手できます。

U8903Bファームウェアをアップデートするには、以下の手順を実行します。

1 ファームウェア・アップデート・ファイルを外部 USBフラッシュ・メモリに保存し
ます。

2 外部 USBフラッシュ・メモリを U8903Bに接続します。

3 ［SYSTEM］パネルの を押します。

4 ［System］メニュー・ページで［Update］ソフトキーを押します。図 1-6に示すよ
うに、［Update］メニュー・ページが表示されます。

図 1-6 System > Updateメニュー・ページ

5 ［Load File］ソフトキーを押すと［Recall］メニュー・ページが表示されるので、
ソースの場所を選択できます。

System

Macro

表 1-6 System > Updateメニュー・ページ

メニュー 概要

Load File
［Load File］ソフトキーを押して、アップデート・ファイルをロードします。［Recall］メニュー・ペー
ジが表示されるので、ソースの場所を選択します。［Recall］メニュー・ページの詳細については、
「Recall」（ページ）87を参照してください。

EULA ［EULA］ソフトキーを押して、U8903B EULA（使用許諾契約書）ページを表示します。
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測定前の準備 1
6 アップデートするファームウェア・ファイルを選択し、［Recall］ソフトキーを押し
ます（図 1-7を参照）。 ［Recall］メニュー・ページの詳細については、「Recall」
（ページ）87を参照してください。

図 1-7 ［Recall］メニュー・ページ

注 ［System］メニュー・ページは、標準モードでのみ使用可能です。U8903Bの使用可能
なモードの詳細については、「メニュー・キー」（ページ）54を参照してください。

注意 ファームウェア・アップデート・プロセスが完了するまでに、20分～ 40分かかる可能
性があります。U8903Bの電源をオフにしないでください。
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1 測定前の準備
セルフテストの実行

U8903Bのセルフテストを実行するには、以下の手順を実行します。

1 ［SYSTEM］パネルの を押します。

2 ［System］メニュー・ページで［Service］ソフトキーを押します。

3 ［Service］メニュー・ページで［Sel f-Test］ソフトキーを押します。図 1-8に示すよ
うに、［Self-Test］メニュー・ページが表示されます。

4 ［Customize Test］ソフトキーを押して、目的のテストを選択します。

5 ［Run Test］ソフトキー押して、選択したテストを実行します。

図 1-8 System > Service > Self-Testメニュー・ページ

System

Macro

表 1-7 System > Service > Self-Testメニュー・ページ

メニュー 概要

Customize Test
［Customize］ソフトキーを押して、目的のテストを選択または選択解除します。

– LANテスト
– カードのセルフテスト

Run Test ［Run Test］ソフトキーを押して、選択したテストを実行します。 

Clear Resul t ［Clear Resul t］ソフトキーを押して、以前のセルフテストの結果をクリアします。セルフテストの結
果がシステム・メモリに保存されます。

注 ［System］メニュー・ページは、標準モードでのみ使用可能です。U8903Bの使用可能
なモードの詳細については、「メニュー・キー」（ページ）54を参照してください。
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測定前の準備 1
U8903Bオプションの追加／削除

U8903Bオプションを追加するには、以下の手順を実行します。

1 ［SYSTEM］パネルの を押します。

2 ［System］メニュー・ページで［Service］ソフトキーを押します。

3 ［Service］メニュー・ページで［Options］ソフトキーを押します。図 1-9に示すよ
うに、［Options］メニュー・ページが表示されます。

図 1-9 System > Service > Optionsメニュー・ページ

4 ［Add option］ソフトキーを押すと［Recall］メニュー・ページが表示されるので、
U8903Bオプション・ファイルを選択できます。

5 ロードする U8903Bオプション・ファイルを選択し、［Recall］ソフトキーを押し
ます（図 1-10を参照）。

System

Macro

表 1-8 System > Service > Optionsメニュー・ページ

メニュー 概要

Add Option ［Add Option］ソフトキーを押して、U8903Bオプション・ファイルをロードします。［Recall］メ
ニュー・ページが表示されるので、ソースの場所を選択します。

Remove Option ［Remove Option］ソフトキーを押して、選択した U8903Bオプションを削除します。
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1 測定前の準備
図 1-10 ［Recall］メニュー・ページ

U8903Bオプションを削除するには、以下の手順を実行します。

1 削除する U8903Bオプションをファイルから選択します。

2 ［Remove option］ソフトキーを押して、U8903Bオプションを削除します（図 1-9を
参照）。

注 新しい U8903Bオプション・ファイルを追加したら、U8903Bを再起動します。

注 ［System］メニュー・ページは、標準モードでのみ使用可能です。U8903Bの使用可能
なモードの詳細については、「メニュー・キー」（ページ）54を参照してください。
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2 動作と機能
テスト機能
U8903Bは、さまざまなオーディオ関連デバイスやコンポーネントのテストが可能で、
研究開発、製造、品質保証などのアプリケーションに使用できます。テストできる製品
の例を以下に示します。

– マルチチャネル・ホーム・シアター・システム

– オーディオ・アンプ（製品またはコンポーネント・レベル）

– ポータブル・オーディオ再生機器（MP3プレーヤーなど）

– スピーカ（マイクロフォンやパワーアンプなどのサードパーティ製アクセサリが
必要）

– PC用オーディオ・カード

– オーディオ・コンポーネント

U8903Bは、以下の 2つの基本機能を実行します。

– オーディオ信号発生

– オーディオ信号解析

U8903Bの基本構成には、2チャネルのアナログ・ジェネレータと、2チャネルのアナロ
グ・アナライザが含まれているので、U8903Bを使ってステレオ機能を持つデバイスを
テストできます。また、U8903Bは、AES3、SPDIF、DSIなどのデジタル・オーディ
オ・インタフェースに対するジェネレータ／アナライザとしても使用できます。使用可
能なオプションの一覧を「U8903Bオプション」（ページ）33に示します。
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動作と機能 2
U8903Bのブロック図

アナログ・オーディオ・インタフェース

信号発生
U8903Bアナログ・ジェネレータの単純化したブロック図を以下に示します。

図 2-1 U8903Bアナログ・ジェネレータのブロック図

デジタル信号処理（DSP）は、方形波以外の必要なすべての波形をデジタル的に発生し
ます。デジタル波形データはリアルタイムで 24ビット D/Aコンバータ (DAC)に入力さ
れ、電圧に変換されます。変換された信号は出力コンディショニング・ブロックに送ら
れ、必要な振幅まで増幅または減衰されます。最後に波形は、平衡（XLR）または不平
衡（BNC）出力信号コネクタを通して、被試験デバイス（DUT）に送られます。出力を
完全にフローティング状態にすることも、測定器のグランドに接続に接続することも可
能です。ループバック機能も備えているので、アナログ・ジェネレータをシステム内部
のアナログ・バスに直接接続して、アナログ・アナライザにルーティングすることもで
きます。

アナログ・ジェネレータ

DAC フィルタ レンジ切替え

アイソレートされたグランド

ループバック

BNC

XLR
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2 動作と機能
測定
U8903Bアナログ・アナライザの単純化したブロック図を以下に示します。

図 2-2 U8903Bアナログ・アナライザのブロック図

オーディオ信号をアナログ・アナライザに入力するには、平衡（XLR）または不平衡
（BNC）入力信号コネクタを使用します。ループバック機能も備えているので、アナロ
グ・ジェネレータをシステム内部のアナログ・バスに直接接続して、アナログ・アナラ
イザにルーティングすることもできます。

信号は、入力コネクタから AC/DC結合回路経由で送られます。AC結合を選択した場合
は、DC成分はブロックされ、信号の AC成分だけが通されます。一方、DC結合を選択
した場合は、信号全体が通り抜けます。

アッテネータ、バッファ、利得、コモン・モード・ノイズ除去比（CMR）により、信
号を A/Dコンバータ（ADC）のフル・スケールにできるだけ近くなるように調整して、
測定のダイナミック・レンジを最適化します。

アナログ・アナライザには 2つの ADCがあります。狭帯域 ADCは、オーディオ帯域幅
以上で最高の性能を発揮するように設計されています。広帯域 ADCは、1.5 MHzまで
の高分解能測定を実現するように設計されています。

デフォルトの入力インピーダンスは、不平衡信号の場合で 100 kΩ、平衡信号の場合で
200 kΩです。600 Ωまたは 300 Ω終端を適用できます。600 Ω終端は 1.5 Wまで、
300 Ω終端は 3 Wまで対応できます。

アナログ・アナライザ

ADCフィルタレンジ切替え

ループバック

BNC

XLR

600 Ω 300 Ω 200 kΩ
終端

AC/DC
結合

100 kΩ
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動作と機能 2
デジタル・オーディオ・インタフェース

U8903Bデジタル・オーディオ・インタフェースの単純化したブロック図を以下に示し
ます。

図 2-3 U8903Bデジタル・ジェネレータのブロック図

信号発生
デジタル・ジェネレータは、必要なすべての波形をデジタル的に発生します。デジタル
波形データは、DSI出力の場合はシリアル・オーディオ・トランスミッタ、平衡／不平
衡／光出力の場合は AESトランスミッタに送られます。最後に、波形は平衡（XLR）、
不平衡（BNC）、光（TOSLINK）、デジタル・シリアル・インタフェース（DSI）のいず
れかの出力信号コネクタを通じて DUTに送られます。

測定
デジタル・オーディオ信号をデジタル・アナライザに入力するには、平衡（XLR）、不
平衡（BNC）、光（TOSLINK）、デジタル・シリアル・インタフェース（DSI）のいずれ
かの入力信号コネクタを使用します。平衡、不平衡、光入力の場合、入力されたオー
ディオ信号は AESレシーバに通されます。DSI入力の場合、入力されたオーディオ信号
はシリアル・オーディオ・レシーバに通されます。オーディオ信号はデジタル・アナラ
イザに送られます。デジタル・アナライザ内部では、デジタル信号を測定セクションに
送る前にデジタル・フィルタに通すことができます。ローパス、ハイパス、評価雑音、
ディエンファシス、サンプリング・レートのそれぞれのフィルタ・グループから 1つず
つ、最大 5つのデジタル・フィルタを選択できます。

AES

シリアル・
オーディオ

デジタル・ジェネレータ

デジタル・アナライザ

AES

25ピン D-SUB（メス）
コネクタ

BNC

XLR

TOSLINK

BNC

XLR

TOSLINK

シリアル・
オーディオ
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2 動作と機能
ナビゲーション /DATA ENTRYパネル

ナビゲーション /DATA ENTRYパネルは、メニュー操作およびパラメータ値の設定／
変更に使用します。

図 2-4 ナビゲーション /DATA ENTRYパネル

Enter

DATA ENTRY

1 2 3

4 5 6

7 8 9

0

ABC DEF

GHI JKL MNO

PQRS TUV WXYZ

Bk Sp ESC Shift

2

1

3

4

5

678

表 2-1 ナビゲーション /DATA ENTRYパネルの概要

項目 概要

1 ノブ ノブは、数値の増減、強調表示されている桁または文字の変更、リスト内または行の項目間の
移動に使用します。

2 矢印キー
矢印キーは、編集の際に LCDディスプレイ上の編集可能な項目を強調表示したり別の項目に移
動するのに使用します。HP8903Bモードでは、 上下の矢印キーを押して周波数値や振幅値を増減
します。

3 エンター・キー を押すと、入力が確定します。

4 数字キー

数字キーは、数字キーと小数点を使用して英数字データを入力したり、チャネル番号を選択す
るのに使用します。

DTMFシングル・モードでは、 を押して ‘*’ DTMFトーンを作成します。

Enter
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動作と機能 2
5 数値符号キー

を押して正の値または負の値を指定します。負の値の場合は、数値を入力する前に

を押して負符号を入力します。

DTMFシングル・モードでは、 を押して ‘#’ DTMFトーンを作成します。

6 シフト・キー
を押してからシフト機能キーを押します。シフト機能は、フロント・パネル・キーの

上部に青色で印刷されています。　詳細については、「GRAPHパネル」（ページ）61と
「SYSTEMパネル」（ページ）71を参照してください。

7 エスケープ・キー を押すと、選択したアクションがキャンセルされます。

8 バックスペース・キー を押すと、カーソルの左側の文字が削除されます。

表 2-1 ナビゲーション /DATA ENTRYパネルの概要（続き）

項目 概要

Shift

ESC

Bk Sp
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2 動作と機能
メニュー・キー

を押すと、使用可能な U8903Bの主な動作モードが一覧表示されます。図 2-5

に示すように、ドロップダウン・リストから目的のモードを選択します。

図 2-5 U8903Bモードの選択

U8903Bのモードを以下に示します。

Menu

表 2-2 U8903Bのモードの概要

モード 概要

Standard View
標準ビュー・モードは、U8903Bのデフォルト・モードです。詳細については、「標準ビュー」（ペー
ジ）55を参照してください。

Test Seq App 詳細については、「テスト・シーケンス・アプリケーション（Test Seq App）」（ページ）56を参照し
てください。

HP 8903B 詳細については、「HP 8903B」（ページ）56を参照してください。
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動作と機能 2
標準ビュー

を押し、［Standard View］を選択して、標準ビュー・メニュー・ページにアク

セスします。標準ビューでは、信号解析、グラフ解析、掃引機能、システム設定を実行
できます。標準ビュー・モードは、U8903Bのデフォルト・モードです。

信号解析

［FUNCTION］パネルの を押して、オーディオ・ジェネレータ・モードとオー

ディオ・アナライザ・モードの間を切り替えます。個々の設定の詳細については、第 3
章、「オーディオ・ジェネレータの機能」および第 4章、「オーディオ・アナライザの
測定機能」を参照してください。

グラフ解析

［FUNCTION］パネルの を押して、グラフ解析モードにアクセスします。グラフ

解析モード設定の詳細については、第 5章、「グラフ解析」を参照してください。

掃引機能

［FUNCTION］パネルの を押して、U8903Bの掃引パラメータと設定にアクセス

します。掃引設定の詳細については、第 6章、「掃引機能」を参照してください。

システム設定

［SYSTEM］パネルの を押して、U8903Bのシステム設定にアクセスします。エ
ラー・メッセージの表示、I/O設定の構成、U8903Bのアップデート、セルフテストの
実行、U8903B設定の構成、HP8903Bモード設定の構成などを行うことができます。シ
ステム設定の詳細については、「System」（ページ）75を参照してください。

Menu

Generator
Analyzer

Graph

Sweep

System

Macro
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2 動作と機能
テスト・シーケンス・アプリケーション（Test Seq App）

を押し、［Test Seq App］を選択して、テスト・シーケンス・アプリケーショ

ン・モードにアクセスします。テスト・シーケンス・アプリケーション・モードでは、
一連の自動測定を実行できます。詳細については、第 7章、「テスト・シーケンス・ア
プリケーション」を参照してください。

HP 8903B

を押し、［HP8903B］を選択して、HP8903Bモードにアクセスします。

HP8903Bモードでは、HP8903Bオーディオ・アナライザの動作をエミュレートできま
す。詳細については、第 8章、「HP 8903B」を参照してください。

Sweep

Menu
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動作と機能 2
FUNCTIONパネル

［FUNCTION］パネルからは、U8903Bのメイン機能にすばやくアクセスできます。

表 2-3 FUNCTIONパネルの概要

FUNCTIONパネル キー 概要

Interface を押すと、アナログ・インタフェースとデジタル・イ
ンタフェースの間で切り替わります。

Generator|Analyzer

を押すと、ジェネレータ・モードとアナライザ・モー
ドの間で切り替わります。
詳細については、第 3章、「オーディオ・ジェネレータの機
能」と第 4章、「オーディオ・アナライザの測定機能」を参照
してください。

Graph を押すと、グラフ解析モードにアクセスします。

詳細については、第 5章、「グラフ解析」を参照してください。

Sweep を押すと、掃引機能モードにアクセスします。

詳細については、第 6章、「掃引機能」を参照してください。

Full Screen

を押すと、グラフ・ビューが画面全体のサイズに最大
化します。
この機能は、グラフ解析モードでのみ適用可能です。詳細につ
いては、「Full screen」（ページ）58を参照してください。

Display

を押すと、アナライザ／ジェネレータ・モードでは、
2パネル・ビュー、4パネル・ビュー、10パネル・ビューの間
で切り替わります。

を押すと、グラフ解析モードでは、1パネル・ビュー
と 2パネル・ビューの間で切り替わります。
詳細については、「Dispalyモード」（ページ）59を参照してく
ださい。

Shortcut 1 カスタマイズ可能なショートカット・キー。詳細については、
表 2-19を参照してください。

Shortcut 2 カスタマイズ可能なショートカット・キー。詳細については、
表 2-19を参照してください。

FUNCTION

Interface Generator
Analyzer

SweepGraph

Full
Screen

Display

ShortcutShortcut
1 2

Interface

Generator
Analyzer

Graph

Sweep

Full
Screen

Display

Display
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2 動作と機能
Full screen

フルスクリーンのグラフ表示を図 2-6に示します。フルスクリーン・グラフ表示を終了

するには、 を押します。

図 2-6 フルスクリーン・グラフ表示

注 フルスクリーン機能は、グラフ解析モードでのみ使用可能です。

Full
Screen
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動作と機能 2
Dispalyモード

U8903Bでは、アナライザ／ジェネレータ・モードでは、メイン・ディスプレイに最大
10個のパネルを表示できます。

図 2-7 4パネル・ビュー

図 2-8 10パネル・ビュー
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2 動作と機能
U8903Bでは、グラフ解析モードでは、メイン・ディスプレイに最大 2個のパネルを表示
できます。

図 2-9 グラフ解析モードの 2パネル・ビュー
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動作と機能 2
GRAPHパネル

［GRAPH］パネルからは、頻繁に使用するグラフ機能にすばやくアクセスできます。グ
ラフ解析モードの詳細については、第 5章、「グラフ解析」を参照してください。

注 一部のキーの上には、シフト機能が印刷されています。［DATA ENTRY］パネルの

を押してから、シフト機能が印刷された目的のキーを押してください。Shift

表 2-4 GRAPHパネルの概要

GRAPHパネル キー 概要

Peak Search

を押すと、［Peak Search］メニュー・ページが表示
され、選択したマーカがマーカ・トレースの Y軸の最大値
のトレース・ポイントに配置されます。詳細については、
「Peak Search」（ページ）62を参照してください。

Marker

マーカ・ソフトキーにアクセスして、現在のマーカと基準
マーカを選択したり、マーカをオン／オフするには、

を押します。

マーカの移動、マーカ測定データの表示、選択したマーカ
位置を基準にしたグラフの部分表示にも使用できます。
詳細については、「Marker」（ページ）64を参照してくだ
さい。

Print 
（Shift＋ Marker）

と を押すと、現在の表示画面がファイル
に出力されます。詳細については、「Save」（ページ）86
を参照してください。

Scale

を押してオートスケールを実行すると、信号に応
じて表示が自動的にスケーリングされます。また、X軸ま
たは Y軸に対するオートスケールも実行できます。詳細に
ついては、「Scale」（ページ）68を参照してください。

Zoom を押すと、グラフの一部が拡大表示されます。詳
細については、「Zoom」（ページ）69を参照してください。

Edit Zoom
（Shift＋ Zoom）

と を押すと、拡大表示するグラフの部分
が設定されます。詳細については、「Edit zoom」（ページ）
70を参照してください。

GRAPH

Peak
Search

Marker

Scale

Zoom

Print

Edi t  Zoom

Peak
Search

Marker

Print

Shift Marker

Print

Scale

Zoom

Edi t  Zoom

Shift Zoom

Edi t  Zoom
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2 動作と機能
Peak Search

［Peak Search］メニュー・ページでは、ピークとみなすことができる信号を決定するた
めのしきい値を設定して、不要な信号の検出を防ぐことができます。立ち上がりスロー
プがそのポイントの前に、立ち下がりスロープがそのポイントより後にある場合にだ
け、ピークとして認識されます。立ち下がりスロープがそのポイントの前に、立ち上が
りスロープがそのポイントより後にある場合にだけ、最小値として認識されます。

図 2-10 Peak Searchメニュー・ページ

注 ［Peak Search］メニュー・ページは、グラフ解析モードでのみ使用可能です。

表 2-5 Saveメニューの概要

メニュー 概要

Max Peak
［Max Peak］ソフトキーを押すと、アクティブ・マーカを検出して、ピークしきい値より大きい最大
ピークに移動します。アクティブ・マーカがオフの場合は、Max Peak動作を実行する前にマーカがオン
になります。

Next Peak
［Next Peak］ソフトキーを押すと、アクティブ・マーカを検出して、ピークしきい値より大きい次の
ピークに移動します。アクティブ・マーカがオフの場合は、Next Peak動作を実行する前にマーカがオン
になります。

Prev Peak
［Prev Peak］ソフトキーを押すと、アクティブ・マーカを検出して、ピークしきい値より大きい前の
ピークに移動します。アクティブ・マーカがオフの場合は、Prev Peak動作を実行する前にマーカがオン
になります。

Next Min
［Next Min］ソフトキーを押すと、アクティブ・マーカを検出して、ピークしきい値より小さい前のピー
クに移動します。アクティブ・マーカがオフの場合は、Next Min動作を実行する前にマーカがオンにな
ります。
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動作と機能 2
Threshold

図 2-11 Peak Search > Thresholdメニュー・ページ

Prev Min
［Prev Min］ソフトキーを押すと、アクティブ・マーカを検出して、ピークしきい値より小さい次のピー
クに移動します。アクティブ・マーカがオフの場合は、Prev Min動作を実行する前にマーカがオンにな
ります。

Threshold ピーク・サーチ設定を構成するには、［Threshold］ソフトキーを押します。詳細については、
「Threshold」（ページ）63を参照してください。

表 2-5 Saveメニューの概要（続き）

メニュー 概要

表 2-6 Peak Search > Thresholdメニューの概要

メニュー 概要

Line Visible

グラフのしきい値線をオン／オフするには、［Line Visible］ソフトキーを押します。しきい値線により、
ピークしきい値と最小しきい値を簡単に決定できます。
– ピークしきい値（緑の線）
– 最小しきい値（オレンジの線）

Peak Thres ピークしきい値を設定するには、［Peak Thres］ソフトキーを押します。ピーク・サーチの実行時にピー
クしきい値が考慮されるようにするためには、ピークがピークしきい値より上になければなりません。

Min Thres 最小しきい値を設定するには、［Min Thres］ソフトキーを押します。ピーク・サーチの実行時に最小し
きい値が考慮されるようにするためには、最小値が最小しきい値より下になければなりません。
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2 動作と機能
Marker

［Marker］メニュー・ページでは、グラフ上にマーカを配置することができます。マー
カをトレース上に配置して、マーカ・ポイントのトレースの値を正確に測定することが
できます。グラフには全部で最大 8個のマーカを配置できます。数字キー（1～ 8）を
1回押してアクティブ・マーカ間を切り替えることも、数字キー（1～ 8）を 2回押し
て選択したマーカの状態を切り替えることもできます。

図 2-12 Markerメニュー・ページ 1

注 ［Marker］メニュー・ページは、グラフ解析モードでのみ使用可能です。

表 2-7 Markeメニューの概要

メニュー 概要

Active Marker
アクティブ・マーカ番号を選択するには、［Active Marker］ソフトキーを押します。アクティブ・マーカ
は緑で表示され、他のマーカは白で表示されます。アクティブ・マーカの基準マーカは赤で表示され
ます。

State アクティブ・マーカをオン／オフするには、［State］ソフトキーを押します。

Trace アクティブ・マーカのトレース番号を選択するには、［Trace］ソフトキーを押します。

Ref Mkr

基準マーカ番号を選択するには、［Ref Mkr］ソフトキーを押します。マーカ・テーブルのデルタ・マー
カ計算を実行するには、基準マーカを指定する必要があります。
– OFF

– M1～M8
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動作と機能 2
Movement

マーカの移動タイプを選択するには、［Movement］ソフトキーーを押します。
– Single
アクティブ・マーカは、ノブの回転速度と回転方向に応じて移動します。

– Pair
アクティブ・マーカは、基準マーカと一緒に移動します。

– Bin
アクティブ・マーカは、ノブの速度に関係なく、次／前のビンまたはピクセルに移動します。

– Peak
アクティブ・マーカは、ピークからピークに移動します。この動作は、ピークしきい値の設定の影
響を受けます。

– Harmonic
アクティブ・マーカは、高調波から高調波に移動します。この設定は、表示オプションが
Harmonicsに変更された場合にのみ有効です。

Function

マーカの機能タイプを選択するには、［Function］ソフトキーを押します。
– None
マーカの機能タイプの指定なし。

– Slope
現在のマーカの傾き。計算で考慮される開始ポイントと終了ポイントは、マーカの前のポイントか
らその後のポイントまでです。

– PSD
バンド内の各周波数ビンに含まれる全パワー。さらに、その結果を「実効帯域幅」で除算します。

Marker -> ［Marker ->］ソフトキーを押すと、グラフの左側値と右側値が現在のマーカ位置を基準にして自動的に
調整されます。詳細については、「Marker ->」（ページ）66を参照してください。

Harmonics マーカを高調波の値に配置するには、［Harmonics］ソフトキーを押します。
詳細については、「Harmonics」（ページ）67を参照してください。

Rdg at Mkr

マーカ測定をオン／オフするには、［Rdg at Mkr］ソフトキーを押します。
アクティブ・マーカの読み値をグラフの左上に表示するか、マーカ位置に表示するか選択できます。
マーカ・テーブルがオンになっている場合は、マーカ位置のマーカ読み値が自動的に非表示になり
ます。

表 2-7 Markeメニューの概要（続き）

メニュー 概要
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2 動作と機能
Marker ->

［Marker ->］メニュー・ページでは、グラフの左側値と右側値を現在のマーカ位置を基
準にして自動的に調整することができます。

図 2-13 Marker > Marker -メニュー・ページ

表 2-8 Marker > Marker -メニューの概要

メニュー 概要

-> Start ［-> Start］ソフトキーを押すと、グラフの左側値が現在のマーカ位置に設定されます。スパンは維持さ
れるので、グラフの右側値を変更することもできます。

-> Stop ［-> Stop］ソフトキーを押すと、グラフの右側値が現在のマーカ位置に設定されます。スパンは維持さ
れるので、グラフの左側値を変更することもできます。

-> Center ［-> Center］ソフトキーを押すと、グラフの中央値が現在のマーカ位置に設定されます。スパンは維持
されるので、グラフの左側値と右側値を変更することもできます。

-> Del ta ［-> Delta］ソフトキーを押すと、グラフの左側値と右側値が現在のマーカと基準マーカの位置に設定さ
れます。

Move to 3 dB ［Move to 3 dB］ソフトキーを押すと、マーカが最も近い－ 3 dB値のデータ・ポイントに配置されます。

Move to 6 dB ［Move to 6 dB］ソフトキーを押すと、マーカが最も近い－ 6 dB値のデータ・ポイントに配置されます。
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動作と機能 2
Harmonics

［Harmonics］メニュー・ページでは、マーカを高調波の値に配置できます。グラフの
表示オプションが高調波表示ビューでなければなりません。すべてのマーカが使用さ
れ、選択したトレースに配置されます。

図 2-14 Marker > Harmonicsメニュー・ページ

表 2-9 Marker > Harmonicsメニューの概要

メニュー 概要

Trace マーカを配置するトレース番号を設定するには、［Trace］ソフトキーを押します。

Enabled マーカを表示したり、非表示にするには、［Enabled］ソフトキーを押します。
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2 動作と機能
Scale

［Scale］メニューでは、オートスケールを実行して、信号に応じて表示を自動的にス
ケーリングしたり、X軸または Y軸に対するオートスケールを実行することができ
ます。

図 2-15 Scaleメニュー・ページ

注 ［Scale］メニュー・ページは、グラフ解析モードでのみ使用可能です。

表 2-10 Scaleメニューの概要

メニュー 概要

AutoScale ［AutoScale］ソフトキーを押すと、X軸と Y軸のオートスケールが実行されます。

AutoScale X ［AutoScale X］ソフトキーを押すと、グラフに表示するデータに基づいて X軸に最適なスケール（左側
値と右側値）を検索して、X軸のオートスケールが実行されます。

AutoScale Y ［AutoScale Y］ソフトキーを押すと、グラフに表示するデータに基づいて Y軸に最適なスケール（上側値
と下側値）を検索して、Y軸のオートスケールが実行されます。
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動作と機能 2
Zoom

U8903Bの画面は、ズーム表示では 2つのウィンドウに分割されます。上側のウィンドウ
は通常のグラフ・ウィンドウで、下側のウィンドウには上側のウィンドウのトレースが
拡大表示されます。両方のウィンドウの画面解像度の違いから、下側のウィンドウの
データの方が詳細になります。上側ウィンドウの赤い境界線で囲まれた領域が拡大領域
です。

図 2-16に示すように、拡大グラフが表示されます。

図 2-16 拡大グラフの表示

注 ズーム表示は、グラフ解析モードでのみ使用可能です。
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2 動作と機能
Edit zoom

ズーム表示にズーム編集モードを表示するには、［DATA ENTRY］パネルの と

［GRAPH］パネルの を押します。上下の矢印キーを押してステップ値を変更し、

左右の矢印キーを使用して上側ウィンドウの赤い境界線で囲まれた領域を移動します。
上側ウィンドウの赤い境界線で囲まれた領域のサイズを変更するには、ノブを回し
ます。

図 2-17に示すように、ズーム編集モードが表示されます。

図 2-17 拡大グラフの表示

ズーム編集モードを終了するには、［DATA ENTRY］パネルの と［GRAPH］パネ

ルの を押します。

ズーム表示を終了するには、［GRAPH］パネルの を押します。

Shift

Zoom

Edi t  Zoom

Shift

Zoom

Edi t  Zoom

Zoom

Edi t  Zoom
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動作と機能 2
SYSTEMパネル

［SYSTEM］パネルからは、いくつかの便利なシステム機能にアクセスできます。

注 一部のキーの上には、シフト機能が印刷されています。［DATA ENTRY］パネルの

を押してから、シフト機能が印刷された目的のキーを押してください。Shift

表 2-11 SYSTEMパネルの概要

SYSTEMパネル キー 概要

Preset
を押すと、［Preset］メニュー・ページが表示され

ます。詳細については、「Preset」（ページ）72を参照して
ください。

Util ity
を押すと、［Utility］メニュー・ページが表示され

ます。詳細については、「Utility」（ページ）73を参照して
ください。

Help
（Shift＋ Util ity）

と を押すと、ヘルプ・モード・ページが
表示されます。詳細については、「ヘルプ・モードへのア
クセス」（ページ）41を参照してください。

System
を押すと、［System］メニュー・ページが表示され

ます。詳細については、「System」（ページ）75を参照し
てください。

Macro
（Shift＋ System） 将来の拡張用に確保されています。

Local

を押すと、リモート制御モードからローカル・
モードに切り替わります。フロント・パネル・キーは、リ
モート・モードではロックされます。リモート制御モード
であることを示すアイコンの詳細については、表 1-5を参
照してください。

Lock/Unlock

ローカル・モードでフロント・パネル・キーをロック／

ロック解除するには、 を押します。ダイアログ・
ボックスがポップアップ表示されるので設定します。フロ
ント・パネル・キーがロック状態であることを示すアイコ
ンの詳細については、表 1-5を参照してください。

SYSTEM

Local

System

Utility

Preset

Help

Macro

L o c k / U n l o c k

Preset

Utility

Help

Shift Utility

Help

System

Macro

Local

L o c k / U n l o c k

Local

L o c k / U n l o c k
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2 動作と機能
Preset

プリセットを実行すると、U8903Bはデフォルト状態に設定されます。I/O設定、校正
データ、システム設定（時刻、日付、モデル番号、シリアル番号）、ライセンス情報に
影響はありません。

図 2-18 Presetメニュー・ページ

注 ［Preset］メニュー・ページは、標準ビュー・モードでのみ使用可能です。詳細につい
ては、「メニュー・キー」（ページ）54を参照してください。

表 2-12 Presetメニュー・ページの概要

メニュー 概要

（現在のモード）

［(現在のモード）］ソフトキーを押すと、現在のモードがデフォルト設定にリセットされます。例えば、ア
ナログ・ジェネレータをリセットした場合には、すべてのジェネレータ設定だけがリセットされ、他の
モードの設定は変更されません。
– Analog Analyzer 
アナログ・アナライザをリセットした場合は、アナログ・ジェネレータのループバック・コネクタもリ
セットされます。

– Analog Generator 
アナログ・ジェネレータをリセットした場合は、アナログ・ジェネレータのループバック・コネクタは
リセットされません。

– Graph Analysis

Save User State ［Save User State］ソフトキーを押すと、現在のユーザ・ステートが保存されます。

Mode ［Mode］ソフトキーを押すと、ユーザ定義のファイルを削除せずに、すべてのモードがデフォルト設定に
リセットされます。自動問合せ、掃引、テスト・シーケンスなど、実行中のすべての動作が中止されます。

To Factory Settings

［To Factory Settings］ソフトキーを押すと、U8903Bが工場設定にリセットされ、内部フラッシュ・メモリに
保存されているすべてのファイル（例えば、ステート・ファイル、任意波形、テスト・シーケンス・プロ
ジェクト・ファイルなど）が削除され、GUIステートが標準ビュー・モードにリセットされます。HP8903B
モードがオンになっている場合は、GUIステートは HP8903Bモードのままになります。

User State ［User State］ソフトキーを押すと、U8903Bが以前に保存したユーザ・ステートにリセットされます。
72 Keysight U8903B ユーザーズ・ガイド



動作と機能 2
Utility

［Utility］メニュー・ページでは、U8903Bステートをファイルに保存したり、U8903B
ステートをファイルからリコールすることができます。

ジェネレータ／アナライザ・モードでは、図 2-19のような［Utility］メニュー・ペー
ジが表示されます。

図 2-19 Utilityメニュー・ページ（ジェネレータ／アナライザ・モード）

注 ［Utility］メニュー・ページは、標準ビュー・モードでのみ使用可能です。詳細について
は、「メニュー・キー」（ページ）54を参照してください。

表 2-13 Utilityメニューの概要（ジェネレータ／アナライザ・モード）

メニュー 概要

Save Channel (x)

(x)＝現在のチャネル
番号

［Save Channel (x)］ソフトキーを押すと、現在のチャネル・ステートがファイルに保存されます。［Save］
メニュー・ページの詳細については、「Save」（ページ）86を参照してください。

Save (x)

(x)＝現在のモード
［Save (x)］ソフトキーを押すと、現在のモード・ステートがファイルに保存されます。［Save］メ
ニュー・ページの詳細については、「Save」（ページ）86を参照してください。

Recall ［Recall］ソフトキーを押すと、保存した U8903Bステートがファイルからリコールされます。［Recall］
メニュー・ページの詳細については、「Recall」（ページ）87を参照してください。

Copy To ［Copy to］ソフトキーを押すと、現在のチャネル・ステートが他のチャネルにコピーされます。

Copy From ［Copy From］ソフトキーを押すと、他のチャネル・ステートが現在のチャネルにコピーされます。
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2 動作と機能
グラフ解析モードでは、図 2-20のような［Utility］メニュー・ページが表示されます。

図 2-20 Utilityメニュー・ページ（グラフ解析モード）

表 2-14 Utilityメニューの概要（グラフ解析モード）

メニュー 概要

Save Graph ［Save Graph］ソフトキーを押すと、現在のグラフ・ステートがファイルに保存されます。［Save］メ
ニュー・ページの詳細については、「Save」（ページ）86を参照してください。

Save Channels Settings
現在のチャネルのグラフ・ステートまたはすべてのチャネルのグラフ・ステートをファイルに保存する
には、［Save Channels Settings］ソフトキーを押します。［Save］メニュー・ページの詳細については、
「Save」（ページ）86を参照してください。

Save Traces
現在のトレースのステート、すべてのトレースのステート、軸設定ステート、または現在のトレース・
データをファイルに保存するには、［Save Traces］ソフトキーを押します。［Save］メニュー・ページの
詳細については、「Save」（ページ）86を参照してください。

Recall ［Recall］ソフトキーを押すと、トレースが CSVファイルからアクティブ・トレースにロードされます。
［Recall］メニュー・ページの詳細については、「Recall」（ページ）87を参照してください。

Copy To ［Copy To］ソフトキーを押すと、現在のチャネルのグラフ・ステートが他のチャネルにコピーされます。

Copy Graph From ［Copy Graph From］ソフトキーを押すと、他のチャネルのグラフ・ステートが現在のチャネルにコピー
されます。
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動作と機能 2
System

［System］メニュー・ページでは、エラー・メッセージの表示、I/O設定の構成、
U8903Bのアップデート、セルフテストの実行、U8903B設定の構成、HP8903Bモード設
定の構成などを行うことができます。

図 2-21 Systemメニュー・ページ 1

注 ［System］メニュー・ページは、標準ビュー・モードでのみ使用可能です。詳細につい
ては、「メニュー・キー」（ページ）54を参照してください。
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2 動作と機能
Error Info

［Error Info］ソフトキーを押して、［Error Info］メニュー・ページを表示します。エ
ラー・メッセージがエラー・ログ表示パネルにリストされます。エラー・メッセージは
降順で表示され、最新のエラー・メッセージがリストの一番上に表示されます。

図 2-22 System > Error Infoメニュー・ページ（エラー） 

表 2-15 Error Infoメニューの概要

メニュー 概要

Load File

［Load File］ソフトキーを押して、エラー・ログ表示パネルにロードするログ・ファイルを選択します。
最新のログ・ファイル名は EventLog_CE.xmlです。それ以前のログ・ファイルには、EventLog_CE
という名前が付けられています。<yyyyMMdd>_n.xml。ここで、yyyy＝年、MM＝月、dd＝日、
n＝バージョンです。U8903Bでは、ログ・ファイルは最大 7日間保存されます。
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動作と機能 2
I/O

［I/O］ソフトキーを押して、［I/O］メニュー・ページを表示します。

図 2-23 System > I/Oメニュー・ページ 

表 2-16 I/Oメニューの概要（ジェネレータ／アナライザ・モード）

メニュー 概要

LAN Settings LAN設定を構成するには、［LAN Settings］ソフトキーを押します。詳細については、表 2-17を参照して
ください。

GPIB 目的の GPIBアドレスを設定するには、［GPIB］ソフトキーを押します。

FTP FTPコントロールをオン／オフするには、［FTP］ソフトキーを押します。
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2 動作と機能
［LAN Settings］メニュー・ページでは、LANのリセット、ホスト名の変更、自動／手
動設定モードの切り替えを行うことができます（図 2-24を参照）。

図 2-24 System > I/O > Lan Settingsメニュー・ページ 1

Update

「U8903Bのアップデート」（ページ）42を参照してください。

表 2-17 System > I/O > LAN Settingsメニューの概要

メニュー 概要

Reset ［Reset］ソフトキーを押すと、LAN設定がリセットされます。

Hostname LANホスト名を設定するには、［Hostname］ソフトキーを押します。

Config Mode

LAN設定モードを選択するには、［Config Mode］ソフトキーを押します。
– Auto

– Manual

IP Address
LAN IPアドレスを設定するには、［IP Address］ソフトキーを押します。
この設定は、LAN設定モードが Manualに設定されている場合にのみ使用可能です。

Subnet mask
LANサブネット・マスク・アドレスを設定するには、［Subnet mask］ソフトキーを押します。
この設定は、LAN設定モードが Manualに設定されている場合にのみ使用可能です。

Gateway
LANゲートウェイ・アドレスを設定するには、［Gateway］ソフトキーを押します。
この設定は、LAN設定モードが Manualに設定されている場合にのみ使用可能です。

DNS 1
LAN DNS 1アドレスを設定するには、［DNS 1］ソフトキーを設定します。
この設定は、LAN設定モードが Manualに設定されている場合にのみ使用可能です。

DNS 2
LAN DNS 2アドレスを設定するには、［DNS 2］ソフトキーを設定します。
この設定は、LAN設定モードが Manualに設定されている場合にのみ使用可能です。
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動作と機能 2
Service

［Service］ソフトキーを押して、［Service］メニュー・ページを表示します。

図 2-25 System > Serviceメニュー・ページ

表 2-18 System > Serviceメニューの概要

メニュー 概要

Sel f-Test セルフテストを実行するには、［Sel f-Test］ソフトキーを押します。詳細については、「セルフテストの
実行」（ページ）44を参照してください。

Diagnostics フロント・パネルまたはディスプレイの診断テストを実行するには、［Diagnostics］ソフトキーを押し
ます。

Secure Erase
内部フラッシュ・メモリに保存されているすべてのファイル（例えば、ステート・ファイル、任意波
形、テスト・シーケンス・プロジェクト・ファイルなど）を安全に消去するには、［Secure Erase］ソフ
トキーを押します。U8903Bの設定やライセンス情報に影響はありません。

Options
インストールされている U8903Bオプションを表示するには、［Options］ソフトキーを押します。
［Options］メニュー・ページから U8903Bのオプションを追加／削除することもできます。詳細について
は、「U8903Bオプションの追加／削除」（ページ）45を参照してください。
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2 動作と機能
Settings

［Settings］ソフトキーを押して、［Settings］メニュー・ページを表示します。

図 2-26 System > Settingsメニュー・ページ 1

表 2-19 System > Settingsメニューの概要

メニュー 概要

Date ［Date］ソフトキーを押して、日付（dd/mm/yyyyフォーマット）を編集します。

Time ［Time］ソフトキーを押して、現在の時刻（24時間フォーマット）を編集します。

Brightness ［Brightness］ソフトキーを押して、LCDディスプレイの輝度値を調整します。

Key Sound ［Key Sound］ソフトキーを押して、フロント・パネル・キーの音をオン／オフします。

Power Up State

［Power Up State］ソフトキーを押して、電源投入時の状態を選択します。
– Last

U8903Bの起動時に最後に保存した設定が使用されます。
– Default

U8903Bの起動時に工場設定が使用されます。

Shortcut 1

［Shortcut 1］ソフトキーを押して、ショートカット 1キーをマッピングする特定の機能を選択します。
– Error List
ログに記録されている直近の 30個のエラー、警告、メッセージを表示します。

– Auto-Scale
グラフ表示を自動的にスケーリングします。

Shortcut 2

［Shortcut 2］ソフトキーを押して、ショートカット 2キーをマッピングする特定の機能を選択します。
– Error List
ログに記録されている直近の 30個のエラー、警告、メッセージを表示します。

– Auto-Scale
グラフ表示を自動的にスケーリングします。
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動作と機能 2
HP8903B Config

［HP8903B Config］ソフトキーを押して、［HP8903B Config］メニュー・ページを表示
します。

図 2-27 System > HP8903B Configメニュー・ページ

注 – HP8903Bの構成設定がリセット操作の影響を受けることはありません。

– HP8903Bモードの詳細については、第 8章、「HP 8903B」を参照してください。

表 2-20 System > HP8903B Configメニューの概要

メニュー 概要

Active Channel

［Active Channel］ソフトキーを押して、HP8903Bのアクティブ・チャネルを選択します。
– 1

– 2

Left Fil ter

［Left Fil ter］ソフトキーを押して、左フィルタ・タイプを選択します。左フィルタは、HP8903Bフロン
ト・パネルの左側にあるフィルタです。HP8903Bフィルタは、モデルと購入した HP8903Bオプション
にょって異なる場合があります。デフォルトの左フィルタは Noneです。
– None

– A-Weighing

– CCIR 1k wtd

– CCIR 2k wtd

– C-Message

– CCITT

– 400 Hz
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2 動作と機能
Fan & Temperature

［Fan & Temperature］ソフトキーを押して、使用可能なカードの温度と U8903B内の
3個の 80 mmファンの速度を表示します。このメニュー・ページはサービスのためだ
けに使用します。詳細については、『U8903Bサービス・ガイド』を参照してください。

図 2-28 System > Fan & Temperatureメニュー・ページ

Right Fil ter

［Right Fil ter］ソフトキーを押して、右フィルタ・タイプを選択します。右フィルタは、HP8903Bフロン
ト・パネルの右側にあるフィルタです。HP8903Bフィルタは、モデルと購入した HP8903Bオプション
にょって異なる場合があります。デフォルトの右フィルタは Noneです。
– None

– A-Weighting

– CCIR 1k wtd

– CCIR 2k wtd

– C-Message

– CCITT

– 400 Hz

Default Fil ter

［Defaul t Fil ter］ソフトキーを押して、HP8903Bモードのデフォルト・フィルタを選択します。デフォル
ト・フィルタは 80 kHzです。
– None

– 30 kHz

– 80 kHz

表 2-20 System > HP8903B Configメニューの概要（続き）

メニュー 概要
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動作と機能 2
Aux Output

［Aux Output］ソフトキーを押して、［Aux Output］メニュー・ページを表示します。

図 2-29 System > Aux Outputメニュー・ページ

表 2-21 System > Aux Outputメニューの概要

メニュー 概要

Audio Monitor ［Aud io Monitor］ソフトキーを押して、補助オーディオ・モニタをオン／オフします。

Audio Output

補助オーディオ出力タイプを選択するには、［Aud io Output］ソフトキーを押します。
– Speaker

– Phone

Audio Mode

Phoneをオーディオ出力として選択した場合にのみ使用可能です。
［Aud io Mode］ソフトキーを押して、補助オーディオ・モード・タイプを選択します。
– Stereo

– Mono

Volume ［Volume］ソフトキーを押して、補助オーディオ音量を選択します。

DC Output ［DC Output］ソフトキーを押して、補助 DC出力値を設定します。
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2 動作と機能
Board Info

［Board Info］ソフトキーを押して、U8903Bの使用可能なカードに関する情報を表示し
ます。

図 2-30 System > Board Infoメニュー・ページ

Legacy Sweep

［Legacy Status］ソフトキーを押して、従来の掃引をオン／オフします。

従来の掃引をオンにした場合は、掃引はアナログに限定され、アナライザとジェネレー
タの掃引チャネルがペアで使用されます。例えば、アナログ・ジェネレータのチャネル
1はアナログ・アナライザのチャネル 1によって測定されます。

従来の掃引をオフにした場合は、掃引するチャネルを複数選択できるので、ジェネレー
タとアナログのチャネルをペアで使用する必要はありません。
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動作と機能 2
RUN CONTROLパネル

RUN CONTROLパネルは、信号の発生、測定、テスト・シーケンスの動作の開始／停止
に使用します。

図 2-31 RUN CONTROLパネル

RUN CONTROL

On
Off Stop All1 2

表 2-22 ナビゲーション /DATA ENTRYパネルの概要

キー 概要

1 On/Off

を押して、選択したジェネレータ・チャネルの信号発生またはアナライザ・チャ

ネルの測定を開始／停止します。

を押して、グラフ解析モードでのグラフの作成を開始します。

を押して、掃引モードでの掃引を開始／停止します。

を押して、テスト・シーケンス・アプリケーション・モードでのテスト・シーケ

ンスを開始／停止します。

2 Stop All を押すと、すべてのジェネレータ、掃引、テスト・シーケンスの動作が停止し

ます。

On
Off

On
Off

On
Off

On
Off

On
Off
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2 動作と機能
Saveおよび Recall

Save

［Save］メニュー・ページでは、U8903Bのステート、グラフ解析トレース設定、掃引
機能ポイント、または現在の表示画面のスクリーン・キャプチャをファイルに保存する
ことができます。

図 2-32 Saveメニュー・ページ

リストの ‘...’を選択し、 を押すと、現在のフォルダから 1レベル上がり、別の

ディレクトリに移動します。矢印キーを使用して、ファイルを検索するか、目的のフォ
ルダまたはファイルを選択します。

表 2-23 Saveメニューの概要

メニュー 概要

Save ［Save］ソフトキーを押すと、特定の機能がファイルに保存されます。

Type ［Type］ソフトキーを押して、現在のディレクトリに表示／保存するファイル・タイプを選択します。

Rename 現在のディレクトリ内の選択したファイルの名前を変更するには、［Rename］ソフトキーを押します。

Copy or Move マークを付けたファイルを選択したフォルダにコピーまたは移動するには、［Copy or Move］ソフトキー
を押します。

Delete 現在のディレクトリ内の選択したファイルを削除するには、［Delete］ソフトキーを押します。

New Folder 現在のディレクトリ内に新しいフォルダを作成するには、［New Folder］ソフトキーを押します。

Enter

注 ファイルの名前変更／コピー／移動／削除の詳細手順については、「付録 Y：ファイル
の名前変更、コピー、移動、削除手順 」（ページ）548を参照してください。
86 Keysight U8903B ユーザーズ・ガイド



動作と機能 2
Recall

［Recall］メニュー・ページでは、U8903Bのステート、グラフ解析トレース設定、また
は掃引機能ポイントをファイルからリコールすることができます。

図 2-33 ［Recall］メニュー・ページ

リストの ‘...’を選択し、 を押すと、現在のフォルダから 1レベル上がり、別の

ディレクトリに移動します。矢印キーを使用して、ファイルを検索するか、目的のフォ
ルダまたはファイルを選択します。

表 2-24 Saveメニューの概要

メニュー 概要

Recall 選択したファイルをリコールするには、［Recall］ソフトキーを押します。

Type 現在のディレクトリに表示するファイル・タイプを選択するには、［Type］ソフトキーを押します。

Rename 現在のディレクトリ内の選択したファイルの名前を変更するには、［Rename］ソフトキーを押します。

Copy or Move マークを付けたファイルを選択したフォルダにコピーまたは移動するには、［Copy or Move］ソフトキー
を押します。

Delete 現在のディレクトリ内の選択したファイルを削除するには、［Delete］ソフトキーを押します。

New Folder 現在のディレクトリ内に新しいフォルダを作成するには、［New Folder］ソフトキーを押します。

Enter

注 ファイルの名前変更／コピー／移動／削除の詳細手順については、「付録 Y：ファイル
の名前変更、コピー、移動、削除手順 」（ページ）548を参照してください。
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2 動作と機能
これは空白のページです。
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3 オーディオ・ジェネレータの機能
オーディオ・ジェネレータ

［FUNCTION］パネルの を押して、オーディオ・ジェネレータ・モードとオーディ

オ・アナライザ・モードの間を切り替えます。［Analog Generator］メニュー・ページと
［Digital Generator］メニュー・ページを、図 3-1と図 3-2にそれぞれ示します。

［FUNCTION］パネルの を押して、アナログ・インタフェースとデジタル・インタ

フェースの間を切り替えます。

［DATA ENTRY］パネルの または を押して、チャネル 1またはチャネル 2

に切り替え、アクティブ・チャネルの設定を開始します。

［RUN CONTROL］パネルの を押すことにより、選択したジェネレータ・

チャネルの信号発生を開始／停止することができます。

図 3-1 Analog Generatorメニュー・ページ

Generator
Analyzer

Interface

1 2 ABC

On
Off

表 3-1 Analog Generatorメニューの概要

メニュー 概要

Waveform ［Waveform］ソフトキーを押すと、使用可能なアナログ・ジェネレータの波形タイプが一覧表示されま
す。ドロップダウン・リストから目的の波形を選択します。

Waveform Config ［Waveform Config］ソフトキーを押して、周波数や振幅などの現在アクティブな波形の設定を行います。
詳細については、「波形設定」（ページ）92を参照してください。

Output Config ［Output Config］ソフトキーを押して、コネクタ・タイプやインピーダンスなどの出力設定を行います。
詳細については、「出力設定（アナログ・ジェネレータ）」（ページ）128を参照してください。

References ［References］ソフトキーを押して、単位変換に使用する出力基準を設定します。詳細については、「基
準（アナログ・ジェネレータ）」（ページ）147を参照してください。
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オーディオ・ジェネレータの機能 3
図 3-2 Digital Generatorメニュー・ページ

表 3-2 Digital Generatorメニューの概要

メニュー 概要

Waveform ［Waveform］ソフトキーを押すと、使用可能なアナログ・ジェネレータの波形タイプが一覧表示されま
す。ドロップダウン・リストから目的の波形を選択します。

Waveform Config ［Waveform Config］ソフトキーを押して、周波数や振幅などの現在アクティブな波形の設定を行います。
詳細については、「波形設定」（ページ）92を参照してください。

Output Config ［Output Config］ソフトキーを押して、コネクタ・タイプやインピーダンスなどの出力設定を行います。
詳細については、「出力設定（デジタル・ジェネレータ）」（ページ）130を参照してください。

DSI Config ［DSI Config］ソフトキーを押して、フォーマットや分解能などの DSI出力設定を行います。詳細につい
ては、「DSI出力設定（デジタル・ジェネレータ）」（ページ）133を参照してください。

AES3/SPDIF ［AES3/SPDIF］ソフトキーを押して、レベルや分解能などの AES3/SPDIF出力設定を行います。詳細につ
いては、「AES3/SPDIF出力設定（デジタル・ジェネレータ）」（ページ）135を参照してください。

References ［References］ソフトキーを押して、単位変換に使用する出力基準を設定します。詳細については、「基
準（デジタル・ジェネレータ）」（ページ）148を参照してください。
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3 オーディオ・ジェネレータの機能
波形設定

正弦波波形

正弦波波形は最も基本的な波形であり、オーディオ解析用の波形として広く用いられ
ます。

正弦波波形モードは、アナログ・ジェネレータとデジタル・ジェネレータの両方に適用
可能です。アナログ・ジェネレータとデジタル・ジェネレータの正弦波波形の波形設定
画面を、図 3-3と図 3-4にそれぞれ示します。

図 3-3 Analog Generator > Waveform Configメニュー・ページ（正弦波波形）

図 3-4 Digital Generator > Waveform Configメニュー・ページ（正弦波波形）
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オーディオ・ジェネレータの機能 3
表 3-3 Analog/Digital Generator > Waveform Configメニューの概要（正弦波波形）

メニュー 概要

Amplitude

アナログ・ジェネレータの場合は、Vrms、Vpeak、Vpp、dBV、dBu、dBmなどで表すことができます。
デジタル・ジェネレータの場合は、FFS、dBFS、%FSで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの 2倍であり、Vrmsは Vpeak/√2に等し
くなります。

Frequency 信号の周期の逆数です。

DC Offset 波形の DC成分です。
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3 オーディオ・ジェネレータの機能
可変位相波形

すべてのチャネルに正弦波波形を出力します。波形の周波数はすべてのチャネルで同一
ですが、位相と振幅はチャネルごとに変えることができます。可変位相波形は、複数
チャネルのオーディオ・システムのチャネル間の位相差やタイミング・スキューの測定
に使用できます。可変位相波形モードは、両方のチャネル出力で選択した周波数の正弦
波波形を出力します。チャネル 2の出力位相の範囲は、チャネル 1の出力を基準にし
て－ 180°～＋ 179.99°です。 

可変位相波形モードは、アナログ・ジェネレータとデジタル・ジェネレータの両方に適
用可能です。アナログ・ジェネレータとデジタル・ジェネレータの可変位相波形の波形
設定画面を、図 3-5と図 3-6にそれぞれ示します。

図 3-5 Analog Generator > Waveform Configメニュー・ページ（可変位相波形）

図 3-6 Digital Generator > Waveform Configメニュー・ページ（可変位相波形）
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オーディオ・ジェネレータの機能 3
表 3-4 Analog/Digital Generator > Waveform Configメニューの概要（可変位相波形）

メニュー 概要

Amplitude

アナログ・ジェネレータの場合は、Vrms、Vpeak、Vpp、dBV、dBu、dBmなどで表すことができます。 
デジタル・ジェネレータの場合は、FFS、dBFS、%FSで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの 2倍であり、Vrmsは Vpeak/√2に等し
くなります。

Frequency 信号の周期の逆数です。

Phase -> 1
アナログ・ジェネレータがチャネル 2にある場合のみ使用可能です。
チャネル 2の正弦波波形の位相をチャネル 1を基準にして指定します。正の値では、チャネル１の出力が
チャネル 2の出力より先行します。負の値では、チャネル 1の出力がチャネル 2の出力より遅れます。 
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3 オーディオ・ジェネレータの機能
デュアル波形

デュアル波形モードでは、2つの独立した正弦波波形の和の複合波形を発生できます。
デュアル正弦波波形は、オーディオ・システムの相互変調歪み特性のテストに使用でき
ます。

デュアル波形モードは、アナログ・ジェネレータとデジタル・ジェネレータの両方に適
用可能です。アナログ・ジェネレータとデジタル・ジェネレータのデュアル波形の波形
設定画面を、図 3-7と図 3-8にそれぞれ示します。

図 3-7 Analog Generator > Waveform Configメニュー・ページ（デュアル波形）

図 3-8 Digital Generator > Waveform Configメニュー・ページ（デュアル波形）
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オーディオ・ジェネレータの機能 3
表 3-5 Analog/Digital Generator > Waveform Configメニューの概要（デュアル波形）

メニュー 概要

Amplitude

アナログ・ジェネレータの場合は、Vrms、Vpeak、Vpp、dBV、dBu、dBmなどで表すことができます。
デジタル・ジェネレータの場合は、FFS、dBFS、%FSで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの 2倍であり、Vrmsは Vpeak/√2に等し
くなります。

Frequency 1 1番目の正弦波成分の周波数です。

Frequency 2 2番目の正弦波成分の周波数です。

DC Offset 波形の DC成分です。

Ratio 2番目の正弦波成分の 1番目の正弦波成分に対する振幅比を示します。

Summation

2つのレベルの合計方法を示します。
– RSS

2つのレベルの 2乗和平方根（RSS）の結果が振幅として表示されます。アナライザの振幅測定値は、
トーンの比に関係なく、ジェネレータで設定された振幅値と同じになります。

– Linear
2つのレベルのリニア加算の結果が振幅として表示されます。各トーンのレベルは、トーンの比から
簡単に逆算できます。
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3 オーディオ・ジェネレータの機能
SMPTE IMD波形（1:1/4:1/10:1）

SMPTE IMDは、2つの正弦波波形を線形結合した信号です。SMPTE IMD波形は、相互
変調歪みのテストに関する SMPTE規格 RP120-1983に適合します。SMPTE IMD 1:1の
場合は、下側周波数の正弦波が 1:1の振幅比で上側周波数の正弦波と線形結合されま
す。SMPTE IMD 4:1の場合は、下側周波数の正弦波が 4:1の振幅比で上側周波数の正弦
波と線形結合されます。SMPTE IMD 10:1の場合は、下側周波数の正弦波が 10:1の振幅
比で上側周波数の正弦波と線形結合されます。 

SMPTE IMD波形モードは、アナログ・ジェネレータとデジタル・ジェネレータの両方
に適用可能です。アナログ・ジェネレータとデジタル・ジェネレータの SMPTE 1:1波
形の波形設定画面を、図 3-9と図 3-10にそれぞれ示します。

図 3-9 Analog Generator > Waveform Configメニュー・ページ（SMPTE 1:1波形）

図 3-10 Digital Generator > Waveform Configメニュー・ページ（SMPTE 1:1波形）
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オーディオ・ジェネレータの機能 3
表 3-6 Analog/Digital Generator > Waveform Configメニューの概要（SMPTE IMD波形）

メニュー 概要

Amplitude

アナログ・ジェネレータの場合は、Vrms、Vpeak、Vpp、dBV、dBu、dBmなどで表すことができます。
デジタル・ジェネレータの場合は、FFS、dBFS、%FSで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの 2倍であり、Vrmsは Vpeak/√2に等し
くなります。

Lower Freq 波形の下側周波数です。下側周波数と上側周波数は、周波数間の振幅比によって区別されます。

Upper Freq 波形の上側周波数です。下側周波数と上側周波数は、周波数間の振幅比によって区別されます。

DC Offset 波形の DC成分です。

Summation

2つのレベルの合計方法を示します。
– RSS

2つのレベルの 2乗和平方根（RSS）の結果が振幅として表示されます。アナライザの振幅測定値は、
トーンの比に関係なく、ジェネレータで設定された振幅値と同じになります。

– Linear
2つのレベルのリニア加算の結果が振幅として示されます。各トーンのレベルは、トーンの比から簡
単に逆算できます。
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3 オーディオ・ジェネレータの機能
DFD IEC波形（IEC 60118/IEC 60268）

DFDデュアル・トーン波形には、DFD IEC 60118と DFD IEC 60268の 2種類の定義済み
波形があります。DFD IEC波形は SMPTE IMD波形に似ていますが、2つのトーンの振
幅が等しく、周波数が近い点が異なります。

DFD波形モードは、アナログ・ジェネレータとデジタル・ジェネレータの両方に適用
可能です。アナログ・ジェネレータとデジタル・ジェネレータの IEC 60118波形の波形
設定画面を、図 3-11と図 3-12にそれぞれ示します。

図 3-11 Analog Generator > Waveform Configメニュー・ページ（IEC 60118波形）

図 3-12 Digital Generator > Waveform Configメニュー・ページ（IEC 60118波形）
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オーディオ・ジェネレータの機能 3
アナログ・ジェネレータとデジタル・ジェネレータの IEC 60268波形の波形設定画面
を、図 3-13と図 3-14にそれぞれ示します。

図 3-13 Analog Generator > Waveform Configメニュー・ページ（IEC 60268波形）

表 3-7 Analog/Digital Generator > Waveform Configメニューの概要（IEC 60118波形）

メニュー 概要

Amplitude

アナログ・ジェネレータの場合は、Vrms、Vpeak、Vpp、dBV、dBu、dBmなどで表すことができます。
デジタル・ジェネレータの場合は、FFS、dBFS、%FSで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの 2倍であり、Vrmsは Vpeak/√2に等し
くなります。

Upper Freq 波形の上側周波数です。

Diff Freq 波形の差周波数です。

DC Offset 波形の DC成分です。

Summation

2つのレベルの合計方法を示します。
– RSS

2つのレベルの 2乗和平方根（RSS）の結果が振幅として表示されます。アナライザの振幅測定値は、
トーンの比に関係なく、ジェネレータで設定された振幅値と同じになります。

– Linear
2つのレベルのリニア加算の結果が振幅として示されます。各トーンのレベルは、トーンの比から簡
単に逆算できます。
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3 オーディオ・ジェネレータの機能
図 3-14 Digital Generator > Waveform Configメニュー・ページ（IEC 60268波形）

表 3-8 Analog/Digital Generator > Waveform Configメニューの概要（IEC 60268波形）

メニュー 概要

Amplitude

アナログ・ジェネレータの場合は、Vrms、Vpeak、Vpp、dBV、dBu、dBmなどで表すことができます。
デジタル・ジェネレータの場合は、FFS、dBFS、%FSで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの 2倍であり、Vrmsは Vpeak/√2に等し
くなります。

Center Freq 波形の中心周波数です。

Diff Freq 波形の差周波数です。

DC Offset 波形の DC成分です。

Summation

2つのレベルの合計方法を示します。
– RSS

2つのレベルの 2乗和平方根（RSS）の結果が振幅として表示されます。アナライザの振幅測定値は、
トーンの比に関係なく、ジェネレータで設定された振幅値と同じになります。

– Linear
2つのレベルのリニア加算の結果が振幅として示されます。各トーンのレベルは、トーンの比から簡
単に逆算できます。
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オーディオ・ジェネレータの機能 3
ガウシアン雑音

ガウシアン雑音は、周波数成分が定済みの周波数値を中心とするガウス分布を持つラン
ダム雑音信号です。

ガウシアン雑音モードは、アナログ・ジェネレータとデジタル・ジェネレータの両方に
適用可能です。アナログ・ジェネレータとデジタル・ジェネレータのガウシアン雑音の
波形設定画面を、図 3-15と図 3-16にそれぞれ示します。

図 3-15 Analog Generator > Waveform Configメニュー・ページ（ガウシアン雑音）

図 3-16 Digital Generator > Waveform Configメニュー・ページ（ガウシアン雑音）
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3 オーディオ・ジェネレータの機能
表 3-9 Analog/Digital Generator > Waveform Configメニューの概要（ガウシアン雑音）

メニュー 概要

Amplitude

アナログ・ジェネレータの場合は、Vrms、Vpeak、Vpp、dBV、dBu、dBmなどで表すことができます。
デジタル・ジェネレータの場合は、FFS、dBFS、%FSで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの 2倍であり、Vrmsは Vpeak/√2に等し
くなります。

DC Offset 波形の DC成分です。
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オーディオ・ジェネレータの機能 3
方形雑音（一様雑音）

方形雑音は、一様分布の雑音信号です。

方形雑音モードは、アナログ・ジェネレータとデジタル・ジェネレータの両方に適用可
能です。アナログ・ジェネレータとデジタル・ジェネレータの方形雑音の波形設定画面
を、図 3-17と図 3-18にそれぞれ示します。

図 3-17 Analog Generator > Waveform Configメニュー・ページ（方形雑音）

図 3-18 Digital Generator > Waveform Configメニュー・ページ（方形雑音）
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3 オーディオ・ジェネレータの機能
表 3-10 Analog/Digital Generator > Waveform Configメニューの概要（方形雑音）

メニュー 概要

Amplitude

アナログ・ジェネレータの場合は、Vrms、Vpeak、Vpp、dBV、dBu、dBmなどで表すことができます。
デジタル・ジェネレータの場合は、FFS、dBFS、%FSで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの 2倍であり、Vrmsは Vpeak/√2に等し
くなります。

DC Offset 波形の DC成分です。
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オーディオ・ジェネレータの機能 3
三角雑音

三角雑音モードは、デジタル・ジェネレータのみに適用可能です。三角雑音の波形設定
画面を、図 3-19に示します。

図 3-19 Digital Generator > Waveform Configメニュー・ページ（三角雑音）

表 3-11 Digital Generator > Waveform Configメニューの概要（三角雑音）

メニュー 概要

Amplitude
デジタル・ジェネレータの場合は、FFS、dBFS、%FSで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの 2倍であり、Vrmsは Vpeak/√2に等し
くなります。

DC Offset 波形の DC成分です。
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3 オーディオ・ジェネレータの機能
ピンク雑音

ピンク雑音は、周波数の増加とともにエネルギーが小さくなる、オクターブ・バンドご
とに音圧レベルが等しい雑音信号です。 

ピンク雑音モードは、アナログ・ジェネレータとデジタル・ジェネレータの両方に適用
可能です。アナログ・ジェネレータとデジタル・ジェネレータのピンク雑音の波形設定
画面を、図 3-20および図 3-21に示します。

図 3-20 Analog Generator > Waveform Configメニュー・ページ（ピンク雑音）

図 3-21 Digital Generator > Waveform Configメニュー・ページ（ピンク雑音）
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オーディオ・ジェネレータの機能 3
表 3-12 Analog/Digital Generator > Waveform Configメニューの概要（ピンク雑音）

メニュー 概要

Amplitude

アナログ・ジェネレータの場合は、Vrms、Vpeak、Vpp、dBV、dBu、dBmなどで表すことができます。
デジタル・ジェネレータの場合は、FFS、dBFS、%FSで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの 2倍であり、Vrmsは Vpeak/√2に等し
くなります。

DC Offset 波形の DC成分です。
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3 オーディオ・ジェネレータの機能
方形波波形

方形波波形は、2つのレベル間を定期的に瞬時に理想的に切り替える波形です。

方形波波形モードは、アナログ・ジェネレータとデジタル・ジェネレータの両方に適用
可能です。アナログ・ジェネレータとデジタル・ジェネレータの方形波波形の波形設定
画面を、図 3-22と図 3-23にそれぞれ示します。

図 3-22 Analog Generator > Waveform Configメニュー・ページ（方形波波形）

図 3-23 Digital Generator > Waveform Configメニュー・ページ（方形波波形）
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オーディオ・ジェネレータの機能 3
表 3-13 Analog/Digital Generator > Waveform Configメニューの概要（方形波波形）

メニュー 概要

Amplitude

アナログ・ジェネレータの場合は、Vrms、Vpeak、Vpp、dBV、dBu、dBmなどで表すことができます。
デジタル・ジェネレータの場合は、FFS、dBFS、%FSで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの 2倍であり、Vrmsは Vpeak/√2に等し
くなります。

Frequency 方形波波形の周波数です。

DC Offset
デジタル・ジェネレータにのみ使用可能です。
波形の DC成分です。 
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3 オーディオ・ジェネレータの機能
DC信号

DC信号出力は、低電流の DC電源が必要な場合に使用します。増幅器またはその他の
同様の回路にバイアスをかける場合などです。

DC信号モードは、アナログ・ジェネレータのみに適用可能です。DC信号の波形設定
画面を、図 3-24に示します。

図 3-24 Analog Generator > Waveform Configメニュー・ページ（DC信号）

表 3-14 Analog Generator > Waveform Configメニューの概要（DC信号）

メニュー 概要

Vol tage 電圧は複合信号の振幅を示します。
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オーディオ・ジェネレータの機能 3
正弦波バースト波形

正弦波バースト波形は、通常、2つのレベルの間で切り替えられる正弦波です。正弦波
バースト波形モードは、デジタル・ジェネレータのみに適用可能です。正弦波バースト
波形の波形設定画面を、図 3-25に示します。

図 3-25 Digital Generator > Waveform Configメニュー・ページ（正弦波バースト）

表 3-15 Digital Generator > Waveform Configメニューの概要（正弦波バースト）

メニュー 概要

Amplitude
デジタル・ジェネレータの場合は、FFS、dBFS、%FSで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの }2倍であり、Vrmsは Vpeak/√2に等し
くなります。

Frequency 1番目の正弦波成分の周波数です。

Burst On 信号振幅レベルが高くなるサイクル数を示します。Burst Onの値は、Periodの値より 1サイクル小さく
設定してください。

Period 1つのバーストの始めから次のバーストの始めまでのサイクル数です。Periodの値は、Burst Onの値より
1サイクル以上大きく設定してください。

Low Level Berst Onと Burst Offの振幅比です。
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3 オーディオ・ジェネレータの機能
ステレオ波形

ステレオ波形モードでは、チャネル 1とチャネル 2用に 2つの独立した正弦波波形が
作成されます。ステレオ波形モードは、デジタル・ジェネレータのみに適用可能です。
アナログ・ジェネレータの場合、ステレオ波形の作成に 2つの異なるチャネルを使用し
ます。ステレオ波形の波形設定画面を、図 3-26に示します。

図 3-26 Digital Generator > Waveform Configメニュー・ページ（ステレオ波形）

表 3-16 Digital Generator > Waveform Configメニューの概要（ステレオ波形）

メニュー 概要

Amplitude
デジタル・ジェネレータの場合は、FFS、dBFS、%FSで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの 2倍であり、Vrmsは Vpeak/√2に等し
くなります。

Frequency 1番目の正弦波成分の周波数です。

DC Offset 波形の DC成分です。
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オーディオ・ジェネレータの機能 3
単調波形

単調波形は、繰り返し方形波の階段状信号から構成されます。方形波の各半サイクルの
持続時間は、Samples/Stepパラメータによって決定されます。

単調波形モードは、デジタル・ジェネレータのみに適用可能です。単調波形の波形設定
画面を、図 3-27に示します。

図 3-27 Digital Generator > Waveform Configメニュー・ページ（単調波形）

表 3-17 Digital Generator > Waveform Configメニューの概要（単調波形）

メニュー 概要

Samples/Step 方形波の各半サイクルの持続時間です。
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3 オーディオ・ジェネレータの機能
一定値波形

一定値波形モードは、同じ一定の値のデータ・サンプルの連続ストリームを出力しま
す。このモードは、デジタル・システムのデータ依存エラーの調査に使用できます。特
定のエラーを繰り返し発生させるには、一定の値を使用する必要があります。

一定値波形モードは、デジタル・ジェネレータのみに適用可能です。一定値波形の波形
設定画面を、図 3-28に示します。

図 3-28 Digital Generator > Waveform Configメニュー・ページ（一定値波形）

表 3-18 Digital Generator > Waveform Configメニューの概要（一定値波形）

Menu 概要

Amplitude
デジタル・ジェネレータの場合は、FFS、dBFS、%FSで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの 2倍であり、Vrmsは Vpeak/√2に等し
くなります。
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オーディオ・ジェネレータの機能 3
ウォーキング・ゼロ

ウォーキング・ゼロ波形モードでは、1つのビットが 0に、残りのビットが 1に設定さ
れます。ビット 0は、最下位ビット（LSB）から最上位ビット（MSB）まで連続的に上
昇して、LSBに戻ります。

ウォーキング・ゼロ波形モードは、デジタル・ジェネレータのみに適用可能です。
ウォーキング・ゼロ波形の波形設定画面を、図 3-29に示します。

図 3-29 Digital Generator > Waveform Configメニュー・ページ（ウォーキング・ゼロ）

表 3-19 Digital Generator > Waveform Configメニューの概要（ウォーキング・ゼロ）

メニュー 概要

Samples/Step 1個のビット 0の増加速度です。
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3 オーディオ・ジェネレータの機能
ウォーキング・ワン

ウォーキング・ワン波形モードでは、1つのビットが 1に、残りのビットが 0に設定さ
れます。ビット 1は、最下位ビット（LSB）から最上位ビット（MSB）まで連続的に上
昇して、LSBに戻ります。

ウォーキング・ワン波形モードは、デジタル・ジェネレータのみに適用可能です。
ウォーキング・ワン波形の波形設定画面を、図 3-30に示します。

図 3-30 Digital Generator > Waveform Configメニュー・ページ（ウォーキング・ワン）

表 3-20 Digital Generator > Waveform Configメニューの概要（ウォーキング・ワン）

メニュー 概要

Samples/Step 1個のビット 1の増加速度です。
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オーディオ・ジェネレータの機能 3
任意波形

適切にフォーマットした波形ファイルを、波形サンプルのシーケンスとして U8903Bに
ロードできます。サンプルは、192 kHzの固定サンプリング・レートで、連続したシー
ケンスでジェネレータから出力されます。波形ファイルは、.arbまたは .wavファイ
ル・フォーマットでなければなりません。.wavファイル・フォーマットでは、サンプ
ル当たり 8/16/24ビットのモノラル／ステレオ・オーディオをサポートしています。 

任意波形モードは、アナログ・ジェネレータとデジタル・ジェネレータの両方に適用可
能です。アナログ・ジェネレータとデジタル・ジェネレータの任意波形の波形設定画面
を、図 3-31と図 3-32にそれぞれ示します。任意波形ファイルのフォーマットの詳細
については、「付録 O：任意波形ファイルのフォーマット」（ページ）512を参照してく
ださい。

図 3-31 Analog Generator > Waveform Configメニュー・ページ（任意波形）

図 3-32 Digital Generator > Waveform Configメニュー・ページ（任意波形）
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3 オーディオ・ジェネレータの機能
表 3-21 Analog/Digital Generator > Waveform Configメニューの概要（任意波形）

メニュー 概要

Amplitude

アナログ・ジェネレータの場合は、Vrms、Vpeak、Vpp、dBV、dBu、dBmなどで表すことができます。
デジタル・ジェネレータの場合は、FFS、dBFS、%FSで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの 2倍であり、Vrmsは Vpeak/√2に等し
くなります。

DC Offset 波形の DC成分です。

Load File 波形をファイルからロードするには、［Load File］ソフトキーを押します。［Recall］メニュー・ページの
詳細については、「Recall」（ページ）87を参照してください。

 Info ロードした波形の情報を表示するには、［Info］ソフトキーを押します。
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オーディオ・ジェネレータの機能 3
マルチトーン波形

マルチトーン波形は、複数の独立した正弦波波形の和の複合波形です。この機能は、1
回のオーディオ・データの収集で、オーディオ・デバイスのさまざまな特性を測定する
のに便利です。

マルチトーン波形モードは、アナログ・オーディオ・ジェネレータとデジタル・オー
ディオ・ジェネレータの両方に適用可能です。アナログ・ジェネレータとデジタル・
ジェネレータのマルチトーン波形の波形設定画面を、図 3-33と図 3-34にそれぞれ示
します。

図 3-33 Analog Generator > Waveform Configメニュー・ページ 1（マルチトーン波形）

図 3-34 Digital Generator > Waveform Configメニュー・ページ 1（マルチトーン波形）
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3 オーディオ・ジェネレータの機能
表 3-22 Analog/Digital Generator > Waveform Configメニューの概要（マルチトーン波形）

メニュー 概要

Amplitude

アナログ・ジェネレータの場合は、Vrms、Vpeak、Vpp、dBV、dBu、dBmなどで表すことができます。
デジタル・ジェネレータの場合は、FFS、dBFS、%FSで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの 2倍であり、Vrmsは Vpeak/√2に等し
くなります。

DC Offset
アナログ・ジェネレータにのみ使用可能です。
波形の DC成分です。

Start Freq マルチトーン波形の最低周波数（通常は最初のトーンの周波数）です。

Stop Freq マルチトーン波形の最高周波数（通常は最後のトーンの周波数）です。

Freq Spacing

トーン間の周波数間隔です。
– Linear

– Log

– Custom

Tone Count 信号の周波数成分の数です。作成可能なトーンの最大トーン数は 60です。

Length

マルチトーン波形の 1回の反復を作成するのに使用するサンプル数を決定する波形長です。波形長が長
いほど周波数分解能は高くなりますが、作成や処理にかかる時間は長くなります。
– 1024

– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

Custom

［Custom］ソフトキーを押すと、マルチトーン波形の［Custom］メニュー・ページにアクセスします。
各トーンの周波数、振幅、位相を設定し、クレスト・ファクタを最適化することができます。マルチ
トーン波形の［Custom］メニュー・ページの詳細については、「カスタム・マルチトーン」（ページ）
123を参照してください。
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カスタム・マルチトーン
アナログ・ジェネレータとデジタル・ジェネレータのカスタム・マルチトーン波形の設
定画面を、図 3-35と図 3-36にそれぞれ示します。

図 3-35 Analog Generator > Waveform Config > Customメニュー・ページ 1（マルチトーン波形）

図 3-36 Digital Generator > Waveform Config > Customメニュー・ページ 1（マルチトーン波形）
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表 3-23 Analog Generator > Waveform Config > Customメニューの概要（マルチトーン波形）

メニュー 概要

Apply カスタム・マルチトーン波形の選択したトーンに対して現在の設定を適用するには、［Apply］ソフト
キーを押します。

Optimize カスタム・マルチトーン波形のクレスト・ファクタを最適化するには、［Optimize］ソフトキーを押し
ます。

Frequency カスタム・マルチトーン波形の周波数値を設定するには、［Frequency］ソフトキーを押します。

Amplitude カスタム・マルチトーン波形の振幅値を設定するには、［Amplitude］ソフトキーを押します。

Phase カスタム・マルチトーン波形の位相値を設定するには、［Phase］ソフトキーを押します。

Add Above カスタム・マルチトーン波形の選択したトーンの上にトーンを追加するには、［Add Above］ソフトキー
を押します。

Add Below カスタム・マルチトーン波形の選択したトーンの下にトーンを追加するには、［Add Below］ソフトキー
を押します。

Remove カスタム・マルチトーン波形の選択したトーンを削除するには、［Remove］ソフトキーを押します。

Clear カスタム・マルチトーン波形リスト内のすべてのトーンをクリアするには、［Clear］ソフトキーを押し
ます。
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デュアル・トーン・マルチ周波数（DTMF）

デュアル・トーン・マルチ周波数（DTMF）は、タッチトーンとも呼ばれる、通信で使
用される信号トーンの方式です。ボイス・メール、ヘルプ・デスク、テレフォン・バン
キングなどのアプリケーションに使用されます。 

12個の DTMF信号があり、各信号は 2つのトーン（以下から選択）で構成されます。 

– 697 Hz

– 770 Hz

– 852 Hz

– 941 Hz

– 1209 Hz

– 1336 Hz

– 1477 Hz

トーンは 2つのグループ（ローとハイ）に分けられ、各 DTMF信号は各グループから
1つずつ使用します。このため、高調波が信号の一部と誤って解釈されることはありま
せん。DTMFの波形設定画面を、図 3-37に示します。

図 3-37 Analog Generator > Waveform Configメニュー・ページ 1（DTMF）
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126 Keysight U8903B ユーザーズ・ガイド

Dial

ダイヤル・モードでは、1つの DTMFトーンを作成、または DTMFシーケンスを変更で
きます。［Mode］ソフトキーを押して、ダイヤル・モードを Single／ Sequenceの間で
切り替えます。表 3-26にリストされているように、［DATA ENTRY］パネルの数字キー
を押して、各 DTMFトーンを作成します。図 3-38に示すように、［Dial］メニュー・
ページが表示されます。

図 3-38 Dialメニュー・ページ

表 3-24 Analog Generator > Waveform Configメニューの概要（DTMF）

メニュー 概要

Dial 1つの DTMFトーンを作成、または DTMFシーケンスを変更するには、［Dial］ソフトキーを押します。
詳細については、「Dial」（ページ）126を参照してください。

Amplitude
アナログ・ジェネレータの場合は、Vrms、Vpeak、Vpp、dBV、dBu、dBmなどで表すことができます。
DCオフセットのない完全な正弦波波形の場合は、Vppは Vpeakの 2倍であり、Vrmsは Vpeak/√2に等し
くなります。

Ratio 高い周波数のトーンと低い周波数のトーン間のレベル差です。

Tone Duration DTMF信号の持続時間です。

Tone Delay 2つの DTMFトーン間の遅延です。

Pause Time DTMFシーケンスのインターバル・タイムです。

Repeat DTMFシーケンスの繰り返しをオン／オフするには、［Repeat］ソフトキーを押します。

Summation

2つのレベルの合計方法を示します。
– RSS

2つのレベルの 2乗和平方根（RSS）の結果が振幅として表示されます。アナライザの振幅測定値は、
トーンの比に関係なく、ジェネレータで設定された振幅値と同じになります。

– Linear
2つのレベルのリニア加算の結果が振幅として示されます。各トーンのレベルは、トーンの比から簡
単に逆算できます。
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表 3-25 Dialメニュー・ページの概要

メニュー 概要

Mode
ダイヤル・モードの動作モードです。
Single - 数字キーと A～ Dのソフトキーを使用して、1つの DTMFトーンを発信することができます。
Sequence – DTMFシーケンスを発信／変更することができます。

A
B
C
D

シングル・ダイヤル・モード
［A］、［B］、［C］または［D］ソフトキーを押し続けると、それぞれ A、B、Cまたは Dトーンが発信され
ます。
シーケンス・ダイヤル・モード
［A］、［B］、［C］または［D］ソフトキーを押すと、Aトーンが DTMFシーケンスに追加されます。

Pause
DTMFシーケンスに追加する休止です。
［Pause］ソフトキーを押して、シーケンスにカンマで休止を追加します。

表 3-26 DTMFトーン・マッピング

DTMFトーン 概要

0～ 9 ［DATA ENTRY］パネルの数字キーを押して、0～ 9の DTMFトーンをそれぞれ作成し
ます。

* ［DATA ENTRY］パネルの を押して、‘*’ DTMFトーンを作成します。

# ［DATA ENTRY］パネルの を押して、‘#’ DTMFトーンを作成します。

A～ D ［A］～［D］のソフトキーを押して、A～ Dの DTMFトーンをそれぞれ作成します。 
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3 オーディオ・ジェネレータの機能
出力設定（アナログ・ジェネレータ）
アナログ・ジェネレータの出力設定画面を、図 3-39に示します。

図 3-39 Analog Generator > Output Configメニュー・ページ

表 3-27 Analog Generator > Output Configメニューの概要

メニュー 概要

Connector

［Connector］ソフトキーを押して、出力コネクタ・タイプを選択します。
– Bal
平衡モードでは、振幅が等しく、位相が 180度ずれている 2つの差動信号が、XLRの正と負のピンに
出力されます。

– UnBal
不平衡モードでは、グランド基準の信号が、BNC出力コネクタに出力されます。

– Com
コモン・モードでは、振幅が等しい 2つの同相信号が、XLRの正と負のピンに出力されます。コモ
ン・モード・テスト信号はピン 2と 3の両方または XLRコネクタに印加され、ピン 1は戻り信号に
接続されます。

– IEC60268
コモン・モード・テスト信号はピン 2と 3の両方または XLRコネクタに印加され、ピン 1は戻り信号
に接続されます。10 Ω出力直列抵抗がピンまたは 3に追加されます。

Impedance

［Impedance］ソフトキーを押して、出力インピーダンス値を選択します。
Bal、Com、IEC60268の場合
– 600 Ω
– 100 Ω
– 40 Ω
UnBalの場合
– 600 Ω
– 50 Ω
– 20 Ω
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IEC60268 10 Ω 

［IEC60268 10 Ω］ソフトキーを押して、一般的な IEC60268構成の XLRコネクタのピン 2または 3に追加
する 10 Ω出力直列抵抗を選択します。この設定は、出力コネクタ・タイプが IEC 60268に設定されてい
る場合にのみ使用可能です。
– Pin2

10 Ω出力直列抵抗がピン 2に追加されます。
– Pin3

 10 Ω出力直列抵抗がピン 3に追加されます。

Ground

［Ground］ソフトキーを押して、グランド・タイプを選択します。
– Float
グランド・タイプがフローティングの場合は、信号の戻り線（平衡出力の XLRピン 1、不平衡出力の
BNCリターン端子）はシャーシ・グランドにグランドされず、「フローティング状態」です。

– Ground
グランド・タイプがグランドの場合は、信号のリターン・ライン（平衡出力の場合は XLRピン 1、不
平衡出力の場合は BNCリターン端子）はシャーシ・グランドに接続されます。

Max Vol tage ［Max Vol tage］ソフトキーを押して、最大電圧を設定します。最大電圧値の設定により、ジェネレータ
からの最大振幅出力を制限し、過剰な高電圧による被試験デバイス（DUT）の損傷を防ぎます。

表 3-27 Analog Generator > Output Configメニューの概要（続き）

メニュー 概要
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出力設定（デジタル・ジェネレータ）
デジタル・ジェネレータの出力設定画面を、図 3-40に示します。

図 3-40 Digital Generator > Output Configメニュー・ページ 1

表 3-28 Digital Generator > Output Configメニューの概要

メニュー 概要

Connector

［Connector］ソフトキーを押して、出力コネクタ・タイプを選択します。
– Bal
平衡モードでは、U8903Bリア・パネルの XLR出力コネクタにデジタル信号が出力されます。

– UnBal
不平衡モードでは、U8903Bリア・パネルの BNC出力コネクタにデジタル信号が出力されます。

AES Output ［AES Output］ソフトキーを押して、AES出力をオン／オフします。

Optical Output ［Optical Output］ソフトキーを押して、光出力をオン／オフします。

Sample Rate ［Sample Rate］ソフトキーを押して、サンプリング・レートの値を設定します。

Aud io Format

［Audio Format］ソフトキーを押して、オーディオ・エンコード・フォーマットを設定します。
– Linear PCM

– A-Law
– μ-Law

Dither 

［Dither］ソフトキーを押して、ディザ・タイプを選択します。ディザとは、信号に重畳できる雑音成分
です。
– Off

– Rectangular

– Triangular

– Shaped
130 Keysight U8903B ユーザーズ・ガイド



オーディオ・ジェネレータの機能 3
基準クロック

図 3-41 Digital Generator > Output Config > Ref Clockメニュー・ページ

Ref Clock ［Ref Clock］ソフトキーを押して、基準クロックの設定を行います。詳細については、「基準クロック」
（ページ）131を参照してください。

Sync Clock ［Sync Clock］ソフトキーを押して、同期クロックの設定を行います。詳細については、「同期クロック」
（ページ）132を参照してください。

表 3-28 Digital Generator > Output Configメニューの概要（続き）

メニュー 概要

表 3-29 Digital Generator > Output Config > Ref Clockメニューの概要

メニュー 概要

Source

［Source］ソフトキーを押して、基準クロック・ソースを選択します。システム・クロックの詳細につ
いては、「付録 R：デジタル・システムのクロック分配ブロック図」（ページ）518を参照してくだ
さい。
– Internal

– AES RCLK

– External

Type

［Type］ソフトキーを押して、外部基準クロック・ソースを選択します。システム・クロックの詳細に
ついては、「付録 R：デジタル・システムのクロック分配ブロック図」（ページ）518を参照してくだ
さい。
– MCLK

– FSYNC

Word Length
［Word Length］ソフトキーを押して、外部基準クロックのワード長の値を設定します。

– 8～ 32

乗数 ［Multipl ier］ソフトキーを押して、外部基準クロックの乗数の値を設定します。外部基準クロック乗数
として選択可能な値は、外部基準クロック・ワード長によって異なります。
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同期クロック

図 3-42 Digital Generator > Output Config > Sync Clockメニュー・ページ

表 3-30 Digital Generator > Output Config > Sync Clockメニューの概要

メニュー 概要

Output ［Output］ソフトキーを押して、同期クロック出力をオン／オフします。

Source

［Source］ソフトキーを押して、同期クロック・ソースを選択します。システム・クロックの詳細につ
いては、「付録 R：デジタル・システムのクロック分配ブロック図」（ページ）518を参照してくだ
さい。
– Internal

– AES RCLK

– External

Divider

［Divider］ソフトキーを押して、同期クロックの分周比の値を選択します。同期クロックの分周比を
1に設定した場合は、同期クロックは 128倍のサンプリング・レートに固定されます（2相クロック）。
同期クロックの分周比を 128に設定した場合は、同期クロックは 128分周されます。これは、U8903B
で設定されたサンプリング・レートと同じです。
– 1

– 128
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DSI出力設定（デジタル・ジェネレータ）

デジタル・ジェネレータの DSI出力設定画面を、図 3-43に示します。

図 3-43 Digital Generator > DSI Configメニュー・ページ 1

 
表 3-31 Digital Generator > DSI Output Configメニューの概要

メニュー 概要

Voltage

［Vol tage］ソフトキーを押して、出力電圧を選択するか、目的の出力電圧を設定します。
– 1.2 Vpp

– 1.5 Vpp

– 1.8 Vpp

– 2.5 Vpp

– 3 Vpp

– 3.3 Vpp

Channels

［Channels］ソフトキーを押して、チャネル数を選択します。
– 2

– 4

– 6

– 8

– 10

– 12

– 14

– 16

Format

［Format］ソフトキーを押して、DSI出力フォーマットを選択します。
– Left

– Right

– I2S

– DSP
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Resolution
［Resolution］ソフトキーを押して、オーディオ分解能を設定します。

– 8～ 24

BClk Edge

［BClk Edge］ソフトキーを押して、クロック・エッジ・タイプを選択します。
– Rising

– Falling

Fsync Polarity

［Fsync Polarity］ソフトキーを押して、同期極性を選択します。
– Rising

– Falling

Fsync Wid th

［Fsync Wid th］ソフトキーを押して、同期幅を選択します。
– One Bit Clock

– One Subframe

– 50% Duty Cycle

Data Shift Cnt ［Data Shift Cnt］ソフトキーを押して、データ・シフト・カウント値を設定します。

Data Shift Dir

［Data Shift Dir］ソフトキーを押して、データ・シフト方向を選択します。
– Left

– Right

Mclk Output ［Mclk Output］ソフトキーを押して、マスタ・クロック出力をオン／オフします。

Word Length
［Word Length］ソフトキーを押して、マスタ・クロックのワード長の値を設定します。ワード長をオー
ディオ分解能より小さい値に設定することはできません。
– 8～ 32

乗数 ［Multipl ier］ソフトキーを押して、乗数の値を設定します。

Sample Rate ［Sample Rate］ソフトキーを押して、サンプリング・レートの値を設定します。

表 3-31 Digital Generator > DSI Output Configメニューの概要（続き）

メニュー 概要
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AES3/SPDIF出力設定（デジタル・ジェネレータ）

デジタル・ジェネレータの AES3/SPDIF出力設定画面を、図 3-44に示します。

図 3-44 Digital Generator > AES Configメニュー・ページ 1

表 3-32 Digital Generator > AES Configメニューの概要

メニュー 概要

Level ［Level］ソフトキーを押して、出力電圧レベルを設定します。

Resolution
［Resolution］ソフトキーを押して、オーディオ分解能の値を設定します。

– 8～ 24

Valid ity Bit

［Valid ity Bit］ソフトキーを押して、有効性ビットを選択します。
– Set

– Clear

Format
［Format］ソフトキーを押して、AES3/SPDIFフォーマットを選択します。

– コンシューマ
– プロフェッショナル

Status Bits

［Status Bits］ソフトキーを押して、ステータス・ビット・タイプを選択します。
– Channel

– User

Ed it Bits
［Edit Bits］ソフトキーを押して、選択したフォーマットに従ってビットを構成します。詳細について
は、「ビットの編集（コンシューマ・フォーマット）」（ページ）136と「ビットの編集（プロフェッ
ショナル・フォーマット）」（ページ）141を参照してください。

Clear Bits ［Clear Bits］ソフトキーを押して、すべてのビットをクリアします。
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ビットの編集（コンシューマ・フォーマット）

コンシューマ・フォーマットの AES3/SPDIFビット設定画面を、図 3-45に示します。

図 3-45 Digital Generator > AES Config > Edit Bits（コンシューマ・フォーマット）メニュー・
ページ 1

Save File ［Save File］ソフトキーを押して、ビットをファイルに保存します。［Save］メニュー・ページの詳細に
ついては、「Save」（ページ）86を参照してください。

Load File ［Load File］ソフトキーを押して、ビットをファイルからロードします。［Recall］メニュー・ページの詳
細については、「Recall」（ページ）87を参照してください。

表 3-32 Digital Generator > AES Configメニューの概要（続き）

メニュー 概要

表 3-33 Digital Generator > AES Config > Edit Bits（コンシューマ・フォーマット）メニューの概要

メニュー 概要

Select Byte ［Select Byte］ソフトキーを押して、バイトを選択して編集します。

Aud io Mode

［Audio Mode］ソフトキーを押して、オーディオ・モードを選択します。
– Non-Linear PCM

– Linear PCM

著作権
［Copyright］ソフトキーを押して、著作権タイプを選択します。

– 著作権
– Non-copyright
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オーディオ・ジェネレータの機能 3
Emphasis

［Emphasis］ソフトキーを押して、エンファシス・タイプを選択します。
– No pre-emphasis
– 50/15 μs

– Reserved 1

– Reserved 2

Channel Mode
［Channel Mode］ソフトキーを押して、チャネル・モードの値を設定します。

– 0～ 3

Category

［Category］ソフトキーを押して、カテゴリ・コード・タイプを選択します。
– General

– Laser Optical

– D/D Converter

– Magnetic

– Digital Broadcast 1

– Digital Broadcast 2

– Musical Instrument

– ADC Non Copyright

– Solid State Memory

– ADC Copyright

– Experimental

– Reserved 1

– Reserved 2

Source Num
［Source Num］ソフトキーを押して、ソース番号を設定します。

– 0～ 15

Channel Num
［Channel Num］ソフトキーを押して、チャネル番号を設定します。

– 0～ 15

Sample Freq

［Sample Freq］ソフトキーを押して、サンプリング周波数の値を選択します。
– Not indicated

– 22.05 kHz

– 24 kHz

– 32 kHz

– 44.1 kHz

– 48 kHz

– 88.2 kHz

– 96 kHz

– 176.4 kHz

– 192 kHz

– 768 kHz

表 3-33 Digital Generator > AES Config > Edit Bits（コンシューマ・フォーマット）メニューの概要（続き）

メニュー 概要
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3 オーディオ・ジェネレータの機能
Clk Accuracy

［Clk Accuracy］ソフトキーを押して、クロック確度タイプを選択します。
– Level 1

– Level 2

– Level 3

– Reserved

Max Word Len

［Max Word Len］ソフトキーを押して、最大ワード長を選択します。
– 24 bits

– 20 bits

Word Length

［Word Length］ソフトキーを押して、ワード長を選択します。
24ビットの最大ワード長
– Not indicated

– 20 bits

– 21 bits

– 22 bits

– 23 bits

– 24 bits

20ビットの最大ワード長
– Not indicated

– 16 bits

– 17 bits

– 18 bits

– 19 bits

– 20 bits

表 3-33 Digital Generator > AES Config > Edit Bits（コンシューマ・フォーマット）メニューの概要（続き）

メニュー 概要
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オーディオ・ジェネレータの機能 3
Orig Samp

［Orig Samp］ソフトキーを押して、元のサンプリング周波数の値を選択します。
– Not indicated

– 8 kHz

– 11.025 kHz

– 12 kHz

– 16 kHz

– 22.05 kHz

– 24 kHz

– 32 kHz

– 44.1 kHz

– 48 kHz

– 88.2 kHz

– 96 kHz

– 176.4 kHz

– 192 kHz

– Reserved 1

– Reserved 2

CGMA-A

［CGMA-A］ソフトキーを押して、CGMA-Aタイプを選択します。
– Copying Permitted

– Condition Not Used

– One Generation Copy

– Copying Denied

表 3-33 Digital Generator > AES Config > Edit Bits（コンシューマ・フォーマット）メニューの概要（続き）

メニュー 概要

表 3-34 AES3/SPDIFコンシューマ・モードのビットの概要

ビット ラベル 概要

0 アプリケーション・
モード

0：コンシューマ
1：プロフェッショナル

1 非オーディオ
0：オーディオ・データはリニア PCMサンプル
1：リニア PCMサンプル以外

2 著作権
0：主張
1：非主張

3～ 5 エンファシス
000：エンファシス指示なし
100: CDタイプ・エンファシス

6～ 7 チャネル・ステー
タス・モード

00：モード 0

他の値は予約済み

8～ 15 カテゴリ・コード ビット 8が LSB

16～ 19 ソース番号 ビット 16が LSB
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3 オーディオ・ジェネレータの機能
20～ 23 チャネル番号 ビット 20が LSB

24～ 27 サンプリング周波数
0000：44.1 kHz

0100：48 kHz

1100：32 kHz

28～ 29 クロック確度
10：レベル I、±50 ppm

00：レベル II、±1000 ppm

01：レベル III、可変ピッチ・シフト

30～ 31 予約

32 ワード長（フィール
ド・サイズ）

0：最大長 20ビット
1：最大長 24ビット

33～ 35 ワード長

000
101
001
010
011
100

ビット 32＝ 1の場合
Not indicated
24 bits

23ビット
22ビット
21ビット
20ビット

ビット 32＝ 0の場合
指示なし
20 bits

19ビット
18ビット
17ビット
16ビット

36～ 39 元のサンプリング
周波数

1111：44.1 kHz

1110：88.2 kHz

1101：22.05 kHz

1100：176.4 kHz

1011：48 kHz

1010：96 kHz

1001：24 kHz

1000：192 kHz

0111：予約
0110：8 kHz

0101：11.025 kHz

0100：12 kHz

0011：32 kHz

0010：予約 

0001：16 kHz
0000：指示なし

40～ 41 CGMS-A

00：コピー可
01：未対応
10：コピー・ワンス
11：コピー不可

42～ 192 予約

表 3-34 AES3/SPDIFコンシューマ・モードのビットの概要（続き）

ビット ラベル 概要
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オーディオ・ジェネレータの機能 3
ビットの編集（プロフェッショナル・フォーマット）

プロフェッショナル・フォーマットの AES3/SPDIFビット設定画面を、図 3-45に示し
ます。

図 3-46 Digital Generator > AES Config > Edit Bits（プロフェッショナル・フォーマット）
メニュー・ページ 1

表 3-35 Digital Generator > AES Config > Edit Bits（プロフェッショナル・フォーマット）メニューの概要

メニュー 概要

Select Byte ［Select Byte］ソフトキーを押して、バイトを選択して編集します。

Audio Mode

［Aud io Mode］ソフトキーを押して、オーディオ・モードを選択します。
– Non-Linear PCM

– Linear PCM

Emphasis

［Emphasis］ソフトキーを押して、エンファシス・タイプを選択します。
– Not indicated

– No pre-emphasis
– 50/15 μs

– CCITT J.17

Freq Mode

［Freq Mode］ソフトキーを押して、周波数モードを選択します。
– Locked

– Unlocked
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3 オーディオ・ジェネレータの機能
Sample Freq

［Sample Freq］ソフトキーを押して、サンプリング周波数の値を選択します。
– Not indicated

– 22.05 kHz

– 24 kHz

– 32 kHz

– 44.1 kHz

– 48 kHz

– 88.2 kHz

– 96 kHz

– 176.4 kHz

– 192 kHz

Freq Scaling ［Freq Scaling］ソフトキーを押して、周波数スケーリングをオン／オフします。

Chan Mode

［Chan Mode］ソフトキーを押して、チャネル・モードを選択します。
– Not indicated

– 2-channel

– Single channel

– Primary-Secondary

– Stereo

– Reserved 1

– Reserved 2

– Mono Double Rate

– Left Double Rate

– Right Double Rate

– Multichannel

User Bits

［User Bits］ソフトキーを押して、ユーザ・ビット・タイプを選択します。
– Not indicated

– 192-bit block

– Reserved for AES18

– User defined

– Reserved for Metadata

– As in IEC60958-3

Aux Bits

［Aux Bits］ソフトキーを押して、補助ビットを選択します。
– 20-bit not defined

– 24-bit main audio

– 20-bit single

– Reserved

表 3-35 Digital Generator > AES Config > Edit Bits（プロフェッショナル・フォーマット）メニューの概要（続き）

メニュー 概要
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オーディオ・ジェネレータの機能 3
Word Length

［Word Length］ソフトキーを押して、ワード長を選択します。
24ビットの最大ワード長
– Not indicated

– 20 bits

– 21 bits

– 22 bits

– 23 bits

– 24 bits

20ビットの最大ワード長
– Not indicated

– 16 bits

– 17 bits

– 18 bits

– 19 bits

– 20 bits

Alignment

［Alignment］ソフトキーを押して、調整レベルを選択します。
– Not Indicated

– － 18.06 dBFS

– － 20 dBFS

– Reserved

Multi-Channel

［Multi-Channel］ソフトキーを押して、マルチチャネル・ステータスを選択します。
– Defined

– Undefined

Multi-Ch Mode

マルチチャネル・ステータスが Definedに設定されている場合にのみ使用可能です。
［Multi-Ch Mode］ソフトキーを押して、マルチチャネル・モードを選択します。 

– Mode 0

– Mode 1

– Mode 2

– Mode 3

– User Defined

Channel Num

［Channel Num］ソフトキーを押して、チャネル番号を設定します。
– 1～ 16（既定義のマルチチャネル・ステータス）
– 1～ 128（未定義のマルチチャネル・ステータス）

Ref Signal

［Ref Signal］ソフトキーを押して、基準信号のタイプを選択します。
– Not a ref. signal

– Grade 1

– Grade 2

– Reserved

Channel Origin ［Channel Origin］ソフトキーを押して、発信元値を設定します（4桁の英数字）。

Channel Dest ［Channel Dest］ソフトキーを押して、チャネル宛先値を設定します (4桁の英数字）。

表 3-35 Digital Generator > AES Config > Edit Bits（プロフェッショナル・フォーマット）メニューの概要（続き）

メニュー 概要
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3 オーディオ・ジェネレータの機能
Local Addr
［Local Addr］ソフトキーを押して、ローカル・アドレスの値を設定します。

– 0～ 232–1

Time of Day
［Time of Day］ソフトキーを押して、時刻を設定します。

– 0～ 232–1

Rel Flags

［Rel Flags］ソフトキーを押して、信頼性フラグを選択します。
– 0-5

– 6-13

– 14-17

– 18-21

表 3-35 Digital Generator > AES Config > Edit Bits（プロフェッショナル・フォーマット）メニューの概要（続き）

メニュー 概要

表 3-36 AES3/SPDIFプロフェッショナル・モードのビットの概要

ビット ラベル 概要

0 アプリケーション・
モード

0：コンシューマ
1：プロフェッショナル

1 非オーディオ
0：オーディオ・データはリニア PCMサンプル
1：リニア PCMサンプル以外

2～ 4 エンファシス

000：指示なし
100: エンファシスなし
110: CDタイプ・エンファシス
111: J-17エンファシス

5 ロック
0：指示なし
1：非ロック

6～ 7 サンプリング周波数

00：指示なし (またはバイト 4を参照 )

10：48 kHz

01：44.1 kHz

11：32 kHz
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オーディオ・ジェネレータの機能 3
8～ 11

チャネル・モード

0000：指示なし（デフォルトは 2チャネル）
0001：2チャネル
0010：1チャネル（モノラル）
0011：プライマリ／セカンダリ
0100：ステレオ
0101：ユーザ・アプリケーション用に予約
0110：ユーザ・アプリケーション用に予約
0111：SCDSR（IDについてはバイト 3を参照）
1000：SCDSR（ステレオ左）
1001：SCDSR（ステレオ右）
1111：マルチチャネル（IDについてはバイト 3を参照）

シングル・チャネル・ダブル・サンプリング・レート（SCDSR）

12～ 15 ユーザ・ビット管理

0000：指示なし
0001：チャネル・ステータスと同様の 192ビット・ブロック
0010：AES18の定義に従う
0011：ユーザ定義
0100：IEC60958-3（コンシューマ）と同じ

16～ 18
AUXサンプル・ワード
使用

0000：未定義、オーディオ最大 20ビット
0001：メイン・オーディオに使用、最大 24ビット
0010：調整信号に使用、オーディオ最大 20ビット
0011：ユーザ定義

19～ 21 ソース・ワード長

000：
001：
010：
011：
100：
101：

最大長＝ 24ビットの場
合
指示なし
23ビット
22ビット
21ビット
20ビット
24ビット

最大長＝ 20ビットの場
合
指示なし
19ビット
18ビット
17ビット
16ビット
20ビット

22～ 23 調整レベル
00：指示なし
01：－ 20 dBFS

10：－ 18.06 dBFS

24～ 31 チャネル識別
ビット 31＝ 0の場合、チャネル番号は 1＋ビット 24～ 30の値です。
ビット 31＝ 1の場合、ビット 4～ 6がマルチチャネル・モードを定義し、
ビット 0～ 3がそのモード内のチャネル番号を表します。

32～ 33
デジタル・オーディオ
基準信号（DARS）

00：DARSなし
01：DARSグレード 1（±1 ppm）
10：DARSグレード 2（±10 ppm）

表 3-36 AES3/SPDIFプロフェッショナル・モードのビットの概要（続き）

ビット ラベル 概要
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3 オーディオ・ジェネレータの機能
35～ 38 サンプリング周波数

0000：指示なし
1000：24 kHz

0100：96 kHz

1001：22.05 kHz

0101：88.2 kHz

1101：176.4 kHz

1111：ユーザ定義

39 サンプリング周波数ス
ケーリング

0：スケーリングなし
1：係数 1/1.001を値に適用

48～ 79 英数字の発信元
パリティなしの 7ビット ASCIIを使用した 4文字のラベル
ビット 55、63、71、79＝ 0

80～ 111 英数字のチャネル宛先
パリティなしの 7ビット ASCIIを使用した 4文字のラベル
ビット 87、95、103、111＝ 0

112～ 143 ローカル・サンプル・
アドレス・コード

チャネル・ステータス・ブロックの最初のサンプルのサンプル・カウント
を表す 32ビットの 2進数

144～ 175 時刻コード
午前 0時からのサンプル数による時間ソース・エンコーディングを表す 32
ビットの 2進数

176～ 183 信頼性フラグ
0：バイト範囲のデータは信頼できる
1：バイト範囲のデータは信頼できない

184～ 191 CRCC
00000000：未実装
nnnnnnnn: ビット 0～ 183のエラー・チェック・コード

表 3-36 AES3/SPDIFプロフェッショナル・モードのビットの概要（続き）

ビット ラベル 概要
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オーディオ・ジェネレータの機能 3
基準（アナログ・ジェネレータ）
アナログ・ジェネレータの出力基準設定画面を、図 3-47に示します。

図 3-47 Analog Generator > Referencesメニュー・ページ

表 3-37 Analog Generator > Referencesメニューの概要

メニュー 概要

Ref. Imp ［Ref. Imp］ソフトキーを押して、dBm測定の単位変換の基準インピーダンス値を設定します。
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3 オーディオ・ジェネレータの機能
基準（デジタル・ジェネレータ）
デジタル・ジェネレータの出力基準設定画面を、図 3-48に示します。

図 3-48 Digital Generator > Referencesメニュー・ページ

表 3-38 Digital Generator > Referencesメニューの概要

メニュー 概要

Vol ts/FS
［Vol ts/FS］ソフトキーを押して、デジタル・フル・スケール（1 FS）への変換時に使用される D/Aコン
バータのアナログ出力電圧（V）の V/FS基準を設定します。これは、D/Aコンバータのデジタル単位か
らアナログ単位への変換テストに便利です。
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4 オーディオ・アナライザの測定機能
オーディオ・アナライザ

［FUNCTION］パネルの を押して、オーディオ・ジェネレータ・モードとオー

ディオ・アナライザ・モードの間を切り替えます。［Analog Analyzer］メニュー・ペー
ジと［Digital Analyzer］メニュー・ページを、図 4-1と図 4-2にそれぞれ示します。

［FUNCTION］パネルの を押して、アナログ・インタフェースとデジタル・イン

タフェースの間を切り替えます。

［DATA ENTRY］パネルの または を押して、チャネル 1またはチャネル 2

に切り替え、アクティブ・チャネルの設定を開始します。

U8903Bは、アナログ・アナライザ・チャネルの追加により、拡張することも可能です。
詳細については、「U8903Bオプション」（ページ）33を参照してください。

［RUN CONTROL］パネルの を押すことにより、選択したアナライザ・チャ

ネルの測定を開始／停止することができます。

図 4-1 Analog Analyzerメニュー・ページ

Generator
Analyzer

Interface

1 2 ABC

On
Off
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オーディオ・アナライザの測定機能 4
図 4-2 Digital Analyzerメニュー・ページ（標準測定モード）

表 4-1 Analog Analyzerメニューの概要

メニュー 概要

Functions ［Functions］ソフトキーを押して、アナログ・アナライザの機能を設定します。詳細については、「機
能」（ページ）155を参照してください。

Fil ters Config ［Fil ters Config］を押して、フィルタ設定を行います。詳細については、「フィルタ設定（アナログ・ア
ナライザ）」（ページ）197を参照してください。

Meas Config ［Meas Config］を押して、測定設定を行います。詳細については、「測定設定（アナログ・アナライザ）」
（ページ）202を参照してください。

Input Config ［Input Config］ソフトキーを押して、入力設定を行います。 詳細については、「入力設定（アナログ・ア
ナライザ）」（ページ）206を参照してください。

Wave File ［Wave File］ソフトキーを押して、波形ファイルの設定を行います。詳細については、「波形ファイル
（アナログ・アナライザ）」（ページ）214を参照してください。

Statistics ［Statistics］ソフトキーを押して、統計の設定を行います。詳細については、「Statistics」（ページ）215
を参照してください。
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4 オーディオ・アナライザの測定機能
表 4-2 Digital Analyzerメニューの概要

メニュー 概要

Meas Mode

［Meas Mode］ソフトキーを押して、測定モードを選択します。詳細については、「測定モード」（ペー
ジ）153を参照してください。
– Standard

– Process Delay

– BERT

Unit

測定モードが BERTの場合にのみ使用可能です。
［Unit］ソフトキーを押して、BERT解析モードの単位を選択します。

– Hex

– Dec

Functions
測定モードが Standardの場合にのみ使用可能です。
［Functions］ソフトキーを押して、アナログ・アナライザの機能を設定します。詳細については、「機
能」（ページ）155を参照してください。

Fil ters Config
測定モードが Standardの場合にのみ使用可能です。
［Fil ters Config］を押して、フィルタ設定を行います。詳細については、「フィルタ設定（デジタル・ア
ナライザ）」（ページ）200を参照してください。

Meas Config
測定モードが Standardの場合にのみ使用可能です。
［Meas Config］を押して、測定設定を行います。詳細については、「測定設定（デジタル l・アナライ
ザ）」（ページ）204を参照してください。

Input Config ［Input Config］ソフトキーを押して、入力設定を行います。 詳細については、「入力設定（デジタル・ア
ナライザ）」（ページ）208を参照してください。

DSI Config ［DSI Config］ソフトキーを押して、フォーマットや分解能などの DSI入力設定を行います。詳細につい
ては、「DSI入力設定（デジタル・アナライザ）」（ページ）210を参照してください。

AES/SPDIF ［AES/SPDIF］ソフトキーを押して、デコードや分解能などの AES3/SPDIF入力設定を行います。詳細につ
いては、「AES/SPDIF入力設定（デジタル・アナライザ）」（ページ）212を参照してください。

Bits Analysis ［Bits Analysis］ソフトキーを押して、ビット解析の設定を行います。詳細については、「ビット解析（デ
ジタル・アナライザ）」（ページ）213を参照してください。

Statistics ［Statistics］ソフトキーを押して、統計の設定を行います。詳細については、「Statistics」（ページ）215
を参照してください。
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オーディオ・アナライザの測定機能 4
測定モード

Standard

標準モードは、デジタル・アナライザのデフォルト・モードです。

Process delay

処理遅延の測定では、出力フレームと入力フレームの時間差が計算されます。デジタ
ル・オーディオ信号が DUTを通って送信される際に、遅延が生じます。処理遅延の測
定では、最初の出力フレーム信号と最初の入力フレーム信号の時間差が計算されます。
この測定は、フレーム間遅延に関する測定の性質上、独自のフレーム・パターンを持つ
AES3信号にのみ適用されます。処理遅延モードでは、処理遅延を秒単位で表示でき
ます。

図 4-3 Digital Analyzerメニュー・ページ（処理遅延測定モード）

注 デジタル・アナライザの解析モードが Process Delayに設定されている場合は、その他
の種類の測定は実行できません。
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4 オーディオ・アナライザの測定機能
BERT（ビット・エラー・レート・テスト）
BERTモード測定では、全エラー数、実行ビット総数、ビット・エラー・レートが測定
されます。このテストは、選択した出力コネクタと入力コネクタが同じタイプの場合に
のみ有意です。

U8903Bでは、以下を除き、デジタル・ジェネレータで作成されたすべての波形タイプ
を BERTモードで解析できます。 

– 単調波形 

– 周波数設定がサンプリング・レートの半分未満の方形波 

– ステップ当たりのサンプル数が 2以上のウォーキング・ワンまたはウォーキング・
ゼロ

図 4-4 Digital Analyzerメニュー・ページ（BERT測定モード）

注 BERT解析に方形波が必要な場合は、方形波の周波数がサンプリング・レートの半分に
なるように設定します。

BERT解析にウォーキング・ワンまたはウォーキング・ゼロが必要な場合は、ステップ
当たりのサンプル数が 1になるように設定します。

注 デジタル・アナライザの解析モードが BERTに設定されている場合は、その他の種類の
測定は実行できません。
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オーディオ・アナライザの測定機能 4
機能
U8903Bでは、1回の問合せで最大 4つの機能を測定できます。アナログ・アナライザと
デジタル・アナライザの機能設定画面を、図 4-5と図 4-6に示します。

図 4-5 Analog Analyzer > Functionsメニュー・ページ 1

図 4-6 Digital Analyzer > Functionsメニュー・ページ 1
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4 オーディオ・アナライザの測定機能
表 4-3 Analog/Digital Analyzer > Functionsメニューの概要

メニュー 概要

Multi-Chn

［Multi-Chn ］ソフトキーを押して、マルチチャネル測定モードを選択します。
– Off
測定機能がすべてのチャネルに個別に設定されます。

– Phase
設定については、「位相測定」（ページ）191を参照してください。

– X-Talk
設定については、「クロストーク測定」（ページ）194を参照してください。

Function No. ［Function No.］ソフトキーを押して、設定を行うアクティブな機能の番号を選択します。

Meas. Func.

［Meas. Func.］ソフトキーを押すと、使用可能なアナライザの測定機能の種類が一覧表示されます。ド
ロップダウン・リストから目的の測定機能を選択します。各測定機能の設定については、「測定機能」
（ページ）157を参照してください。
この設定は、マルチチャネル・モードが Offに設定されている場合にのみ使用可能です。
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オーディオ・アナライザの測定機能 4
測定機能

周波数測定

周波数は一般的で基本的な測定機能であり、ヘルツ (Hz)で表されます。U8903Bは、ソ
フトウェア・アルゴリズムを使って繰り返し波形の周期を検出し、その逆数を取ること
によって周波数を求めます。

確度と分解能を改善するには、オートレンジをオンにします。低周波信号の場合は、サ
ンプル・サイズを大きくすることにより、より正確で安定した測定値が得られます。ま
た、入力フィルタをオンにすることにより、測定対象の信号から不要な高周波雑音を除
去して、より安定した測定値を得ることができます。

周波数測定機能モードは、アナログ・アナライザとデジタル・アナライザの両方に適用
可能です。アナログ・アナライザとデジタル・アナライザの周波数測定の設定画面を、
図 4-7と図 4-8にそれぞれ示します。

図 4-7 Analog Analyzer > Functions > Frequencyメニュー・ページ 1
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4 オーディオ・アナライザの測定機能
図 4-8 Digital Analyzer > Functions > Frequencyメニュー・ページ 1

表 4-4 Analog/Digital Analyzer > Functions > Frequencyメニューの概要

メニュー 概要

Unit

［Unit］ソフトキーを押して、測定単位を選択します。
– Hz

– DHz

Format

［Format］ソフトキーを押して、測定機能の戻り値のフォーマットを選択します。 
– Off
［Off］を選択すると、フォーマットせずに測定値（生の値）が返されます。 

– Delta
［Delta］を選択すると、測定された周波数から基準周波数を差し引いた測定結果が返されます。

Set resul t as ref. from ［Set resul t as ref. from］ソフトキーを押して、選択したチャネルの測定結果を基準周波数として保存し
ます。

Ref. Freq ［Ref. Freq］ソフトキーを押して、基準周波数を設定します。
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オーディオ・アナライザの測定機能 4
AC電圧レベル測定

AC電圧レベル測定は、AC信号に対する最も一般的な測定機能です。U8903Bでは、実
効値とピークツーピークの 2種類の ACレベル検出を使用できます。実効値検出方法を
選択した場合は、AC電圧測定値は実効値で表示されます。同様に、ピークツーピー
ク・ディテクタを選択した場合は、結果は p-p値です。

例えば、1 Vrmsの正弦波入力信号の場合は、実効値ディテクタを選択すると、ディス
プレイには 1 Vと表示されます。これに対して、ピークツーピーク・ディテクタを選択
した場合は、ディスプレイには 2.828 V（1.414×2）と表示されます。

AC電圧レベル測定機能モードは、アナログ・アナライザとデジタル・アナライザの両
方に適用可能です。アナログ・アナライザとデジタル・アナライザの AC電圧レベル測
定の設定画面を、図 4-9と図 4-10にそれぞれ示します。

図 4-9 Analog Analyzer > Functions > AC Voltageメニュー・ページ 1

注 AC電圧レベルを測定する前に、入力結合が ACに設定されていることを確認してくだ
さい。詳細については、「入力設定（アナログ・アナライザ）」（ページ）206と「測定
設定（デジタル l・アナライザ）」（ページ）204を参照してください。
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4 オーディオ・アナライザの測定機能
図 4-10 Digital Analyzer > Functions > AC Voltageメニュー・ページ 1

表 4-5 Analog/Digital Analyzer > Functions > AC Voltageメニューの概要

メニュー 概要

Unit

［Unit］ソフトキーを押して、測定単位を選択します。
アナログ・アナライザ
– dBg

– dBm

– dBr

– dBu

– dBV

– W

– V

– DV

– dBSPL

– x

デジタル・アナライザ
– FFS

– dBFS

– ％FS

– V

– dB

– dBV

– dBr

– x

– LSB

– Hex

– Dec

– dBSPL
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オーディオ・アナライザの測定機能 4
Format

［Format］ソフトキーを押して、測定機能の戻り値のフォーマットを選択します。 
– Off
［Off］を選択すると、フォーマットせずに測定値（生の値）が返されます。

– Logarithmic
［Logarithmic］を選択すると、次の式に基づいて測定結果が返されます。

結果は dBr単位で返されます。 
– Linear
［Linear］を選択すると、測定されたレベルを基準レベルで除算した測定結果が返されます。結果は x
単位で返されます。 

– Delta
［Delta］を選択すると、測定されたレベルから基準レベルを差し引いた測定結果が返されます。結果
は DV単位で返されます。アナログ・アナライザにのみ使用可能です。

Set to 0 dB
アナログ・アナライザにのみ使用可能です。
［Set to 0dB］ソフトキーを押して、測定されたレベルを基準レベルとして保存し、測定読取りフォー
マットを Logarithmicに設定します。

Set resul t as ref. from ［Set resul t as ref. from］ソフトキーを押して、選択したチャネルの測定結果を基準レベルとして保存し
ます。

Ref. Level ［Ref. Levelソフトキーを押して、基準レベル値を設定します。基準レベルは各チャネルに対して 1つだ
けです。

Ref. Imp
アナログ・アナライザにのみ使用可能です。
［Ref. Impソフトキーを押して、基準インピーダンス値を設定します。この設定は、単位が Wに設定さ
れている場合にのみ使用可能です。

Volt/FS
デジタル・アナライザにのみ使用可能です。
［Vol t/FS］ソフトキーを押して、V/FS基準値を設定します。

Cal SPL ［Cal SPL］ソフトキーを押して、キャリブレータ・レベルの値を設定します。この設定は、単位が
dBSPLに設定されている場合にのみ使用可能です。

Detector

［Detector］ソフトキーを押して、ACレベル検出タイプを選択します。
– RMS

– Pk-Pk

表 4-5 Analog/Digital Analyzer > Functions > AC Voltageメニューの概要（続き）

メニュー 概要

20 10 Measured rms voltage
Reference level

---------------------------------------------------------- 
 log
Keysight U8903B ユーザーズ・ガイド 161



4 オーディオ・アナライザの測定機能
DC電圧レベル測定

DC電圧レベルは、オーディオ信号の一部ではありませんが、オーディオ機器に一般的
に見られます。例えば、バイアス電圧や、AC/DCコンバータの出力などです。DC電圧
はボルト (V)で表されます。DC電圧レベル測定を行う場合、入力結合は DCに設定す
る必要があります。 

DC電圧レベル測定機能モードは、アナログ・アナライザとデジタル・アナライザの両
方に適用可能です。アナログ・アナライザとデジタル・アナライザの DC電圧レベル測
定の設定画面を、図 4-11と図 4-12にそれぞれ示します。

図 4-11 Analog Analyzer > Functions > DC Voltageメニュー・ページ 1

注 DC電圧レベルを測定する前に、入力結合が DCに設定されていることを確認してくだ
さい。詳細については、「入力設定（アナログ・アナライザ）」（ページ）206と「測定
設定（デジタル l・アナライザ）」（ページ）204を参照してください。
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オーディオ・アナライザの測定機能 4
図 4-12 Digital Analyzer > Functions > DC Voltageメニュー・ページ 1

表 4-6 Analog/Digital Analyzer > Functions > DC Voltageメニューの概要

メニュー 概要

Unit

［Unit］ソフトキーを押して、測定単位を選択します。
アナログ・アナライザ
– V

– DV

– x

デジタル・アナライザ
– FFS

– V

– Hex

– x

Format

［Format］ソフトキーを押して、測定機能の戻り値のフォーマットを選択します。 
– Off
［Off］を選択すると、フォーマットせずに測定値（生の値）が返されます。

– Linear
［Linear］を選択すると、測定されたレベルを基準レベルで除算した測定結果が返されます。結果は x
単位で返されます。 

– Delta
［Delta］を選択すると、測定されたレベルから基準レベルを差し引いた測定結果が返されます。結果
は DV単位で返されます。アナログ・アナライザにのみ使用可能です。

Set resul t as ref. from ［Set resul t as ref. from］ソフトキーを押して、選択したチャネルの測定結果を基準レベルとして保存し
ます。

Ref. Level ［Ref. Levelソフトキーを押して、基準レベル値を設定します。基準レベルは各チャネルに対して 1つだ
けです。
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4 オーディオ・アナライザの測定機能
THD＋ N比測定と THD＋ Nレベル測定

単一スペクトルの高調波歪みは、信号が通過する回路の非線形性から生じます。非線形
性の原因としては、アクティブ・デバイスの伝達特性や、アクティブ・デバイスで生じ
る飽和やカットオフがあります。ほとんどの場合、信号レベルを下げたり、フィルタを
適用したり、負のフィードバックを追加したりすることにより、歪みを減らすことがで
きます。

フーリエ解析によれば、回路の伝達関数の非線形項により、信号の高調波が生じます。
このため、THD＋ N機能により、オーディオ信号の品質、すなわち信号純度の定量的
な測定を実行できます。

THD＋ N比は、信号のすべての高調波成分および雑音振幅の 2乗和平方根と、全信号
振幅との比と定義されます。THD＋ N比は以下のように計算されます。

THD＋ N比測定機能モードは、アナログ・アナライザとデジタル・アナライザの両方
に適用可能です。アナログ・アナライザとデジタル・アナライザの THD＋ N比測定の
設定画面を、図 4-13と図 4-14にそれぞれ示します。

図 4-13 Analog Analyzer > Functions > THD+N Ratioメニュー・ページ 1

THD+N ratio 20 Log10
rms value of noise and distortion

rms value of signal, noise, and distortion
---------------------------------------------------------------------------------------------------------- 
 =
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オーディオ・アナライザの測定機能 4
図 4-14 Digital Analyzer > Functions > THD+N Ratioメニュー・ページ 1

表 4-7 Analog/Digital Analyzer > Functions > THD+N Ratioメニューの概要

メニュー 概要

Unit

［Unit］ソフトキーを押して、測定単位を選択します。
– dB

– DdB

– %

– x

Format

［Format］ソフトキーを押して、測定機能の戻り値のフォーマットを選択します。
– Off
［Off］を選択すると、フォーマットせずに測定値（生の値）が返されます。

– Linear
［Linear］を選択すると、測定された比を基準比で除算した測定結果が返されます。結果は x単位で返
されます。

– Delta
［Delta］を選択すると、測定された比から基準比を差し引いた測定結果が返されます。結果は DdB単
位で返されます。

Set to 0 dB
アナログ・アナライザにのみ使用可能です。
［Set to 0dB］ソフトキーを押して、測定された比を基準比として保存し、測定読取りフォーマットを

Deltaに設定します。

Set resul t as ref. from ［Set resul t as ref. from］ソフトキーを押して、選択したチャネルの測定結果を基準比として保存します。

Ref. Ratio ［Ref. Ratioソフトキーを押して、基準比の値を設定します。

Precision
デジタル・アナライザにのみ使用可能です。
［Precision］ソフトキーを押して、高精度モードをオン／オフします。
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4 オーディオ・アナライザの測定機能
THD＋ Nレベルは、信号のすべての高調波成分および雑音振幅の 2乗和平方根と定義
され、Vrmsで表されます。THD＋ Nレベルは以下のように計算されます。

THD＋ Nレベル測定機能モードは、アナログ・アナライザとデジタル・アナライザの
両方に適用可能です。アナログ・アナライザとデジタル・アナライザの THD＋ Nレベ
ル測定の設定画面を、図 4-15と図 4-16にそれぞれ示します。

図 4-15 Analog Analyzer > Functions > THD+N Levelメニュー・ページ 1

Freq Lock

［Freq Lock］ソフトキーを押して、基本波周波数の探索方法を選択します。
– Auto
［Auto］を選択した場合は、U8903Bは基本波周波数を自動的に探索します。

– Gen Lock
［Gen Lock］を選択した場合は、U8903Bは各ジェネレータ・チャネルの周波数値に基づいて基本波周
波数を探索します。ジェネレータ・チャネルを選択するには、［Meas. Config.］メニュー・ページの
Src Channelを設定します。この Gen Lock方法は、内蔵オーディオ・ジェネレータを使用している場合
にのみ有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Fund Freq］で周波数値を設定することによ
り、基本波周波数値を定義することができます。

Fund Freq ［Fund Freq］ソフトキーを押して、基本波周波数値を設定します。この設定は、Freq Lockが Customに設
定されている場合にのみ使用可能です。

表 4-7 Analog/Digital Analyzer > Functions > THD+N Ratioメニューの概要（続き）

メニュー 概要

THD+N Level rms value of noise and distortion=
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オーディオ・アナライザの測定機能 4
図 4-16 Digital Analyzer > Functions > THD+N Levelメニュー・ページ 1

表 4-8 Analog/Digital Analyzer > Functions > THD+N Levelメニューの概要

メニュー 概要

Unit

［Unit］ソフトキーを押して、測定単位を選択します。
アナログ・アナライザ
– dBg

– dBm

– dBr

– dBu

– dBV

– W

– V

– DV

– dBSPL

– x

デジタル・アナライザ
– FFS

– dBFS

– ％FS

– V

– dB

– dBV

– dBr

– x

– LSB

– Hex

– Dec

– dBSPL
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4 オーディオ・アナライザの測定機能
Format

［Format］ソフトキーを押して、測定機能の戻り値のフォーマットを選択します。 
– Off
［Off］を選択すると、フォーマットせずに測定値（生の値）が返されます。

– Logarithmic
［Logarithmic］を選択すると、次の式に基づいて測定結果が返されます。

結果は dBr単位で返されます。 
– Linear
［Linear］を選択すると、測定されたレベルを基準レベルで除算した測定結果が返されます。結果は x
単位で返されます。 

– Delta
［Delta］を選択すると、測定されたレベルから基準レベルを差し引いた測定結果が返されます。結果
は DV単位で返されます。アナログ・アナライザにのみ使用可能です。

Set to 0 dB
アナログ・アナライザにのみ使用可能です。
［Set to 0dB］ソフトキーを押して、測定されたレベルを基準レベルとして保存し、測定読取りフォー
マットを Logarithmicに設定します。

Set resul t as ref. from ［Set resul t as ref. from］ソフトキーを押して、選択したチャネルの測定結果を基準レベルとして保存し |

ます。

Ref. Level ［Ref. Levelソフトキーを押して、基準レベル値を設定します。基準レベルは各チャネルに対して 1つだ
けです。

Ref. Imp
アナログ・アナライザにのみ使用可能です。
［Ref. Impソフトキーを押して、基準インピーダンス値を設定します。この設定は、単位が Wに設定さ
れている場合にのみ使用可能です。

Vol t/FS
デジタル・アナライザにのみ使用可能です。
［Vol t/FS］ソフトキーを押して、V/FS基準値を設定します。

Precision
デジタル・アナライザにのみ使用可能です。
［Precision］ソフトキーを押して、高精度モードをオン／オフします。

Cal SPL ［Cal SPL］ソフトキーを押して、キャリブレータ・レベルの値を設定します。この設定は、単位が
dBSPLに設定されている場合にのみ使用可能です。

Freq Lock

［Freq Lock］ソフトキーを押して、基本波周波数の探索方法を選択します。
– Auto
［Auto］を選択した場合は、U8903Bは基本波周波数を自動的に探索します。

– Gen Lock
［Gen Lock］を選択した場合は、U8903Bは各ジェネレータ・チャネルの周波数値に基づいて基本波周
波数を探索します。ジェネレータ・チャネルを選択するには、［Meas. Config.］メニュー・ページの
Src Channelを設定します。この Gen Lock方法は、内蔵オーディオ・ジェネレータを使用している場合
にのみ有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Fund Freq］で周波数値を設定することによ
り、基本波周波数値を定義することができます。

Fund Freq ［Fund Freq］ソフトキーを押して、基本波周波数値を設定します。この設定は、Freq Lockが Customに設
定されている場合にのみ使用可能です。

表 4-8 Analog/Digital Analyzer > Functions > THD+N Levelメニューの概要（続き）

メニュー 概要

20 10 Measured rms voltage
Reference level

---------------------------------------------------------- 
 log
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オーディオ・アナライザの測定機能 4
SINAD測定

SINAD（信号、雑音、歪み比）は、歪み測定の逆数に相当します。これは主に、通信レ
シーバの感度を求めるために使用されます。SINAD測定で計算される比は以下のよう
になります。

SINAD測定機能モードは、アナログ・オーディオ・アナライザとデジタル・オーディ
オ・アナライザの両方に適用可能です。アナログ・アナライザとデジタル・アナライザ
の SINAD測定の設定画面を、図 4-17と図 4-18にそれぞれ示します。

図 4-17 Analog Analyzer > Functions > SINADメニュー・ページ 1

図 4-18 Digital Analyzer > Functions > SINADメニュー・ページ 1

SINAD 20 Log rms value of signal, noise, and distortion
rms value of noise and distortion

---------------------------------------------------------------------------------------------------------- 
 =
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4 オーディオ・アナライザの測定機能
表 4-9 Analog/Digital Analyzer > Functions > SINADメニューの概要

メニュー 概要

Unit

［Unit］ソフトキーを押して、測定単位を選択します。
– dB

– DdB

– %

– x

Format

［Format］ソフトキーを押して、測定機能の戻り値のフォーマットを選択します。
– Off
［Off］を選択すると、フォーマットせずに測定値（生の値）が返されます。

– Linear
［Linear］を選択すると、測定された比を基準比で除算した測定結果が返されます。結果は x単位で返
されます。

– Delta
［Delta］を選択すると、測定された比から基準比を差し引いた測定結果が返されます。結果は DdB単
位で返されます。

Set to 0 dB
アナログ・アナライザにのみ使用可能です。
［Set to 0dB］ソフトキーを押して、測定された比を基準比として保存し、測定読取りフォーマットを

Deltaに設定します。

Set resul t as ref. from ［Set resul t as ref. from］ソフトキーを押して、選択したチャネルの測定結果を基準比として保存します。

Ref. Ratio ［Ref. Ratioソフトキーを押して、基準比の値を設定します。

Precision
デジタル・アナライザにのみ使用可能です。
［Precision］ソフトキーを押して、高精度モードをオン／オフします。

Freq Lock

［Freq Lock］ソフトキーを押して、基本波周波数の探索方法を選択します。
– Auto
［Auto］を選択した場合は、U8903Bは基本波周波数を自動的に探索します。

– Gen Lock
［Gen Lock］を選択した場合は、U8903Bは各ジェネレータ・チャネルの周波数値に基づいて基本波周
波数を探索します。ジェネレータ・チャネルを選択するには、［Meas. Config.］メニュー・ページの
Src Channelを設定します。この Gen Lock方法は、内蔵オーディオ・ジェネレータを使用している場合
にのみ有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Fund Freq］で周波数値を設定することによ
り、基本波周波数値を定義することができます。

Fund Freq ［Fund Freq］ソフトキーを押して、基本波周波数値を設定します。この設定は、Freq Lockが Customに設
定されている場合にのみ使用可能です。
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オーディオ・アナライザの測定機能 4
THD比測定と THDレベル測定

THD（全高調波歪み）測定では、DUTの非線形性に起因する選択した高調波の振幅を測
定し、それらの高調波の振幅を合計します。THD測定では、DUTに存在する可能性の
ある雑音成分は除外されます。

THD比は、THDレベルの基本波信号振幅に対する比として定義され、dB（デフォルト）
または％で表されます。THD比は以下のように計算されます。

THD比測定機能モードは、アナログ・アナライザとデジタル・アナライザの両方に適
用可能です。アナログ・アナライザとデジタル・アナライザの THD比測定の設定画面
を、図 4-19と図 4-20にそれぞれ示します。

図 4-19 Analog Analyzer > Functions > THD Ratioメニュー・ページ 1

THD ratio 20 Log10
rms value of distortion

rms value of signal and distortion
---------------------------------------------------------------------------------------- 
 =
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4 オーディオ・アナライザの測定機能
図 4-20 Digital Analyzer > Functions > THD Ratioメニュー・ページ 1

表 4-10 Analog/Digital Analyzer > Functions > THD Ratioメニューの概要

メニュー 概要

Unit

［Unit］ソフトキーを押して、測定単位を選択します。
– dB
– DdB
– %
– x

Format

［Format］ソフトキーを押して、測定機能の戻り値のフォーマットを選択します。 
– Off
［Off］を選択すると、フォーマットせずに測定値（生の値）が返されます。

– Delta
［Delta］を選択すると、測定された比から基準比を差し引いた測定結果が返されます。結果は DdB単
位で返されます。

– Linear
［Linear］を選択すると、測定された比を基準比で除算した測定結果が返されます。結果は x単位で返
されます。

Set to 0 dB
アナログ・アナライザにのみ使用可能です。
［Set to 0dB］ソフトキーを押して、測定された比を基準比として保存し、測定読取りフォーマットを

Deltaに設定します。

Set resul t as ref. from ［Set resul t as ref. from］ソフトキーを押して、選択したチャネルの測定結果を基準比として保存します。

Ref. Ratio ［Ref. Ratioソフトキーを押して、基準比の値を設定します。

Even Harmonic

［Even Harmonic］ソフトキーを押して、偶数次高調波の次数の選択を表示します。ナビゲーション・パ
ネルの［Enter］キーを押して目的の偶数次高調波の次数を選択し、［Even Harmonic］ソフトキーをもう
一度押して選択を確定します。
– ALL
– 2
– 4
– 6
– 8
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オーディオ・アナライザの測定機能 4
THDレベルは、信号のすべての高調波成分の 2乗和平方根と定義され、Vrmsで表され
ます。THDレベルは以下のように計算されます。

THDレベル測定機能モードは、アナログ・アナライザとデジタル・アナライザの両方
に適用可能です。アナログ・アナライザとデジタル・アナライザの THDレベル測定の
設定画面を、図 4-21と図 4-22にそれぞれ示します。

図 4-21 Analog Analyzer > Functions > THD levelメニュー・ページ 1

Odd Harmonic

［Odd Harmonic］ソフトキーを押して、奇数次高調波の次数の選択を表示します。ナビゲーション・パネ
ルの［Enter］キーを押して目的の奇数次高調波の次数を選択し、［Odd Harmonic］ソフトキーをもう一度
押して選択を確定します。
– ALL

– 3

– 5

– 7

– 9

Freq Lock

アナログ・アナライザにのみ使用可能です。
［Freq Lock］ソフトキーを押して、基本波周波数の探索方法を選択します。

– Auto
［Auto］を選択した場合は、U8903Bは基本波周波数を自動的に探索します。

– Gen Lock
［Gen Lock］を選択した場合は、U8903Bは各ジェネレータ・チャネルの周波数値に基づいて基本波周
波数を探索します。ジェネレータ・チャネルを選択するには、［Meas. Config.］メニュー・ページの
Src Channelを設定します。この Gen Lock方法は、内蔵オーディオ・ジェネレータを使用している場合
にのみ有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Fund Freq］で周波数値を設定することによ
り、基本波周波数値を定義することができます。

Fund Freq ［Fund Freq］ソフトキーを押して、基本波周波数値を設定します。この設定は、Freq Lockが Customに設
定されている場合にのみ使用可能です。

表 4-10 Analog/Digital Analyzer > Functions > THD Ratioメニューの概要（続き）

メニュー 概要

THD Level rms value of distortion=
Keysight U8903B ユーザーズ・ガイド 173



4 オーディオ・アナライザの測定機能
図 4-22 Digital Analyzer > Functions > THD levelメニュー・ページ 1

表 4-11 Analog/Digital Analyzer > Functions > THD Levelメニューの概要

メニュー 概要

Unit

［Unit］ソフトキーを押して、測定単位を選択します。
アナログ・アナライザ
– dBg

– dBm

– dBr

– dBu

– dBV

– W

– V

– DV

– dBSPL

– x

デジタル・アナライザ
– FFS

– dBFS

– ％FS

– V

– dB

– dBV

– dBr

– x

– LSB

– Hex

– Dec

– dBSPL
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オーディオ・アナライザの測定機能 4
Format

［Format］ソフトキーを押して、測定機能の戻り値のフォーマットを選択します。 
– Off
［Off］を選択すると、フォーマットせずに測定値（生の値）が返されます。

– Logarithmic
［Logarithmic］を選択すると、次の式に基づいて測定結果が返されます。

結果は dBr単位で返されます。 
– Linear
［Linear］を選択すると、測定されたレベルを基準レベルで除算した測定結果が返されます。結果は x
単位で返されます。 

– Delta
［Delta］を選択すると、測定されたレベルから基準レベルを差し引いた測定結果が返されます。結果
は DV単位で返されます。アナログ・アナライザにのみ使用可能です。

Set to 0 dB
アナログ・アナライザにのみ使用可能です。
［Set to 0dB］ソフトキーを押して、測定されたレベルを基準レベルとして保存し、測定読取りフォー
マットを Logarithmicに設定します。

Set resul t as ref. from ［Set resul t as ref. from］ソフトキーを押して、選択したチャネルの測定結果を基準レベルとして保存し
ます。

Ref. Level ［Ref. Levelソフトキーを押して、基準レベル値を設定します。基準レベルは各チャネルに対して 1つだ
けです。

Ref. Imp
アナログ・アナライザにのみ使用可能です。
［Ref. Impソフトキーを押して、基準インピーダンス値を設定します。この設定は、単位が Wに設定さ
れている場合にのみ使用可能です。

Volt/FS
デジタル・アナライザにのみ使用可能です。
［Vol t/FS］ソフトキーを押して、V/FS基準値を設定します。

Precision
デジタル・アナライザにのみ使用可能です。
［Precision］ソフトキーを押して、高精度モードをオン／オフします。

Cal SPL ［Cal SPL］ソフトキーを押して、キャリブレータ・レベルの値を設定します。この設定は、単位が
dBSPLに設定されている場合にのみ使用可能です。

Even Harmonic

［Even Harmonic］ソフトキーを押して、偶数次高調波を選択します。
– ALL

– 2

– 4

– 6

– 8

Odd Harmonic

［Odd Harmonic］ソフトキーを押して、奇数次高調波を選択します。
– ALL

– 3

– 5

– 7

– 9

表 4-11 Analog/Digital Analyzer > Functions > THD Levelメニューの概要（続き）

メニュー 概要

20 10 Measured rms voltage
Reference level

---------------------------------------------------------- 
 log
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4 オーディオ・アナライザの測定機能
Freq Lock

アナログ・アナライザにのみ使用可能です。
［Freq Lock］ソフトキーを押して、基本波周波数の探索方法を選択します。

– Auto
［Auto］を選択した場合は、U8903Bは基本波周波数を自動的に探索します。

– Gen Lock 
［Gen Lock］を選択した場合は、U8903Bは各ジェネレータ・チャネルの周波数値に基づいて基本波周
波数を探索します。ジェネレータ・チャネルを選択するには、［Meas. Config.］メニュー・ページの
Src Channelを設定します。この Gen Lock方法は、内蔵オーディオ・ジェネレータを使用している場合
にのみ有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Fund Freq］で周波数値を設定することによ
り、基本波周波数値を定義することができます。

Fund Freq ［Fund Freq］ソフトキーを押して、基本波周波数値を設定します。この設定は、Freq Lockが Customに設
定されている場合にのみ使用可能です。

表 4-11 Analog/Digital Analyzer > Functions > THD Levelメニューの概要（続き）

メニュー 概要
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オーディオ・アナライザの測定機能 4
SMPTE IMD測定

SMPTE IMD機能は、DUTから生じる 2次と 3次の相互変調歪みを測定するものです。
このために、2つの純粋なトーン（トーン 1とトーン 2。トーン 1の方がトーン 2より
はるかに低い周波数。例えば 60 Hzと 7 kHzなど）を DUTに入力します。SMPTE IMD
は、dB（デフォルト）または％で表されます。

トーン 1＝ f1、トーン 2＝ f2とすると、以下の高調波が考慮されます。

– f－ 2f1

– f2＋ f1

– f2－ 2f1

– f2＋ 2f1

SMPTE IMDの値は、相互変調成分の振幅の和と、上側周波数のトーンの振幅との比と
して計算されます。この測定のためのデュアル・トーンの発生方法については、「デュ
アル波形」（ページ）96を参照してください。

SMPTE IMD測定機能は、アナログ・アナライザとデジタル・アナライザの両方に適用
可能です。アナログ・アナライザとデジタル・アナライザの SMPTE IMD測定の設定画
面を、図 4-23と図 4-24にそれぞれ示します。

図 4-23 Analog Analyzer > Functions > SMPTE IMDメニュー・ページ 1
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4 オーディオ・アナライザの測定機能
図 4-24 Digital Analyzer > Functions > SMPTE IMDメニュー・ページ 1

表 4-12 Analog/Digital Analyzer > Functions > SMPTE IMDメニューの概要

メニュー 概要

Unit

［Unit］ソフトキーを押して、測定単位を選択します。
– dB

– DdB

– %

– x

Format

［Format］ソフトキーを押して、測定機能の戻り値のフォーマットを選択します。 
– Off
［Off］を選択すると、フォーマットせずに測定値（生の値）が返されます。

– Delta
［Delta］を選択すると、測定された比から基準比を差し引いた測定結果が返されます。結果は DdB単
位で返されます。

– Linear
［Linear］を選択すると、測定された比を基準比で除算した測定結果が返されます。結果は x単位で返
されます。

Set to 0 dB
アナログ・アナライザにのみ使用可能です。
［Set to 0dB］ソフトキーを押して、測定された比を基準比として保存し、測定読取りフォーマットを

Deltaに設定します。

Set resul t as ref. from ［Set resul t as ref. from］ソフトキーを押して、選択したチャネルの測定結果を基準比として保存します。

Ref. Ratio ［Ref. Ratio］ソフトキーを押して、基準比を設定します。
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オーディオ・アナライザの測定機能 4
Freq Lock

アナログ・アナライザにのみ使用可能です。
［Freq Lock］ソフトキーを押して、上側周波数と下側周波数の探索方法を選択します。

– Gen Lock 
［Gen Lock］を選択した場合は、U8903Bは各ジェネレータ・チャネルの上側周波数と下側周波数に基
づいて入力信号の上側周波数と下側周波数を探索します。ジェネレータ・チャネルを選択するには、
［Meas. Config.］メニュー・ページの Src Channelを設定します。この Gen Lock方法は、内蔵オーディ
オ・ジェネレータを使用している場合にのみ有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Upper Freq］および［Lower Freq］で周波数
値を設定することにより、上側周波数と下側周波数の値を定義することができます。

Upper Freq ［Upper Freq］ソフトキーを押して、上側周波数値を設定します。この設定は、Freq Lockが Customに設定
されている場合にのみ使用可能です。

Lower Freq ［Lower Freq］ソフトキーを押して、下側周波数値を設定します。この設定は、Freq Lockが Customに設定
されている場合にのみ使用可能です。

表 4-12 Analog/Digital Analyzer > Functions > SMPTE IMDメニューの概要（続き）

メニュー 概要
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4 オーディオ・アナライザの測定機能
DFD測定

DFD測定は SMPTE IMDに似ていますが、入力信号の 2つのトーンの振幅が等しく、周
波数が近い（通常は 19 kHzと 20 kHz）点が異なっています。また、この測定では、2
次または 3次の相互変調歪みを選択できます。使用可能な DFD測定は、DFD 60268 
2nd、DFD 60268 3rd、DFD 60118 2nd、DFD 60118 3rdです。

DFD測定機能モードは、アナログ・アナライザとデジタル・アナライザの両方に適用
可能です。アナログ・アナライザとデジタル・アナライザの DFD測定の設定画面を、
図 4-25と図 4-26にそれぞれ示します。

図 4-25 Analog Analyzer > Functions > DFD 60268 2ndメニュー・ページ 1

図 4-26 Digital Analyzer > Functions > DFD 60268 2ndメニュー・ページ 1
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オーディオ・アナライザの測定機能 4
表 4-13 Analog/Digital Analyzer > Functions > DFD測定のメニューの概要

メニュー 概要

Unit

［Unit］ソフトキーを押して、測定単位を選択します。
– dB

– DdB

– %

– x

Format

［Format］ソフトキーを押して、測定機能の戻り値のフォーマットを選択します。 
– Off
［Off］を選択すると、フォーマットせずに測定値（生の値）が返されます。

– Delta
［Delta］を選択すると、測定された比から基準比を差し引いた測定結果が返されます。結果は DdB単
位で返されます。

– Linear
［Linear］を選択すると、測定された比を基準比で除算した測定結果が返されます。結果は x単位で返
されます。

Set to 0 dB
アナログ・アナライザにのみ使用可能です。
［Set to 0dB］ソフトキーを押して、測定された比を基準比として保存し、測定読取りフォーマットを

Deltaに設定します。

Set resul t as ref. from ［Set resul t as ref. from］ソフトキーを押して、選択したチャネルの測定結果を基準比として保存します。

Ref. Ratio ［Ref. Ratio］ソフトキーを押して、基準比を設定します。
Keysight U8903B ユーザーズ・ガイド 181



4 オーディオ・アナライザの測定機能
SNR測定

SNRは、信号振幅と雑音振幅の比として定義されます。U8903Bの SNR測定の実装は
閉ループ構成で、ジェネレータとアナライザの両方がテスト・セットアップに使用され
ます。例えば、この測定では、アナログ・ジェネレータとアナログ・アナライザのチャ
ネル 1を組み合わせて使用する必要があります。

さらに、SNRは測定帯域幅によって定義されます。測定帯域幅は、オーディオ・アナ
ライザ用に選択したフィルタの仕様によって決まります。SNR測定は、U8903Bジェネ
レータの出力をオン／オフする内蔵ルーチンによって実行されます。U8903Bの出力が
オフ状態にある場合は、U8903Bの出力は DUTの入力で終端されます。

SNRの結果は、dB（デフォルト）または％で表されます。SNRは以下のように計算さ
れます。

SNR測定機能モードは、アナログ・アナライザにのみ適用可能です。SNR測定の設定
画面を、図 4-27に示します。

図 4-27 Analog Analyzer > Functions > SNRメニュー・ページ 1

SNR 20 Log10
rms value of signal
rms value of noise
------------------------------------------------- 
 =
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オーディオ・アナライザの測定機能 4
表 4-14 Analog Analyzer > Functions > SNRメニューの概要

メニュー 概要

Unit

［Unit］ソフトキーを押して、測定単位を選択します。
– dB

– DdB

– %

– x

Format

［Format］ソフトキーを押して、測定機能の戻り値のフォーマットを選択します。 
– Off
［Off］を選択すると、フォーマットせずに測定値（生の値）が返されます。

– Delta
［Delta］を選択すると、測定された比から基準比を差し引いた測定結果が返されます。結果は DdB単
位で返されます。

– Linear
［Linear］を選択すると、測定された比を基準比で除算した測定結果が返されます。結果は x単位で返
されます。

Set to 0 dB ［Set to 0dB］ソフトキーを押して、測定された比を基準比として保存し、測定読取りフォーマットを
Deltaに設定します。

Set resul t as ref. from ［Set resul t as ref. from］ソフトキーを押して、選択したチャネルの測定結果を基準比として保存します。

Ref. Ratio ［Ref. Ratio］ソフトキーを押して、基準比を設定します。

SNR Delay ［SNR Delay］ソフトキーを押して、SNR遅延を設定します。
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4 オーディオ・アナライザの測定機能
SNR（高速モード）測定

SNR（高速モード）測定は、信号振幅と雑音振幅の比を測定するのに使用されます。
SNR（高速モード）測定は周波数ドメインでの計算です。この方法は、標準的な SNR
測定よりもはるかに高速ですが、非常に高い SNRの測定には適していません。雑音測
定は、ノッチ・フィルタで基本波と高調波を周波数スペクトラムから除去することに
よって行います。

計算で除去する高調波の数を設定することができます。例えば、高調波の数が 1の場合
は、基本波周波数だけが除去されます。高調波の数が 3の場合は、計算では、基本波周
波数、1番目と 2番目の高調波が除去されます。

SNR（高速モード）は以下のように計算されます。

SNR（高速モード）測定機能モードは、アナログ・アナライザにのみ適用可能です。
SNR（高速モード）測定の設定画面を、図 4-28に示します。

図 4-28 Analog Analyzer > Functions > SNR (Fast)メニュー・ページ 1

SNR 20 Log10
rms value of signal
rms value of noise
------------------------------------------------- 
 =
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オーディオ・アナライザの測定機能 4
表 4-15 Analog Analyzer > Functions > SNR (Fast)メニューの概要

メニュー 概要

Unit

［Unit］ソフトキーを押して、測定単位を選択します。
– dB

– DdB

– %

– x

Format

［Format］ソフトキーを押して、測定機能の戻り値のフォーマットを選択します。 
– Off
［Off］を選択すると、フォーマットせずに測定値（生の値）が返されます。

– Delta
［Delta］を選択すると、測定された比から基準比を差し引いた測定結果が返されます。結果は DdB単
位で返されます。

– Linear
［Linear］を選択すると、測定された比を基準比で除算した測定結果が返されます。結果は x単位で返
されます。

Set to 0 dB ［Set to 0dB］ソフトキーを押して、測定されたレベルまたは比を基準値として保存し、保存した基準値
を参照するように読取りを設定します。

Set resul t as ref. from ［Set resul t as ref. from］ソフトキーを押して、選択したチャネルの測定結果を基準比として保存します。

Ref. Ratio ［Ref. Ratio］ソフトキーを押して、基準比を設定します。

Freq Lock

［Freq Lock］ソフトキーを押して、基本波周波数の探索方法を選択します。
– Auto
［Auto］を選択した場合は、U8903Bは基本波周波数を自動的に探索します。

– Gen Lock
［Gen Lock］を選択した場合は、U8903Bは各ジェネレータ・チャネルの周波数値に基づいて基本波周
波数を探索します。ジェネレータ・チャネルを選択するには、［Meas. Config.］メニュー・ページの
Src Channelを設定します。この Gen Lock方法は、内蔵オーディオ・ジェネレータを使用している場合
にのみ有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Fund Freq］で周波数値を設定することによ
り、基本波周波数値を定義することができます。

Fund Freq ［Fund Freq］ソフトキーを押して、基本波周波数値を設定します。この設定は、Freq Lockが Customに設
定されている場合にのみ使用可能です。

Harmonics ［Harmonics］ソフトキーを押して、除去する高調波の次数を設定します。
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4 オーディオ・アナライザの測定機能
ジッタ・テスト測定

デジタル・システム内のジッタは、周期的なサンプル間の時間変動と定義されます。
ジッタは、ADC/DACのサンプリング・プロセスやクロック・リカバリ・プロセス中に
発生することがあります。デジタル・インタフェース・リンクのデータ・パターンにも
ジッタが見られる場合もあります。

ジッタ・テストは、デジタル信号のワーストケースのデータ・ジッタをシミュレートし
たり、DACのジッタ耐性をテストするために開発された AES3テスト信号です。ジッ
タ・テスト信号は、サンプリング・レートの 1/4の周波数（Fs）のテスト・トーンと周
波数が 1/192 Fsのジッタ信号で構成されます。送信されるジッタ・テストのデジタル・
パターンを以下に示します。

C00000 C00000 400000 400000 x24
BFFFFF BFFFFF BFFFFF BFFFFF x24

このデジタル・パターンは、デジタル信号に符号間干渉を発生させ、DACクロック・
リカバリ・サブシステムにストレスを印加します。FFTスペクトラムで DACのアナロ
グ出力をモニタすることにより、DACシステムのジッタ性能を測定することができ
ます。

ジッタ・テスト測定機能モードは、アナログ・アナライザにのみ適用可能です。ジッ
タ・テスト測定の表示を、図 4-29に示します。

図 4-29 Analog Analyzer > Functions > J-Testメニュー・ページ
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オーディオ・アナライザの測定機能 4
正ピーク測定

正ピーク測定機能モードでは、正の最大電圧レベルを測定します。正ピーク測定機能
は、デジタル・アナライザにのみ適用可能です。正ピーク測定の表示を、図 4-30に示
します。

図 4-30 Digital Analyzer > Functions > Positive Peakメニュー・ページ

表 4-16 Digital Analyzer > Functions > Positive Peakメニューの概要

メニュー 概要

Unit

［Unit］ソフトキーを押して、測定単位を選択します。
– FFS

– dBFS

– ％FS

– V

– dB

– dBV

– dBr

– x

– LSB

– Hex

– Dec

– dBSPL
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4 オーディオ・アナライザの測定機能
Format

［Format］ソフトキーを押して、測定機能の戻り値のフォーマットを選択します。 
– Off
［Off］を選択すると、フォーマットせずに測定値（生の値）が返されます。

– Logarithmic
［Logarithmic］を選択すると、次の式に基づいて測定結果が返されます。

結果は dBr単位で返されます。 
– Linear
［Linear］を選択すると、測定されたレベルを基準レベルで除算した測定結果が返されます。結果は x
単位で返されます。 

Set resul t as ref. from ［Set resul t as ref. from］ソフトキーを押して、選択したチャネルの測定結果を基準レベルとして保存し
ます。

Ref. Level ［Ref. Levelソフトキーを押して、基準レベル値を設定します。基準レベルは各チャネルに対して 1つだ
けです。

Vol t/FS ［Vol t/FS］ソフトキーを押して、V/FS基準値を設定します。

表 4-16 Digital Analyzer > Functions > Positive Peakメニューの概要（続き）

メニュー 概要

20 10 Measured rms voltage
Reference level

---------------------------------------------------------- 
 log
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オーディオ・アナライザの測定機能 4
負ピーク測定

負ピーク測定機能モードでは、負の最大電圧レベルを測定します。負ピーク測定機能
は、デジタル・アナライザにのみ適用可能です。負ピーク測定の表示を、図 4-31に示
します。

図 4-31 Digital Analyzer > Functions > Negative Peakメニュー・ページ

表 4-17 Digital Analyzer > Functions > Negative Peakメニューの概要

メニュー 概要

単位

［Unit］ソフトキーを押して、測定単位を選択します。
– FFS

– dBFS

– ％FS

– V

– dB

– dBV

– dBr

– x

– LSB

– Hex

– Dec

– dBSPL
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4 オーディオ・アナライザの測定機能
Format

［Format］ソフトキーを押して、測定機能の戻り値のフォーマットを選択します。 
– Off
［Off］を選択すると、フォーマットせずに測定値（生の値）が返されます。

– Logarithmic
［Logarithmic］を選択すると、次の式に基づいて測定結果が返されます。

結果は dBr単位で返されます。 
– Linear
［Linear］を選択すると、測定されたレベルを基準レベルで除算した測定結果が返されます。結果は x
単位で返されます。 

Set resul t as ref. from ［Set resul t as ref. from］ソフトキーを押して、選択したチャネルの測定結果を基準レベルとして保存し
ます。

Ref. Level ［Ref. Levelソフトキーを押して、基準レベル値を設定します。基準レベルは各チャネルに対して 1つだ
けです。

Vol t/FS ［Vol t/FS］ソフトキーを押して、V/FS基準値を設定します。

表 4-17 Digital Analyzer > Functions > Negative Peakメニューの概要（続き）

メニュー 概要

20 10 Measured rms voltage
Reference level

---------------------------------------------------------- 
 log
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オーディオ・アナライザの測定機能 4
位相測定
位相測定は、周期的な波形サイクル（正弦波波形など）の、基準波形に対する正または
負の時間オフセットを測定します。基準波形は通常、システムの異なるポイントにおけ
る同一信号、またはシステムの別のチャネルにある関連信号です。位相は度（°）で表
されます。

位相シフトは周波数によって異なるため、複数の周波数で位相測定を実行したり、周波
数掃引の位相応答をプロットしたりすることがよく行われます。

位相測定には一般的に、以下の 2種類があります。

– チャネル間位相遅延

– デバイスの位相応答

チャネル間位相測定を実行するには、信号レベルを指定する必要があります。位相測定
は、信号が雑音より十分大きく、歪みレベルより低ければ、一般的にレベルに影響され
ません。

例えば、ステレオ・システムのチャネル間位相遅延をテストする場合は、同じアナロ
グ・ジェネレータ・チャネルを使用して 1 Vrms、1 kHzの正弦波波形を入力します。1
つのチャネルの出力をアナログ・アナライザのチャネル 1に、もう一方をチャネル 2
に接続します。アナログ・アナライザを位相測定に設定します。チャネル 1を基準チャ
ネルに設定した場合は、チャネル 2の結果がチャネル間位相遅延になります。

位相応答測定は、DUTの出力信号の位相を入力信号の位相と比較します。例えば、こ
の測定を実行する簡単な方法は、アナログ・アナライザ・チャネル 1を入力の測定に、
アナログ・アナライザ・チャネル 2を出力の測定に使用することです。

U8903Bは常にアナログ・ジェネレータのチャネル 1を基準チャネルに使用しますが、
チャネル間位相測定では選択したアナログ・アナライザ・チャネルが基準チャネルとな
ります。

位相測定機能モードは、アナログ・アナライザとデジタル・オーディオ・アナライザの
両方に適用可能です。アナログ・アナライザとデジタル・アナライザの位相測定の設定
画面を、図 4-32と図 4-33にそれぞれ示します。

注 オートレンジは、位相測定ではオフになります。入力電圧レンジの設定については、
「測定設定（アナログ・アナライザ）」（ページ）202を参照してください。
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4 オーディオ・アナライザの測定機能
図 4-32 Analog Analyzer > Functions > Phaseメニュー・ページ

図 4-33 Digital Analyzer > Functions > Phaseメニュー・ページ
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オーディオ・アナライザの測定機能 4
表 4-18 Analog/Digital Analyzer > Functions > Phaseメニューの概要

メニュー 概要

Ref. Channel ［Ref. Channel］ソフトキーを押して、基準チャネル番号を設定します。

Freq Lock

アナログ・アナライザにのみ使用可能です。
［Freq Lock］ソフトキーを押して、基本波周波数の探索方法を選択します。

– Auto
［Auto］を選択した場合は、U8903Bは基本波周波数を自動的に探索します。

– Gen Lock
［Gen Lock］を選択した場合は、U8903Bは各ジェネレータ・チャネルの周波数値に基づいて基本波周
波数を探索します。ジェネレータ・チャネルを選択するには、［Meas. Config.］メニュー・ページの
Src Channelを設定します。この Gen Lock方法は、内蔵オーディオ・ジェネレータを使用している場合
にのみ有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Fund Freq］で周波数値を設定することによ
り、基本波周波数値を定義することができます。

Fund Freq ［Fund Freq］ソフトキーを押して、基本波周波数値を設定します。この設定は、Freq Lockが Customに設
定されている場合にのみ使用可能です。
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4 オーディオ・アナライザの測定機能
クロストーク測定
複数チャネルのオーディオ・システムでは、1つのチャネルの信号が、別のチャネルに
低いレベルで現れる場合があります。クロストークとは、このようなチャネル間の信号
漏れのことで、dB（デフォルト）または％で表されます。

クロストーク測定では、未使用チャネルの信号振幅と、信号でドライブされたチャネル
の振幅との比を測定します。未使用チャネルは、グランドに接続するか、適切なバイア
ス・ポイントに設定する必要があります。クロストークは、デバイスのチャネル導体の
間の容量結合から主に生じ、通常は周波数によって異なります。クロストークは以下の
ように計算されます。

位相測定機能モードは、アナログ・アナライザとデジタル・オーディオ・アナライザの
両方に適用可能です。アナログ・アナライザとデジタル・アナライザのクロストーク測
定の設定画面を、図 4-34と図 4-35にそれぞれ示します。

図 4-34 Analog Analyzer > Functions > X-Talkメニュー・ページ 1

Crosstalk 20 Log10
rms value of signal measured

rms value of signal driven
----------------------------------------------------------------------------- 
 =
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オーディオ・アナライザの測定機能 4
図 4-35 Digital Analyzer > Functions > X-Talkメニュー・ページ 1

表 4-19 Analog/Digital Analyzer > Functions > X-Talkメニューの概要

Menu 概要

Ref. Channel ［Ref. Channel］ソフトキーを押して、ドライブ・チャネルを設定します。

単位

［Unit］ソフトキーを押して、測定単位を選択します。
– dB

– ΔdB

– %

– x

Format

［Format］ソフトキーを押して、測定機能の戻り値のフォーマットを選択します。 
– Off
［Off］を選択すると、フォーマットせずに測定値（生の値）が返されます。

– Delta
［Delta］を選択すると、測定された比から基準比を差し引いた測定結果が返されます。結果は DdB単
位で返されます。

– Linear
［Linear］を選択すると、測定された比を基準比で除算した測定結果が返されます。結果は x単位で返
されます。

Set to 0 dB
アナログ・アナライザにのみ使用可能です。
［Set to 0dB］ソフトキーを押して、測定されたレベルまたは比を基準値として保存し、保存した基準値
を参照するように読取りを設定します。

Set resul t as ref. from ［Set resul t as ref. from］ソフトキーを押して、選択したチャネルの測定結果を基準比として保存します。

Ref. Ratio ［Ref. Ratio］ソフトキーを押して、基準比を設定します。
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4 オーディオ・アナライザの測定機能
Freq Lock

アナログ・アナライザにのみ使用可能です。
［Freq Lock］ソフトキーを押して、基本波周波数の探索方法を選択します。

– Auto
［Auto］を選択した場合は、U8903Bは基本波周波数を自動的に探索します。

– Gen Lock
［Gen Lock］を選択した場合は、U8903Bは各ジェネレータ・チャネルの周波数値に基づいて基本波周
波数を探索します。ジェネレータ・チャネルを選択するには、［Meas. Config.］メニュー・ページの
Src Channelを設定します。この Gen Lock方法は、内蔵オーディオ・ジェネレータを使用している場合
にのみ有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Fund Freq］で周波数値を設定することによ
り、基本波周波数値を定義することができます。

Fund Freq ［Fund Freq］ソフトキーを押して、基本波周波数値を設定します。この設定は、Freq Lockが Customに設
定されている場合にのみ使用可能です。

表 4-19 Analog/Digital Analyzer > Functions > X-Talkメニューの概要（続き）

Menu 概要
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オーディオ・アナライザの測定機能 4
フィルタ設定（アナログ・アナライザ）
フィルタは、測定機能を適用する前に、入力信号の帯域幅を制限するために使用されま
す。アナログ・アナライザのフィルタ設定画面を、図 4-36に示します。

図 4-36 Analog Analyzer > Filter Configメニュー・ページ

表 4-20 Analog Analyzer > Filter Configメニューの概要

メニュー 概要

Clear Fil ters ［Clear Fil ters］ソフトキーを押して、すべてのフィルタ設定をクリアします。 

LPF

［LPF］ソフトキーを押して、ローパス・フィルタを選択します。
– None

– 2 kHz

– 3 kHz

– 5 kHz

– 8 kHz

– 10 kHz

– 15 kHz

– 20 kHz

– 22 kHz

– 30 kHz

– 40 kHz

– 50 kHz

– 80 kHz

– Custom（詳細については、「ユーザ定義フィルタ・ファイルのフォーマット」（ページ）514を参照し
てください）。
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4 オーディオ・アナライザの測定機能
HPF

［HPF］ソフトキーを押して、ハイパス・フィルタを選択します。 
– None

– 15 Hz

– 20 Hz

– 22 Hz

– 30 Hz

– 50 Hz

– 70 Hz

– 100 Hz

– 200 Hz

– 300 Hz

– 400 Hz

– Custom（詳細については、「ユーザ定義フィルタ・ファイルのフォーマット」（ページ）514を参照し
てください）。

Weighting

［Weighting］ソフトキーを押して、評価雑音フィルタを選択します。
– None

– A

– CCIR 1k

– CCIR 2k

– CCITT

– C-Message

– Custom（詳細については、「ユーザ定義フィルタ・ファイルのフォーマット」（ページ）514を参照し
てください）。

Deemphasis

［Deemphasis］ソフトキーを押して、ディエンファシス値を選択します。
– None

– 50 μs

– 75 μs

– Custom

Notch Fil ter ［Notch Fil ter］ソフトキーを押して、ノッチ・フィルタの設定を行います。 詳細については、「Notch 
Filter」（ページ）199を参照してください。

表 4-20 Analog Analyzer > Filter Configメニューの概要（続き）

メニュー 概要
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オーディオ・アナライザの測定機能 4
Notch Filter

ノッチ・フィルタは、入力信号の不要な周波数成分を除去するために使用されます。こ
の設定は、THD+N測定と SINAD測定にのみ適用可能です。

図 4-37 Analog Analyzer > Filter Config > Notch Filterメニュー・ページ

表 4-21 Analog Analyzer > Filter Config > Notch Filterメニューの概要

メニュー 概要

State ［State］ソフトキーを押して、ノッチ・フィルタをオン／オフします。

Center Freq ［Center Freq］ソフトキーを押して、入力信号から除去する成分の周波数を設定します。

Band wid th ［Band wid th］ソフトキーを押して、除去する信号成分の帯域幅を設定します。
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4 オーディオ・アナライザの測定機能
フィルタ設定（デジタル・アナライザ）
フィルタは、測定機能を適用する前に、入力信号の帯域幅を制限するために使用されま
す。デジタル・アナライザのフィルタ設定画面を、図 4-38に示します。

図 4-38 Digital Analyzer > Filter Configメニュー・ページ

表 4-22 Digital Analyzer > Filter Configメニューの概要

メニュー 概要

Clear Fil ters ［Clear Fil ters］ソフトキーを押して、すべてのフィルタ設定をクリアします。 

LPF

［LPF］ソフトキーを押して、ローパス・フィルタを選択します。
– None

– 15 kHz

– 20 kHz

– 22 kHz

– 30 kHz

– Custom（詳細については、「ユーザ定義フィルタ・ファイルのフォーマット」（ページ）514を参照し
てください）。

HPF

［HPF］ソフトキーを押して、ハイパス・フィルタを選択します。 
– None

– 20 Hz

– 100 Hz

– 400 Hz

– Custom（詳細については、「ユーザ定義フィルタ・ファイルのフォーマット」（ページ）514を参照し
てください）。
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オーディオ・アナライザの測定機能 4
Weighting

［Weighting］ソフトキーを押して、評価雑音フィルタを選択します。
– None

– A

– CCIR 1k

– CCIR 2k

– CCITT

– C-Message

– Custom（詳細については、「ユーザ定義フィルタ・ファイルのフォーマット」（ページ）514を参照し
てください）。

Deemphasis

［Deemphasis］ソフトキーを押して、ディエンファシス値を選択します。
– None

– 50 μs

– 75 μs

– Custom

Sample Rate

デジタル・アナライザにのみ使用可能です。
［Sample Rate］ソフトキーを押して、サンプリング・レートを選択します。

– 32 kHz

– 44.1 kHz

– 48 kHz

– 88.2 kHz

– 96 kHz

– 176.4 kHz

– 192 kHz

表 4-22 Digital Analyzer > Filter Configメニューの概要（続き）

メニュー 概要
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4 オーディオ・アナライザの測定機能
測定設定（アナログ・アナライザ）
アナログ・アナライザの測定設定画面を、図 4-39に示します。

図 4-39 Analog Analyzer > Meas Configメニュー・ページ 1

表 4-23 Analog Analyzer > Meas Configメニューの概要

メニュー 概要

Auto Range ［Auto Range］ソフトキーを押して、オートレンジをオン／オフします。

Range

［Range］ソフトキーを押して、入力電圧レンジを選択します。この設定は、オートレンジがオフの場合
にのみ使用可能です。
– 140 V

– 100 V

– 32 V

– 10 V

– 3.2 V

– 1 V

– 320 mV
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オーディオ・アナライザの測定機能 4
Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Average Points
［Average Points］を押して、移動平均計算に使用する測定値の個数を設定します。これは、ノイズの多
い信号に有用です。アベレージング・ポイントを適用することにより、測定値の不一致の原因である雑
音によるばらつきが平滑化されます。

Src Channel

［Src Channel］を押して、以下の状況で使用する基準チャネルとして、内蔵ジェネレータ・チャネルを
選択します。
– dBg単位での結果の計算。
– 周波数ロックが Gen Lockに設定されている場合の周波数探索アルゴリズム。

Trigger ［Trigger］ソフトキーを押して、トリガの設定を行います。 詳細については、「Trigger」（ページ）205を
参照してください。

表 4-23 Analog Analyzer > Meas Configメニューの概要（続き）

メニュー 概要
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4 オーディオ・アナライザの測定機能
測定設定（デジタル l・アナライザ）

デジタル・アナライザの測定設定画面を、図 4-40に示します。

図 4-40 Digital Analyzer > Meas Configメニュー・ページ

表 4-24 Digital Analyzer > Meas Configメニューの概要

メニュー 概要

Coupling

［Coupl ing］ソフトキーを押して、結合タイプを選択します。
– DC

DC結合では、ACと DCの両方の入力信号がデジタル・アナライザに送られ、0 Hzまでの測定が可能
です。この設定は、DC電圧測定を実行する場合に選択します。

– AC
AC結合は、入力信号の DC成分をブロックします。この設定は、信号の AC成分だけを測定したい場
合に選択します。例えば、実効値電圧またはピークツーピーク電圧測定を実行する場合です。

Sample Size

［Sample Size］ソフトキーを押して、サンプル・サイズを選択します。サンプル・サイズは、測定用に収
集するデータ・ポイント数です。サンプル・サイズが大きいほど、測定結果の確度は高くなります。
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Average Points
［Average Points］ソフトキーを押して、アベレージング・ポイントを設定します。解析対象のデータに
ノイズが多い場合は、アベレージング・ポイント数を増やします。
– 1～ 20ポイント

Trigger ［Trigger］ソフトキーを押して、トリガの設定を行います。 詳細については、「Trigger」（ページ）205を
参照してください。
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オーディオ・アナライザの測定機能 4
Trigger

図 4-41 Digital Analyzer > Meas Config > Triggerメニュー・ページ

表 4-25 Digital Analyzer > Meas Config > Triggerメニューの概要

メニュー 概要

Trigger Source

［Trigger Source］ソフトキーを押して、トリガ・ソースを選択します。デフォルトのトリガ入力は Free 
Runです。この場合は、アナライザは前のデータが捕捉された後で即座にトリガします。トリガ入力を
Externalに設定した場合は、アナライザはリア・パネルの Trigger Inコネクタでトリガ・パルスが検出さ
れるのを待ってから、測定データを捕捉します。
– Free Run

– External

– Channel

Trigger Edge

トリガ・ソースが Externalまたは Channelの場合にのみ使用可能です。
［Trigger Edge］ソフトキーを押して、トリガ・エッジ・タイプを選択します。 

– Rising

– Falling

Interface

トリガ・ソースが Channelの場合にのみ使用可能です。
［Interface］ソフトキーを押して、トリガ・インタフェースを選択します。

– Analog

– Digital

Channel
トリガ・ソースが Channelの場合にのみ使用可能です。
［Channel］ソフトキーを押して、チャネル番号を設定します。 

Trigger Level
トリガ・ソースが Channelの場合にのみ使用可能です。
［Trigger Level］ソフトキーを押して、トリガ・レベルを設定します。 
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4 オーディオ・アナライザの測定機能
入力設定（アナログ・アナライザ）
アナログ・アナライザの入力設定画面を、図 4-42に示します。

図 4-42 Analog Analyzer > Input Configメニュー・ページ

表 4-26 Analog Analyzer > Input Configメニューの概要

メニュー 概要

Connector

［Connector］ソフトキーを押して、入力コネクタ・タイプを選択します。
– UnBal
不平衡コネクタ・タイプでは、信号は BNC入力コネクタからルーティングされます。同軸コネクタ
の内部導体の信号が、グランドを基準にして測定されます。

– Bal
平衡コネクタ・タイプでは、信号はフロント・パネルの XLR入力コネクタからアナログ・アナライ
ザにルーティングされます。 XLRコネクタの正と負のピンの信号は、差動増幅器に入力され、減算さ
れてからディテクタに送られます。 

– Loopback
ループバック・コネクタ・タイプでは、信号はジェネレータからアナライザに内部でルーティング
されます。
ジェネレータ・チャネル 1の信号はアナライザの奇数チャネル（1、3、5、7）に、ジェネレータ・
チャネル 2の信号はアナライザの偶数チャネル（2、4、6、8）にルーティングされます。
例えば、アナライザの奇数チャネルのいずれかで Loopbackを選択した場合には、ジェネレータ・
チャネル 1の出力コネクタ・タイプは自動的に Loopbackに設定されます。

Impedance

［Impedance］ソフトキーを押して、入力インピーダンスの値を選択します。この設定は、Connectorが
UnBalまたは Balに設定されている場合にのみ使用可能です。
– 100 kΩ (for UnBal)

– 200 kΩ (for Bal)

– 600 Ω
– 300 Ω
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オーディオ・アナライザの測定機能 4
Coupling

［Coupling］ソフトキーを押して、入力結合タイプを選択します。
– DC

DC結合では、ACと DCの両方のアナログ入力信号がアナログ・アナライザに送られ、0 Hzまでの測
定が可能です。この設定は、DC電圧測定を実行する場合に選択します。

– AC
AC結合では、入力経路に直列にキャパシタが接続され、入力信号の DC成分がブロックされます。
この設定は、信号の AC成分だけを測定したい場合に選択します。例えば、実効値電圧またはピーク
ツーピーク電圧測定を実行する場合には、AC結合を使用します。 

Band wid th

［Band wid th］ソフトキーを押して、入力帯域幅の値を選択します。この設定は、オプション N3431Aで
のみ使用可能です。詳細については、「U8903Bオプション」（ページ）33を参照してください。
– 90 kHz 
（これは、サンプリング・レートが 192 kHzの場合のデフォルト設定です）

– 1.5 MHz

Ext. Gain

［Ext. Gain］ソフトキーを押して、入力の外部利得値を設定します。
外部利得は、－ 60 dB～ 60 dBの範囲で設定できます。デフォルトの外部利得は 0 dBです。外部利得
は、測定セットアップの外部利得／損失の影響を補正するために使用されます。
例えば、増幅器が測定セットアップに含まれる場合は、外部利得値は、増幅器の利得の影響を除去する
のに使用されます。ただし、高電圧測定に外部アッテネータが使用される場合は、外部利得値は、その
損失を補正するのに使用されます。外部利得値は、dBまたは x単位で設定できます。

表 4-26 Analog Analyzer > Input Configメニューの概要（続き）

メニュー 概要
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4 オーディオ・アナライザの測定機能
入力設定（デジタル・アナライザ）
デジタル・アナライザの入力設定画面を、図 4-43に示します。

図 4-43 Digital Analyzer > Input Configメニュー・ページ

表 4-27 Digital Analyzer > Input Configメニューの概要

メニュー 概要

Connector

［Connector］ソフトキーを押して、コネクタ・タイプを選択します。
– UnBal
不平衡コネクタ・タイプでは、デジタル信号はリア・パネルの BNC入力コネクタからデジタル・ア
ナライザにルーティングされます。

– Bal
平衡コネクタ・タイプでは、デジタル信号はリア・パネルの XLR入力コネクタからデジタル・アナ
ライザにルーティングされます。

– Optical
光コネクタ・タイプでは、デジタル信号はリア・パネルの TOSLINK入力コネクタからデジタル・アナ
ライザにルーティングされます。

– DSI
DSIコネクタ・タイプでは、デジタル信号はリア・パネルの 25ピン D-SUB（メス）コネクタからデ
ジタル・アナライザにルーティングされます。

Impedance

［Impedance］ソフトキーを押して、入力インピーダンスを選択します。
不平衡コネクタ・タイプ
– 75 W

– HiZ

平衡コネクタ・タイプ
– 110 W

– HiZ
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オーディオ・アナライザの測定機能 4
Freq Scaling

［Freq Scaling］ソフトキーを押して、周波数スケーリング・タイプを選択します。
– MISR
周波数は入力ワード・クロックをトラッキングして、元の周波数の音声を復元します。

– Custom
オーディオ信号周波数は、Ref SRで設定した基準サンプリング・レートに従って変換されます。

Ref SR
周波数スケーリングが Customの場合にのみ使用可能です。
［Ref SR］ソフトキーを押して、基準サンプリング・レートの値を設定します。 

表 4-27 Digital Analyzer > Input Configメニューの概要（続き）

メニュー 概要
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4 オーディオ・アナライザの測定機能
DSI入力設定（デジタル・アナライザ）

デジタル・アナライザの DSI入力設定画面を、図 4-44に示します。

図 4-44 Digital Analyzer > DSI Configメニュー・ページ 1

表 4-28 Digital Analyzer > DSI Configメニューの概要

メニュー 概要

Format

［Format］ソフトキーを押して、データ・フォーマットを選択します。
– Left

– Right

– I2S

– DSP

Fsync Polarity

フォーマットが Leftまたは Rightの場合にのみ使用可能です。
［Fsync Polarity］ソフトキーを押して、フレーム・クロックのエッジ同期を選択します。

– Rising（フレーム・クロックがデータの左チャネルで高いことを示します）
– Falling（フレーム・クロックがデータの左チャネルで低いことを示します）

Fsync Wid th

フォーマットが Leftまたは Rightの場合にのみ使用可能です。
［Fsync Wid th］ソフトキーを押して、フレーム・クロックの同期幅を選択します。 

– One Bit Clock

– One Subframe

– 50% Duty Cycle

Data Shift Cnt
フォーマットが Leftまたは Rightの場合にのみ使用可能です。
［Data Shift Cnt］ソフトキーは、フレーム・クロックを基準にしてシフトするデータ・ビットの数を設定
します。 
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Data Shift Dir

フォーマットが Leftまたは Rightの場合にのみ使用可能です。
［Data Shift Dir］ソフトキーを押して、データ・シフト方向を選択します。 

– Left

– Right

Word Length
［Word Length］ソフトキーを押して、ワード長の値を設定します。ワード長の値は、オーディオ分解能
以上である必要があります。
– 8～ 32

Resolution
［Resolution］ソフトキーを押して、オーディオ分解能の値を設定します。

– 8～ 24

Decoding 

［Decoding］ソフトキーを押して、デコード・フォーマットを選択します。
– Linear PCM

– A-Law

– m-Law

W/Bclk Dir

［W/Bclk Dir］ソフトキーを押して、ワード／ビット・クロック方向を選択します。
– In

– Out

Bit Clk Edge

［Bit Clk Edge］ソフトキーを押して、ビット・クロック・エッジを選択します。
– Rising

– Falling

Voltage

［Vol tage］ソフトキーを押して、入力電圧値を選択します。
– 1.2 Vpp

– 1.5 Vpp

– 1.8 Vpp

– 2.5 Vpp

– 3 Vpp

– 3.3 Vpp

– Custom

表 4-28 Digital Analyzer > DSI Configメニューの概要（続き）

メニュー 概要
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4 オーディオ・アナライザの測定機能
AES/SPDIF入力設定（デジタル・アナライザ）

デジタル・アナライザの AES/SPDIF入力設定画面を、図 4-45に示します。

図 4-45 Digital Analyzer > AES Configメニュー・ページ 1

表 4-29 Digital Analyzer > AES Configメニューの概要

メニュー 概要

Decoding 

［Decod ing］ソフトキーを押して、デコード・フォーマットを選択します。
– Linear PCM

– A- Law

– m- Law

Resolution
［Resolution］ソフトキーを押して、オーディオ分解能の値を設定します。

– 8～ 24

Status Bits

［Status Bits］ソフトキーを押して、ステータス・ビット・タイプを選択します。
– Channel

– User

Save in Hex ［Save in Hex］ソフトキーを押して、ステータス・ビットを HEXファイルに保存します。［Save］メ
ニュー・ページの詳細については、「Save」（ページ）86を参照してください。

Save in Xml ［Save in Xml］ソフトキーを押して、ステータス・ビットを XMLファイルに保存します。［Save］メ
ニュー・ページの詳細については、「Save」（ページ）86を参照してください。
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オーディオ・アナライザの測定機能 4
ビット解析（デジタル・アナライザ）
［Bits Analysis］メニュー・ページでは、デジタル信号に埋め込まれたオーディオ・デー
タの各ワードのすべてのビットのデータを表示できます。デジタル・アナライザのビッ
ト解析設定画面を、図 4-46に示します。

図 4-46 Digital Analyzer > Bits Analysisメニュー・ページ 1

表 4-30 Digital Analyzer > Bits Analysisメニューの概要

メニュー 概要

Refresh Rate ［Refresh Rate］ソフトキーを押して、リフレッシュ・レートを設定します。Bit Typesが Active Bitに設定
されている場合にのみ適用可能です。

Bit Types

［Bit Types］ソフトキーを押して、ビット・タイプを選択します。
– Data
データ・ビットは、測定時点でのデジタル信号に埋め込まれたオーディオ・データのワードのデー
タを表します。"1"は該当するビットのデータが 1であること、"0"は該当するビットのデータが 0で
あることを示します。

– Active
アクティブ・ビットは、測定期間中にステートが変化したビットを示します。"1"はビットのステー
トが変化したこと、"0"は変化しなかったことを示します。
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4 オーディオ・アナライザの測定機能
波形ファイル（アナログ・アナライザ）
U8903Bでは、入力測定信号を記録して、波形ファイルに保存することができます。記
録した波形ファイルは、テスト信号として使用することができます。アナログ・アナラ
イザの波形ファイル設定画面を、図 4-47に示します。

図 4-47 Analog Analyzer > Wave Fileメニュー・ページ

表 4-31 Analog Analyzer > Wave Fileメニューの概要

メニュー 概要

Channel

［Channel］ソフトキーを押して、波形ファイルのチャネル・タイプを選択します。
– Left
［Left］を選択すると、アナログ・アナライザ・チャネル 1の信号がモノラル波形ファイルに記録され
ます。

– Right
［Right］を選択すると、アナログ・アナライザ・チャネル 2の信号がモノラル波形ファイルに記録さ
れます。

– Stereo
［Stereo］を選択すると、アナログ・アナライザのチャネル 1とチャネル 2の両方の信号がステレオ
波形ファイルに記録されます。

Bits/Sample

［Bits/Sample］ソフトキーを押して、波形ファイルのサンプル当たりのビット数を選択します。
– 8

– 16

– 24

Duration ［Duration］ソフトキーを押して、波形ファイルのレコーディング時間を設定します。

Record ［Record］ソフトキーを押して、記録を開始し、測定値を波形ファイルに保存します。［Save］メ
ニュー・ページの詳細については、「Save」（ページ）86を参照してください。
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オーディオ・アナライザの測定機能 4
Statistics

アナログ・アナライザとデジタル・アナライザの統計設定画面を、図 4-48と図 4-49
にそれぞれ示します。

図 4-48 Analog Analyzer > Statisticsメニュー・ページ

図 4-49 Digital Analyzer > Statisticsメニュー・ページ
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4 オーディオ・アナライザの測定機能
表 4-32 Analog/Digital Analyzer > Statisticsメニューの概要

メニュー 概要

Show Stats ［Show Stats］ソフトキーを押して、統計計算をオン／オフします。

No. of Reading ［No. of Read ing］ソフトキーを押して、統計計算に使用する測定値の個数を設定します。

Stat 1
Stat 2
Stat 3

各ソフトキーを押して、統計計算タイプを選択します。U8903Bでは、3種類の統計データを表示する
ことができます。
– Min
測定で得られた最小値。

– Max
測定で得られた最大値。

– Average
捕捉された個数の測定値で計算された平均値。

– Std Dev
捕捉された個数の測定値で計算された標準偏差値。

– DMinMax
最大値と最小値の差。

測定値の個数とは、No. Of Readingsで設定した値です。

Clear ［Clear］ソフトキーを押して、現在のアナログ・アナライザの統計結果をリセットします。
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5 グラフ解析
グラフ解析

U8903Bグラフ解析モードでは、信号の 2次元グラフが表示されます。［FUNCTION］パ

ネルの を押して、グラフ解析モードにアクセスします。図 5-1に示すように、

［Graph Analysis］メニュー・ページが表示されます。

［RUN CONTROL］パネルの を押すことにより、グラフ解析を開始／停止す

ることができます。

頻繁に使用するグラフ機能にすばやくアクセスするためには、「GRAPHパネル」（ペー
ジ）61を参照してください。

図 5-1 Graph Analysisメニュー・ページ

注 – U8903Bのグラフ解析モードは、標準ビュー・モードでのみ使用可能です。詳細につ
いては、「メニュー・キー」（ページ）54を参照してください。

– グラフ解析モードをオンにすると、すべてのフィルタがオフになります。

Graph

On
Off
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グラフ解析 5
表 5-1 Graph Analysisメニューの概要

メニュー 概要

Analysis Type

［Analysis Type］ソフトキーを押して、現在の Graphパネルにプロットするグラフ解析モードを選択します。
– Frequency
周波数ドメイン

– Phase
位相振幅

– Time
タイム・ドメイン

– PSD
バンド内の各周波数ビンに含まれる全パワー。さらに、その結果を「実効帯域幅」で除算します。

Graph Settings ［Graph Settings］ソフトキーを押して、グラフの設定を行います。詳細については、「Graph Settings」
（ページ）220を参照してください。

Axis Settings ［Axis Settings］ソフトキーを押して、軸の設定を行います。 詳細については、「軸設定」（ページ）222
を参照してください。

Trace Settings ［Trace Settings］ソフトキーを押して、トレースの設定を行います。詳細については、「トレース設定」
（ページ）224を参照してください。

Display Option

［Display Option］ソフトキーを押して、グラフ解析の表示オプションを選択します。詳細については、
「表示オプション」（ページ）229を参照してください。

– Graph

– Data Table

– Marker Table

– Statistics

– Harmonics

– Signal Analysis

Running Mode
［Running Mode］ソフトキーを押して、グラフ解析の実行モードを選択します。

Continuous
Single

Measurement ［Measurement］ソフトキーを押して、グラフ解析測定の設定を行います。詳細については、「測定設定」
（ページ）234を参照してください。
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5 グラフ解析
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Graph Settings

グラフ解析のグラフ設定画面を、図 5-2に示します。

図 5-2 Graph Analysis > Graph Settingsメニュー・ページ

表 5-2 Graph Analysis > Graph Settingsメニューの概要

メニュー 概要

Active Channel ［Active Channel］ソフトキーを押して、使用可能なアクティブ・チャネルを選択します。アクティブ・
チャネルによって、グラフ設定用のチャネルが決定します。

Sample Size

［Sample Size］ソフトキーを押して、グラフのサンプル・サイズの値を選択します。サンプル・サイズ
は、実行する解析の性能と品質に影響を及ぼします。周波数ドメイン測定では、返されるデータは現在
選択されているサンプル・サイズの半分です。
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

アナライザ・カード・チャネルのサンプル・サイズが 2Mに設定されている場合は、アナライザ・カー
ド・チャネルの残りのサンプル・サイズは 2048に設定されます。
アナライザ・カード・チャネルのサンプル・サイズが 1Mに設定されている場合は、アナライザ・カー
ド・チャネルの残りのサンプル・サイズは 262144に設定されます（初期サンプル・サイズが 262144よ
り大きい場合）。
アナライザ・カード・チャネルのサンプル・サイズが 52428に設定されている場合は、アナライザ・
カード・チャネルの残りのサンプル・サイズは 262144に設定されます（初期サンプル・サイズが 
262144より大きい場合）。



グラフ解析 5
Window

［Window］ソフトキーを押して、FFT処理前にデータに適用するウィンドウ関数を選択します。選択す
るウィンドウ関数は、必要な測定結果のタイプによって異なります。ウィンドウ関数は通常、FFT解析
の実行時に発生する可能性があるスペクトラム・リーケージの影響を低減します。
– Rectangular

– Hanning

– Blackman

– Rife-Vincent 

– Rife-Vincent 3

– Hamming

– Flat Top

– Kaiser

Sync Avg ［Sync Avg］ソフトキーを押して、FFT処理が実行される前に収集／アベレージングするサンプルの数を
設定します。 

Hold

［Hold］ソフトキーを押して、 softkey to select the type of hold to be performed after the FFT process.FFT処理後に
実行するホールドのタイプを選択します。
– None

Noneを選択した場合は、常に最新データが表示されます。
– Average

Averageホールドでは、現在のデータと以前のデータの両方がアベレージングされます。
– Min

Minホールドでは、現在のデータと以前のデータが比較され、どちらか小さい方の値が保持されます。
– Max

Maxホールドでは、現在のデータと以前のデータが比較され、どちらか大きい方の値が保持されます。

表 5-2 Graph Analysis > Graph Settingsメニューの概要（続き）

メニュー 概要
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5 グラフ解析
軸設定
グラフ解析の軸設定画面を、図 5-3に示します。

図 5-3 Graph Analysis > Axis Settingsメニュー・ページ 1

表 5-3 Graph Analysis > Axis Settingsメニューの概要

メニュー 概要

Axis

［Axis］ソフトキーを押して、設定するアクティブ軸を選択します。 
– Primary

– Secondary

Enabled ［Enabled］ソフトキーを押して、軸設定をオン／オフします。この設定は、軸タイプが Secondaryの場
合にのみ使用可能です。軸タイプが Primaryの場合は、常に Onに設定されます。 

Left ［Left］ソフトキーを押して、左軸のリミット値を設定します。入力した値が右側値より大きい場合に
は、右側値が（Left＋ 10）の値に自動的に設定されます。

Right ［Right］ソフトキーを押して、右軸のリミット値を設定します。入力した値が左側値より大きい場合に
は、左側値が（Right－ 10）の値に自動的に設定されます。

Span ［Span］ソフトキーを押して、グラフ内のモニタする全 X軸スパンまたは全範囲を設定します。

Center ［Center］ソフトキーを押して、グラフ内の X軸の中心点を設定します。 

Top ［Top］ソフトキーを押して、上軸のリミット値を設定します。入力した値が下側値より小さい場合に
は、下側値が（Top－ 10）の値に自動的に設定されます。

Bottom ［Bottom］ソフトキーを押して、下軸のリミット値を設定します。入力した値が上側値より大きい場合
には、上側値が（Bottom＋ 10）の値に自動的に設定されます。
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グラフ解析 5
X-Scale

［X-Scale］ソフトキーを押して、X軸のスケール・タイプを選択します。ログ・スケールを使用するた
めには、左側値と右側値は 0より大きくなければなりません。
– Linear

– Log

Y-Scale

［Y-Scale］ソフトキーを押して、Y軸のスケール・タイプを選択します。ログ・スケールを使用するた
めには、下側値と上側値は 0より大きくなければなりません。
– Linear

– Log

表 5-3 Graph Analysis > Axis Settingsメニューの概要（続き）

メニュー 概要
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5 グラフ解析
トレース設定
グラフ解析のトレース設定画面を、図 5-4に示します。

図 5-4 Graph Analysis > Trace Settingsメニュー・ページ 1

表 5-4 Graph Analysis > Trace Settingsメニューの概要

メニュー 概要

Active Trace ［Active Trace］ソフトキーを押して、アクティブ・トレース番号を選択します。

Source ［Source］ソフトキーを押して、使用可能なチャネル、ファイル、メモリから、アクティブ・トレース
のデータ・ソースを選択します。

Enabled ［Enabled］ソフトキーを押して、アクティブ・トレース・データをオン／オフします。［DATA ENTRY］パネ
ルの［Shift］キーとトレース番号のキーを押すことによって、この機能にアクセスすることも可能です。

Memory ［Memory］ソフトキーを押して、トレースを保存またはロードします。詳細については、「Memory」
（ページ）226を参照してください。

Math ［Math］ソフトキーを押して、演算関数を適用します。詳細については、「Math」（ページ）227を参照
してください。

Unit

［Unit］ソフトキーを押して、トレースの単位タイプを選択します。
– V

– dBV

– dBu

– W

– dBm

– dBSPL

Persistence ［Persistence］ソフトキーを押して、残光表示の設定を行います。詳細については、「Persistence」
（ページ）228を参照してください。
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グラフ解析 5
Axis

［Axis］ソフトキーを押して、アクティブ・トレースをプライマリ軸またはセカンダリ軸に配置します。
アクティブ・トレースの表示は、選択した軸に反映されます。
– Primary

– Secondary

Color

［Color］ソフトキーを押して、アクティブ・トレースの色を選択します。
– Yellow

– Cyan

– White

– Pink

– Green

– Orange

– Red

– Purple

表 5-4 Graph Analysis > Trace Settingsメニューの概要（続き）

メニュー 概要
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5 グラフ解析
Memory

図 5-5 Graph Analysis > Trace Settings > Memoryメニュー・ページ

表 5-5 Graph Analysis > Trace Settings > Memoryメニューの概要

メニュー 概要

Save To Memory

［Save To Memory］ソフトキーを押して、アクティブ・トレースをメモリ・バッファに保存します[a]。メ
モリ・バッファ内のトレースは他のトレースにロードできます。表 1-5に示すように、メモリ・バッ
ファに保存されているトレースがある場合は、ディスプレイ上部にメモリ・バッファ・アイコンが表示
されます。

Load From Memory
［Load From Memory］ソフトキーを押して、トレースをメモリ・バッファからアクティブ・トレースに
ロードします。メモリ・バッファ内にトレースがない場合にこのソフトキーを押すと、エラーが表示さ
れます。

Clear Memory ［Clear Memory］ソフトキーを押して、トレースをメモリ・バッファから消去します。

[a] 内部揮発性メモリに保存されているファイルは、電源を入れ直す／リセットすると、消去されます（「Preset」（ページ）72
を参照してください）。
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グラフ解析 5
Math

図 5-6 Graph Analysis > Trace Settings > Mathメニュー・ページ

表 5-6 Graph Analysis > Trace Settings > Mathメニューの概要

メニュー 概要

Apply Math ［Apply Math］ソフトキーを押して、対応する演算関数をトレース・データに適用するか、オフにします。

Function

［Function］ソフトキーを押して、アクティブ・トレースに適用する演算関数を選択します。
– None

– f(Source) + x

– f(Source) - x

– f(Source) * x

– f(Source) / x

Variable ［Variable］ソフトキーを押して、選択した演算関数の x値を設定します。
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5 グラフ解析
Persistence

図 5-7 Graph Analysis > Trace Settings > Persistenceメニュー・ページ

表 5-7 Graph Analysis > Trace Settings > Persistenceメニューの概要

メニュー 概要

Persist

［Persist］ソフトキーを押して、アクティブ・トレースの残光表示をオン／オフします。残光表示では、
以前のトレース・データ・セットを削除する前にグラフに表示することができます。以前のトレース・
データはアクティブ・トレースに薄い色で表示されるので、以前のトレース・データと最新のトレー
ス・データを区別できます。

Persist Count

［Persist Count］ソフトキーを押して、削除する前にグラフに表示する以前のトレース・データのセット
数を設定します。例えば、5に設定すると、全部で最大 5セットの以前のトレース・データが、削除す
る前にグラフに表示されます。
この設定は、残光表示をオンにしている場合にのみ使用可能です。
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グラフ解析 5
表示オプション

グラフ

グラフ・ビューは、デフォルトの表示オプションです。グラフ・ビューでは、周波数／
位相／タイム・ドメイン解析を行います。図 5-8に示すようなグラフ・ビューが表示さ
れます。

図 5-8 Graph Analysis > Display Option > Graphメニュー・ページ
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データ・テーブル

データ・テーブル・ビューでは、個々のデータ・ポイントを表形式でモニタできます。
最大 4種類のトレースをスクロールせずに表示できます。図 5-9に示すようなデータ・
テーブル・ビューが表示されます。上下の矢印キーを押して、テーブル内のデータ・ポ
イントを上下にスクロールします。

図 5-9 Graph Analysis > Display Option > Data Tableメニュー・ページ

マーカ・テーブル

マーカ・テーブル・ビューでは、マーカ／クロスマーカ計算情報を表形式でモニタでき
ます。テーブルには、デルタ・マーカ読み値もリスト表示されます。図 5-10に示すよ
うなマーカ・テーブル・ビューが表示されます。

図 5-10 Graph Analysis > Display Option > Marker Tableメニュー・ページ



グラフ解析 5
統計

統計ビューには、代表的な統計計算がリスト表示されます。使用可能な統計処理機能
は、最小値、最大値、標準偏差、平均値です。図 5-11に示すような統計ビューが表示
されます。

図 5-11 Graph Analysis > Display Option > Statisticsメニュー・ページ

高調波

高調波ビューでは、高調波解析を表示／実行することができます。基本波周波数の振幅
や各高調波などの情報を棒グラフでモニタできます。個々のチャネルの THD情報もモ
ニタできます。高調波表示画面を図 5-12に示します。

図 5-12 Graph Analysis > Display Option > Harmonicsメニュー・ページ
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5 グラフ解析
［Harm Settings］ソフトキーを押して、高調波の設定を行います。この設定は、グラフ解
析の表示オプションが Harmonicsの場合にのみ使用可能です。

図 5-13 Graph Analysis > Harm Settingsメニュー・ページ（高調波表示）

表 5-8 Graph Analysis > Harm Settingsメニューの概要（高調波表示）

メニュー 概要

Active Channel ［Active Channel］ソフトキーを押して、アクティブ・チャネルを選択します。 

Odd Harmonics

［Odd Harmonics］ソフトキーを押して、奇数次高調波を選択します。
– ALL

– 3

– 5

– 7

– 9

Even Harmonics

［Even Harmonics］ソフトキーを押して、偶数次高調波を選択します。
– ALL

– 2

– 4

– 6

– 8

Display

［Display］ソフトキーを押して、表示する高調波解析データのタイプを選択します。
– Harmonics

– THD 

THD unit

［THD unit］ソフトキーを押して、THD測定の単位を選択します。
– dB

– %
232 Keysight U8903B ユーザーズ・ガイド



グラフ解析 5
信号解析

信号解析ビューでは、アナライザとジェネレータのチャネル情報を表示することができ
ます。信号解析表示画面を図 5-14に示します。

図 5-14 Graph Analysis > Display Option > Signal Analysisメニュー・ページ
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5 グラフ解析
測定設定
U8903Bでは、最大 2種類の同時実行中の測定をグラフ解析モードでモニタできます。測
定値がグラフ下部に表示されます。グラフ解析の測定設定画面を、図 5-15に示します。

図 5-15 Graph Analysis > Measurementメニュー・ページ

表 5-9 Graph Analysis > Measurementメニューの概要

メニュー 概要

Enabled ［Enabled］ソフトキーを押して、グラフの測定値をオン／オフします。測定値が不要な場合は、測定値
をオフにすることによって性能が向上します。

Measurement 1 ［Measurement 1］ソフトキーを押して、測定 1のパラメータを設定します。詳細については、
「測定 1/測定 2」（ページ）235を参照してください。

Measurement 2 ［Measurement 2］ソフトキーを押して、測定 2のパラメータを設定します。詳細については、
「測定 1/測定 2」（ページ）235を参照してください。
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グラフ解析 5
測定 1/測定 2

図 5-16 Graph Analysis > Measurement > Measurement 1メニュー・ページ

表 5-10 Graph Analysis > Measurement > Measurement 1/Measurement 2メニューの概要

メニュー 概要

Interface
［Interface］ソフトキーを押して、測定のインタフェース・タイプを選択します。

– アナログ・アナライザ
– デジタル

Channel ［Channel］ソフトキーを押して、測定を実行するために必要なチャネルを選択します。

Function No

［Function No］ソフトキーを押して、機能番号（1～ 4）に基づいて表示する機能を選択します。機能番
号は、アナライザの各測定機能に対応します。使用可能な測定機能を以下に示します。
– Frequency

– DC電圧
– THD比
– THDレベル
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5 グラフ解析
これは空白のページです。
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6 掃引機能
掃引パラメータ

U8903Bの掃引モードでは、掃引を実行し、結果をプロット・ビューに表示できます。

［FUNCTION］パネルの を押して、掃引モードにアクセスします。図 6-1に示す

ように、［Sweep Parameter］メニュー・ページが表示されます。 

［Sweep Parameter］メニュー・ページには、3つのメイン・パネルがあります。上側の
パネルには現在の掃引設定が、下側の 2つのパネルにはオーディオ・パラメータとオー

ディオ・アナライザの設定がそれぞれ表示されます。［FUNCTION］パネルの を

押して、アナログ・インタフェースとデジタル・インタフェースの間を切り替えます。
パネル間の移動には、矢印キーを使用します。

［RUN CONTROL］パネルの を押すことにより、掃引モードでの掃引を開始

／停止することができます。

図 6-1 Sweep Parameterメニュー・ページ

注 U8903Bの掃引モードは、標準ビュー・モードでのみ使用可能です。詳細については、
「メニュー・キー」（ページ）54を参照してください。

Sweep

Interface

On
Off
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掃引機能 6
表 6-1 Sweep Parameterメニューの概要

メニュー 概要

App. Type

［App. Type］ソフトキーを押して、掃引のアプリケーション・タイプを選択します。
– Sweep
– Group Delay
デジタル・インタフェースにのみ適用可能です。詳細については、「群遅延」（ページ）240を参照し
てください。

Parameter
掃引のアプリケーション・タイプが Sweepの場合にのみ使用可能です。
［Parameter］ソフトキーを押して、掃引パラメータ・タイプを選択します。パラメータの選択は、アナ
ログ・ジェネレータの波形タイプの設定に依存します。

Points Settings
［Points Settings］ソフトキーを押して、スタート値、ストップ値、ステップ・サイズ、ポイント数、間
隔などの掃引ポイント・パラメータを設定します。
詳細については、「ポイント設定」（ページ）241を参照してください。

Dwell Time ［Dwell Time］ソフトキーを押して、ジェネレータの信号出力の遅延時間を ms単位で設定します。

Sweep Mode

［Sweep Mode］ソフトキーを押して、掃引モードを選択します。
– Continuous
すべてのポイントを掃引します。

– Single
ポイント単位で掃引します。

Channels
［Channels］ソフトキーを押して、掃引チャネルを設定します。
詳細については、「掃引チャネル」（ページ）242を参照してください。この設定は、従来の掃引がオフ
の場合にのみ使用可能です。

Plot View ［Plot View］ソフトキーを押して、［Plot View］メニュー・ページを表示します。
詳細については、「Plot View」（ページ）243を参照してください。
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6 掃引機能
群遅延

群遅延は、周波数の差に対する位相の差です。フィルタ、増幅器、プロセッサなどのデ
バイスを信号が通過する際に、必ず遅延が生じます。このわずかな遅延は通常は問題に
なりませんが、遅延が周波数ごとに異なり、信号が複数の周波数から構成されている場
合は、信号の形状が歪みます。異なる周波数での遅延の差が群遅延です。

群遅延は、位相歪みの有効な指標です。リニア位相からのずれから歪みが生じるので、
群遅延の変動によって信号が歪みます。群遅延は、周波数に対する DUTの位相応答を微
分することによって計算されます。群遅延は、掃引を行う場合にのみ意味があります。

入力信号と出力信号間の位相を計算するために、入力信号と出力信号が比較されます。
周波数 1の位相が記録されます。出力周波数が周波数 2にシフトされ、位相が再度測
定されます。その結果、群遅延値（（位相 1－位相 2）／（周波数 1－周波数 2））が得
られます。この測定を一連の周波数ポイントに対して実行することにより、位相対周波
数プロットの直線性を示す群遅延測定グラフをプロットすることができます。

群遅延測定機能モードは、デジタル・インタフェースにのみ適用可能です。 

図 6-2 Sweep Parameter > App. Type > Group Delayメニュー・ページ
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ポイント設定

図 6-3 Sweep Parameter > Points Settingsメニュー・ページ 1

表 6-2 Sweep Parameter > Points Settingsメニューの概要

メニュー 概要

Spacing

［Spacing］ソフトキーを押して、間隔タイプを選択します。
– Log – 等比数列

– Linear – 等差数列

– Custom – 任意間隔

Unit

［Unit］ソフトキーを押して、掃引単位を選択します。 この設定は、掃引パラメータが振幅の場合にのみ
使用可能です。
– Vrms

– dBV

– Vp

– Vpp

– dBm

– dBu

– dBSPL

Start ［Start］ソフトキーを押して、掃引スタート値を設定します。この設定は、掃引間隔が Logまたは Linear
の場合にのみ使用可能です。

Stop ［Stop］ソフトキーを押して、掃引ストップ値を設定します。この設定は、掃引間隔が Logまたは Linear
の場合にのみ使用可能です。

Step size 10

10 Stop
Start
--------- 
 log

Points 1–( )-------------------------
=

Step size Start Stop–( )
Points 1–( )---------------------------=



6 掃引機能
掃引チャネル

図 6-4 Sweep Parameter > Channelsメニュー・ページ

Step ［Step］ソフトキーを押して、掃引ステップ値を設定します。掃引ステップ値を調整すると、掃引ポイ
ント数が変更されます。この設定は、掃引間隔が Logまたは Linearの場合にのみ使用可能です。

Points ［Points］ソフトキーを押して、掃引ポイント数を設定します。掃引ポイント値を調整すると、掃引ス
テップ数が変更されます。この設定は、掃引間隔が Logまたは Linearの場合にのみ使用可能です。

Ed it Points
［Edit Points］ソフトキーを押して、掃引ポイントを設定します。
詳細については、「ポイント編集」（ページ）246を参照してください。掃引ポイントを変更すると、掃
引間隔モードが Customに設定されます。

表 6-2 Sweep Parameter > Points Settingsメニューの概要（続き）

メニュー 概要

注 この設定は、従来の掃引がオフの場合にのみ使用可能です。

表 6-3 Sweep Parameter > Channelsメニューの概要

メニュー 概要

Source ［Source］ソフトキーを押して、ソース・チャネルを選択します。

Measure ［Measure］ソフトキーを押して、測定チャネルを選択します。選択可能な数は、インストールされてい
るアナログ・アナライザ・カードの数によって異なります。
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掃引機能 6
Plot View

図 6-5に示すように、［Sweep Plot View］メニュー・ページが表示されます。

［RUN CONTROL］パネルの を押すことにより、掃引モードでの掃引を開始

／停止することができます。

図 6-5 Sweep > Plot Viewメニュー・ページ

On
Off

表 6-4 Sweep > Plot Viewメニューの概要

メニュー 概要

Axis Settings
［Axis Settings］ソフトキーを押して、掃引軸の設定を行います。
詳細については、「軸設定」（ページ）244を参照してください。

Plot Settings
［Plot Settings］ソフトキーを押して、掃引トレースの設定を行います。
詳細については、「プロット設定」（ページ）245を参照してください。

Edit Points
［Edit Points］ソフトキーを押して、掃引ポイントを設定します。
詳細については、「ポイント編集」（ページ）246を参照してください。

Save Pts
掃引ポイントをファイルに保存するには、［Save Pts］を押します。
Saveメニュー・ページについては、「Save」（ページ）86を参照してください。
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軸設定

図 6-6 Sweep > Plot View > Axis Settingsメニュー・ページ

表 6-5 Sweep > Plot View > Axis Settingsメニューの概要

メニュー 概要

Left ［Left］ソフトキーを押して、左軸の値を設定します。

Right ［Right］ソフトキーを押して、右軸の値を設定します。

Top ［Top］ソフトキーを押して、上軸の値を設定します。

Bottom ［Bottom］ソフトキーを押して、下軸の値を設定します。

X-Scale

［X-Scale］ソフトキーを押して、X軸のスケール・タイプを設定します。
– Linear

– Log

Y-Scale

［Y-Scale］ソフトキーを押して、Y軸のスケール・タイプを設定します。
– Linear

– Log
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プロット設定

図 6-7 Sweep > Plot View > Plot Settingsメニュー・ページ

表 6-6 Sweep > Plot View > Plot Settingsメニューの概要

Menu メニュー

Data Channel ［Data Channel］ソフトキーを押して、プロットするトレース・データ・チャネル番号を選択します。こ
の設定は、測定チャネルが複数ある場合にのみ使用可能です。

Y Data

［Y Data］ソフトキーを押して、Y軸のトレース・データ・ソースを選択します。
– S:<掃引パラメータ >

– F1: <掃引機能 1>

– F2: <掃引機能 2>

– F3: <掃引機能 3>

– F4: <掃引機能 4>

X Data

［X Data］ソフトキーを押して、X軸のトレース・データ・ソースを選択します。
– S:<掃引パラメータ >

– F1: <掃引機能 1>

– F2: <掃引機能 2>

– F3: <掃引機能 3>

– F4: <掃引機能 4>

Hold Type

［Hold Type］ソフトキーを押して、グラフにプロットするデータ・タイプを選択します。
– None
初期掃引データ。

– Average
各ポイントが前の結果の対応するポイントでアベレージングされます。

– Max
常に各ポイントの最大値が維持されます。

– Min
常に各ポイントの最小値がプロットされます。



6 掃引機能
ポイント編集

図 6-8 Sweep > Edit Pointsメニュー・ページ 1

表 6-7 Sweep > Edit Pointsメニューの概要

メニュー 概要

Data Channel ［Data Channel］ソフトキーを押して、プロットするトレース・データ・チャネル番号を選択します。
この設定は、測定チャネルが複数ある場合にのみ使用可能です。

Goto Point ［Goto Point］ソフトキーを押して、移動先の掃引ポイント番号を設定します。掃引ポイント番号が強調
表示されます。矢印キーを使用して目的の掃引ポイントを選択することもできます。

Point Value ［Point Value］ソフトキーを押して、現在選択されている掃引ポイントの値を設定します。

Add Point ［Add Point］ソフトキーを押して、掃引ポイントを追加します。

Remove Point ［Remove Point］ソフトキーを押して、選択した掃引ポイントを削除します。

Load Points ［Load Points］ソフトキーを押して、掃引ポイントをファイルからロードします。
Recallメニュー・ページについては、「Recall」（ページ）87を参照してください。

Save Points ［Save Points］ソフトキーを押して、掃引ポイントをファイルに保存します。
Saveメニュー・ページについては、「Save」（ページ）86を参照してください。

注 掃引ポイントを変更すると、掃引間隔モードが Customに設定されます。詳細について
は、表 6-2を参照してください。
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7 テスト・シーケンス・アプリケーション
Voice quality     348
Measurement Results     352
Report     356

Properties     357

この章では、U8903Bテスト・シーケンス・アプリケーションの各種設定について説明
します。
248 Keysight U8903B ユーザーズ・ガイド



テスト・シーケンス・アプリケーション 7
テスト・シーケンス・アプリケーション
U8903Bテスト・シーケンス・アプリケーション（Test Seq App）モードでは、DUTに対
して実行する一連の自動測定を作成することができます。測定の実行順のカスタマイ
ズ、合否判定リミットの編集、サブステップの追加、詳細な測定レポートの作成が可能
です。

テスト・シーケンス・アプリケーション・モードには、主に 2つのタブ、［Project］タ
ブと［Report］タブがあります。

［Project］タブでは、最大 20個のテスト・シーケンスの追加や各テスト・シーケンス
の測定の設定を行うことができます。［Report］タブでは、すべての測定結果を表示し、
レポートを作成することができます。

［Project］タブと［Report］タブの間を切り替えるには、左右の矢印キーを使用します。
詳細については、「Project」（ページ）251と「Report」（ページ）356を参照してくだ
さい。

［Project］タブ・メニュー・ページの表示例を、図 7-1に示します。

図 7-1 TSA > Projectメニュー・ページ
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7 テスト・シーケンス・アプリケーション
を押して、テスト・シーケンスを開始／停止します。図 7-2に示すように、

［Test Application］メニュー・ページが表示されます。

図 7-2 Test Applicationメニュー・ページ

On
Off

表 7-1 Test Applicationメニューの概要

メニュー 概要

Start Test App ［Start Test App］ソフトキーを押して、テスト・アプリケーション・プロジェクトを開始します。 

Start Test App From Here
［Start Test App From Here］ソフトキーを押して、選択したテストまたは測定タブからテスト・アプリ
ケーションを開始します。
この設定は、［On/Off］キーを押してテストまたは測定タブを選択した場合にのみ使用可能です。 

Start Selected 
Measurement

［Start Selected Measurement］ソフトキーを押して、選択した測定のテストを開始します。
この設定は、［On/Off］キーを押して測定タブを選択した場合にのみ使用可能です。
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Project

図 7-3に示すように、［TSA > Project］メニュー・ページが表示されます。

図 7-3 TSA > Projectメニュー・ページ

上下の矢印キーを押して、テスト・シーケンス、IO設定、または測定タブを選択しま
す。各メニュー・ページが表示されます。詳細については、「テスト・シーケンス」
（ページ）253、「IO設定」（ページ）254、「測定」（ページ）263を参照してください。

表 7-2 TSA > Projectメニューの概要

メニュー 概要

New Project ［New Project］ソフトキーを押して、新規プロジェクトを作成します。

Open Project ［Open Project］ソフトキーを押して、プロジェクトをファイルからロードします。［Recall］メニュー・
ページの詳細については、「Recall」（ページ）87を参照してください。

Save Project ［Save Project］ソフトキーを押して、プロジェクトをファイルに保存します。［Save］メニュー・ページ
の詳細については、「Save」（ページ）86を参照してください。

Properties ［Properties］ソフトキーを押して、プロジェクトのプロパティを設定します。［Properties］メニュー・
ページの詳細については、「Properties」（ページ）252を参照してください。
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Properties

図 7-4に示すように、［TSA > Project > Properties］メニュー・ページが表示されます。

図 7-4 TSA > Project > Propertiesメニュー・ページ

表 7-3 TSA > Project > Propertiesメニューの概要

メニュー 概要

Prompt DUT ID ［Prompt DUT ID］ソフトキーを押して、テスト・シーケンスの開始時にデバイス ID（デバイスのシリア
ル番号）の入力を求めるプロンプトの表示をオン／オフします。

Prompt Msg ［Prompt Msg］ソフトキーを押して、プロンプト・メッセージを設定します。この設定は、Prompt DUT ID
がオンになっている場合にのみ使用可能です。

Pass/Fail Msg
［Pass/Fail Msg］ソフトキーを押して、テスト・シーケンスの終わりに表示されるオンスクリーン・メッ
セージ・ダイアログ・ボックスをオン／オフします。［Enter］を押すと、ダイアログ・ボックスが閉じ
ます。

Pass Message
［Pass Message］ソフトキーを押して、合格メッセージを編集します。テスト・シーケンス内のすべての
測定が合格した場合には、合格メッセージが表示されます。デフォルト・メッセージは "Passed"です。
この設定は、Pass/Fail Msgがオンになっている場合にのみ使用可能です。

Fail Message
［Fail Message］ソフトキーを押して、不合格メッセージを編集します。テスト・シーケンス内の 1つ以
上の測定が不合格となった場合には、不合格メッセージが表示されます。デフォルト・メッセージは
"Failed"です。この設定は、Pass/Fail Msgがオンになっている場合にのみ使用可能です。
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テスト・シーケンス
図 7-5に示すように、［TSA > Project > Test］メニュー・ページが表示されます。

図 7-5 TSA > Project > Testメニュー・ページ

表 7-4 TSA > Project > Testメニューの概要

メニュー 概要

Enable ［Enable］ソフトキーを押して、選択したテスト・シーケンスをオン／オフします。オンにすると、テ
ストおよびテストのすべての測定のチェック・ボックスが選択されます。

Add Test Sequence

［Add Test Sequence］ソフトキーを押して、テスト・シーケンスを追加します。 
– New
新しいテスト・シーケンスを追加します。

– Saved
保存したテスト・シーケンス・ファイルをロードします。［Recall］メニュー・ページの詳細について
は、「Recall」（ページ）87を参照してください。

Delete Test Sequence ［Delete Test Sequence］ソフトキーを押して、選択したテスト・シーケンスを削除します。

Save ［Save］ソフトキーを押して、テスト・シーケンスをファイルに保存します。［Save］メニュー・ページ
の詳細については、「Save」（ページ）86を参照してください。

Ed it ［Edit］ソフトキーを押して、選択したテスト・シーケンスを移動またはコピーするか、選択したテス
ト・シーケンスの後にコピーしたテスト・シーケンスを貼り付けます。

Properties ［Properties］ソフトキーを押して、テスト・シーケンス名を設定します。
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IO設定

［IO Configuration］タブでは、出力設定と入力設定を行うことができます。各テスト・
シーケンスに 1つの［IO Configuration］タブがあります。IO設定の設定内容は、テス
ト・シーケンス内のすべての測定に適用されます。図 7-6に示すように、［TSA > 
Project > Test > IO Configuration］メニュー・ページが表示されます。

図 7-6 TSA > Project > Test > IO Configurationメニュー・ページ

表 7-5 TSA > Project > Test > IO Configurationメニューの概要

メニュー 概要

Add Measurement ［Add Measurement］ソフトキーを押して、測定を選択したテスト・シーケンスに追加します。詳細につ
いては、「測定」（ページ）263を参照してください。

Ed it ［Edit］ソフトキーを押して、IO設定の後にコピーした測定を貼り付けます。IO設定を移動／コピーす
ることはできません。

Settings ［Settings］ソフトキーを押して、IO設定を行います。詳細については、「Settings」（ページ）255を参
照してください。

Properties ［Properties］ソフトキーを押して、IO設定のプロパティを設定します。詳細については、「Properties」
（ページ）259を参照してください。
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Settings

上下の矢印キーを押して、出力設定と入力設定のどちらかを選択します。

出力設定
図 7-7に示すように、［TSA > Project > Test > IO Configuration > Output Configuration］メ
ニュー・ページが表示されます。

図 7-7 TSA > Project > Test > IO Configuration > Output Configurationメニュー・ページ

表 7-6 TSA > Project > Test > IO Configuration > Output Configurationメニューの概要

メニュー 概要

Channels

［Channels］ソフトキーを押して、使用する出力チャネル数を選択します。
– None (External)
ジェネレータの出力をオフにし、アナライザを外部ソース（開ループ）測定用に構成します。

– 1

– 2

Connector

［Connector］ソフトキーを押して、出力コネクタ・タイプを選択します。
– Bal
平衡モードでは、振幅が等しく、位相が 180度ずれている 2つの差動信号が、XLRの正と負のピンに
出力されます。

– UnBal
不平衡モードでは、グランド基準の信号が、BNC出力コネクタに出力されます。

– Com
コモン・モードでは、振幅が等しい 2つの同相信号が、XLRの正と負のピンに出力されます。コモ
ン・モード・テスト信号はピン 2と 3の両方または XLRコネクタに印加され、ピン 1は戻り信号に
接続されます。

– IEC60268
コモン・モード・テスト信号はピン 2と 3の両方または XLRコネクタに印加され、ピン 1は戻り信号
に接続されます。10 Ω出力直列抵抗がピンまたは 3に追加されます。
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Impedance

［Impedance］ソフトキーを押して、出力インピーダンス値を選択します。
Bal、Com、IEC60268の場合
– 600 Ω
– 100 Ω
– 40 Ω
UnBalの場合
– 600 Ω
– 50 Ω
– 20 Ω

IEC60268 10 Ω 

［IEC60268 10 Ω］ソフトキーを押して、一般的な IEC60268構成の XLRコネクタのピン 2または 3に追加
する 10 Ω出力直列抵抗を選択します。この設定は、出力コネクタ・タイプが IEC 60268に設定されてい
る場合にのみ使用可能です。
– Pin2

10 Ω出力直列抵抗がピン 2に追加されます。
– Pin3

 10 Ω出力直列抵抗がピン 3に追加されます。

Ground

［Ground］ソフトキーを押して、グランド・タイプを選択します。
– Float
グランド・タイプがフローティングの場合は、信号の戻り線（平衡出力の XLRピン 1、不平衡出力の
BNCリターン端子）はシャーシ・グランドにグランド接続されず、「フローティング状態」です。

– Ground
グランド・タイプがグランドの場合は、信号のリターン・ライン（平衡出力の場合は XLRピン 1、不
平衡出力の場合は BNCリターン端子）はシャーシ・グランドに接続されます。

Max Vol tage ［Max Voltage］ソフトキーを押して、最大電圧を設定します。最大電圧値の設定により、ジェネレータ
からの最大振幅出力を制限し、過剰な高電圧による DUTの損傷を防ぎます。

Reference
［Reference］ソフトキーを押して、ジェネレータの出力基準を設定します。

– Impedance
dBm測定の単位変換の基準インピーダンス値を設定します。

表 7-6 TSA > Project > Test > IO Configuration > Output Configurationメニューの概要（続き）

メニュー 概要
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入力設定
図 7-8に示すように、［TSA > Project > Test > IO Configuration > Input Configuration］メ
ニュー・ページが表示されます。

図 7-8 TSA > Project > Test > IO Configuration > Input Configurationメニュー・ページ

表 7-7 TSA > Project > Test > IO Configuration > Input Configurationメニューの概要

メニュー 概要

Channels ［Channels］ソフトキーを押して、使用する入力チャネル数を選択します。

Connector

［Connector］ソフトキーを押して、入力コネクタ・タイプを選択します。
– UnBal
不平衡コネクタ・タイプでは、信号は BNC入力コネクタからルーティングされます。同軸コネクタ
の内部導体の信号が、グランドを基準にして測定されます。

– Bal
平衡コネクタ・タイプでは、信号はフロント・パネルの XLR入力コネクタからアナログ・アナライ
ザにルーティングされます。 XLRコネクタの正と負のピンの信号は、差動増幅器に入力され、減算さ
れてからディテクタに送られます。 

– Loopback
ループバック・コネクタ・タイプでは、信号はジェネレータからアナライザに内部でルーティング
されます。
ジェネレータ・チャネル 1の信号はアナライザの奇数チャネル（1、3、5、7）に、ジェネレータ・
チャネル 2の信号はアナライザの偶数チャネル（2、4、6、8）にルーティングされます。
例えば、アナライザの奇数チャネルのいずれかで Loopbackを選択した場合には、ジェネレータ・
チャネル 1の出力コネクタ・タイプは自動的に Loopbackに設定されます。

Impedance

［Impedance］ソフトキーを押して、入力インピーダンスの値を選択します。この設定は、Connectorが
UnBalまたは Balに設定されている場合にのみ使用可能です。
– 100 kΩ (for Unbalanced)
– 200 kΩ (for Balanced)
– 600 Ω
– 300 Ω
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Coupling

［Coupl ing］ソフトキーを押して、入力結合タイプを選択します。
– DC

DC結合では、ACと DCの両方のアナログ入力信号がアナログ・アナライザに送られ、0 Hzまでの測
定が可能です。この設定は、DC電圧測定を実行する場合に選択します。

– AC
AC結合では、入力経路に直列にキャパシタが接続され、入力信号の DC成分がブロックされます。
この設定は、信号の AC成分だけを測定したい場合に選択します。例えば、実効値電圧またはピーク
ツーピーク電圧測定を実行する場合には、AC結合を使用します。 

Band wid th

［Band wid th］ソフトキーを押して、入力帯域幅の値を選択します。
– 90 kHz 
（これは、サンプリング・レートが 192 kHzの場合のデフォルト設定です）

– 1.5 MHz 

– この設定は、オプション N3431Aでのみ使用可能です。詳細については、「U8903Bオプション」
（ページ）33を参照してください。

Reference

［Reference］ソフトキーを押して、アナライザの入力基準を設定します。
– Voltage

– Ratio

– Frequency

– Impedance

– Sound level

– Calibrator level

表 7-7 TSA > Project > Test > IO Configuration > Input Configurationメニューの概要（続き）

メニュー 概要
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Properties

図 7-9に示すように、［TSA > Project > Test > IO Configuration > Properties］メニュー・
ページが表示されます。

図 7-9 Test > IO Configuration > Propertiesメニュー・ページ

表 7-8 TSA > Project > Test > IO Configuration > Propertiesメニューの概要

メニュー 概要

Name ［Name］ソフトキーを押して、IO設定の名前を変更します。

Sub-Steps ［Sub-Steps］ソフトキーを押して、サブステップの設定を行います。サブステップ設定の詳細について
は、「Sub-Steps」（ページ）260を参照してください。
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Sub-Steps

任意の数のサブステップを測定に追加することができます。サブステップは、オン、オ
フ、削除、または任意の順序での移動が可能です。サブステップに遅延、プロンプトを
追加したり、SCPIコマンドを送信することも可能です。［Add Sub-Step］ソフトキーを押
してサブステップを追加し、上下の矢印キーを押して目的のサブステップを選択します。

図 7-10に示すように、［Delay Sub-Steps］メニュー・ページが表示されます。

図 7-10 Delay Sub-Stepsメニュー・ページ

表 7-9 Sub-stepsメニューの概要

メニュー 概要

Enable ［Enable］ソフトキーを押して、選択したサブステップをオン／オフします。オンにすると、サブス
テップのチェック・ボックスが選択されます。

Add Sub-Step

［Add Sub-Step］ソフトキーを押して、サブステップをリストに追加します。
– Delay

– Prompt

– Send SCPI

Delete Sub-Step ［Delete Sub-Step］ソフトキーを押して、選択したサブステップを削除します。

Ed it ［Edit］ソフトキーを押して、選択したサブステップを移動またはコピーするか、選択したサブステッ
プの後にコピーしたサブステップを貼り付けます。

Settings

［Settings］ソフトキーを押して、サブステップの設定を行います。
– Delay
遅延時間を秒単位で設定します。
最小：0 s
最大：3600 s（1時間）

– Prompt
詳細については、「Prompt Sub-Steps設定」（ページ）261を参照してください。

– Send SCPI
詳細については、「Send SCPIサブステップ設定」（ページ）262を参照してください。

Properties ［Properties］ソフトキーを押して、サブステップの名前を変更します。
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Prompt Sub-Steps設定

Promp Stepの Sub-Stepsでは、プロンプト・メッセージと測定に対する応答オプショ
ンを挿入します。これにより、シーケンスとやり取りするための情報と機会が得られま
す。［OK］を押して、プロンプト・ウィンドウを閉じ、テスト・シーケンスを続行しま
す。図 7-11に示すように、Prompt Sub-Steps設定メニュー・ページが表示されます。

図 7-11 Prompt Sub-Steps設定メニュー・ページ

表 7-10 Prompt Sub-Steps設定メニューの概要

メニュー 概要

Message ［Message］ソフトキーを押して、プロンプト・メッセージをメイン・ディスプレイの下半分に設定します。

Prompt Icon

［Prompt Icon］ソフトキーを押して、表示するプロンプト・アイコンを選択します。
– None

– Hand

– Question

– Exclamation

– Asterisk

Dialog Settings

［Dialog Settings］ソフトキーを押して、プロンプト・ウィンドウに設定を追加します。
– Timeout
選択すると、タイムアウト値によってプロンプト・ウィンドウの最大表示時間が秒単位で設定され
ます。タイムアウトに達すると、現在の測定は不合格になります。選択しないと、プロンプト・
ウィンドウはユーザが閉じるまで開いたままになります。

– Cancel
選択すると、［Cancel］ボタンがプロンプト・ウィンドウに追加されます。［Cancel］ボタンを押して、
プロンプト・ウィンドウを閉じ、テスト・シーケンスを停止します。

Timeout

［Timeout］ソフトキーを押して、プロンプトのタイムアウト値を秒単位で設定します。この設定は、ダ
イアログの設定で Timeoutを選択した場合にのみ使用可能です。
最小：1 s
最大：3600 s（1時間）
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Send SCPIサブステップ設定

Send SCPIサブステップをテスト・シーケンス内の任意の測定に挿入して、SCPIコマ
ンドを接続されている外部測定器に送ったり、コマンドの送信後に指定の遅延時間の間
休止することができます。このサブステップは、測定の実行前に、USB/GPIBインタ
フェース経由で接続されている外部測定器をセットアップするのに有効です。図 7-12
に示すように、Send SCPIサブステップ設定メニュー・ページが表示されます。

図 7-12 Send SCPIサブステップ設定メニュー・ページ

表 7-11 Send SCPIサブステップ設定メニューの概要

メニュー 概要

GPIB Address ［GPIB Address］ソフトキーを押して、目的の GPIBアドレスを選択します。

SCPI Commands

［SCPI Commands］ソフトキーを押して、SCPIコマンドを設定します。
– Edit

SCPIコマンドをメイン・ディスプレイの下半分に設定します。
– Import

SCPIコマンドをファイルからロードします。［Recall］メニュー・ページの詳細については、「Recall」
（ページ）87を参照してください。

Progress Msg ［Progress Msg］ソフトキーを押して、Delayで設定した時間の長さに対して、ダイアログ・ボックスに
表示するオプションのテキスト・メッセージを設定します。

Delay

［Delay］ソフトキーを押して、SCPIコマンド発行後の遅延時間の長さを設定します。SCPIコマンドに
よって外部イベントが開始される場合がありますが、完了するまで時間がかかります。オプションの遅
延時間を設定して、完了まで待つことができます。遅延時間が経過するまで、テスト・シーケンスの次
のサブステップは実行されません。
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測定
U8903Bでは、1回の測定で最大 20個の結果が得られます。選択した測定を同じテスト・
シーケンス内で移動させることができます。Measurementメニュー・ページの表示例
を、図 7-13に示します。

図 7-13 TSA > Project > Test > AC Levelメニュー・ページ

表 7-12 TSA > Project > Test > Measurementメニューの概要

メニュー 概要

Enable ［Enable］ソフトキーを押して、選択した測定をオン／オフします。オンにすると、測定のチェック・
ボックスが選択されます。

Add Measurement ［Add Measurement］ソフトキーを押して、測定を追加します。

Delete Measurement ［Delete Measurement］ソフトキーを押して、選択した測定を削除します。

Ed it ［Edit］ソフトキーを押して、選択した測定を移動またはコピーするか、選択した測定の後にコピーし
た測定を貼り付けます。
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Settings

［Settings］ソフトキーを押して、選択した測定の設定を行います。詳細については、各測定の設定を参
照してください。
– AC level
– Frequency
– Phase
– SNR

– THD＋ N
– DC level
– Crosstalk
– SMPTE IMD
– DFD IMD
– Multitone analyzer
– Stepped frequency sweep
– SMPTE frequency sweep
– DFD frequency sweep
– Stepped level sweep
– SMPTE level sweep
– DFD level sweep
– DC level sweep
– Receiver sensitivity
– Measurement recorder
– Voice quality

Properties ［Properties］ソフトキーを押して、測定のプロパティを設定します。詳細については、「Properties」
（ページ）265を参照してください。

表 7-12 TSA > Project > Test > Measurementメニューの概要（続き）

メニュー 概要
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Properties

Measurement Propertiesメニュー・ページの表示例を、図 7-14に示します。

図 7-14 TSA > Project > Test > AC Level > Propertiesメニュー・ページ

表 7-13 TSA > Project > Test > Measurement > Propertiesメニューの概要

メニュー 概要

Name ［Name］ソフトキーを押して、選択した測定の名前を変更します。

Sub-Steps ［Sub-Steps］ソフトキーを押して、サブステップの設定を行います。サブステップ設定の詳細について
は、「Sub-Steps」（ページ）260を参照してください。

Failure Handling

［Failure Handl ing］ソフトキーを押して、選択した測定の失敗時の処理タイプを選択します。測定が設定
されたリミット値を超えたり、不適切な設定（存在しないファイルの呼出しや接続されていないデバイ
スへの SCPIサブステップの送信など）のために障害が発生した場合には、アプリケーションに以下を
指示することができます。
– Cancel Seq.
テスト・シーケンスを停止します。

– Allow Retry
プロンプト・ウィンドウが表示され、Abort、Retry、Ignoreコマンドが表示されます。Abortは、テス
ト・シーケンスを即座に停止します。Retryは、選択した測定を再実行します。Ignoreは、測定に
failedフラグを立て、テスト・シーケンスを続行します。

– Continue Seq.
測定に failedフラグを立て、テスト・シーケンスを続行します。
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AC level

ACレベル測定では、各アナライザ入力で測定された、各 DUTチャネルの出力レベルの
単一の値が測定されます。ACレベル測定の設定により、信号の発生や解析の設定を行
うことができます。選択したすべてのチャネルの ACレベル測定の結果が棒グラフに表
示されます（AC Levelと Gain）。出力設定チャネルに対して Noneを選択した場合は、
利得結果は使用できません。各結果のメニュー・ページの詳細については、
「Measurement Results」（ページ）352を参照してください。

各タブ間の移動およびメニュー・ページの表示には、矢印キーを使用します。

Signal generation

図 7-15に示すように、AC Level Signal Generation設定メニュー・ページが表示されます。

図 7-15 TSA > Project > Test > AC Level > Settings > Signal Generationメニュー・ページ

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
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Signal analysis

図 7-16に示すように、AC Level Signal Analysis設定メニュー・ページが表示されます。

図 7-16 TSA > Project > Test > AC Level > Settings > Signal Analysisメニュー・ページ

表 7-14 TSA > Project > Test > AC Level > Settings > Signal Generationメニューの概要

メニュー 概要

Waveform

［Waveform］ソフトキーを押して、波形タイプを選択します。
– Sine

– Variable Phase

– Square

– Arbitrary

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 使用可能な設定は、波形のタイプに
よって異なります。
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Frequency
周波数値を設定します。

– Amplitude
振幅値を設定します。

– DC Offset
DCオフセット値を設定します。

– Phase->1st Ch
 位相値を設定します。この設定は、チャネル 2が選択されている場合にのみ使用可能です。
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表 7-15 TSA > Project > Test > AC Level > Settings > Signal Analysisメニューの概要

メニュー 概要

Detector

［Detector］ソフトキーを押して、ACレベル・ディテクタ・タイプを選択します。
– RMS

ACレベル測定値は実効値で表示されます。 
– Pk-Pk

ACレベル測定値は Vpp値で表示されます。 

LPF

［LPF］ソフトキーを押して、ローパス・フィルタを選択します。
– None

– 2 kHz

– 3 kHz

– 5 kHz

– 8 kHz

– 10 kHz

– 15 kHz

– 20 kHz

– 22 kHz

– 30 kHz

– 40 kHz

– 50 kHz

– 80 kHz

– Custom

Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。
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Frequency

周波数測定では、各 DUTチャネルの出力信号内の最も強い成分の周波数の単一の値が測
定されます。周波数測定の設定により、信号の発生や解析の設定を行うことができます。 

選択したすべてのチャネルの周波数測定の結果が棒グラフに表示されます
（Frequency）。各結果のメニュー・ページの詳細については、「Measurement Results」
（ページ）352を参照してください。各タブ間の移動およびメニュー・ページの表示に
は、矢印キーを使用します。

Signal generation

図 7-17に示すように、Frequency Signal Generation設定メニュー・ページが表示されます。

図 7-17 Frequency > Signal Generation設定メニュー・ページ

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
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表 7-16 Frequency > Signal Generation設定メニューの概要

メニュー 概要

Waveform

［Waveform］ソフトキーを押して、波形タイプを選択します。
– Sine

– Variable Phase

– Square

– Arbitrary

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 使用可能な設定は、波形のタイプに
よって異なります。
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Frequency
周波数値を設定します。

– Amplitude
振幅値を設定します。

– DC Offset
DCオフセット値を設定します。

– Phase->1st Ch
 位相値を設定します。この設定は、チャネル 2が選択されている場合にのみ使用可能です。
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Signal analysis

図 7-18に示すように、Frequency Signal Analysis設定メニュー・ページが表示されます。

図 7-18 Frequency > Signal Analysis設定メニュー・ページ

表 7-17 Frequency > Signal Analysis設定メニューの概要

メニュー 概要

Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。
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Phase

位相測定では、DUTチャネルの相対位相の単一の値が測定されます。1つのチャネルが
位相基準チャネルとして選択され、残りのチャネルがそのチャネルと比較されます。位
相測定の設定により、信号の発生や解析の設定を行うことができます。 

選択したすべてのチャネルの位相測定の結果が棒グラフに表示されます（Phase）。各
結果のメニュー・ページの詳細については、「Measurement Results」（ページ）352を
参照してください。各タブ間の移動およびメニュー・ページの表示には、矢印キーを使
用します。

信号発生

図 7-19に示すように、Phase Signal Generation設定メニュー・ページが表示されます。

図 7-19 Phase > Signal Generation設定メニュー・ページ

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
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表 7-18 Phase > Signal Generation設定メニューの概要

メニュー 概要

Waveform

［Waveform］ソフトキーを押して、波形タイプを選択します。
– Sine

– Variable Phase

– Square

– Arbitrary

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 使用可能な設定は、波形のタイプに
よって異なります。
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Frequency
周波数値を設定します。

– Amplitude
振幅値を設定します。

– DC Offset
DCオフセット値を設定します。

– Phase->1st Ch
 位相値を設定します。この設定は、チャネル 2が選択されている場合にのみ使用可能です。
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Signal analysis

図 7-20に示すように、Phase Signal Analysis設定メニュー・ページが表示されます。

図 7-20 Phase > Signal Analysis設定メニュー・ページ

表 7-19 Phase > Signal Analysis設定メニューの概要

メニュー 概要

Ref Channel ［Ref Channel］ソフトキーを押して、基準チャネル番号を設定します。各チャネルの基準チャネルに対
する位相を測定します。基準チャネルの位相結果は常にゼロと表示されます。

Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Track 1st Ch

Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。
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SNR

SNR測定では、各 DUTチャネルの出力信号の S/N比の単一の値が測定されます。SNR
は、正常な信号レベルと雑音の差分を示すことにより、信号の明瞭度を評価するのに使
用されます。SNRは、2つの測定から求められます。1つは信号レベルの測定で、もう
1つは信号をオフにした状態での雑音レベルの測定です。これらの 2つの測定値は比で
表され、デシベル単位で表示されます。SNR測定の設定により、信号の発生や解析の
設定を行うことができます。

選択したすべてのチャネルの SNR測定の結果が棒グラフに表示されます（SNR）。各結
果のメニュー・ページの詳細については、「Measurement Results」（ページ）352を参
照してください。各タブ間の移動およびメニュー・ページの表示には、矢印キーを使用
します。

信号発生

図 7-21に示すように、SNR Signal Generation設定メニュー・ページが表示されます。

図 7-21 SNR > Signal Generation設定メニュー・ページ

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
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表 7-20 SNR > Signal Generation設定メニューの概要

メニュー 概要

Waveform

［Waveform］ソフトキーを押して、波形タイプを選択します。
– Sine

– Variable phase

– Square

– Arbitrary

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 使用可能な設定は、波形のタイプに
よって異なります。
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Frequency
周波数値を設定します。

– Amplitude
振幅値を設定します。

– DC Offset
DCオフセット値を設定します。

– Phase->1st Ch
 位相値を設定します。この設定は、チャネル 2が選択されている場合にのみ使用可能です。
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Signal analysis

図 7-22に示すように、SNR Signal Analysis設定メニュー・ページが表示されます。

図 7-22 SNR > Signal Analysis設定メニュー・ページ

表 7-21 SNR > Signal Analysis設定メニューの概要

メニュー 概要

SNR Mode

［SNR Mode］ソフトキーを押して、SNR測定モードを選択します。
– Fast

SNR測定は、周波数ドメイン計算方法をベースとします。
– Standard

SNR測定は、U8903Bジェネレータの出力をオン／オフする内蔵ルーチンによって実行されます。こ
のモードは、ジェネレータとアナライザの両方がテスト・セットアップに必要な閉ループ構成です。

SNR Delay ［SNR Delay］ソフトキーを押して、SNR遅延を設定します。この設定は、SNR Modeが Standardに設定さ
れている場合にのみ使用可能です。

Freq Lock

［Freq Lock］ソフトキーを押して、基本波周波数の探索方法を選択します。この設定は、SNR Modeが
Fastに設定されている場合にのみ使用可能です。
– Auto
［Auto］を選択した場合は、U8903Bは基本波周波数を自動的に探索します。

– Gen Lock
［Gen Lock］を選択した場合は、U8903Bは各ジェネレータ・チャネルの周波数値に基づいて基本波周
波数を探索します。この Gen Lock方法は、内蔵オーディオ・ジェネレータを使用している場合にの
み有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Fund Freq］で周波数値を設定することによ
り、基本波周波数値を定義することができます。

Fund Freq ［Fund Freq］ソフトキーを押して、基本波周波数値を設定します。この設定は、SNR Modeが Fastに、
Freq Lockが Customに設定されている場合にのみ使用可能です。

Harmonic Cnt ［Harmonic Cnt］ソフトキーを押して、削除する高調波の次数を設定します。この設定は、SNR Modeが
Fastに設定されている場合にのみ使用可能です。
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LPF

［Fil tering］ソフトキーを押して、ローパス・フィルタを選択します。
– None

– 2 kHz

– 3 kHz

– 5 kHz

– 8 kHz

– 10 kHz

– 15 kHz

– 20 kHz

– 22 kHz

– 30 kHz

– 40 kHz

– 50 kHz

– 80 kHz

– Custom

HPF

［HPF］ソフトキーを押して、ハイパス・フィルタを選択します。
– None

– 15 Hz

– 20 Hz

– 22 Hz

– 30 Hz

– 50 Hz

– 70 Hz

– 100 Hz

– 200 Hz

– 300 Hz

– 400 Hz

– Custom

Weighting

［Weighting］ソフトキーを押して、評価雑音フィルタを選択します。
– None

– A

– CCIR 1k

– CCIR 2k

– CCITT

– C-Message

– Custom

Deemphasis

［Deemphasis］ソフトキーを押して、ディエンファシス・フィルタを選択します。
– None
– 50 μs
– 75 μs

– Custom

表 7-21 SNR > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。

表 7-21 SNR > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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THD＋ N

THD＋ N測定では、各アナライザ入力で測定された、各 DUTチャネルからの出力信号
内の THD＋ N（全高調波歪み＋雑音）の単一の値が測定されます。THD＋ N測定の設
定により、信号の発生や解析の設定を行うことができます。 

選択したすべてのチャネルの THD＋ N測定の結果が棒グラフに表示されます（SINAD、
THD Level、THD Ratio、THD+N Level、THD+N Ratio）。各結果のメニュー・ページの詳
細については、「Measurement Results」（ページ）352を参照してください。各タブ間
の移動およびメニュー・ページの表示には、矢印キーを使用します。

信号発生

図 7-23に示すように、THD＋ N Signal Generation設定メニュー・ページが表示されます。

図 7-23 THD+N > Signal Generation設定メニュー・ページ

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
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Signal analysis

図 7-24に示すように、THD＋ N Signal Analysis設定メニュー・ページが表示されます。

図 7-24 THD+N > Signal Analysis設定メニュー・ページ

表 7-22 THD+N > Signal Generation設定メニューの概要

メニュー 概要

Waveform

［Waveform］ソフトキーを押して、波形タイプを選択します。
– Sine

– Variable phase

– Square

– Arbitrary

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 使用可能な設定は、波形のタイプに
よって異なります。
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Frequency
周波数値を設定します。

– Amplitude
振幅値を設定します。

– DC Offset
DCオフセット値を設定します。

– Phase->1st Ch
 位相値を設定します。この設定は、チャネル 2が選択されている場合にのみ使用可能です。
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表 7-23 THD+N > Signal Analysis設定メニューの概要

メニュー 概要

Freq Lock

［Freq Lock］ソフトキーを押して、基本波周波数の探索方法を選択します。
– Auto
［Auto］を選択した場合は、U8903Bは基本波周波数を自動的に探索します。

– Gen Lock
［Gen Lock］を選択した場合は、U8903Bは各ジェネレータ・チャネルの周波数値に基づいて基本波周
波数を探索します。この Gen Lock方法は、内蔵オーディオ・ジェネレータを使用している場合にの
み有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Fund Freq］で周波数値を設定することによ
り、基本波周波数値を定義することができます。

Fund Freq ［Fund Freq］ソフトキーを押して、基本波周波数値を設定します。この設定は、Freq Lockが Customに設
定されている場合にのみ使用可能です。

Harmonics

［Harmonics］ソフトキーを押して、THD比および THDレベルの結果に使用する高調波の数を選択します。
– All

– 2～ 9

LPF

［LPF］ソフトキーを押して、ローパス・フィルタを選択します。
– None

– 2 kHz

– 3 kHz

– 5 kHz

– 8 kHz

– 10 kHz

– 15 kHz

– 20 kHz

– 22 kHz

– 30 kHz

– 40 kHz

– 50 kHz

– 80 kHz

– Custom

HPF

［HPF］ソフトキーを押して、ハイパス・フィルタを選択します。
– None

– 15 Hz

– 20 Hz

– 22 Hz

– 30 Hz

– 50 Hz

– 70 Hz

– 100 Hz

– 200 Hz

– 300 Hz

– 400 Hz

– Custom
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Weighting

［Weighting］ソフトキーを押して、評価雑音フィルタを選択します。
– None

– A

– CCIR 1k

– CCIR 2k

– CCITT

– C-Message

– Custom

Deemphasis

［Deemphasis］ソフトキーを押して、ディエンファシス・フィルタを選択します。
– None
– 50 μs
– 75 μs

– Custom

Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。

表 7-23 THD+N > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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DC level

DCレベル測定では、各 DUTチャネルに存在する DC電圧の単一の値が測定されます。
入力設定で AC結合を選択した場合でも、DCレベル測定の実行中は DC結合に変更され
ます。DCレベル測定の設定により、信号の発生や解析の設定を行うことができます。 

選択したすべてのチャネルの DCレベル測定の結果が棒グラフに表示されます（DC 
Level）。各結果のメニュー・ページの詳細については、「Measurement Results」（ペー
ジ）352を参照してください。各タブ間の移動およびメニュー・ページの表示には、矢
印キーを使用します。

信号発生

図 7-25に示すように、DC Level Signal Generation設定メニュー・ページが表示されます。

図 7-25 DC Level > Signal Generation設定メニュー・ページ

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
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表 7-24 DC Level > Signal Generation設定メニューの概要

メニュー 概要

Waveform

［Waveform］ソフトキーを押して、波形タイプを選択します。
– Sine

– Arbitrary

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 使用可能な設定は、波形のタイプに
よって異なります。
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Frequency
周波数値を設定します。

– Amplitude
振幅値を設定します。

– DC Offset
DCオフセット値を設定します。
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Signal analysis

図 7-26に示すように、DC Level Signal Analysis設定メニュー・ページが表示されます。

図 7-26 DC Level > Signal Analysis設定メニュー・ページ

表 7-25 DC Level > Signal Analysis設定メニューの概要

メニュー 概要

Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。
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Crosstalk

クロストークとは、DUT内の 1つまたは複数のチャネルから他のチャネルに信号が漏
れ込むことで、望ましくないものです。クロストーク測定では、1つのチャネルのシ
ミュレーション時にシミュレーション対象でない DUTチャネルに漏れるクロストーク
が測定されます。 

ジェネレータは、選択したドライブ・チャネル上の DUTにテスト信号を出力します。
次に、残りの各チャネルのクロストークが測定されます。クロストーク測定の設定によ
り、信号の発生や解析の設定を行うことができます。 

各チャネルで測定されたクロストークが棒グラフで表示されます（クロストーク）。各
結果のメニュー・ページの詳細については、「Measurement Results」（ページ）352を
参照してください。各タブ間の移動およびメニュー・ページの表示には、矢印キーを使
用します。

信号発生

図 7-27に示すように、Crosstalk Signal Generation設定メニュー・ページが表示されます。

図 7-27 Crosstalk > Signal Generation設定メニュー・ページ

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
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Signal analysis

図 7-28に示すように、Crosstalk Signal Analysis設定メニュー・ページが表示されます。

図 7-28 Crosstalk > Signal Analysis設定メニュー・ページ

表 7-26 Crosstalk > Signal Generation設定メニューの概要

メニュー 概要

Waveform

［Waveform］ソフトキーを押して、波形タイプを選択します。
– Sine

– Arbitrary

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 使用可能な設定は、波形のタイプに
よって異なります。
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Frequency
周波数値を設定します。

– Amplitude
振幅値を設定します。

– DC Offset
DCオフセット値を設定します。
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表 7-27 Crosstalk > Signal Analysis設定メニューの概要

メニュー 概要

Driven Ch ［Driven Ch］ソフトキーを押して、ジェネレータのドライブ・チャネル番号を選択します。

Freq Lock

［Freq Lock］ソフトキーを押して、基本波周波数の探索方法を選択します。
– Auto
［Auto］を選択した場合は、U8903Bは基本波周波数を自動的に探索します。

– Gen Lock
［Gen Lock］を選択した場合は、U8903Bはドライブ・チャネルの周波数値を使用します。ジェネレー
タ・チャネルを選択するには、Driven Chを設定します。この Gen Lock方法は、内蔵オーディオ・
ジェネレータを使用している場合にのみ有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Fund Freq］で周波数値を設定することによ
り、基本波周波数値を定義することができます。

Fund Freq ［Fund Freq］ソフトキーを押して、基本波周波数値を設定します。この設定は、Freq Lockが Customに設
定されている場合にのみ使用可能です。

Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。
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SMPTE IMD

SMPTE IMD測定では、SMPTE法を用いて、各 DUTチャネルの出力信号内の IMD比の
単一の値が測定されます。SMPTE IMD測定の設定により、信号の発生や解析の設定を
行うことができます。 

選択したすべてのチャネルの SMPTE比測定の結果が棒グラフに表示されます（SMPTE 
Ratio）。各結果のメニュー・ページの詳細については、「Measurement Results」（ペー
ジ）352を参照してください。各タブ間の移動およびメニュー・ページの表示には、矢
印キーを使用します。

信号発生

図 7-29に示すように、SMPTE IMD Signal Generation設定メニュー・ページが表示され
ます。

図 7-29 SMPTE IMD > Signal Generation設定メニュー・ページ

注 この測定には、ジェネレータとアナライザの両方がテスト・セットアップに使用される
閉ループ構成が必要です。出力設定チャネルに対して Noneを選択した場合は、この測
定は使用できません。

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
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Signal analysis

図 7-30に示すように、SMPTE IMD Signal Analysis設定メニュー・ページが表示されます。

図 7-30 SMPTE IMD > Signal Analysis設定メニュー・ページ

表 7-28 SMPTE IMD > Signal Generation設定メニューの概要

メニュー 概要

Waveform

［Waveform］ソフトキーを押して、波形タイプを選択します。
– SMPTE 1:1

– SMPTE 4:1

– SMPTE 10:1

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 使用可能な設定は、波形のタイプに
よって異なります。
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Upper Freq
上側周波数値を設定します。

– Lower Freq
下側周波数値を設定します。

– Amplitude
振幅値を設定します。

– DC Offset
DCオフセット値を設定します。
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表 7-29 SMPTE IMD > Signal Analysis設定メニューの概要

メニュー 概要

Freq Lock

［Freq Lock］ソフトキーを押して、上側周波数と下側周波数の探索方法を選択します。 
– Gen Lock 
［Gen Lock］を選択した場合は、U8903Bは各ジェネレータ・チャネルの上側周波数と下側周波数に基
づいて入力信号の上側周波数と下側周波数を探索します。この Gen Lock方法は、内蔵オーディオ・
ジェネレータを使用している場合にのみ有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Upper Freq］および［Lower Freq］で周波数
値を設定することにより、上側周波数と下側周波数の値を定義することができます。

Upper Freq ［Upper Freq］ソフトキーを押して、上側基本波周波数値を設定します。この設定は、Freq Lockが Custom
に設定されている場合にのみ使用可能です。

Lower Freq ［Lower Freq］ソフトキーを押して、下側基本波周波数値を設定します。この設定は、Freq Lockが Custom
に設定されている場合にのみ使用可能です。

Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。
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DFD IMD

DFD IMD測定では、DFD法を用いて、各 DUTチャネルの出力信号内の IMD比の単一の
値が測定されます。DFD測定の設定により、信号の発生や解析の設定を行うことがで
きます。 

選択したすべてのチャネルの DFD比測定の結果が棒グラフに表示されます（DFD 
Ratio）。各結果のメニュー・ページの詳細については、「Measurement Results」（ペー
ジ）352を参照してください。各タブ間の移動およびメニュー・ページの表示には、矢
印キーを使用します。

信号発生

図 7-31に示すように、DFD IMD Signal Generation設定メニュー・ページが表示されます。

図 7-31 DFD IMD > Signal Generation設定メニュー・ページ

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
Keysight U8903B ユーザーズ・ガイド 293



7 テスト・シーケンス・アプリケーション
Signal analysis

図 7-32に示すように、DFD IMD Signal Analysis設定メニュー・ページが表示されます。

図 7-32 DFD IMD > Signal Analysis設定メニュー・ページ

表 7-30 DFD IMD > Signal Generation設定メニューの概要

メニュー 概要

Waveform

［Waveform］ソフトキーを押して、波形タイプを選択します。
– IEC60118

– IEC60268

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 使用可能な設定は、波形のタイプに
よって異なります。
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Upper Freq
上側周波数値を設定します。

– Center Freq
中心周波数値を設定します。

– Diff Freq
差周波数値を設定します。

– Amplitude
振幅値を設定します。

– DC Offset
DCオフセット値を設定します。
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表 7-31 DFD IMD > Signal Analysis設定メニューの概要

メニュー 概要

DFD order

［DFD order］ソフトキーを押して、測定する歪みの次数を選択します。
– 2nd

– 3rd

Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。
Keysight U8903B ユーザーズ・ガイド 295



7 テスト・シーケンス・アプリケーション
Multitone analyzer

マルチトーン・アナライザ測定では、 マルチトーン入力信号波形による FFT解析が用い
られます。マルチトーン入力信号は、2つ以上の正弦波波形が結合されています。マル
チトーン信号が DUTに印加され、DUTの出力が測定のために捕捉されます。信号発生
設定の［Tones Config］メニュー・ページからマルチトーンを作成することができます。

選択したすべてのチャネルマルチトーン・アナライザ測定の結果がグラフ（Spectrum、
Waveform、Level、Gain）と棒グラフ（Max Tone Level、Min Tone Level、TD+N Level、
TD+N Ratio、Tone Level）に表示されます。各結果のメニュー・ページの詳細について
は、「Measurement Results」（ページ）352を参照してください。各タブ間の移動およ
びメニュー・ページの表示には、矢印キーを使用します。

信号発生

図 7-33に示すように、Multitone Analyzer Signal Generation設定メニュー・ページが表
示されます。

図 7-33 Multitone Analyzer > Signal Generation設定メニュー・ページ

注 この測定には、ジェネレータとアナライザの両方がテスト・セットアップに使用される
閉ループ構成が必要です。出力設定チャネルに対して Noneを選択した場合は、この測
定は使用できません。

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
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表 7-32 Multitone Analyzer > Signal Generation設定メニューの概要

メニュー 概要

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Amplitude
振幅値を設定します。

Tones Config

［Tones Config］ソフトキーを押して、トーンを設定します。
– Start freq
マルチトーン波形の最低周波数で、通常は最初のトーンの周波数。

– Stop freq
マルチトーン波形の最高周波数で、通常は最後のトーンの周波数。

– Spacing
トーン間の周波数間隔。

– Tones
信号の周波数成分の数。作成可能なトーンの最大トーン数は 60です。

– Length
マルチトーン波形の 1回の反復を作成するのに使用するサンプル数を決定する波形長。波形長が長
いほど周波数分解能は高くなりますが、作成や処理にかかる時間は長くなります。

– Phase Dist
各トーンの位相分布。

– Ampl. Mode
各トーンの振幅比。［Zero］を選択して、すべてのトーンの振幅を 0 dBに設定します。

– Optimization
クレスト・ファクタの最適化をオン／オフします。

– Edit tones
個々のトーン周波数、振幅、位相を編集します。

– Apply Settings
［Tones Config］メニューの設定を変更するたびに、マルチトーン信号のクレスト・ファクタの計算に
設定を適用します。

– Active Channel
The active channel for the absolute amplitude for each tone to be displayed in a table.各トーンの絶対振幅をテー
ブルに表示するアクティブ・チャネル。
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Signal analysis

図 7-34に示すように、Multitone Analyzer Signal Analysis設定メニュー・ページが表示さ
れます。

図 7-34 Multitone Analyzer > Signal Analysis設定メニュー・ページ

表 7-33 Multitone Analyzer > Signal Analysis設定メニューの概要

メニュー 概要

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Track 1st Ch

Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。
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Stepped frequency sweep

ステップ掃引はオーディオのテスト方法で、1つのパラメータを値の範囲全体にわたっ
て掃引しながら、1つまたは複数の他のパラメータを測定します。ステップ周波数掃引
測定では、正弦波の入力信号が周波数レンジ全体にわたって指定したポイント数で移動
します。DUTの出力がアナライザによって捕捉され、その結果が X-Yグラフ上に表示
されます。X軸にはジェネレータの周波数が、Y軸には DUTの測定結果（AC Level、
Gain、Phase、THD Ratio、THD Level、THD+N Ratio、THD+N Level、SINAD）が表示さ
れます。

各結果のメニュー・ページの詳細については、「Measurement Results」（ページ）352
を参照してください。位相結果については、自動レンジ切替えはサポートされていませ
ん。各タブ間の移動およびメニュー・ページの表示には、矢印キーを使用します。

信号発生

図 7-35に示すように、Stepped Frequency Sweep Signal Generation設定メニュー・ペー
ジが表示されます。

図 7-35 Stepped Frequency Sweep > Signal Generation設定メニュー・ページ

注 この測定には、ジェネレータとアナライザの両方がテスト・セットアップに使用される
閉ループ構成が必要です。出力設定チャネルに対して Noneを選択した場合は、この測
定は使用できません。

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
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表 7-34 Stepped Frequency Sweep > Signal Generation設定メニューの概要

メニュー 概要

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Sweep Config

［Sweep Config］ソフトキーを押して、掃引設定を行います。
– Start
掃引パラメータのスタート値を設定します。

– Stop
掃引パラメータのストップ値を設定します。

– Spacing
掃引間隔として、Log、Linearまたは Customを選択します。

– Points
掃引ポイント数を設定します。

– Step Size
リニア間隔のステップ幅を選択します。この設定は、Spacingが Linearに設定されている場合にのみ
使用可能です。

– Dwell Time
掃引ポイント間の遅延を設定します。

– Edit Points
個々のポイントの値の編集、ポイントの挿入／削除、ポイントのロード、ポイントの保存を行います。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Amplitude
振幅値を設定します。

– DC Offset
DCオフセット値を設定します。
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Signal analysis

図 7-36に示すように、Stepped Frequency Sweep Signal Analysis設定メニュー・ページ
が表示されます。

図 7-36 Stepped Frequency Sweep > Signal Analysis設定メニュー・ページ

表 7-35 Stepped Frequency Sweep > Signal Analysis設定メニューの概要

メニュー 概要

Ref Channel ［Ref Channel］ソフトキーを押して、基準チャネル番号を設定します。各チャネルの基準チャネルに対
する位相を測定します。基準チャネルの位相結果は常にゼロと表示されます。

Harmonics

［Harmonics］ソフトキーを押して、THD比および THDレベルの結果に使用する高調波の数を選択します。
– All

– 2～ 9

LPF

［LPF］ソフトキーを押して、ローパス・フィルタを選択します。
– None

– 2 kHz

– 3 kHz

– 5 kHz

– 8 kHz

– 10 kHz

– 15 kHz

– 20 kHz

– 22 kHz

– 30 kHz

– 40 kHz

– 50 kHz

– 80 kHz

– Custom
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HPF

［HPF］ソフトキーを押して、ハイパス・フィルタを選択します。
– None

– 15 Hz

– 20 Hz

– 22 Hz

– 30 Hz

– 50 Hz

– 70 Hz

– 100 Hz

– 200 Hz

– 300 Hz

– 400 Hz

– Custom

Weighting

［Weighting］ソフトキーを押して、評価雑音フィルタを選択します。
– None

– A

– CCIR 1k

– CCIR 2k

– CCITT

– C-Message

– Custom

Deemphasis

［Deemphasis］ソフトキーを押して、ディエンファシス・フィルタを選択します。
– None
– 50 μs
– 75 μs

– Custom

Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

表 7-35 Stepped Frequency Sweep > Signal Analysis設定メニューの概要（続き）

メニュー 概要
302 Keysight U8903B ユーザーズ・ガイド



テスト・シーケンス・アプリケーション 7
Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。

表 7-35 Stepped Frequency Sweep > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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SMPTE frequency sweep

SMPTE周波数掃引測定では、2つのトーンのうちの 1つを一定の周波数に保持しなが
ら、他方のトーンを周波数レンジ全体にわたって掃引します。その結果が X-Yグラフ上
に表示されます。X軸には掃引周波数が、Y軸には SMPTE比の測定値が表示されます。 

各結果のメニュー・ページの詳細については、「Measurement Results」（ページ）352
を参照してください。各タブ間の移動およびメニュー・ページの表示には、矢印キーを
使用します。

信号発生

図 7-37に示すように、SMPTE Frequency Sweep Signal Generation設定メニュー・ページ
が表示されます。

図 7-37 SMPTE Frequency Sweep > Signal Generation設定メニュー・ページ

注 この測定には、ジェネレータとアナライザの両方がテスト・セットアップに使用される
閉ループ構成が必要です。出力設定チャネルに対して Noneを選択した場合は、この測
定は使用できません。

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
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表 7-36 SMPTE Frequency Sweep > Signal Generation設定メニューの概要

メニュー 概要

Waveform

［Waveform］ソフトキーを押して、波形タイプを選択します。
– SMPTE 1:1

– SMPTE 4:1

– SMPTE 10:1

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Sweep Config

［Sweep Config］ソフトキーを押して、掃引設定を行います。
– Swept
掃引パラメータとして、Upper Freqまたは Lower Freqを選択します。

– Start
掃引パラメータのスタート値を設定します。

– Stop
掃引パラメータのストップ値を設定します。

– Spacing
掃引間隔として、Log、Linearまたは Customを選択します。

– Points
掃引ポイント数を設定します。

– Step Size
リニア間隔のステップ幅を選択します。この設定は、Spacingが Linearに設定されている場合にのみ
使用可能です。

– Dwell Time
掃引ポイント間の遅延を設定します。

– Edit Points
個々のポイントの値の編集、ポイントの挿入／削除、ポイントのロード、ポイントの保存を行います。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Upper Freq
上側周波数値を設定します。この設定は、Sweptが Lower Freqに設定されている場合にのみ使用可能
です。

– Lower Freq
下側周波数値を設定します。この設定は、Sweptが Upper Freqに設定されている場合にのみ使用可能
です。

– Amplitude
振幅値を設定します。

– DC Offset
DCオフセット値を設定します。
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Signal analysis

図 7-38に示すように、SMPTE Frequency Sweep Signal Analysis設定メニュー・ページが
表示されます。

図 7-38 SMPTE Frequency Sweep > Signal Analysis設定メニュー・ページ

表 7-37 SMPTE Frequency Sweep > Signal Analysis設定メニューの概要

メニュー 概要

Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。
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DFD frequency sweep

SMPTE周波数掃引測定では、2つの周波数（IEC60118上側周波数または差周波数と
IEC60268中心周波数または差周波数）のうちの 1つを一定の周波数に保持しながら、
他方の周波数を周波数レンジ全体にわたって掃引します。その結果が X-Yグラフ上に
表示されます。X軸には掃引周波数が、Y軸には DFD比の測定値が表示されます。 

各結果のメニュー・ページの詳細については、「Measurement Results」（ページ）352
を参照してください。各タブ間の移動およびメニュー・ページの表示には、矢印キーを
使用します。

信号発生

図 7-39に示すように、DFD Frequency Sweep Signal Generation設定メニュー・ページが
表示されます。

図 7-39 DFD Frequency Sweep > Signal Generation設定メニュー・ページ

注 この測定には、ジェネレータとアナライザの両方がテスト・セットアップに使用される
閉ループ構成が必要です。出力設定チャネルに対して Noneを選択した場合は、この測
定は使用できません。

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
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表 7-38 DFD Frequency Sweep > Signal Generation設定メニューの概要

メニュー 概要

Waveform

［Waveform］ソフトキーを押して、波形タイプを選択します。
– IEC60118

– IEC60268

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Sweep Config

［Sweep Config］ソフトキーを押して、掃引設定を行います。
– Swept
掃引パラメータとして、Upper Freqまたは Diff Freqを選択します。

– Start
掃引パラメータのスタート値を設定します。

– Stop
掃引パラメータのストップ値を設定します。

– Spacing
掃引間隔として、Log、Linearまたは Customを選択します。

– Points
掃引ポイント数を設定します。

– Step Size
リニア間隔のステップ幅を選択します。この設定は、Spacingが Linearに設定されている場合にのみ
使用可能です。

– Dwell Time
掃引ポイント間の遅延を設定します。

– Edit Points
個々のポイントの値の編集、ポイントの挿入／削除、ポイントのロード、ポイントの保存を行います。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Upper Freq
上側周波数値を設定します。この設定は、Sweptが Diff Freqに設定されている場合にのみ使用可能です。

– Diff Freq
差周波数値を設定します。この設定は、Sweptが Upper Freqに設定されている場合にのみ使用可能です。

– Amplitude
振幅値を設定します。

– DC Offset
DCオフセット値を設定します。
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Signal analysis

図 7-40に示すように、DFD Frequency Sweep Signal Analysis設定メニュー・ページが表
示されます。

図 7-40 DFD Frequency Sweep > Signal Analysis設定メニュー・ページ

表 7-39 DFD Frequency Sweep > Signal Analysis設定メニューの概要

メニュー 概要

DFD order

［DFD order］ソフトキーを押して、測定する歪み成分の次数を選択します。
– 2nd

– 3rd

Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M
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Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。

表 7-39 DFD Frequency Sweep > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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外部周波数掃引

各結果のメニュー・ページの詳細については、「Measurement Results」（ページ）352
を参照してください。各タブ間の移動およびメニュー・ページの表示には、矢印キーを
使用します。

信号発生
図 7-41に示すように、External Frequency Sweep Signal Generation設定メニュー・ペー
ジが表示されます。

図 7-41 External Frequency Sweep > Signal Generation設定メニュー・ページ

表 7-40 External Frequency Sweep > Signal Generation設定メニューの概要

メニュー 概要

機器

［Instrument］ソフトキーを押して、測定器モデルを選択します。
– Keysight 33220A
– Keysight 33250A
– Keysight 33500A
– Keysight 33600A

– Other

GPIB Address
［GPIB Address］ソフトキーを押して、GPIBアドレスを選択します。

– 0～ 30

Init Instrument ［Init Instrument］ソフトキーを押して、U8903Bによる接続された信号発生器を初期化するための SCPIコ
マンドの送信をオン／オフします。

Init SCPI

［Init SCPI］ソフトキーを押して、接続測定器を初期化する SCPIコマンドを設定します。SCPIコマンド
は、直接設定することも、ファイルからロードすることもできます。
– Edit

– Import（［Recall］メニュー・ページの詳細については、「Recall」（ページ）87を参照してください）。
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Sweep SCPI

［Sweep SCPI］ソフトキーを押して、接続測定器を初期化する掃引用 SCPIコマンドを設定します。SCPI
コマンドは、直接設定することも、ファイルからロードすることもできます。
– Edit

– Import（［Recall］メニュー・ページの詳細については、「Recall」（ページ）87を参照してください）。

Sweep Config

［Sweep Config］ソフトキーを押して、掃引設定を行います。
– Start
掃引パラメータのスタート値を設定します。

– Stop
掃引パラメータのストップ値を設定します。

– Spacing
掃引間隔として、Log、Linearまたは Customを選択します。

– Points
掃引ポイント数を設定します。

– Step Size
リニア間隔のステップ幅を選択します。この設定は、Spacingが Linearに設定されている場合にのみ
使用可能です。

– Dwell Time
掃引ポイント間の遅延を設定します。

– Edit Points
個々のポイントの値の編集、ポイントの挿入／削除、ポイントのロード、ポイントの保存を行います。

表 7-40 External Frequency Sweep > Signal Generation設定メニューの概要（続き）

メニュー 概要
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Signal analysis

図 7-42に示すように、External Frequency Sweep Signal Analysis設定メニュー・ページ
が表示されます。

図 7-42 External Frequency Sweep > Signal Analysis設定メニュー・ページ

表 7-41 External Frequency Sweep > Signal Analysis設定メニューの概要

メニュー 概要

Ref Channel ［Ref Channel］ソフトキーを押して、基準チャネル番号を選択します。各チャネルの基準チャネルに対
する位相を測定します。基準チャネルの位相結果は常にゼロと表示されます。

Harmonics

［Harmonics］ソフトキーを押して、THD比および THDレベルの結果に使用する高調波の数を選択します。
– All

– 2～ 9

LPF

［LPF］ソフトキーを押して、ローパス・フィルタを選択します。
– None

– 2 kHz

– 3 kHz

– 5 kHz

– 8 kHz

– 10 kHz

– 15 kHz

– 20 kHz

– 22 kHz

– 30 kHz

– 40 kHz

– 50 kHz

– 80 kHz

– Custom
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HPF

［HPF］ソフトキーを押して、ハイパス・フィルタを選択します。
– None

– 15 Hz

– 20 Hz

– 22 Hz

– 30 Hz

– 50 Hz

– 70 Hz

– 100 Hz

– 200 Hz

– 300 Hz

– 400 Hz

– Custom

Weighting

［Weighting］ソフトキーを押して、評価雑音フィルタを選択します。
– None

– A

– CCIR 1k

– CCIR 2k

– CCITT

– C-Message

– Custom

Deemphasis

［Deemphasis］ソフトキーを押して、ディエンファシス・フィルタを選択します。
– None
– 50 μs
– 75 μs

– Custom

Notch Fil ter

［Notch Fil ter］ソフトキーを押して、ノッチ・フィルタの設定を行います。 
– HP8903B

HP8903Bモードをオン／オフします。
– Custom Notch
カスタム・ノッチをオン／オフします。

– Center Freq
中心周波数値を設定します。カスタム・ノッチがオンになっている場合にのみ適用可能です。

– Bandwidth
帯域幅値を設定します。カスタム・ノッチがオンになっている場合にのみ適用可能です。

表 7-41 External Frequency Sweep > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。

表 7-41 External Frequency Sweep > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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Stepped level sweep

ステップ掃引はオーディオのテスト方法で、1つのパラメータを値の範囲全体にわたっ
て掃引しながら、1つまたは複数の他のパラメータを測定します。ステップ・レベル掃
引測定では、正弦波の入力信号がレベルの範囲全体にわたって指定したポイント数で移
動します。DUTの出力がアナライザによって捕捉され、その結果が X-Yグラフ上に表
示されます。X軸にはジェネレータのレベルが、Y軸には DUTの測定結果（AC Level、
Gain、THD Ratio、THD Level、THD Ratio Vs Measured Amplitude、THD Level Vs 
Measured Amplitude、THD+N ratio、THD+N Level、THD+N Ratio Vs Measured 
Amplitude、THD+N Level Vs Measured Amplitude、SINAD）が表示されます。

各結果のメニュー・ページの詳細については、「Measurement Results」（ページ）352
を参照してください。各タブ間の移動およびメニュー・ページの表示には、矢印キーを
使用します。

信号発生

図 7-43に示すように、Stepped Level Sweep Signal Generation設定メニュー・ページが
表示されます。

図 7-43 Stepped Level Sweep > Signal Generation設定メニュー・ページ

注 この測定には、ジェネレータとアナライザの両方がテスト・セットアップに使用される
閉ループ構成が必要です。出力設定チャネルに対して Noneを選択した場合は、この測
定は使用できません。

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
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表 7-42 Stepped Level Sweep > Signal Generation設定メニューの概要

メニュー 概要

Waveform

［Waveform］ソフトキーを押して、波形タイプを選択します。
– Sine

– Arbitrary

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Sweep Config

［Sweep Config］ソフトキーを押して、掃引設定を行います。
– Start
掃引パラメータのスタート値を設定します。

– Stop
掃引パラメータのストップ値を設定します。

– Spacing
掃引間隔として、Log、Linearまたは Customを選択します。

– Points
掃引ポイント数を設定します。

– Step Size
リニア間隔のステップ幅を選択します。この設定は、Spacingが Linearに設定されている場合にのみ
使用可能です。

– Dwell Time
掃引ポイント間の遅延を設定します。

– Edit Points
個々のポイントの値の編集、ポイントの挿入／削除、ポイントのロード、ポイントの保存を行います。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Frequency
周波数値を設定します。

– DC Offset
DCオフセット値を設定します。
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Signal analysis

図 7-44に示すように、Stepped Level Sweep Signal Analysis設定メニュー・ページが表示
されます。

図 7-44 Stepped Level Sweep > Signal Analysis設定メニュー・ページ

表 7-43 Stepped Level Sweep > Signal Analysis設定メニューの概要

メニュー 概要

Freq Lock

［Freq Lock］ソフトキーを押して、基本波周波数の探索方法を選択します。
– Auto
［Auto］を選択した場合は、U8903Bは基本波周波数を自動的に探索します。

– Gen Lock
［Gen Lock］を選択した場合は、U8903Bは各ジェネレータ・チャネルの周波数値に基づいて基本波周
波数を探索します。この Gen Lock方法は、内蔵オーディオ・ジェネレータを使用している場合にの
み有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Fund Freq］で周波数値を設定することによ
り、基本波周波数値を定義することができます。

Fund Freq ［Fund Freq］ソフトキーを押して、基本波周波数値を設定します。この設定は、Freq Lockが Customに設
定されている場合にのみ使用可能です。
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LPF

［LPF］ソフトキーを押して、ローパス・フィルタを選択します。
– None

– 2 kHz

– 3 kHz

– 5 kHz

– 8 kHz

– 10 kHz

– 15 kHz

– 20 kHz

– 22 kHz

– 30 kHz

– 40 kHz

– 50 kHz

– 80 kHz

– Custom

HPF

［HPF］ソフトキーを押して、ハイパス・フィルタを選択します。
– None

– 15 Hz

– 20 Hz

– 22 Hz

– 30 Hz

– 50 Hz

– 70 Hz

– 100 Hz

– 200 Hz

– 300 Hz

– 400 Hz

– Custom

Weighting

［Weighting］ソフトキーを押して、評価雑音フィルタを選択します。
– None

– A

– CCIR 1k

– CCIR 2k

– CCITT

– C-Message

– Custom

Deemphasis

［Deemphasis］ソフトキーを押して、ディエンファシス・フィルタを選択します。
– None
– 50 μs
– 75 μs

– Custom

表 7-43 Stepped Level Sweep > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。

表 7-43 Stepped Level Sweep > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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SMPTE level sweep

SMPTEレベル掃引測定では、周波数の異なる 2つのトーンを 1つの入力信号に付加し
て、レベルの範囲全体にわたって掃引します。その結果が X-Yグラフ上に表示されま
す。X軸にはジェネレータの掃引レベルまたは DUTのレベル測定値が、Y軸には
SMPTE比の測定値が表示されます。 

各結果のメニュー・ページの詳細については、「Measurement Results」（ページ）352
を参照してください。各タブ間の移動およびメニュー・ページの表示には、矢印キーを
使用します。

信号発生

図 7-45に示すように、SMPTE Level Sweep Signal Generation設定メニュー・ページが表
示されます。

図 7-45 SMPTE Level Sweep > Signal Generation設定メニュー・ページ

注 この測定には、ジェネレータとアナライザの両方がテスト・セットアップに使用される
閉ループ構成が必要です。出力設定チャネルに対して Noneを選択した場合は、この測
定は使用できません。

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
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表 7-44 SMPTE Level Sweep > Signal Generation設定メニューの概要

メニュー 概要

Waveform

［Waveform］ソフトキーを押して、波形タイプを選択します。
– SMPTE 1:1

– SMPTE 4:1

– SMPTE 10:1

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Sweep Config

［Sweep Config］ソフトキーを押して、掃引設定を行います。
– Start
掃引パラメータのスタート値を設定します。

– Stop
掃引パラメータのストップ値を設定します。

– Spacing
掃引間隔として、Log、Linearまたは Customを選択します。

– Points
掃引ポイント数を設定します。

– Step Size
リニア間隔のステップ幅を選択します。この設定は、Spacingが Linearに設定されている場合にのみ
使用可能です。

– Dwell Time
掃引ポイント間の遅延を設定します。

– Edit Points
個々のポイントの値の編集、ポイントの挿入／削除、ポイントのロード、ポイントの保存を行います。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Upper Freq
上側周波数値を設定します。

– Lower Freq
下側周波数値を設定します。

– DC Offset
DCオフセット値を設定します。
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Signal analysis

図 7-46に示すように、SMPTE Level Sweep Signal Analysis設定メニュー・ページが表示
されます。

図 7-46 SMPTE Level Sweep > Signal Analysis設定メニュー・ページ

表 7-45 SMPTE Level Sweep > Signal Analysis設定メニューの概要

メニュー 概要

Freq Lock

［Freq Lock］ソフトキーを押して、上側周波数と下側周波数の探索方法を選択します。 
– Gen Lock 
［Gen Lock］を選択した場合は、U8903Bは各ジェネレータ・チャネルの上側周波数と下側周波数に基
づいて入力信号の上側周波数と下側周波数を探索します。この Gen Lock方法は、内蔵オーディオ・
ジェネレータを使用している場合にのみ有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Upper Freq］および［Lower Freq］で周波数
値を設定することにより、上側周波数と下側周波数の値を定義することができます。

Upper Freq ［Upper Freq］ソフトキーを押して、上側基本波周波数値を設定します。この設定は、Freq Lockが Custom
に設定されている場合にのみ使用可能です。

Lower Freq ［Lower Freq］ソフトキーを押して、下側基本波周波数値を設定します。この設定は、Freq Lockが Custom
に設定されている場合にのみ使用可能です。
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Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。

表 7-45 SMPTE Level Sweep > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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DFD level sweep

DFDレベル掃引測定では、周波数の異なる最大 2つのトーンを 1つの入力信号に付加
して、レベルの範囲全体にわたって掃引します。その結果が X-Yグラフ上に表示され
ます。X軸にはジェネレータの掃引レベルまたは DUTのレベル測定値が、Y軸には
DFD比の測定値が表示されます。 

各結果のメニュー・ページの詳細については、「Measurement Results」（ページ）352
を参照してください。各タブ間の移動およびメニュー・ページの表示には、矢印キーを
使用します。

信号発生

図 7-47に示すように、DFD Level Sweep Signal Generation設定メニュー・ページが表示
されます。

図 7-47 DFD Level Sweep > Signal Generation設定メニュー・ページ

注 この測定には、ジェネレータとアナライザの両方がテスト・セットアップに使用される
閉ループ構成が必要です。出力設定チャネルに対して Noneを選択した場合は、この測
定は使用できません。

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
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表 7-46 DFD Level Sweep > Signal Generation設定メニューの概要

メニュー 概要

Waveform

［Waveform］ソフトキーを押して、波形タイプを選択します。
– IEC60118

– IEC60268

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Sweep Config

［Sweep Config］ソフトキーを押して、掃引設定を行います。
– Start
掃引パラメータのスタート値を設定します。

– Stop
掃引パラメータのストップ値を設定します。

– Spacing
掃引間隔として、Log、Linearまたは Customを選択します。

– Points
掃引ポイント数を設定します。

– Step Size
リニア間隔のステップ幅を選択します。この設定は、Spacingが Linearに設定されている場合にのみ
使用可能です。

– Dwell Time
掃引ポイント間の遅延を設定します。

– Edit Points
個々のポイントの値の編集、ポイントの挿入／削除、ポイントのロード、ポイントの保存を行います。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Upper Freq
上側周波数値を設定します。

– Diff Freq
差周波数値を設定します。

– DC Offset
DCオフセット値を設定します。
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Signal analysis

図 7-48に示すように、DFD Level Sweep Signal Analysis設定メニュー・ページが表示さ
れます。

図 7-48 DFD Level Sweep > Signal Analysis設定メニュー・ページ

表 7-47 DFD Level Sweep > Signal Analysis設定メニューの概要

メニュー 概要

DFD order

［DFD order］ソフトキーを押して、測定する歪み成分の次数を選択します。
– 2nd

– 3rd

Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M
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Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。

表 7-47 DFD Level Sweep > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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DC level sweep

DCレベル掃引測定では、値の範囲全体にわたって一連のポイントで DC信号を掃引し、
DUTの出力をアナライザが捕捉します。その結果が X-Yグラフ上に表示されます。X
軸にはジェネレータの DCレベルが、Y軸には測定結果が表示されます。 入力設定で AC
結合を選択した場合でも、DCレベル掃引測定の実行中は一時的に DC結合に設定され
ます。

各結果のメニュー・ページの詳細については、「Measurement Results」（ページ）352
を参照してください。各タブ間の移動およびメニュー・ページの表示には、矢印キーを
使用します。

信号発生

図 7-49に示すように、DC Level Sweep Signal Generation設定メニュー・ページが表示さ
れます。

図 7-49 DC Level Sweep > Signal Generation設定メニュー・ページ

注 この測定には、ジェネレータとアナライザの両方がテスト・セットアップに使用される
閉ループ構成が必要です。出力設定チャネルに対して Noneを選択した場合は、この測
定は使用できません。

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。
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Signal analysis

図 7-50に示すように、DC Level Sweep Signal Analysis設定メニュー・ページが表示され
ます。

図 7-50 DC Level Sweep > Signal Analysis設定メニュー・ページ

表 7-48 DC Level Sweep > Signal Generation設定メニューの概要

メニュー 概要

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Sweep Config

［Sweep Config］ソフトキーを押して、掃引設定を行います。
– Start
掃引パラメータのスタート値を設定します。

– Stop
掃引パラメータのストップ値を設定します。

– Spacing
掃引間隔として、Log、Linearまたは Customを選択します。

– Points
掃引ポイント数を設定します。

– Step Size
リニア間隔のステップ幅を選択します。この設定は、Spacingが Linearに設定されている場合にのみ
使用可能です。

– Dwell Time
掃引ポイント間の遅延を設定します。

– Edit Points
個々のポイントの値の編集、ポイントの挿入／削除、ポイントのロード、ポイントの保存を行います。
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表 7-49 DC Level Sweep > Signal Analysis設定メニューの概要

メニュー 概要

LPF

［LPF］ソフトキーを押して、ローパス・フィルタを選択します。
– None

– 2 kHz

– 3 kHz

– 5 kHz

– 8 kHz

– 10 kHz

– 15 kHz

– 20 kHz

– 22 kHz

– 30 kHz

– 40 kHz

– 50 kHz

– 80 kHz

– Custom

HPF

［HPF］ソフトキーを押して、ハイパス・フィルタを選択します。
– None

– 15 Hz

– 20 Hz

– 22 Hz

– 30 Hz

– 50 Hz

– 70 Hz

– 100 Hz

– 200 Hz

– 300 Hz

– 400 Hz

– Custom

Weighting

［Weighting］ソフトキーを押して、評価雑音フィルタを選択します。
– None

– A

– CCIR 1k

– CCIR 2k

– CCITT

– C-Message

– Custom

Deemphasis

［Deemphasis］ソフトキーを押して、ディエンファシス・フィルタを選択します。
– None
– 50 μs
– 75 μs

– Custom
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Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。

表 7-49 DC Level Sweep > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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Receiver sensitivity

レシーバ感度測定では、外部 RF（無線周波数）信号発生器を使用して作成した RF入
力信号が、パワーの範囲全体にわたって指定したポイント数で移動します。アナログ・
オーディオの DUT出力がアナライザによって捕捉され、表示用に処理されます。

レシーバ感度測定は通常、SINADの測定による無線機の感度の評価に用いられます。
SINADは、無線レシーバの RF感度を仕様化するのに用いられる音声品質の値です。
SINAD値が高いほど、オーディオ品質が高いことを示します。

図 7-51に、レシーバ感度測定用の一般的なセットアップを示します。信号発生器は独
自の変調機能を備え、U8903Bは信号発生器を Keysight 82357Bの USB/GPIBインタ
フェース経由で制御します。双方向無線機などのレシーバが、直接または音響カプラ経
由で U8903Bに接続されます。

図 7-51 レシーバ感度測定用の一般的なセットアップ

レシーバのオーディオ出力レベルを必要に応じて設定し、信号発生器の各種設定を目的
の値に設定します。U8903Bは、レシーバの出力で目標とする SINADが得られるよう
に、信号発生器からの RFパワー出力を自動的に調整します。目標とする SINAD値は通
常、通信用レシーバの場合で 12 dB、カーラジオや Hi-Fiチューナなどの放送用レシー
バの場合で 23 dB（モノラル）または 26 dB（ステレオ）です。

その結果が X-Yグラフ上に表示されます。X軸には RFパワー・パラメータが、Y軸に
は SINADの測定結果が表示されます。各結果のメニュー・ページの詳細については、
「Measurement Results」（ページ）352を参照してください。各タブ間の移動およびメ
ニュー・ページの表示には、矢印キーを使用します。
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信号発生
図 7-52に示すように、Receiver Sensitivity Signal Generation設定メニュー・ページが表
示されます。

図 7-52 Receiver Sensitivity > Signal Generation設定メニュー・ページ

表 7-50 Receiver Sensitivity > Signal Generation設定メニューの概要

メニュー 概要

Instrument
［Instrument］ソフトキーを押して、信号発生器モデルを選択します。

– KeysightE4438C

– Other

GPIB address ［GPIB address］ソフトキーを押して、接続された信号発生器の GPIBアドレスを設定します。

Start Power ［Start Power］ソフトキーを押して、掃引開始時の RFパワーを設定します。

Stop Power ［Stop Power］ソフトキーを押して、掃引停止時の RFパワーを設定します。

Step Size ［Step Size］ソフトキーを押して、ステップ幅を設定します。 

Dwell Time ［Dwell Time］ソフトキーを押して、各 SINAD測定値間の遅延を秒単位で設定します。

Init Instrument ［Init Instrument］ソフトキーを押して、U8903Bによる接続された信号発生器を初期化するための SCPIコ
マンドの送信をオン／オフします。

FM Frequency ［FM Frequency］ソフトキーを押して、RF信号の出力周波数を設定します。この設定は、
InstrumentKeysightが E4438Cに設定され、Init Instrumentがオンになっている場合にのみ使用可能です。

FM Deviation ［FM Deviation］ソフトキーを押して、RF信号の周波数変調偏移を設定します。この設定は、
InstrumentKeysightが E4438Cに設定され、Init Instrumentがオンになっている場合にのみ使用可能です。

FM Rate ［FM Rate］ソフトキーを押して、RF信号の内部周波数変調レートを設定します。この設定は、
Instrumentが Keysight E4438Cに設定され、Init Instrumentがオンになっている場合にのみ使用可能です。
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Signal analysis

図 7-53に示すように、Receiver Sensitivity Signal Analysis設定メニュー・ページが表示
されます。

図 7-53 Receiver Sensitivity > Signal Analysis設定メニュー・ページ

Init SCPI
［Init SCPI］ソフトキーを押して、接続された信号発生器を初期化する SCPIコマンドを設定します。SCPI
コマンドは、直接設定することも、ファイルからロードすることもできます。この設定は、Instrument
が Otherに設定され、Init Instrumentがオンになっている場合にのみ使用可能です。

Output Power SCPI

［Output Power SCPI］ソフトキーを押して、接続された信号発生器の RFパワーを調整する SCPIコマンド
を編集します。コマンドのパターンは以下のとおりです。
Cmds <val>

Cmdsは SCPIコマンドで、<val>は掃引を実行するために測定で埋められる値です。例：POW 
<val>DBM。この設定は、Instrumentが Otherに設定されている場合にのみ使用可能です。

表 7-50 Receiver Sensitivity > Signal Generation設定メニューの概要（続き）

メニュー 概要

表 7-51 Receiver Sensitivity > Signal Analysis設定メニューの概要

メニュー 概要

Meas Channel ［Meas Channel］ソフトキーを押して、測定チャネル番号を設定します。

Target SINAD ［Target SINAD］ソフトキーを押して、Meas Channelから測定するターゲットの SINAD値を設定します。

Min 1st Value ［Min 1st Value］ソフトキーを押して、最初の値の最小値を設定します。

Stop Condition

［Stop Cond ition］ソフトキーを押して、ストップ条件を選択します。
– Until End

– On Target
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Freq Lock

［Freq Lock］ソフトキーを押して、基本波周波数の探索方法を選択します。
– Auto
［Auto］を選択した場合は、U8903Bは基本波周波数を自動的に探索します。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Fund Freq］で周波数値を設定することによ
り、基本波周波数値を定義することができます。

Fund Freq ［Fund Freq］ソフトキーを押して、基本波周波数値を設定します。この設定は、Freq Lockが Customに設
定されている場合にのみ使用可能です。

LPF

［LPF］ソフトキーを押して、ローパス・フィルタを選択します。
– None

– 2 kHz

– 3 kHz

– 5 kHz

– 8 kHz

– 10 kHz

– 15 kHz

– 20 kHz

– 22 kHz

– 30 kHz

– 40 kHz

– 50 kHz

– 80 kHz

– Custom

HPF

［HPF］ソフトキーを押して、ハイパス・フィルタを選択します。
– None

– 15 Hz

– 20 Hz

– 22 Hz

– 30 Hz

– 50 Hz

– 70 Hz

– 100 Hz

– 200 Hz

– 300 Hz

– 400 Hz

– Custom

Weighting

［Weighting］ソフトキーを押して、評価雑音フィルタを選択します。
– None

– A

– CCIR 1k

– CCIR 2k

– CCITT

– C-Message

– Custom

表 7-51 Receiver Sensitivity > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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Deemphasis

［Deemphasis］ソフトキーを押して、ディエンファシス・フィルタを選択します。
– None
– 50 μs
– 75 μs

– Custom

Notch Fil ter

［Notch Fil ter］ソフトキーを押して、ノッチ・フィルタの設定を行います。
– HP8903B

HP8903Bノッチ・フィルタ・モードをオン／オフします。
– Custom Notch
カスタム・ノッチ・フィルタをオン／オフします。

– Center Freq
中心周波数値を設定します。Custom Notchがオンになっている場合にのみ使用可能です。

– Bandwidth
帯域幅値を設定します。Custom Notchがオンになっている場合にのみ使用可能です。

Average Points
［Average Points］を押して、平均値計算に使用する測定値の個数を設定します。これは、ノイズの多い
信号に有用です。アベレージング・ポイントを適用することにより、測定値の不一致の原因となる雑音
によるばらつきが平滑化されます。 

Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。

表 7-51 Receiver Sensitivity > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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External level sweep

各結果のメニュー・ページの詳細については、「Measurement Results」（ページ）352
を参照してください。各タブ間の移動およびメニュー・ページの表示には、矢印キーを
使用します。

信号発生
図 7-54に示すように、External Level Sweep Signal Generation設定メニュー・ページが
表示されます。

図 7-54 External Level Sweep > Signal Generation設定メニュー・ページ

表 7-52 External Level Sweep > Signal Generation設定メニューの概要

メニュー 概要

Instrument

［Instrument］ソフトキーを押して、測定器モデルを選択します。
– Keysight 33220A
– Keysight 33250A
– Keysight 33500A
– Keysight 33600A

– その他

GPIB Address
［GPIB Address］ソフトキーを押して、GPIBアドレスを選択します。

– 0～ 30

Init Instrument
［Init Instrument］ソフトキーを押して、U8903Bによる接続された信号発生器を初期化するための SCPIコ
マンドの送信をオン／オフします。
signal generator.

Init SCPI

［Init SCPI］ソフトキーを押して、接続測定器を初期化する SCPIコマンドを設定します。SCPIコマンド
は、直接設定することも、ファイルからロードすることもできます。
– Edit

– Import（［Recall］メニュー・ページの詳細については、「Recall」（ページ）87を参照してください）。
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Sweep SCPI

［Sweep SCPI］ソフトキーを押して、接続測定器を初期化する掃引用 SCPIコマンドを設定します。SCPI
コマンドは、直接設定することも、ファイルからロードすることもできます。
– Edit

– Import（［Recall］メニュー・ページの詳細については、「Recall」（ページ）87を参照してください）。

Sweep Config

［Sweep Config］ソフトキーを押して、掃引設定を行います。
– Start
掃引パラメータのスタート値を設定します。

– Stop
掃引パラメータのストップ値を設定します。

– Spacing
掃引間隔として、Log、Linearまたは Customを選択します。

– Points
掃引ポイント数を設定します。

– Step Size
リニア間隔のステップ幅を選択します。この設定は、Spacingが Linearに設定されている場合にのみ
使用可能です。

– Dwell Time
掃引ポイント間の遅延を設定します。

– Edit Points
個々のポイントの値の編集、ポイントの挿入／削除、ポイントのロード、ポイントの保存を行います。

表 7-52 External Level Sweep > Signal Generation設定メニューの概要（続き）

メニュー 概要
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Signal analysis

図 7-55に示すように、External Level Sweep Signal Analysis設定メニュー・ページが表示
されます。

図 7-55 External Level Sweep > Signal Analysis設定メニュー・ページ

表 7-53 External Level Sweep > Signal Analysis設定メニューの概要

メニュー 概要

Freq Lock

［Freq Lock］ソフトキーを押して、基本波周波数の探索方法を選択します。
– Auto
［Auto］を選択した場合は、U8903Bは基本波周波数を自動的に探索します。

– Gen Lock
［Gen Lock］を選択した場合は、U8903Bは各ジェネレータ・チャネルの周波数値に基づいて基本波周
波数を探索します。この Gen Lock方法は、内蔵オーディオ・ジェネレータを使用している場合にの
み有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Fund Freq］で周波数値を設定することによ
り、基本波周波数値を定義することができます。

Fund Freq ［Fund Freq］ソフトキーを押して、基本波周波数値を設定します。この設定は、Freq Lockが Customに設
定されている場合にのみ使用可能です。
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LPF

［LPF］ソフトキーを押して、ローパス・フィルタを選択します。
– None

– 2 kHz

– 3 kHz

– 5 kHz

– 8 kHz

– 10 kHz

– 15 kHz

– 20 kHz

– 22 kHz

– 30 kHz

– 40 kHz

– 50 kHz

– 80 kHz

– Custom

HPF

［HPF］ソフトキーを押して、ハイパス・フィルタを選択します。
– None

– 15 Hz

– 20 Hz

– 22 Hz

– 30 Hz

– 50 Hz

– 70 Hz

– 100 Hz

– 200 Hz

– 300 Hz

– 400 Hz

– Custom

Weighting

［Weighting］ソフトキーを押して、評価雑音フィルタを選択します。
– None

– A

– CCIR 1k

– CCIR 2k

– CCITT

– C-Message

– Custom

Deemphasis

［Deemphasis］ソフトキーを押して、ディエンファシス・フィルタを選択します。
– None
– 50 μs
– 75 μs

– Custom

表 7-53 External Level Sweep > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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Notch Fil ter

［Notch Fil ter］ソフトキーを押して、ノッチ・フィルタの設定を行います。 
– HP8903B

HP8903Bモードをオン／オフします。
– Custom Notch
カスタム・ノッチをオン／オフします。

– Center Freq
中心周波数値を設定します。

– Bandwidth
帯域幅値を設定します。

Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。

表 7-53 External Level Sweep > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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Measurement recorder

測定レコーダは、多数の測定値を経過時間と対比して記録するツールです。DUTの出
力を長期間にわたってモニタするのに便利です。 測定レコーダは特定のテスト信号を必
要としません。アナライザの入力レンジ内の任意のオーディオ信号を用いることができ
ます。信号を用いなくても大丈夫です。

測定レコーダの測定速度は、チャネル数、サンプル・サイズ、結果のタイプによって異
なります。読み値は、測定開始時および経過時間までの設定された持続時間を通して得
られます。

その結果が X-Yグラフ上に表示されます。X軸には時間パラメータが、Y軸には DUT
の測定結果（AC Level、Gain、Phase、THD+N Ratio、THD+N Level、DC Level、
Frequency、SINAD）が表示されます。各結果のメニュー・ページの詳細については、
「Measurement Results」（ページ）352を参照してください。各タブ間の移動およびメ
ニュー・ページの表示には、矢印キーを使用します。

注 – 位相結果については、自動レンジ切替えはサポートされていません。

– 出力設定で AC結合を選択した場合は、DCレベル結果は使用できません。
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信号発生

図 7-56に示すように、Measurement Recorder Signal Generation設定メニュー・ページ
が表示されます。

図 7-56 Measurement Recorder > Signal Generation設定メニュー・ページ

注 出力設定チャネルに対して Noneを選択した場合は、信号発生はオフになります。

表 7-54 Measurement Recorder > Signal Generation設定メニューの概要

メニュー 概要

Waveform

［Waveform］ソフトキーを押して、波形タイプを選択します。
– Sine

– Variable Phase

– Square

– Arbitrary

Output ［Output］ソフトキーを押して、出力チャネルを選択します。

Waveform Config

［Waveform Config］ソフトキーを押して、波形の設定を行います。 
– Track 1st Ch

Track 1st Chをオンにした場合は、ジェネレータ・チャネル 1の波形設定が他のチャネルにコピーされ
ます。他のチャネルの波形設定を編集することはできません。チャネル 1の波形設定に対して行っ
た変更は、他のチャネルの波形設定に反映されます。Track 1st Chをオフにして、個々のチャネルを設
定します。

– Frequency
周波数値を設定します。

– Amplitude
振幅値を設定します。

– DC Offset
DCオフセット値を設定します。
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Signal analysis

図 7-57に示すように、Measurement Recorder Signal Analysis設定メニュー・ページが表
示されます。

図 7-57 Measurement Recorder > Signal Analysis設定メニュー・ページ

表 7-55 Measurement Recorder > Signal Analysis設定メニューの概要

メニュー 概要

Duration

［Duration］ソフトキーを押して、測定レコード長を設定します。持続時間のパターンは以下のとおりです。
hh:mm:ss

hhは時間、mmは分、ssは秒です。 
最小持続時間は 0秒、最大持続時間は 3日（71:59:59）です。 持続時間を 0 sに設定した場合は、1回
の測定が実行されます。

Ref Channel ［Ref Channel］ソフトキーを押して、基準チャネル番号を設定します。各チャネルの基準チャネルに対
する位相を測定します。基準チャネルの位相結果は常にゼロと表示されます。

Freq Lock

［Freq Lock］ソフトキーを押して、基本波周波数の探索方法を選択します。
– Auto
［Auto］を選択した場合は、U8903Bは基本波周波数を自動的に探索します。

– Gen Lock
［Gen Lock］を選択した場合は、U8903Bは各ジェネレータ・チャネルの周波数値に基づいて基本波周
波数を探索します。この Gen Lock方法は、内蔵オーディオ・ジェネレータを使用している場合にの
み有効です。

– Custom
既知の入力信号の場合は、探索方法を Customに設定し、［Fund Freq］で周波数値を設定することによ
り、基本波周波数値を定義することができます。

Fund Freq ［Fund Freq］ソフトキーを押して、基本波周波数値を設定します。この設定は、Freq Lockが Customに設
定されている場合にのみ使用可能です。
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LPF

［LPF］ソフトキーを押して、ローパス・フィルタを選択します。
– None

– 2 kHz

– 3 kHz

– 5 kHz

– 8 kHz

– 10 kHz

– 15 kHz

– 20 kHz

– 22 kHz

– 30 kHz

– 40 kHz

– 50 kHz

– 80 kHz

– Custom

HPF

［HPF］ソフトキーを押して、ハイパス・フィルタを選択します。
– None

– 15 Hz

– 20 Hz

– 22 Hz

– 30 Hz

– 50 Hz

– 70 Hz

– 100 Hz

– 200 Hz

– 300 Hz

– 400 Hz

– Custom

Weighting

［Weighting］ソフトキーを押して、評価雑音フィルタを選択します。
– None

– A

– CCIR 1k

– CCIR 2k

– CCITT

– C-Message

– Custom

Deemphasis

［Deemphasis］ソフトキーを押して、ディエンファシス・フィルタを選択します。
– None
– 50 μs
– 75 μs

– Custom

表 7-55 Measurement Recorder > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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Sample Size

［Sample Size］ソフトキーを押して、測定のために収集するサンプル数を選択します。 
– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

Input Range

［Input Range］ソフトキーを押して、入力レンジの設定を行います。
– Auto Range
自動入力レンジをオン／オフします。
Auto Rangeをオンにした場合は、各アナログ・チャネルの入力レンジが、入力信号のレベルに応じて
自動的に決定されます。入力信号レベルがレンジしきい値を超えて変化した場合、Auto Rangeでは、
レンジを適切に切り替えるために、入力レンジ切替え回路が動作します。
Auto Rangeをオフにした場合は、各アナログ入力チャネルに対して一定の入力電圧レンジを設定でき
ます。

– Track 1st Ch
Track 1st Chをオンにした場合は、他のすべてのチャネルがチャネル 1のレンジ設定に従うように設定
されます。チャネル 1のレンジ設定に対して行った変更は、他のチャネルに反映されます。Track 1st 
Chをオフにして、個々のチャネルを設定します。

– Voltage Range
入力電圧レンジを設定します。

表 7-55 Measurement Recorder > Signal Analysis設定メニューの概要（続き）

メニュー 概要
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Voice quality

POLQA（Perceptual Objective Listening Quality Assessment）は、固定、モバイル、IP
ベースのネットワークのための次世代の音声品質テスト・テクノロジーです。POLQA
は、国際電気通信連合（ITU-T）によって P.863として標準化された新しい勧告で、適
用対象はハイビジョン音声、3G、4G/LTEネットワークの音声品質解析です。POLQA
は、OPTICOM GmbHからライセンスを受けています。

POLQAは、3Gのベンチマークの正確性を大幅に高めます。また、2001年に公表され
た PESQ/P8.862に比べて、ユニファイド・コミュニケーション、次世代ネットワーク、
4G/LTEなどの最新テクノロジーのテストを強力にサポートしています。

POLQA測定の動作モデルは、デジタル音声信号を解析することによって音声品質を予
測することを目的としています。主観的なリスニング・テストで得られるような主観的
な品質スコアに、客観的指標をできるだけ近付ける必要があります。POLQA測定では
通常、実際の音声をテスト・スティミュラス信号として使用して、テレフォニー・ネッ
トワークの品質と性能を評価します。POLQA測定は、PESQ/P8.862測定に代わる測定
です。

選択したすべてのチャネルの音声品質測定の結果が棒グラフに表示されます
（MOS-LQOと Levels）。各結果のメニュー・ページの詳細については、「Measurement 
Results」（ページ）352を参照してください。各タブ間の移動およびメニュー・ページ
の表示には、矢印キーを使用します。

注 POLQA測定と PESQ測定は、N3432Aと N3433Aでのみ使用可能です。 詳細について
は、「U8903Bオプション」（ページ）33を参照してください。

注 本製品に搭載された ITU-T勧告 P. 863に準拠した POLQA（Perceptual Objective 
Listening Quality Analysis）は、著作権、および欧州や米国などの国際特許／特許出願に
よって保護されており、OPTICOM Dipl.-Ing. M. Keyhl GmbH, Erlangen, Germany, 2011 
（www.opticom.de）からライセンスを受けて提供されています。

POLQA®は、OPTICOM GmbHの登録商標です。 許可を得て使用しています。 

© 2011 by the POLQA Coalition of OPTICOM GmbH, Germany - SwissQual AG, Switzerland 
- KPN, The Netherlands - TNO, The Netherlands. 

POLQAソフトウェアを複写、変更、翻訳、分解模倣、逆コンパイルすることは禁止さ
れています。POLQAソフトウェアに関する権利の承諾を、POLQAソフトウェアまたは
それをインストールしたものから削除してはなりません。

詳細については、www.polqa.infoをご覧ください。
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Signal generation and analysis

図 7-58に示すように、Voice Quality Signal Generation/Signal Analysis設定メニュー・
ページが表示されます。

図 7-58 Voice Quality > Signal Generation/Signal Analysis設定メニュー・ページ

表 7-56 Voice Quality > Signal Generation/Signal Analysis設定メニューの概要

メニュー 概要

Test Config
(POLQA)

［Test Config］ソフトキーを押して、テストの設定を行います。
– Test Standard
テスト標準として、POLQAまたは PESQを選択します。

– Analysis Mode
POLQA解析モードとして、Basicまたは Advancedを選択します。ベーシック・モードでは、信号劣化
の量がわかっている基準波形ファイルをダウンロードして、解析を自動的に実行することができま
す。アドバンスド・モードでは、波形ファイルの再生／記録、解析を自動的に実行することができ
ます。

– Bandwidth
帯域幅タイプとして、Narrowbandまたは Super Widebandを選択します。

– Auto Lvl Align
自動レベル調整をオン／オフします。

– Auto Fs
入力信号の適切なサンプリング・レートへのリサンプリングをオン／オフします。すべての狭帯域
モード入力ファイルとスーパーワイドバンド入力ファイルのサンプリング・レートが、それぞれ 8 
kHzと 48 kHzにリサンプリングされます。

– Target Fs
狭帯域のサンプリング・レートを選択します（8 kHz、16 kHz、48 kHz）。この設定は、Bandwidthが
Narrowbandの場合にのみ適用可能です。
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Test Config
(PESQ)

［Test Config］ソフトキーを押して、テストの設定を行います。
– Test Standard
テスト標準として、POLQAまたは PESQを選択します。

– Analysis Mode
PESQ解析モードとして、Select Basicまたは Advancedを選択します。ベーシック・モードでは、信号
劣化の量がわかっている基準波形ファイルをダウンロードして、解析を自動的に実行することがで
きます。アドバンスド・モードでは、波形ファイルの再生／記録、解析を自動的に実行することが
できます。

– Bandwidth
帯域幅タイプとして、Narrowbandまたは Widebandを選択します。

– Target Fs
狭帯域のサンプリング・レートを選択します（8 kHzおよび 16 kHz）。この設定は、Bandwidthが
Narrowbandの場合にのみ適用可能です。

Playback File Path
［Playback File Path］ソフトキーを押して、使用する再生波形ファイル・ソースを選択します。［Recall］
メニュー・ページの詳細については、「Recall」（ページ）87を参照してください。この設定は、Test 
Configの Analysis Modeが Basicに設定されている場合にのみ使用可能です。

Degraded File Path
［Degraded File Path］ソフトキーを押して、使用する劣化済み波形ファイル・ソースを選択します。
［Recall］メニュー・ページの詳細については、「Recall」（ページ）87を参照してください。この設定
は、Test Configの Analysis Modeが Basicに設定されている場合にのみ使用可能です。

Reference Source

［Reference Source］ソフトキーを押して、基準ソースの設定を行います。この設定は、Test Configの
Analysis Modeが Advancedに設定されている場合にのみ使用可能です。
– Source
基準ソースとして、ファイルまたはジェネレータを選択します。

– Playback File
使用する再生波形ファイル・ソースを選択します。この設定は、Sourceが Fileに設定されている場合
にのみ使用可能です。

– Playback Ch
基準ファイルまたは波形を再生するジェネレータ・チャネルを選択します。

– Use PB as Ref
基準ファイルとしての再生をオン／オフします。

– Ref File from AA
アナログ・アナライザの基準ファイルをオン／オフします。

– Ref File
基準ファイルを選択します。

– Save Rec File
レコード・ファイルの保存をオン／オフします。この設定は、Ref File from AAがオンになっている場
合にのみ使用可能です。

– Record File
レコード・ファイルを選択します。この設定は、Save Rec Fileがオンになっている場合にのみ使用可
能です。

– Recording Ch
基準ファイルとして、アナライザ・チャネルを選択します。この設定は、Save Rec Fileがオンになっ
ている場合にのみ使用可能です。

– Rec Duration
アナライザ・チャネルからのレコーディング時間を設定します。この設定は、Save Rec Fileがオンに
なっている場合にのみ使用可能です。

– Auto Start Rec
記録の自動開始をオン／オフします。この設定は、Save Rec Fileがオンになっている場合にのみ使用
可能です。

– Delay
ジェネレータをオンにしてから記録を実行するまでの遅延を秒単位で設定します。この設定は、
Record ing Chがアナライザ・チャネルに設定されている場合にのみ使用可能です。

– Save to File
基準ファイルの自動保存をオン／オフします。この設定は、Recording Chがアナライザ・チャネルに
設定されている場合にのみ使用可能です。

– Save File Path
基準ファイルの保存場所を設定します。この設定は、Save to Fileがオンになっている場合にのみ使用
可能です。

表 7-56 Voice Quality > Signal Generation/Signal Analysis設定メニューの概要（続き）

メニュー 概要
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Degraded Source

［Degraded Source］ソフトキーを押して、劣化済みソースの設定を行います。この設定は、Test Configの
Analysis Modeが Advancedに設定されている場合にのみ使用可能です。
– Source
劣化済みソースとして、ファイルまたはアナライザ・チャネルを選択します。

– Save Rec File
レコード・ファイルの保存をオン／オフします。この設定は、Sourceがアナライザ・チャネルに設
定されている場合にのみ使用可能です。

– Rec Duration
劣化済み波形ファイルのレコーディング時間を設定します。この設定は、Sourceがアナライザ・
チャネルに設定されている場合にのみ使用可能です。

– Auto Start Rec
記録の自動開始をオン／オフします。この設定は、Sourceがアナライザ・チャネルに設定されてい
る場合にのみ使用可能です。

– Delay
ジェネレータをオンにしてから記録を実行するまでの遅延を秒単位で設定します。この設定は、
Sourceがアナライザ・チャネルに設定されている場合にのみ使用可能です。

– Degraded File
使用する劣化済み波形ファイル・ソースを選択します。この設定は、Sourceが Fileに設定されている
場合にのみ使用可能です。

IO Config

［IO Config］ソフトキーを押して、IO設定を行います。
– Output Level
出力レベル値を設定します。

– Input Range
入力レンジの値を選択します。

Show/Hide POLQA 
License ［Show/Hide POLQA License］ソフトキーを押して、POLQAライセンス情報を表示したり、非表示にします。

表 7-56 Voice Quality > Signal Generation/Signal Analysis設定メニューの概要（続き）

メニュー 概要
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Measurement Results

テスト・シーケンス・アプリケーションを使用すれば、測定結果を棒グラフまたはグラ
フに表示することができます。

棒グラフ
Result（棒グラフ）メニュー・ページの表示例を、図 7-59に示します。

図 7-59 AC Level > Settings > Result (AC level)メニュー・ページ

表 7-57 TSA > Project > Test > Measurement > Settings > Result（棒グラフ）メニューの概要

メニュー 概要

Enable ［Enable］ソフトキーを押して、選択した結果タブをオン／オフします。

Add Result ［Add Resul t］ソフトキーを押して、新しい結果タブを測定に追加します。

Delete Resul t ［Delete Resul t］ソフトキーを押して、選択した結果タブを測定から削除します。

Save Data
［Save Data］ソフトキーを押して、選択した結果データを、内部ストレージまたは外部 USBフラッ
シュ・メモリの CSVファイル・フォーマットに保存します。Saveメニュー・ページについては、
「Save」（ページ）86を参照してください。
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Graph

Result（グラフ）メニュー・ページの表示例を、図 7-60に示します。

図 7-60 Multitone Analyzer > Settings > Result (Spectrum)メニュー・ページ

Ed it Limits

［Edit Limits］ソフトキーを押して、リミット値設定を行います。
– Track 1st

Track 1stトレースをオンにした場合は、チャネル 1のリミット値設定が他のチャネルにコピーされま
す。他のチャネルのリミット値設定を編集することはできません。チャネル 1のリミット値設定に
対して行った変更は、他のチャネルのリミット値設定に再現されます。Track 1stトレースをオフにし
て、個々のチャネルのリミット値を設定します。

– Lower Limit
下限値をオン／オフします。

– Upper Limit
上限値をオン／オフします。

– Lower Limit
下限値を設定します。

– Upper Limit
上限値を設定します。

Graph Properties

［Graph Properties］ソフトキーを押して、グラフのプロパティを設定します。
– Title
棒グラフのタイトルを編集します。

– X-axis
– Auto Scale

X軸のオートスケールをオン／オフします。
– Unit

X軸の単位タイプを選択します。
– Left

X軸の左側エッジの値を設定します。この設定は、Auto Scaleがオフの場合にのみ使用可能です。
– Right

X軸の右側エッジの値を設定します。この設定は、Auto Scaleがオフの場合にのみ使用可能です。

表 7-57 TSA > Project > Test > Measurement > Settings > Result（棒グラフ）メニューの概要（続き）

メニュー 概要
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表 7-58 TSA > Project > Test > Measurement > Settings > Result（グラフ）メニューの概要

メニュー 概要

Enable ［Enable］ソフトキーを押して、選択した結果タブをオン／オフします。

Add Result ［Add Resul t］ソフトキーを押して、新しい結果タブを測定に追加します。

Delete Resul t ［Delete Resul t］ソフトキーを押して、選択した結果タブを測定から削除します。

Save Data
［Save Data］ソフトキーを押して、選択した結果データを、内部ストレージまたは外部 USBフラッ
シュ・メモリの CSVファイル・フォーマットに保存します。Saveメニュー・ページについては、
「Save」（ページ）86を参照してください。

Ed it Limits

［Edit Limits］ソフトキーを押して、リミット値設定を行います。
– Trace
トレース・チャネル番号またはトレース・タイプ（POLQA測定）を選択します。

– Limit Type
リミット・タイプとして、Upperまたは Lowerを選択します。

– Track 1st
Track 1stトレースをオンにした場合は、チャネル 1のリミット値設定が他のチャネルにコピーされま
す。他のチャネルのリミット値設定を編集することはできません。チャネル 1のリミット値設定に
対して行った変更は、他のチャネルのリミット値設定に再現されます。Track 1stトレースをオフにし
て、個々のチャネルのリミット値を設定します。

– Limit
リミット値をオン／オフします。

– Points

– Point No
ポイント番号を設定します。

– X
選択したポイント番号の X軸の値を設定します。

– Y
選択したポイント番号の Y軸の値を設定します。

– Add Point
リミット・ポイントを追加します。

– Remove Point
選択したリミット・ポイントを削除します。

– Clear Points
すべてのリミット・ポイントをクリアします。

– Load Points
リミット・ポイントをファイルからロードします。Recallメニュー・ページについては、「Recall」
（ページ）87を参照してください。

– Save Points
選択したリミット・ポイントをファイルに保存します。Saveメニュー・ページについては、「Save」
（ページ）86を参照してください。
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Graph Properties

［Graph Properties］ソフトキーを押して、グラフのプロパティを設定します。
– Title
グラフのタイトルを編集します。

– X-axis

– Auto Scale
X軸のオートスケールをオン／オフします。

– Spacing
間隔として、Linearまたは Logを選択します。

– Unit
X軸の単位タイプを選択します。

– Left
X軸の左側エッジの値を設定します。この設定は、Auto Scaleがオフの場合にのみ使用可能です。

– Right
X軸の右側エッジの値を設定します。この設定は、Auto Scaleがオフの場合にのみ使用可能です。

– Center
X軸の中央値を設定します。この設定は、Auto Scaleがオフの場合にのみ使用可能です。

– Span
X軸のスパン値を設定します。この設定は、Auto Scaleがオフの場合にのみ使用可能です。

– Y軸
– Auto Scale

Y軸のオートスケールをオン／オフします。
– Spacing
間隔として、Linearまたは Logを選択します。

– Unit
Y軸の単位タイプを選択します。

– Top
Y軸の上側値を設定します。この設定は、Auto Scaleがオフの場合にのみ使用可能です。

– Bottom
Y軸の下側値を設定します。この設定は、Auto Scaleがオフの場合にのみ使用可能です。

– Traces 

– Trace
アナライザのトレース・チャネルを選択します。

– State
トレースをオン／オフします。

– Color
トレースの色を選択します。

Graph Properties

（POLQA測定の
MOS-LQOおよび Delay
の結果にのみ適用
可能）

［Graph Properties］ソフトキーを押して、グラフのプロパティを設定します。
– Title
棒グラフのタイトルを編集します。

– Auto Scale
オートスケールをオン／オフします。

– Left
X軸の左側エッジの値を設定します。この設定は、Auto Scaleがオフの場合にのみ使用可能です。

– Right
X軸の右側エッジの値を設定します。この設定は、Auto Scaleがオフの場合にのみ使用可能です。

– Top
Y軸の上側エッジの値を設定します。この設定は、Auto Scaleがオフの場合にのみ使用可能です。

– Bottom
Y軸の下側エッジの値を設定します。この設定は、Auto Scaleがオフの場合にのみ使用可能です。

表 7-58 TSA > Project > Test > Measurement > Settings > Result（グラフ）メニューの概要（続き）

メニュー 概要
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Report

U8903Bでは、テスト・シーケンスの結果レポートを作成することができます。図 7-61
に示すように、［TSA > Report］メニュー・ページが表示されます。

図 7-61 TSA > Reportメニュー・ページ

表 7-59 TSA > Reportメニューの概要

メニュー 概要

Clear ［Clear］ソフトキーを押して、すべてのレポート・データをクリアします。

Save ［Save］ソフトキーを押して、レポートを DOCXファイル・フォーマットに保存します。［Save］メ
ニュー・ページの詳細については、「Save」（ページ）86を参照してください。

プロパティ
［Properties］ソフトキーを押して、自動保存の設定を行います。 詳細については、「Properties」（ペー
ジ）357を参照してください。
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Properties

図 7-62 TSA > Report > Propertiesメニュー・ページ

表 7-60 TSA > Report > Propertiesメニューの概要

メニュー 概要

Auto Save ［Auto Save］ソフトキーを押して、テスト・シーケンスの終了時のレポートの自動保存をオン／オフし
ます。

Format

［Format］ソフトキーを押して、保存するレポートのファイル・フォーマットを選択します。
– Docx

– Html

Name Option

［Name Option］ソフトキーを押して、自動保存するレポートのファイル名の命名規則を選択します。
– Timestamp
タイムスタンプの添え字が付いたファイル名でレポートを保存します。

– Numeric
数値の添え字が付いたファイル名でレポートを保存します。保存する度に数値が増えます。

– Prompt
テスト・シーケンスの終了時にファイル名を入力するように求めるプロンプトを表示します。

Prefix ［Prefix］ソフトキーを押して、ファイル名のプレフィックスを設定します。

Location ［Location］ソフトキーを押して、自動保存するレポートのフォルダを選択します。詳細については、
「Location」（ページ）358を参照してください。
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Location

リストの ‘...’を選択し、 を押すと、現在のフォルダから 1レベル上がり、別の

ディレクトリに移動します。矢印キーを使用して、ファイルを検索するか、目的のフォ
ルダまたはファイルを選択します。

［Select］ソフトキーを押して、現在のフォルダを保存場所として選択します。［New 
Folder］ソフトキーを押して、現在のディレクトリまたはフォルダに新しいフォルダを
作成します。

図 7-63 Select Pathメニュー・ページ

Enter
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8 HP 8903B

HP 8903B     360
Measurement     362
Generator     364
Sweep     365

スペシャル・ファンクション・コード・リスト     366
SPCL     368

この章では、HP8903Bモードの各種設定について説明します。

注 HP8903Bモードは、GPIBの初期化に成功した場合にのみ使用可能です。HP8903B
モードを開始／終了すると、システムがリセットされます。標準ビュー・モードで動作
するアナログ・アナライザとアナログ・ジェネレータのアクティブ・チャネルに対する
SCPIコマンドの一部は、HP8903Bモードでは動作しません。
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HP 8903B

を押し、［HP8903B］を選択して、［HP8903B］メニュー・ページにアクセスしま

す。U8903Bでは、HP8903Bオーディオ・アナライザの動作を HP8903Bモードでエ
ミュレートすることができます。

図 8-1 HP8903Bメニュー・ページ

Menu

1

2

3

4 5
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表 8-1 U8903B LCDディスプレイの概要

項目 概要

1 SINADメータ SINAD測定モードの読み値が表示されます。

2 アナライザ・パネル
測定結果が表示されます。左側には周波数の測定結果が、右側には選択した測
定モードの測定結果が表示されます。使用可能な測定モについては、
「Measurement」（ページ）362を参照してください。

3 ジェネレータ・パネル

正弦波波形の周波数値と振幅値が表示されます。赤で強調表示されているジェ
ネレータ・パラメータ・ラベルは、現在の増分パラメータを示します。上下の
矢印キーを使用して、現在のパラメータ値をパラメータ・ステップ値に応じて
増分／減分することができます。詳細にいては、「Generator」（ページ）364
を参照してください。

4 測定設定パネル 現在の測定設定が赤で表示されます。

5 HP8903B設定パネル
入力レンジ、ディテクタ、インピーダンス、掃引ポイントの現在の設定が表示
されます。オートレンジを選択した場合は、入力レンジパラメータが赤で強調
表示されます。
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Measurement

［HP8903B］メニュー・ページの［Measurement］を選択して、HP8903Bの測定の設定
を行います。

図 8-2 HP8903B > Measurementメニュー・ページ

表 8-2 HP8903B > Measurementメニューの概要

メニュー 概要

Function

［Function］ソフトキーを押して、HP8903Bの測定モードを選択します。
– AC LEVEL

– SINAD

– DISTN

– DC LEVEL

– SIG / NOISE

– DISTN LEVEL

LP Fil ter

［LP Fil ter］ソフトキーを押して、HP8903B測定のローパス・フィルタの値を選択します。デフォルトの
ローパス・フィルタは、「HP8903B Config」（ページ）81で設定できます。
– None

– 30 kHz

– 80 kHz

HP/W Fil ter ［HP/W Fil ter］ソフトキーを押して、HP8903Bハイパス／評価雑音フィルタの値を選択します。フィルタ
の選択は、「HP8903B Config」（ページ）81で設定した左フィルタと右フィルタに依存します。

Reference ［Reference］ソフトキーを押して、比モードの測定値と比較する基準値を設定します。基準値を変更す
ると、比測定モードがオンになります。

Ratio ［Ratio］ソフトキーを押して、HP8903B測定の比モードをオン／オフします。

Format

［Format］ソフトキーを押して、HP8903B測定のフォーマット・タイプを選択します。
– Log

– Lin
362 Keysight U8903B ユーザーズ・ガイド
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表 8-3に、HP8903Bの個々の測定モードに対応する測定単位を示します。

表 8-3 HP8903Bの単位表

測定 Ratio On Ratio Off

LOG LIN LOG LIN

AC LEVEL dB % dBm（600 Ω 負荷） V

DC LEVEL dB % dBm（600 Ω 負荷） V

SINAD dB % dB %

SIG/NOISE dB % dB %

DSTN dB % dB %

DSTN LEVEL dB % dBm（600 Ω 負荷） V
Keysight U8903B ユーザーズ・ガイド 363
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Generator

［HP8903B］メニュー・ページの［Generator］を選択して、HP8903Bのジェネレータの
設定を行います。

図 8-3 HP8903B > Generatorメニュー・ページ

注 HP8903Bのジェネレータは正弦波波形を出力します。

表 8-4 HP8903B > Generatorメニューの概要

メニュー 概要

Frequency ［Frequency］ソフトキーを押して、HP8903Bジェネレータの周波数値を設定します。周波数値を変更す
ると、ステップ・パラメータも周波数に設定されます。

Amplitude ［Amplitude］ソフトキーを押して、HP8903Bジェネレータの振幅値を設定します。振幅値を変更すると、
ステップ・パラメータも振幅に設定されます。

Step Param

［Step Param］ソフトキーを押して、HP8903Bジェネレータのステップ・パラメータ・タイプを選択します。
– Frequency

– Amplitude

Freq. Step ［Freq. Step］ソフトキーを押して、HP8903Bジェネレータの周波数のステップ値を設定します。この設
定は、ステップ・パラメータが周波数に設定されている場合にのみ使用可能です。

Amp. Step ［Amp. Step］ソフトキーを押して、HP8903Bジェネレータの振幅のステップ値を設定します。この設定
は、ステップ・パラメータが振幅に設定されている場合にのみ使用可能です。

× 10 ［× 10］ソフトキーを押して、現在のパラメータ・ステップ値に 10を乗算します。

÷ 10 ［÷ 10］ソフトキーを押して、現在のパラメータ・ステップ値を 10で除算します。
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Sweep

HP8903Bモードでは、信号源の周波数がログ間隔で掃引されます。掃引の周波数ポイ
ント数は、掃引幅（ストップ周波数とスタート周波数の比）と選択した掃引分解能に
よって決まります。掃引の最大許容ポイント数は 255です。掃引の周波数ポイントは、
次の式を使用して計算できます。

ここで、nは周波数ポイント番号（0がスタート周波数）、kはディケードごとのポイン
ト数です。表 8-6にリストされている HP8903Bのスペシャル・ファンクション・コー
ド（17.0～ 17.9）を参照してください。逆方向掃引の周波数ポイントの式は以下のと
おりです。

［HP8903B］メニュー・ページの［Sweep］を選択して、HP8903Bの掃引設定を行います。

図 8-4 HP8903B > Sweepメニュー・ページ

Frequency Start frequency 10

n
k
-- 
 

¥=

Frequency Start frequency 10

n–
k

---- 
 

¥=

表 8-5 HP8903B > Sweepメニューの概要

メニュー 概要

Freq. Start ［Freq. Start］ソフトキーを押して、HP8903Bの掃引周波数のスタート値を設定します。

Freq. Stop ［Freq. Stop］ソフトキーを押して、HP8903Bの掃引周波数のストップ値を設定します。

Sweep Status ［Sweep Status］ソフトキーを押して、HP8903Bモードでの掃引を開始／中断します。
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スペシャル・ファンクション・コード・リスト

［HP8903B］メニュー・ページの［Code List］を選択して、サポートされている
HP8903Bのスペシャル・ファンクション・コードのリストを表示します。図 8-5に示
すように、スペシャル・ファンクション・コードがメイン・ディスプレイの下部に表示
されます。上下の矢印キーを押して、選択したスペシャル・ファンクション・コード・
リストを 1つ 1つ上下にスクロールします。HP8903Bのスペシャル・ファンクショ
ン・コードを表 8-6に示します。

図 8-5 HP8903B > Code Listメニュー・ページ（Input Level Range (except DC Level)）

表 8-6 HP8903Bのスペシャル・ファンクション・コード・リストの概要

スペシャル・ファンクション コード 概要

Input Level Range (except DC Level)

1.0
1.3
1.4 ~ 1.5
1.6 ~ 1.8
1.9 ~ 1.10
1.11 ~ 1.13
1.14 ~ 1.15
1.16 ~ 1.19

オートレンジ
140 Vレンジ
100 Vレンジ
32 Vレンジ
10 Vレンジ
3.2 Vレンジ
1 Vレンジ
0.32 Vレンジ

Input Level Range (DC Level only)

2.0
2.2
2.3
2,4

オートレンジ
100 Vレンジ
32 Vレンジ
10 Vレンジ

Post Notch Detector Response (except in SINAD) 5.0 ~ 5.1 RMSディテクタ

Display Source Settings 10.0 ジェネレータ・メニューをオンにします

Re-enter Ratio Mode

11.0

11.1

直近の RATIO基準を復元し、可能であれば
RATIOモードに入ります
RATIO基準を表示します（測定メニューが
オンになります）
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Signal-to-Noise Measurement Delay

12.0
12.1
12.2
12.3
12.4
12.5
12.6
12.7
12.8
12.9

遅延なし
200 msの遅延
400 msの遅延
600 msの遅延
800 msの遅延
1.0 sの遅延
1.2 sの遅延
1.4 sの遅延
1.6 sの遅延
1.8 sの遅延

SINAD and Signal-to-Noise Display Resolution
16.0

16.1

0.01 dB（25 dB以上）
0.5 dB（25 dB以下）
0.01 dB（全レンジで）

Sweep Resolution (maximum 255 points/sweep)

17.0
17.1
17.2
17.3
17.4
17.5
17.6
17.7
17.8
17.9

10ポイント／ディケード
1ポイント／ディケード
2ポイント／ディケード
5ポイント／ディケード
10ポイント／ディケード
20ポイント／ディケード
50ポイント／ディケード
100ポイント／ディケード
200ポイント／ディケード
500ポイント／ディケード

Display Level in Watts
19.0
19.NNN

レベルを Wで表示します（8 Ω負荷）
レベルを Wで表示します（NNN W負荷）

Read Display to SCPI
20.0
20.1

右側のディスプレイを読み取ります
左側のディスプレイ（周波数）を読み取
ります

GPIB Address (SCPI Only) 21.1 GPIBアドレスを 10進数で表示します

GPIB Service Request Condition (SCPI Only) 22.N

Conditionをオンにして、サービス・リク
エストを出します Nは、以下の重み付き
条件の任意の組み合わせの和です。
1 - データ・レディ
2 - GPIBエラー
4 - 測定器エラー
22.2ステートで、測定器の電源が投入さ
れます。

Source Output Impedance (Instrument powers up at 600 Ω)
47.0
47.1

600 Ω
50 Ω

表 8-6 HP8903Bのスペシャル・ファンクション・コード・リストの概要（続き）

スペシャル・ファンクション コード 概要
Keysight U8903B ユーザーズ・ガイド 367
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SPCL

［SPCL］ソフトキーを押して、SCPI onlyと示されているものを除き、HP8903Bのスペ
シャル・ファンクション・コードを設定し、スペシャル・ファンクションを実行しま
す。HP8903Bのスペシャル・ファンクション・コードを表 8-6に示します。
368 Keysight U8903B ユーザーズ・ガイド
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9 特性と仕様
製品の特性

消費電力
≤250 VA

AC電源ライン要件
– 100 Vac～ 240 Vac

– 47 Hz～ 63 Hz

– 250 W

– 主電源の電圧変動は、公称電圧の ±10 ％を超えない

動作環境
「環境条件」（ページ）5を参照。

保管環境
「環境条件」（ページ）5を参照。

安全および EMC規格
「規制情報」（ページ）5を参照。

寸法（幅 ×奥行き ×高さ）
425.60 mm×430.00 mm×133.60 mm

質量
8.5 kg

保証
– 以下を参照：http://www.keysight.co.jp/go/warranty_terms

– 製品本体は 3年間
– 特に記載のない限り、標準付属品は 3ヶ月
370 Keysight U8903B ユーザーズ・ガイド
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仕様
以下の仕様は、特に記載のない限り、30分間のウォームアップ後、0 ℃～ 55 ℃の温度
における性能に基づいています。

アナログ・ジェネレータ仕様

出力仕様

発生波形

– 正弦波
– 可変位相
– デュアル正弦波
– SMPTE IMD（1:1/4:1/10:1）
– DFD IEC（IEC 60118/IEC 60268）
– 方形波
– 雑音（ガウシアン／方形／ピンク）
– DC信号
– マルチトーン
– 任意（.arbおよび .wavファイル）
– 波形ファイル再生 

– DTMF

コネクタ・タイプ
平衡
不平衡
コモン・モード

– XLR

– BNC

– XLR

インピーダンス
平衡

不平衡

コモン・モード

– 40 Ω
– 100 Ω
– 600 Ω

– 20 Ω
– 50 Ω
– 600 Ω

– 40 Ω
– 100 Ω
– 600 Ω
– 10 Ω（不平衡、IEC 60268に準拠）

グランド
– 真のフローティング
– グランド接続

最大出力パワー（600 Ω負荷）
平衡（600 Ω）
不平衡（600 Ω）

20 dBm
14 dBm
Keysight U8903B ユーザーズ・ガイド 371
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正弦波、デュアル正弦波、可変位相

デュアル正弦波比の範囲 0～ 100 ％

位相 － 180°～ 179.99°

掃引
– 周波数
– 振幅
– 位相

周波数
レンジ
確度
分解能

5 Hz～ 80 kHz

2 ppm＋ 100 μHz
0.1 Hz

出力
レンジ（平衡）
レンジ（不平衡／コモン）
電流制限値（代表値）
振幅確度（1 kHz）
振幅分解能
フラットネス（1 kHz基準）

5 Hz～ 20 kHz

5 Hz～ 80 kHz

0～ 16 Vrms

0～ 8 Vrms
50 mA

±0.09 dB（±1 ％）（0 ℃～ 55 ℃）
1 μVrms（分解能は 5桁に制限される）

±0.008 dB（＜ ±0.003 dB、代表値）
±0.08 dB

THDおよび THD＋ N

残留 THD＋ N（1 kHz、1 Vrms、
20 Hz～ 20 kHzの帯域幅）

残留 THD

≤－ 108 dB（＜－ 110 dB、代表値）（23 ℃ ±5 ℃）[a]

≤－ 100 dB（0 ℃～ 55 ℃）[a]

≤－ 87 dB

クロストーク
≤20 kHz ≤－ 130 dB＋ 0.1 μV

方形波

周波数レンジ 5 Hz～ 30 kHz

立ち上がり時間 <2 μs

出力
レンジ（平衡）
レンジ（不平衡／コモン）
振幅確度（1 kHz）

0～ 45.2 Vpp

0～ 22.6 Vpp
±1%

SMPTE IMD（1:1/4:1/10:1）

混合比（LF:HF）
– 10:1

– 4:1

– 1:1

残留 IMD（20 Hz～ 20 kHz）
– ≤－ 95 dB（23 ℃ ±5 ℃）
– ≤－ 90 dB（0 ℃～ 55 ℃）

掃引
– 上側周波数
– 下側周波数
– 振幅
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周波数
低周波（LF）トーン
高周波（HF）トーン

40 Hz～ 500 Hz

2 kHz～ 60 kHz

出力
レンジ（平衡）
レンジ（不平衡／コモン）

0～ 16 Vrms

0～ 8 Vrms

DFD（IEC 60118/IEC 60268）

固有歪み（20 Hz～ 20 kHz） ≤－ 106 dB（1 Vrms）

掃引
– 上側周波数
– 中心周波数
– 振幅

周波数
差周波数
上側周波数
中心周波数

80 Hz～ 2 kHz

3 kHz～ 80 kHz

3 kHz～ 79 kHz

出力
レンジ（平衡）
レンジ（不平衡／コモン）

0～ 16 Vrms

0～ 8 Vrms

雑音

タイプ
– ガウシアン
– 方形
– ピンク

出力
レンジ（平衡）

レンジ（不平衡／コモン）

– 0～ 7.2 Vrms（ガウシアン）
– 0～ 10 Vrms（方形）
– 0～ 7.2 Vrms（ピンク）
– 0～ 3.6 Vrms（ガウシアン）
– 0～ 5 Vrms（方形）
– 0～ 3.6 Vrms（ピンク）

任意波形

信号 ユーザ選択ファイルによって決定

サンプリング・レート 192 kHz

サンプル・サイズ 最大 800万ポイント

マルチトーン

信号 ユーザ指定の周波数、振幅、位相データによって決定

サンプリング・レート 192 kHz

長さ 1024～ 65536ポイント／チャネル

最大トーン数 60
Keysight U8903B ユーザーズ・ガイド 373
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波長ファイル再生

ファイルのタイプ .WAVファイル

サンプリング・レート 192 kHz

長さ 最大 5分 

DC

出力
レンジ（平衡）
レンジ（不平衡／コモン）
振幅確度

－ 22.6 V～ 22.6 V

－ 11.3 V～ 11.3 V
±1%

DCオフセット

可変位相、DC、方形波波形を除くすべての波形タイプに適用可能です。

出力レベル
範囲
振幅確度[b]

－ 11.3 V～ 11.3 V

±1.5 ％（±250 mV～ ±11.3 V）

[a] ジェネレータやアナライザの影響を含みます。個々の影響は通常、記載されている値を下回ります。

[b] DC出力と DCオフセット出力は、0～ ±250 mVで機能します。この範囲の振幅確度は保証されていません。
374 Keysight U8903B ユーザーズ・ガイド
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アナログ・アナライザ仕様

入力仕様

周波数レンジ 10 Hz～ 96 kHz

結合
– DC

– AC

入力レンジ
– 320 mV～ 140 Vrms[a]（不平衡）

– 320 mV～ 300 Vrms[a]（平衡）

測定範囲 ＜ 1 μ[b] V～ 300Vrms

最大定格入力 200 Vp（高度 3000 mまで）

入力保護
すべてのレンジでの過負荷保護、フロント・パネル画面に警告メッセージ
を表示

コネクタ・タイプ
平衡
不平衡

XLR
BNC

測定帯域幅
帯域幅 96 kHz

インピーダンス
平衡

不平衡

– 300 Ω（最大 3 W）
– 600 Ω（最大 1.5 W）
– 200 kΩ
– 300 Ω（最大 3 W）
– 600 Ω（最大 1.5 W）
– 100 kΩ

CMRR

≤20 kHz（入力レンジ ≤3.2 V）
≤20 kHz（入力レンジ＞ 3.2 V）

≥80 dB[c]

≥50 dB[c]

クロストーク
≤20 kHz ≤－ 140 dB＋ 0.1 μV

THD＋ Nおよび SINAD

表示範囲 － 999.999 dB～ 0 dB

確度
＜ 20 kHz

＜ 100 kHz

±0.5 dB
±0.7 dB

入力電圧レンジ ＜ 1 μV～ 140Vrms

3 dB測定帯域幅 96 kHz

検出 RMS

表示分解能 ％で小数点以下 3桁まで（dBで小数点以下 2桁まで）
Keysight U8903B ユーザーズ・ガイド 375
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残留 THD＋ N（1 kHz、1 Vrms、
（20 Hz～ 20 kHzの帯域幅）

≤－ 108 dB（＜－ 110 dB、代表値）（23 ℃ ±5 ℃）[d]

≤－ 100 dB（0 ℃～ 55 ℃）[d]

残留ノイズ
（20 Hz～ 20 kHzの帯域幅） ≤1.3 μVrms

SNR

表示範囲 － 999.999 dB～ 0 dB 

確度
＜ 20 kHz

＜ 100 kHz

±0.5 dB
±0.7 dB

入力電圧レンジ ＜ 1 μV～ 140Vrms

トリガ

タイプ
– フリーラン
– 外部

レベル 5 V

最小トリガ Hi電圧 1.25 V

最大トリガ Lo電圧 0.5 V

入力インピーダンス ＞ 10 kΩ

振幅

DC測定範囲 0 V～ ±200  V

DC確度 ±1%

AC確度（1 kHz）
0.03 dB（0.35 ％）（23 ℃ ±5 ℃）
0.05 dB（0.58 ％）（0 ℃～ 55 ℃）

フラットネス（1 kHz基準）
≤20 kHz
≤80 kHz
≤96 kHz

±0.008 dB（＜ ±0.003 dB、代表値）
±0.08 dB
±0.1 dB

ACレベル検出
– RMS

– p-p

周波数

レンジ 10 Hz～ 96 kHz

最小入力 1 mV（(S/N＞ 40 dB）

確度
– 2 ppm＋ 100 μHz（≤50 kHz）
– ＜ 5 ppm（＞ 50 kHz）

分解能 6桁
376 Keysight U8903B ユーザーズ・ガイド
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位相

確度
＜ 20 kHz

＜ 96 kHz

±2°
±4°

最小入力 1 mV（(S/N＞ 40 dB）

分解能 0.01°

SMPTE IMD

残留 IMD ≤0.0025 ％（－ 92 dB）

[a] 使用可能な入力レンジについては「測定設定（アナログ・アナライザ）」（ページ）202を参照。

[b] 24ビット測定によって定義。

[c] AC結合の場合は、低い周波数で CMRRは悪化します。

[d] ジェネレータやアナライザの影響を含みます。個々の影響は通常、記載されている値を下回ります。
Keysight U8903B ユーザーズ・ガイド 377
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デジタル・ジェネレータ仕様[1]

[1] デジタル・ジェネレータ仕様は、24ビット FFSを表します。

正弦波、デュアル正弦波、可変位相

周波数
レンジ
確度

5 Hz～ 0.45×サンプリング・レート（Fs）
±10 ppm

フラットネス ±0.001 dB

残留 THD＋ N ≤－ 140 dB

方形波

周波数レンジ 5 Hz～ 0.45 Fs

SMPTE IMD（1:1/4:1/10:1）

周波数
低周波 (LF)トーン
高周波（HF）トーン

40 Hz～ 500 Hz

2 kHz～ 60 kHzまたは 0.45 Fs（どちらか小さい方）

混合比（LF:HF）
– 10:1

– 4:1

– 1:1

掃引
– 上側周波数
– 下側周波数
– Amplitude

DFD（IEC 60118/IEC 60268）

周波数
差周波数
上側周波数
中心周波数

80 Hz～ 2 kHz

3 kHz～ 80 kHzまたは 0.45 Fs（どちらか小さい方）
3 kHz～ 79 kHzまたは 0.45 Fs（どちらか小さい方）

掃引
– 上側周波数
– 中心周波数
– 振幅

雑音

タイプ

– 方形
– ガウシアン
– 三角
– ピンク

振幅 0～ 1 FFS

波形ファイル再生

信号 ユーザ選択ファイルによって決定

ファイル・フォーマット WAVE（.wav）

長さ 最大 5分



特性と仕様 9
ファイル分解能
– 8ビット
– 16ビット
– 24ビット

周波数レンジ 2 Hz～ 0.45 Fs

マルチトーン

信号 ユーザ指定の周波数、振幅、位相データによって決定

周波数レンジ 2 Hz～ 0.45 Fs

最大トーン数 64

正弦波バースト

周期 2サイクル～ 65,535サイクル

バースト・オン 1サイクル～（65,534または周期－ 1のうちどちらか小さい方）

バースト・オン／バースト・オフ比 0～ 100 ％

単調波形

サンプル／ステップ 1～ 32,768

ウォーキング・ワン／ウォーキング・ゼロ

サンプル／ステップ 1～ 65,535

一定値

振幅 － 1 FFS～ 1FFS

DCオフセット

DCオフセット － 1 FFS～ 1FFS

ディザ

分布
– なし
– 三角
– 方形

レベル 0.5 LSB
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9 特性と仕様
デジタル・アナライザ仕様

振幅

ACレベル・レンジ <－ 120 dBFS～ 0 dBFS

DCレベル・レンジ ±1 FFS

AC確度 ±0.001 dB（1 kHz）

DC確度 ±0.001 dB

ACフラットネス ±0.001 dB（10 Hz～ 0.45 Fs）

単位（基準）

– FFS

– dBFS

– ％FS

– V

– dB

– dBV

– dBr

– x

– LSB

– Hex

– Dec

– dBSPL

周波数

レンジ 5 Hz～ 0.45 Fs

確度 ±5 ppm（10 Hz～ 0.45 Fs）

位相

確度 ±0.005 °

分解能 ±0.001 °

THD＋ N

レンジ 10 Hz～ 0.45 Fs

確度 ±0.3 dB

残留歪み ≤－ 140 dB

IMD

SMPTE IMD

– 1:1

– 4:1

– 10:1

高周波 2 kHz～ 60 kHzまたは 0.45 Fs（どちらか小さい方）

低周波 40 Hz～ 500 Hz

確度 ±0.5 dB
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特性と仕様 9
DFD

周波数差 80 Hz～ 2 kHz

中心周波数 3 kHz～ 79 kHzまたは 0.45 Fs（どちらか小さい方）

確度 ±0.5 dB
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9 特性と仕様
AES3/SPDIFインタフェース出力仕様

出力仕様

出力コネクタ・タイプ
平衡
不平衡
光

XLR（トランス結合）
BNC（グランド接続）
TOSLINKコネクタ

出力インピーダンス
平衡
不平衡

110 Ω
75 Ω

出力レベル
平衡
不平衡

0.3 Vpp～ 5.1 Vpp

0.3 Vpp～ 2.5 Vpp

サンプリング・レート 28 kHz～ 192 kHz

サンプリング・レート確度 ±5 ppm

出力レベル確度 ±1 dB（代表値）、±1.5 dB

オーディオ・ビット 8ビット～ 24ビット

固有ジッタ（代表値）
平衡
不平衡
光

≤1.5 ns
≤1.5 ns
≤5 ns

クロックおよび同期

内部マスタ・クロック
最大クロック・レート
確度
固有ジッタ

192 kHz
±5 ppm
≤1 ns

同期クロック出力
コネクタ・タイプ
インピーダンス
出力レベル
極性

出力タイプ

25ピン D-SUB（メス）コネクタ・ピン 1
50 Ω
3.3 V（LVCMOS IO規格）
– ノーマル
– 反転
ビット・クロック（128 Fs）
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特性と仕様 9
プロトコル

チャネル・ステータス・ビット
– プロフェッショナル
– コンシューマ
（高度な設定のために、適用可能なすべてのビットが編集可能）

フォーマット
– プロフェッショナル
– コンシューマ

ユーザ・ビット
– 設定
– クリア

有効性フラグ
– 設定
– クリア
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9 特性と仕様
AES3/SPDIFインタフェース入力仕様

入力仕様

入力コネクタ・タイプ
平衡
不平衡
光

XLR（トランス結合）
BNC（グランド接続）
TOSLINKコネクタ

入力インピーダンス
平衡
不平衡

110 Ωまたは高インピーダンス（>2 kΩ）
75 Ωまたは高インピーダンス（代表値 20 kΩ）

入力レベル
平衡
不平衡

0.3 Vpp～ 5.1 Vpp

0.3 Vpp～ 2.5 Vpp

サンプリング・レート 28 kHz～ 192 kHz

サンプリング・レート確度 ±5 ppm

入力レベル確度 ±1 dB（代表値）、±1.5 dB

オーディオ・ビット 8ビット～ 24ビット

固有ジッタ（代表値）
平衡
不平衡
光

≤1.5 ns
≤1.5 ns
≤5 ns

クロックおよび同期

内部マスタ・クロック
最大クロック・レート
確度
固有ジッタ

192 kHz
±5 ppm
≤1 ns

同期クロック入力
コネクタ・タイプ
インピーダンス
極性

BNC（リア・パネルの SYNC IN）
10 kΩ
– ノーマル
– 反転

プロトコル

チャネル・ステータス・ビット
– プロフェッショナル
– コンシューマ
（高度な設定のために、適用可能なすべてのビットが編集可能）

フォーマット
– プロフェッショナル
– コンシューマ

ユーザ・ビット
– 設定
– クリア

有効性フラグ
– 設定
– クリア
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特性と仕様 9
DSI出力仕様

出力仕様

コネクタ・タイプ – 25ピン D-SUB（メス）コネクタ
– 25ピン D-SUB（メス）－ BNCコネクタ（オプションのアクセサリ）

インピーダンス 50 Ω

ロジック・レベル

– 1.2 V

– 1.5 V

– 1.8 V

– 2.5 V

– 3.3 V

– ユーザ定義（LVCMOS規格）

サンプリング・レート 6.75 kHz～ 400 kHz

サンプリング・レート確度 ±5 ppm

マスタ・クロック
乗数
最大周波数
最大ビット・クロック
最大サンプリング・レート

64～ 1024（ワード長による）
51.2 MHz
51.2 MHz
400 kHz

データ・フォーマット

– Left Justified

– Right Justified

– I2S

– DSP

ワード長 1チャネルあたり 8ビット～ 32ビット

オーディオ・ビット 8ビット～ 24ビット（1ビット・ステップ）

ワード・クロック・レート 6.75 kHz～ 400 kHz

クロックおよび同期

内部マスタ・クロック
最大クロック・レート
安定度
固有ジッタ

10 MHz
±5 ppm
≤1 ns

クロック・ソース設定
（アナライザおよびジェネレータ）

– DUTからの入力ビット・クロック
– 内部クロック
– 外部同期クロック入力からの外部クロック

DSIクロック出力
インピーダンス
出力レベル
極性

10 kΩ（代表値）
1.2 Vpp～ 3.3 Vpp

ノーマルまたは反転

ワード・クロック極性
– 立ち上がりエッジ
– 立ち下がりエッジ
（ビット・クロックを基準にして）
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9 特性と仕様
386 Keysight U8903B ユーザーズ・ガイド

DSI入力仕様

入力仕様

コネクタ・タイプ
– 25ピン D-SUB（メス）コネクタ
– 25ピン D-SUB（メス）－ BNCコネクタ（オプションのアクセサリ）

インピーダンス ≥10 kΩ

ロジック・レベル

– 1.2 V

– 1.5 V

– 1.8 V

– 2.5 V

– 3.3 V

– ユーザ定義（LVCMOS規格）

サンプリング・レート 6.75 kHz～ 400 kHz

サンプリング・レート確度 ±5 ppm

マスタ・クロック
乗数
最大周波数
最大ビット・クロック
最大サンプリング・レート

64～ 1024（ワード長による）
51.2 MHz
51.2 MHz
400 kHz

データ・フォーマット

– Left Justified

– Right Justified

– I2S

– DSP

ワード長 1チャネルあたり 8ビット～ 32ビット

オーディオ・ビット 8ビット～ 24ビット（1ビット・ステップ）

ワード・クロック・レート 6.75 kHz～ 400 kHz

クロックおよび同期

内部マスタ・クロック
最大クロック・レート
安定度
固有ジッタ

10 MHz
±5 ppm
≤1 ns

クロック・ソース設定
（アナライザおよびジェネレータ）

– DUTからの入力ビット・クロック
– 内部クロック
– 外部同期クロック入力からの外部クロック

DSIクロック入力
インピーダンス
入力レベル
極性

10 kΩ（代表値）
1.2 Vpp～ 3.3 Vpp

– ノーマル
– 反転

ワード・クロック極性
– 立ち上がりエッジ
– 立ち下がりエッジ
（ビット・クロックを基準にして）
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アナログ・オーディオ・フィルタ

ローパス・フィルタ

– 2 kHz

– 3 kHz

– 5 kHz

– 8 kHz

– 10 kHz

– 15 kHz

– 20 kHz

– 22 kHz

– 30 kHz

– 40 kHz

– 50 kHz

– 80 kHz

– ユーザ定義[a]

ハイパス・フィルタ

– 15 Hz

– 20 Hz

– 22 Hz

– 30 Hz

– 50 Hz

– 70 Hz

– 100 Hz

– 200 Hz

– 300 Hz

– 400 Hz

– ユーザ定義 [a]

評価雑音フィルタ

– A評価雑音（ANSI-IEC “A”評価雑音、IEC Rec 179による）
– CCIR 1K評価雑音 (CCIR Rec. 468)

– CCIR 2K評価雑音 (Dolby 2K)

– Cメッセージ（IEEE 743による Cメッセージ）
– CCITT(ITU-T Rec. O.41、ITU-T Rec. P.53)

– ユーザ定義 [a]

ディエンファシス
– 50 μs
– 75 μs

– ユーザ定義 [a]

[a] 標準 I/O接続経由でユーザ定義フィルタをアップロード可能。
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9 特性と仕様
デジタル・オーディオ・フィルタ

ローパス・フィルタ

– 15 kHzローパス
– 20 kHzローパス
– 22 kHzローパス
– 30 kHzローパス

– ユーザ定義[a][b]

ハイパス・フィルタ

– 20 Hzハイパス
– 100 Hzハイパス
– 400 Hzハイパス

– ユーザ定義 [a][b]

評価雑音フィルタ

– A評価雑音（ANSI-IEC “A”評価雑音、IEC Rec 179による）
– CCIR 1K評価雑音 (CCIR Rec. 468)

– CCIR 2K評価雑音 (Dolby 2K)

– Cメッセージ（IEEE 743による Cメッセージ）
– CCITT(ITU-T Rec. O.41、ITU-T Rec. P.53)

– ユーザ定義 [a][b]

ディエンファシス
– 50 μs
– 75 μs

– ユーザ定義 [a][b]

サンプリング・レート・サポート

– 32 kHz

– 44.1 kHz

– 48 kHz

– 88.2 kHz

– 96 kHz

– 176.4 kHz

– 192 kHz

（フィルタのカットオフ周波数に依存）

[a] 標準 I/O接続経由でユーザ定義フィルタをアップロード可能。

[b] ユーザ定義フィルタの係数は最大 252個。
388 Keysight U8903B ユーザーズ・ガイド



特性と仕様 9
グラフ仕様

掃引仕様

FFTアナライザ

サンプル・サイズ

– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

ウィンドウ関数

– 方形
– ハニング
– ブラックマン
– ライフ・ビンセント
– ライフ・ビンセント 3

– ハミング
– フラット・トップ
– Kaiser

振幅確度（フラット・トップ・ウィンドウ） ±0.1 dB（±1.2 ％）

ジェネレータ掃引

パラメータ
– 周波数
– 振幅
– 位相

掃引間隔
– リニア
– ログ

掃引モード
– 自動掃引
– 自動リスト

ホールド
– なし
– 最大値
– 最小値
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9 特性と仕様
オーディオ・モニタ仕様

1.5 MHz帯域幅（オプション N3431A）仕様[1]

U8903B-AUX

モニタ出力 各アナライザ入力レンジの上端が 1 Vrmsになるようにスケーリング

補助出力 0.5 Vdc～ 5.1 Vdc±5 ％、100 mAに電流制限

ヘッドフォン・コネクタ

推奨するヘッドフォン 3.5 mmコネクタ付きヘッドフォン

[1] 標準帯域幅に加えた仕様。

入力仕様

基本波周波数レンジ 10 Hz ～ 1.5 MHz

周波数確度 2 ppm（＞ 50 kHz）

測定帯域幅
帯域幅 1.5 MHz

フラットネス（1 kHz基準）
≤200 kHz
≤1 MHz
≤ 1.5 MHz

±0.1 dB
±0.5 dB
±1.0 dB
390 Keysight U8903B ユーザーズ・ガイド



特性と仕様 9
POLQA測定（オプション N3432A）仕様[1]

PESQ測定（オプション N3433A）仕様 [1]

[1] OPTICOM Gmbhからライセンスを受けています。

PERCEPTIUAL OBJECTIVE LISTENING QUALITY ASSESSMENT（ITU-T Rec. P.863に準拠）

数値結果
– POLQAスコア
– MOS-LQO狭帯域／広帯域の平均値のみ

グラフィック表示（対時間）

– POLQAスコア
– MOS-LQO

– 遅延
– ドロップアウト
– 基準信号
– 劣化信号

PERCEPTIUAL EVALUATION OF SPEECH QUALITY（ITU-T Rec. P.862、862.1、862.2に準拠）

数値結果
– PESQスコア
– MOS-LQO狭帯域／広帯域の平均値のみ

グラフィック表示（対時間）

– PESQスコア
– MOS-LQO

– 遅延
– ドロップアウト
– 基準信号
– 劣化信号
Keysight U8903B ユーザーズ・ガイド 391



9 特性と仕様
測定カテゴリ
U8903Bは、3000 mまでの高度、測定カテゴリ I、200 Vpの条件下での測定に使用するこ
とを意図しています。

測定カテゴリの定義

表 9-1 測定カテゴリの定義

測定カテゴリ I
主電源に直接接続されていない回路に対して実行される測定。
例えば、主電源から派生していない回路、特別に保護された（内部）主電源から派
生する回路の測定。

測定カテゴリ II
低電圧設備に直接接続されている回路に対して実行される測定。
例えば、家庭電化製品、携帯用工具、類似の機器の測定。

測定カテゴリ III

固定の建物設備で実行される測定。
例えば、分電盤、サーキット・ブレーカ、配線（ケーブルを含む）、固定設備のバ
ス・バー、ジャンクション・ボックス、スイッチ、コンセント、産業用機器、固定
設備に恒久的に接続された固定モータの測定。

測定カテゴリ IV
低電圧設備の電源で実行される測定。
例えば、電気メータ、1次過電流保護デバイスの測定、リップル制御装置。
392 Keysight U8903B ユーザーズ・ガイド
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付録 A
付録 A： FUNCTIONパネル

表 A-1 FUNCTIONパネルの概要

キー 概要

Interface アナログ・インタフェースとデジタル・インタフェースを切り替えます。

Generator|Analyzer

ジェネレータ・モードとアナライザ・モードの間を切り替えます。
アナログ・ジェネレータとアナログ・アナライザのメニュー・ツリーについては、
「アナログ・ジェネレータのメニュー・ツリー」（ページ）402および「アナログ・
アナライザのメニュー・ツリー」（ページ）417を参照してください。

Graph
グラフ解析モードにアクセスします。
グラフ解析のメニュー・ツリーについては、「Graph Analysisメニュー・ツリー」
（ページ）440を参照してください。

Sweep
掃引機能モードにアクセスします。
掃引機能のメニュー・ツリーについては、「掃引機能のメニュー・ツリー」（ページ）
444を参照してください。

Full Screen グラフ・ビューを画面全体のサイズに最大化します。
この機能は、グラフ解析モードでのみ適用可能です。

Display
アナライザ／ジェネレータ・モードでは、2パネル・ビュー、4パネル・ビュー、10
パネル・ビューの間を切り替えます。
グラフ解析モードでは、1パネル・ビューと 2パネル・ビューを切り替えます。

Shortcut 1 カスタマイズ可能なショートカット・キー。詳細については、「SYSTEMパネルのメ
ニュー・ツリー」（ページ）398を参照してください。

Shortcut 2 カスタマイズ可能なショートカット・キー。詳細については、「SYSTEMパネルのメ
ニュー・ツリー」（ページ）398を参照してください。
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A 付録
付録 B： GRAPHパネルのメニュー・ツリー

表 A-2 GRAPHパネルのメニュー・ツリーの概要

キー レベル 1 レベル 2 概要

Peak Search

Max Peak アクティブ・マーカを検出して、ピークしきい値よりも大きい
最大ピークに移動します。

Next Peak アクティブ・マーカを検出して、ピークしきい値よりも大きい
次のピークに移動します。

Prev Peak アクティブ・マーカを検出して、ピークしきい値よりも大きい
前のピークに移動します。

Next Min アクティブ・マーカを検出して、最小しきい値よりも小さい前
のピークに移動します。

Prev Min アクティブ・マーカを検出して、最小しきい値よりも小さい次
のピークに移動します。

Threshold

Line Visible
グラフのしきい値線をオン／オフします。
– On

– Off

Peak Thres ピークしきい値を設定します。
Min Thres 最小しきい値を設定します。

Marker

Active Marker M1～ M8 アクティブ・マーカ番号を選択します。

State
– On

– Off
アクティブ・マーカをオン／オフします。

Trace 1～ 8 アクティブ・マーカのトレース番号を選択します。

Ref Mkr
– OFF

– M1～ M8
基準マーカ番号を選択します。

Movement

– Single

– Pair

– Bin

– Peak

– Harmonic

マーカの移動タイプを選択します。

Function

– None

– Slope

– PSD

マーカの機能タイプを選択します。

Marker ->

-> Start グラフの左側値を現在のマーカ位置に設定します。
-> Stop グラフの右側値を現在のマーカ位置に設定します。
-> Center グラフの中央値を現在のマーカ位置に設定します。

-> Delta グラフの左側値と右側値を現在のマーカと基準マーカの位置に
設定します。

Move to 3 dB マーカを最も近い－ 3 dB値のデータ・ポイントに配置します。

Move to 6 dB マーカを最も近い－ 6 dB値のデータ・ポイントに配置します。
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付録 A
Marker

Harmonics

Trace マーカを配置するトレース番号を設定します。

Enabled
マーカを表示したり、非表示にします。
– On

– Off

Rdg at Mkr
– On

– Off
マーカ測定をオン／オフします。

Print 
（Shift + Marker） 現在の表示画面をファイルに出力します。

Scale

AutoScale X軸と Y軸のオートスケールを実行します。

AutoScale X
グラフに表示するデータに基づいて X軸に最適なスケール（左
側値と右側値）を検索することにより、X軸のオートスケール
を実行します。

AutoScale Y
グラフに表示するデータに基づいて Y軸に最適なスケール（上
側値と下側値）を検索することにより、Y軸のオートスケール
を実行します。

Zoom グラフの一部を拡大します。

表 A-2 GRAPHパネルのメニュー・ツリーの概要（続き）

キー レベル 1 レベル 2 概要
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A 付録
付録 C： SYSTEMパネルのメニュー・ツリー

表 A-3 SYSTEMパネルのメニュー・ツリーの概要

キー レベル 1 レベル 2 レベル 3 概要

Preset

（現在のモード） 現在のモードをデフォルト設定にリセットします。
Save User State 現在のユーザ・ステートを保存します。

Mode ユーザ定義のファイルを削除せずに、すべてのモード
をデフォルト設定にリセットします。

To Factory Settings

U8903Bを工場設定にリセットし、内部フラッシュ・メ
モリに保存されているすべてのファイル（例えば、ス
テート・ファイル、任意波形、テスト・シーケンス・
プロジェクト・ファイルなど）を削除し、GUIステー
トを標準ビュー・モードにリセットします。HP8903B
モードがオンになっている場合は、GUIステートは
HP8903Bモードのままになります。

User State U8903Bを以前に保存したユーザ・ステートにリセット
します。

Util ity
（モードがアナライ
ザ・モードまたは
ジェネレータ・
モードの場合）

Save Channel (x)
(x)＝現在のチャ
ネル番号

現在のチャネル・ステートをファイルに保存します。
Saveメニュー・ツリーについては、「Saveメニュー・
ツリー」（ページ）447を参照してください。

Save (x)
(x)＝現在のモ
ード

現在のモード・ステートをファイルに保存します。
Saveメニュー・ツリーについては、「Saveメニュー・
ツリー」（ページ）447を参照してください。

Recall

保存した U8903Bステートをファイルからリコールし
ます。
Recallメニュー・ツリーについては、「Recallメ
ニュー・ツリー」（ページ）448を参照してください。

Copy To 現在のチャネル・ステートを他のチャネルにコピーし
ます。

Copy From ステートを現在のチャネルにコピーするチャネル番号
を選択します。

Util ity
（モードがグラフ解
析モードの場合）

Save Graph
現在のグラフ・ステートをファイルに保存します。
Saveメニュー・ツリーについては、「Saveメニュー・
ツリー」（ページ）447を参照してください。

Save Channels 
Settings

Channel (x)
(x)＝現在の
チャネル

現在のチャネルのグラフ・ステートをファイルに保存
します。
Saveメニュー・ツリーについては、「Saveメニュー・
ツリー」（ページ）447を参照してください。

All Channels 
Settings

すべてのチャネルのグラフ・ステートをファイルに保
存します。
Saveメニュー・ツリーについては、「Saveメニュー・
ツリー」（ページ）447を参照してください。
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付録 A
Util ity
（モードがグラフ解
析モードの場合）

Save Traces

Trace (x)
(x)＝現在のト
レース番号

アクティブ・トレースを CSVファイル・フォーマット
に保存します。
Saveメニュー・ツリーについては、「Saveメニュー・
ツリー」（ページ）447を参照してください。

All Traces

すべてのトレースのステートをファイルに保存しま
す。
Saveメニュー・ツリーについては、「Saveメニュー・
ツリー」（ページ）447を参照してください。

Axis Settings
軸設定ステートをファイルに保存します。
Saveメニュー・ツリーについては、「Saveメニュー・
ツリー」（ページ）447を参照してください。

Traces + Axis

すべてのトレースのステートと軸設定ステートを保存
します。
Saveメニュー・ツリーについては、「Saveメニュー・
ツリー」（ページ）447を参照してください。

Save Trace (x) 
Data
(x)＝現在の
チャネル

アクティブ・トレース・データを CSVファイル・
フォーマットに保存します。
Saveメニュー・ツリーについては、「Saveメニュー・
ツリー」（ページ）447を参照してください。

Recall

トレースを CSVファイルからアクティブ・トレースに
ロードします。
Recallメニュー・ツリーについては、「Recallメ
ニュー・ツリー」（ページ）448を参照してください。

Copy To 現在のチャネルのグラフ・ステートを他のチャネルに
コピーします。

Copy Graph From グラフ・ステートを現在のチャネルにコピーするチャ
ネル番号を選択します。

Help
（Shift ＋ Util ity）

ヘルプ・モードを表示します。
［Shift］＋［Util ity］を押して、ヘルプ・モードを終了
します。

System

Error Info Load File

エラー・ログ表示パネルにロードするログ・ファイル
を選択します。
Recallメニュー・ツリーについては、「Recallメ
ニュー・ツリー」（ページ）448を参照してください。

I/O
LAN Settings

Reset LAN設定をリセットします。

Hostname LANのホスト名を設定します。

Config Mode
LAN設定モードを選択します。
– Auto
– Manual

IP Address LANの IPアドレスを設定します。

Subnet mask LANサブネット・マスク・アドレスを設定します。

Gateway LANゲートウェイ・アドレスを設定します。

DNS 1 LAN DNS 1アドレスを設定します。

DNS 2 LAN DNS 2アドレスを設定します。

GPIB 0～ 30 目的の GPIBアドレスを設定します。

FTP
– Enabled
– Disabled

FTPコントロールをオン／オフします。

表 A-3 SYSTEMパネルのメニュー・ツリーの概要（続き）

キー レベル 1 レベル 2 レベル 3 概要
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A 付録
System

Update
Load File

アップデート・ファイルをロードします。
Recallメニュー・ツリーについては、「Recallメ
ニュー・ツリー」（ページ）448を参照してください。

EULA Keysight EULAページを表示します。

Service

Self-Test

Customize Test

すべてを選択するか、目的のテストの選択を解除し
ます。
LANテスト
カードのセルフテスト

Run Test 選択したテストを実行します。
Clear Result 以前のセルフテストの結果をクリアします。

Diagnostic
Front Panel フロント・パネル診断を実行します。
Display ディスプレイ診断を実行します。

Secure Erase

内部フラッシュ・メモリに保存されているすべての
ファイル（例えば、ステート・ファイル、任意波形、
テスト・シーケンス・プロジェクト・ファイルなど）
のセキュアな消去を行います。U8903Bの設定やライ
センス情報に影響はありません。

Options
Add Option

新しい U8903Bオプションを追加します。
Recallメニュー・ツリーについては、「Recallメ
ニュー・ツリー」（ページ）448を参照してください。

Remove Option 選択した U8903Bオプションを削除します。

Settings

Date 日付を編集します（dd/mm/yyyyフォーマット）。

Time 現在の時刻を編集します（24時間フォーマット）。

Brightness 0～ 6 LCDディスプレイの輝度値を調整します。

Key Sound
– On
– Off

フロント・パネル・キーの音をオン／オフします。

Power Up State
– Last
– Default

電源投入時の状態を選択します。

Shortcut 1
– Error List
– Auto-Scale

ショートカット 1キーをマッピングする特定の機能を
選択します。

Shortcut 2
– Error List
– Auto-Scale

ショートカット 2キーをマッピングする特定の機能を
選択します。

表 A-3 SYSTEMパネルのメニュー・ツリーの概要（続き）

キー レベル 1 レベル 2 レベル 3 概要
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付録 A
System

HP8903B Config

Active Channel
– 1
– 2

HP8903Bのアクティブ・チャネルを選択します。

Left Filter

– None
– A-Weighting
– CCIR 1k wtd
– CCIR 2k wtd
– C-Message
– CCITT
– 400 Hz

左フィルタ・タイプを選択します。

Right Filter

– None
– A-Weighting
– CCIR 1k wtd
– CCIR 2k wtd
– C-Message
– CCITT
– 400 Hz

右フィルタ・タイプを選択します。

Default LPF
– None
– 30 kHz
– 80 kHz

HP8903Bモードのデフォルト・フィルタを選択し
ます。

Fan & Temperature 使用可能なカードの温度と U8903B内の 3個の 80 mm
ファンの速度を表示します。

Aux Output

Audio Monitor
– On
– Off

補助オーディオ・モニタをオン／オフします。

Audio Output
– Speaker
– Phone

補助オーディオ出力タイプを選択します。

Audio Mode
– Stereo
– Mono

オーディオ出力が Phoneの場合にのみ使用可能です。
補助オーディオ・モード・タイプを選択します。 

Volume 0～ 100 補助オーディオ音量を選択します。
DC Output 補助 DC出力値を設定します。

Board Info U8903Bの使用可能なカードに関する情報を表示し
ます。

Legacy Status
– On
– Off

従来の掃引をオ／オフします。

Macro
（Shift＋ System） 将来の拡張用に確保されています。

Local
リモート制御モードからローカル・モードに切り替え
ます。フロント・パネル・キーは、リモート・モード
ではロックされます。

Lock/Unlock

ローカル・モードでフロント・パネル・キーをロッ
ク／ロック解除します。
ダイアログ・ボックスがポップアップ表示されるので
設定します。

表 A-3 SYSTEMパネルのメニュー・ツリーの概要（続き）

キー レベル 1 レベル 2 レベル 3 概要
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A 付録
付録 D： アナログ・ジェネレータのメニュー・ツリー

表 A-4 アナログ・ジェネレータのメニュー・ツリーの概要

レベル 1 レベル 2 レベル 3 概要

Waveform

– Sine

– V. Phase

– Dual

– SMPTE 1:1

– SMPTE 4:1

– SMPTE 10:1

– IEC 60118

– IEC 60268

– Gaus. Noise

– Rect. Noise

– Pink Noise

– Square

– DC

– Arbitrary

– Multitone

– DTMF

波形タイプを選択します。

Waveform Config 
(Sine)

Amplitude 信号の振幅値を設定します。
Frequency 信号の周波数値を設定します。

DC Offset 信号の DCオフセット値を設定します。

Waveform Config 
(V. Phase)

Amplitude 信号の振幅値を設定します。
Frequency 信号の周波数値を設定します。

Phase -> 1

アナログ・ジェネレータがチャネル 2にある場合のみ使用可能
です。
チャネル 2の正弦波波形の位相をチャネル 1を基準にして設定
します。

Waveform Config 
(Dual)

Amplitude 信号の振幅値を設定します。
Frequency 信号の周波数値を設定します。

Frequency 2
2番目の正弦波信号の周波数値を設定します。
この設定はデュアル波形の場合のみ適用可能です。

DC Offset 信号の DCオフセット値を設定します。

Ratio 2番目の正弦波の 1番目の正弦波に対する振幅比を設定します。

Summation
– RSS

– Linear
Summationは、2つのレベルの合計方法を示します。
402 Keysight U8903B ユーザーズ・ガイド



付録 A
Waveform Config 
(SMPTE 1:1/4:1/10:1)

Amplitude 信号の振幅値を設定します。
Lower Freq 下側周波数値を設定します。
Upper Freq 上側周波数値を設定します。

DC Offset 信号の DCオフセット値を設定します。

Summation
– RSS

– Linear
2つのレベルの合計方法を示します。

Waveform Config 
(IEC 60118)

Amplitude 信号の振幅値を設定します。
Upper Freq 上側周波数値を設定します。
Diff Freq 波形の差周波数を設定します。

DC Offset 信号の DCオフセット値を設定します。

Summation
– RSS

– Linear
2つのレベルの合計方法を示します。

Waveform Config 
(IEC 60268)

Amplitude 信号の振幅値を設定します。
Center Freq 波形の中心周波数を設定します。
Diff Freq 波形の差周波数を設定します。

DC Offset 信号の DCオフセット値を設定します。

Summation
– RSS

– Linear
2つのレベルの合計方法を示します。

Waveform Config 
(Gaus. Noise)

Amplitude 信号の振幅値を設定します。

DC Offset 信号の DCオフセット値を設定します。

Waveform Config 
(Rect. Noise)

Amplitude 信号の振幅値を設定します。

DC Offset 信号の DCオフセット値を設定します。

Waveform Config 
(Pink Noise)

Amplitude 信号の振幅値を設定します。

DC Offset 信号の DCオフセット値を設定します。

Waveform Config 
(Square)

Amplitude 信号の振幅値を設定します。
Frequency 信号の周波数値を設定します。

Waveform Config 
(DC)

Voltage 信号の電圧値を設定します。

Waveform Config 
(Abitrary)

Amplitude 信号の振幅値を設定します。

DC Offset 信号の DCオフセット値を設定します。

Load File
波形をファイルからロードします。
Recallメニュー・ツリーについては、「Recallメニュー・ツ
リー」（ページ）448を参照してください。

 Info ロードした波形情報を表示します。

表 A-4 アナログ・ジェネレータのメニュー・ツリーの概要（続き）

レベル 1 レベル 2 レベル 3 概要
Keysight U8903B ユーザーズ・ガイド 403



A 付録
Waveform Config 
(Multitone)

Amplitude 信号の振幅値を設定します。

DC Offset 信号の DCオフセット値を設定します。

Start Freq マルチトーン波形の最低周波数（通常は最初のトーンの周波
数）を設定します。

Stop Freq マルチトーン波形の最高周波数（通常は最後のトーンの周波
数）を設定します。

Freq Spacing

– Linear

– Log

– Custom

トーン間の周波数間隔を選択します。
カスタム・マルチトーン波形が設定されている場合は、Custom
が選択されます。

Tones 信号の周波数成分の数を設定します。

Length

– 1024

– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

マルチトーン波形の 1回の反復を作成するのに使用するサンプ
ル数を決定する波形長を選択します。

Custom

Apply カスタム・マルチトーン波形の選択したトーンに対して、現在
の設定を適用します。

Optimize カスタム・マルチトーン波形のクレスト・ファクタを最適化し
ます。

Frequency カスタム・マルチトーン波形の周波数値を設定します。
Amplitude カスタム・マルチトーン波形の振幅値を設定します。
Phase カスタム・マルチトーン波形の位相値を設定します。

Add Above カスタム・マルチトーン波形の選択したトーンの上にトーンを
追加します。

Add Below カスタム・マルチトーン波形の選択したトーンの下にトーンを
追加します。

Remove カスタム・マルチトーン波形の選択したトーンを削除します。

Clear カスタム・マルチトーン波形リスト内のすべてのトーンをクリ
アします。

Waveform Config 
(DTMF)

Dial

Mode
ダイヤル・モードの動作モードを選択します。
Single
Sequence

A
B
C
D

シングル・ダイヤル・モード
–［A］、［B］、［C］または［D］ソフトキーを押し続けると、
それぞれ A、B、Cまたは Dトーンが発信されます。

シーケンス・ダイヤル・モード
–［A］、［B］、［C］または［D］ソフトキーを押すと、Aトーン
が DTMFシーケンスに追加されます。

Pause DTMFシーケンスにカンマで休止を追加します。

Amplitude DTMF信号の振幅レベルを設定します。

Ratio 高周波トーンと低周波トーン間のレベル差を設定します。

表 A-4 アナログ・ジェネレータのメニュー・ツリーの概要（続き）

レベル 1 レベル 2 レベル 3 概要
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付録 A
Waveform Config 
(DTMF)

Tone Duration DTMF信号の持続時間を設定します。

Tone Delay 2つの DTMFトーン間の遅延を設定します。

Pause Time DTMFシーケンスのインターバル・タイムを設定します。

Repeat DTMFシーケンスの繰り返しをオン／オフします。

Summation
– RSS

– Linear
2つのレベルの合計方法を示します。

Output Config

Connector

– Bal

– UnBal

– Com

– IEC60268

出力コネクタ・タイプを選択します。

Impedance

Bal、Com、
IEC60268の場合
– 600 Ω
– 100 Ω
– 40 Ω
UnBalの場合
– 600 Ω
– 50 Ω
– 20 Ω

出力インピーダンス値を選択します。

IEC60268 10 Ω
– Pin 2

– Pin 3

一般的な IEC 60268構成の XLRコネクタのピン 2または 3に追
加する 10 Ω出力直列抵抗を選択します。
この設定は、出力コネクタ・タイプが IEC 60268に設定されて
いる場合にのみ使用可能です。

Ground
– Float

– Ground
グランド・タイプを選択します。

Max Voltage 最大電圧値を設定します。

References Ref Impedance dBm測定の単位変換の基準インピーダンス値を設定します。

表 A-4 アナログ・ジェネレータのメニュー・ツリーの概要（続き）

レベル 1 レベル 2 レベル 3 概要
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A 付録
付録 E： デジタル・ジェネレータのメニュー・ツリー

表 A-5 デジタル・ジェネレータのメニュー・ツリーの概要

レベル 1 レベル 2 レベル 3 レベル 4 概要

Waveform

– Sine

– V. Phase

– Dual

– SMPTE 1:1

– SMPTE 4:1

– SMPTE 10:1

– IEC 60118

– IEC 60268

– Gaus. Noise

– Rect. Noise

– Tri. Noise

– Pink Noise

– Square

– Sine Burst

– Stereo

– Monotonicity

– Constant

– Walking Zero

– Walking One

– Multitone

– Arbitrary

波形タイプを選択します。

Waveform Config 
(Sine)

Amplitude 信号の振幅値を設定します。
Frequency 信号の周波数値を設定します。

DC Offset 信号の DCオフセット値を設定します。

Waveform Config 
(V. Phase)

Amplitude 信号の振幅値を設定します。
Frequency 信号の周波数値を設定します。

Phase -> 1

デジタル・ジェネレータがチャネル 2に
ある場合のみ使用可能です。
チャネル 2の正弦波波形の位相をチャネ
ル 1を基準にして設定します。
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付録 A
Waveform Config 
(Dual)

Amplitude 信号の振幅値を設定します。
Frequency 信号の周波数値を設定します。

Frequency 2

2番目の正弦波信号の周波数値を設定し
ます。
この設定はデュアル波形の場合のみ適用
可能です。

DC Offset 信号の DCオフセット値を設定します。

Ratio 2番目の正弦波の 1番目の正弦波に対する
振幅比を設定します。

Summation
– RSS

– Linear
. 2つのレベルの合計方法を示します。

Waveform Config 
(SMPTE 1:1/4:1/10:1)

Amplitude 信号の振幅値を設定します。
Lower Freq 下側周波数値を設定します。
Upper Freq 上側周波数値を設定します。

DC Offset 信号の DCオフセット値を設定します。

Summation
– RSS

– Linear
2つのレベルの合計方法を示します。

Waveform Config 
(IEC 60118)

Amplitude 信号の振幅値を設定します。
Upper Freq 上側周波数値を設定します。
Diff Freq 波形の差周波数を設定します。

DC Offset 信号の DCオフセット値を設定します。

Summation
– RSS

– Linear
2つのレベルの合計方法を示します。

Waveform Config 
(IEC 60268)

Amplitude 信号の振幅値を設定します。
Center Freq 波形の中心周波数を設定します。
Diff Freq 波形の差周波数を設定します。

DC Offset 信号の DCオフセット値を設定します。

Summation
– RSS

– Linear
2つのレベルの合計方法を示します。

Waveform Config 
(Gaus. Noise)

Amplitude 信号の振幅値を設定します。

DC Offset 信号の DCオフセット値を設定します。

Waveform Config 
(Rect. Noise)

Amplitude 信号の振幅値を設定します。

DC Offset 信号の DCオフセット値を設定します。

Waveform Config 
(Triangular Noise)

Amplitude 信号の振幅値を設定します。

DC Offset 信号の DCオフセット値を設定します。

Waveform Config 
(Pink Noise)

Amplitude 信号の振幅値を設定します。

DC Offset 信号の DCオフセット値を設定します。

表 A-5 デジタル・ジェネレータのメニュー・ツリーの概要（続き）

レベル 1 レベル 2 レベル 3 レベル 4 概要
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A 付録
Waveform Config 
(Square)

Amplitude 信号の振幅値を設定します。
Frequency 信号の周波数値を設定します。

DC Offset 信号の DCオフセット値を設定します。

Waveform Config 
(Sine Burst)

Amplitude 信号の振幅値を設定します。
Frequency 信号の周波数値を設定します。

Burst On 信号振幅レベルが高くなるサイクル数を
設定します。

Period 1つのバーストの始めから次のバーストの
始めまでのサイクル数を設定します。

Low Level Burst Onと Burst Offの振幅比を設定します。

Waveform Config 
(Stereo)

Amplitude 信号の振幅値を設定します。
Frequency 信号の周波数値を設定します。

DC Offset 信号の DCオフセット値を設定します。

Waveform Config 
(Monotonicity)

Samples/Step 方形波の各半サイクルの持続時間を設定
します。

Waveform Config 
(Constant)

Amplitude 信号の振幅値を設定します。

Waveform Config 
(Walking Zero)

Samples/Step 1個のビット 0の増加速度を設定します。

Waveform Config 
(Walking One)

Samples/Step 1個のビット 1の増加速度を設定します。

Waveform Config 
(Multitone)

Amplitude 信号の振幅値を設定します。

Start Freq マルチトーン波形の最低周波数（通常は
最初のトーンの周波数）を設定します。

Stop Freq マルチトーン波形の最高周波数（通常は
最後のトーンの周波数）を設定します。

Freq Spacing

– Linear

– Log

– Custom

トーン間の周波数間隔を選択します。
カスタム・マルチトーン波形が設定され
ている場合は、Customが選択されます。

Tones 信号の周波数成分の数を設定します。

Length

– 1024

– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

マルチトーン波形の 1回の反復を作成す
るのに使用するサンプル数を決定する波
形長を選択します。

表 A-5 デジタル・ジェネレータのメニュー・ツリーの概要（続き）

レベル 1 レベル 2 レベル 3 レベル 4 概要
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付録 A
Waveform Config 
(Multitone)

Custom

Apply
カスタム・マルチトーン波形の選択し
たトーンに対して、現在の設定を適用し
ます。

Optimize カスタム・マルチトーン波形のクレスト・
ファクタを最適化します。

Frequency カスタム・マルチトーン波形の周波数値
を設定します。

Amplitude カスタム・マルチトーン波形の振幅値を
設定します。

Phase カスタム・マルチトーン波形の位相値を
設定します。

Add Above カスタム・マルチトーン波形の選択した
トーンの上にトーンを追加します。

Add Below カスタム・マルチトーン波形の選択した
トーンの下にトーンを追加します。

Remove カスタム・マルチトーン波形の選択した
トーンを削除します。

Clear カスタム・マルチトーン波形リスト内の
すべてのトーンをクリアします。

Waveform Config 
(Abitrary)

Amplitude 信号の振幅値を設定します。

DC Offset 信号の DCオフセット値を設定します。

Load File

波形をファイルからロードします。
Recallメニュー・ツリーについては、
「Recallメニュー・ツリー」（ページ）448
を参照してください。

 Info ロードした波形情報を表示します。

Output Config

Connector
– Bal

– UnBal
出力コネクタ・タイプを選択します。

AES Output
– On

– Off
AES出力をオン／オフします。

Optical Output
– On

– Off
光出力をオン／オフします。

Sample Rate サンプリング・レートの値を設定します。

Audio Format
– Linear PCM

– A-Law
– μ-Law

オーディオ・エンコード・フォーマット
を設定します。

Dither 

– Off

– Rectangular

– Triangular

– Shaped

ディザ・タイプを選択します。

表 A-5 デジタル・ジェネレータのメニュー・ツリーの概要（続き）

レベル 1 レベル 2 レベル 3 レベル 4 概要
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A 付録
Output Config

Ref Clock

Source

– Internal

– AES RCLK

– External

基準クロック・ソースを選択します。

Type
– MCLK

– FSYNC
外部基準クロック・ソースを選択します。

Ref Clock

Word Length 8～ 32 外部基準クロックのワード長の値を設定
します。

Multiplier

外部基準クロックの乗数の値を設定しま
す。外部基準クロック乗数として選択可
能な値は、外部基準クロック・ワード長
によって異なります。

Sync Clock

Output
– On

– Off
同期クロック出力をオン／オフします。

Source

– Internal

– AES RCLK

– External

同期クロック・ソースを選択します。

Divider
– 1

– 128
同期クロックの分周比の値を選択します。

DSI Config

Voltage

– 1.2 Vpp

– 1.5 Vpp

– 1.8 Vpp

– 2.5 Vpp

– 3 Vpp

– 3.3 Vpp

出力電圧を選択するか、目的の出力電圧
を設定します。

Channels

– 2

– 4

– 6

– 8

– 10

– 12

– 14

– 16

チャネル数を選択します。

Format

– Left

– Right

– I2S

– DSP

DSI出力フォーマットを選択します。

Resolution 8～ 24 オーディオ分解能を設定します。

BClk Edge
– Rising

– Falling
クロック・エッジ・タイプを選択します。

Fsync Polarity
– Rising

– Falling
同期極性を選択します。

表 A-5 デジタル・ジェネレータのメニュー・ツリーの概要（続き）

レベル 1 レベル 2 レベル 3 レベル 4 概要
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付録 A
DSI Config

Fsync Width

– One Bit Clock

– One Subframe

– 50% Duty Cycle

同期幅を選択します。

Data Shift Cnt データ・シフト・カウント値を設定し
ます。

Data Shift Dir
– Left

– Right
データ・シフト方向を選択します。

Mclk Output
– On

– Off
マスタ・クロック出力をオン／オフし
ます。

Word Length

マスタ・クロックのワード長の値を設定
します。ワード長をオーディオ分解能よ
り小さい値に設定することはできません。
– 8～ 32

乗数 乗数の値を設定します。
Sample Rate サンプリング・レートの値を設定します。

AES3/SPDIF 

Level 出力電圧レベルを設定します。

Resolution 8～ 24 オーディオ分解能の値を設定します。

Validity Bit
– Set

– Clear
有効性ビットを選択します。

Format
– コンシューマ
– プロフェッショ
ナル

AES3/SPDIFフォーマットを選択します。

Status Bits
– Channel

– User
ステータス・ビット・タイプを選択し
ます。

Edit Bits
(Consumer)

Select Byte バイトを選択して編集します。

Audio Mode
– Non-Linear PCM

– Linear PCM
オーディオ・モードを選択します。

著作権
– 著作権
– Non-copyright

著作権タイプを選択します。

Emphasis

– No pre-emphasis

– 50/15 ìs

– Reserved 1

– Reserved 2

エンファシス・タイプを選択します。

Channel Mode 0～ 3 チャネル・モードの値を設定します。

表 A-5 デジタル・ジェネレータのメニュー・ツリーの概要（続き）

レベル 1 レベル 2 レベル 3 レベル 4 概要
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A 付録
AES3/SPDIF 
Edit Bits
(Consumer)

Category

– General

– Laser Optical

– D/D Converter

– Magnetic

– Digital Broadcast 1

– Digital Broadcast 2

– Musical Instrument

– ADC Non Copyright

– Solid State Memory

– ADC Copyright

– Experimental

– Reserved 1

– Reserved 2

カテゴリ・コード・タイプを選択します。

Source Num 0～ 15 ソース番号を設定します。

Channel Num 0～ 15 チャネル番号を設定します。

Sample Freq

– Not indicated

– 22.05 kHz

– 24 kHz

– 32 kHz

– 44.1 kHz

– 48 kHz

– 88.2 kHz

– 96 kHz

– 176.4 kHz

– 192 kHz

– 768 kHz

サンプリング周波数の値を選択します。

Clk Accuracy

– Level 1

– Level 2

– Level 3

– Reserved

クロック確度タイプを選択します。

Max Word Len
– 24 bits

– 20 bits
最大ワード長を選択します。

表 A-5 デジタル・ジェネレータのメニュー・ツリーの概要（続き）

レベル 1 レベル 2 レベル 3 レベル 4 概要
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付録 A
AES3/SPDIF 

Edit Bits
(Consumer)

Word Length

24ビットの最大
ワード長
– 指示なし
– 20 bits
– 21 bits
– 22 bits
– 23 bits
– 24 bits
20ビットの最大
ワード長
– Not indicated
– 16 bits
– 17 bits
– 18 bits
– 19 bits
– 20 bits

ワード長を選択します。

Orig Samp

– Not indicated
– 8 kHz
– 11.025 kHz
– 12 kHz
– 16 kHz
– 22.05 kHz
– 24 kHz
– 32 kHz
– 44.1 kHz
– 48 kHz
– 88.2 kHz
– 96 kHz
– 176.4 kHz
– 192 kHz
– Reserved 1
– Reserved 2

元のサンプリング周波数の値を選択し
ます。

CGMA-A

– Copying Permitted
– Condition Not Used
– One Generation 

Copy
– Copying Denied

CGMA-Aタイプを選択します。

Edit Bits
(Professional)

Select Byte バイトを選択して編集します。

Audio Mode
– Non-Linear PCM
– Linear PCM

オーディオ・モードを選択します。

Emphasis

– Not indicated
– No pre-emphasis
– 50/15 μs
– CCITT J.17

エンファシス・タイプを選択します。

表 A-5 デジタル・ジェネレータのメニュー・ツリーの概要（続き）
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A 付録
AES3/SPDIF 
Edit Bits
(Professional)

Freq Mode
– Locked

– Unlocked
周波数モードを選択します。

Sample Freq

– Not indicated

– 22.05 kHz

– 24 kHz

– 32 kHz

– 44.1 kHz

– 48 kHz

– 88.2 kHz

– 96 kHz

– 176.4 kHz

– 192 kHz

サンプリング周波数の値を選択します。

Freq Scaling
– On

– Off
周波数スケーリングをオン／オフします。

Chan Mode

– Not indicated

– 2-channel

– Single channel

– Primary-Secondary

– Stereo

– Reserved 1

– Reserved 2

– Mono Double Rate

– Left Double Rate

– Right Double Rate

– Multichannel

チャネル・モードを選択します。

User Bits

– Not indicated

– 192-bit block

– Reserved for AES18

– User defined

– Reserved for 
Metadata

– As in IEC60958-3

ユーザ・ビット・タイプを選択します。

Aux Bits

– 20-bit not defined

– 24-bit main audio

– 20-bit single

– Reserved

補助ビットを選択します。

表 A-5 デジタル・ジェネレータのメニュー・ツリーの概要（続き）
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付録 A
AES3/SPDIF 
Edit Bits
(Professional)

Word Length

24ビットの最大
ワード長
– Not indicated

– 20 bits

– 21 bits

– 22 bits

– 23 bits

– 24 bits

20ビットの最大
ワード長
– Not indicated

– 16 bits

– 17 bits

– 18 bits

– 19 bits

– 20 bits

ワード長を選択します。

Alignment

– Not Indicated

– － 18.06 dBFS

– － 20 dBFS

– Reserved

調整レベルを選択します。

Multi-Channel
– Defined

– Undefined
マルチチャネル・ステータスを選択し
ます。

Multi-Ch Mode

– Mode 0

– Mode 1

– Mode 2

– Mode 3

– User Defined

マルチチャネル・ステータスが Definedに
設定されている場合にのみ使用可能です。
マルチチャネル・モードを選択します。 

Channel Num

– 1～ 16（既定義
のマルチチャネ
ル・ステータス）

– 1～ 128（未定義
のマルチチャネ
ル・ステータス）

チャネル番号を設定します。

Ref Signal

– Not a ref. signal

– Grade 1

– Grade 2

– Reserved

基準信号のタイプを選択します。

Channel Origin 発信元値を設定します（4桁の英数字）。

Channel Dest チャネル宛先値を設定します (4桁の英
数字）。

Local Addr 0～ 232–1 ローカル・アドレスの値を設定します。

Time of Day 0～ 232–1 時刻を設定します。

表 A-5 デジタル・ジェネレータのメニュー・ツリーの概要（続き）
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A 付録
AES3/SPDIF 

Edit Bits
(Professional)

Rel Flags

– 0-5

– 6-13

– 14-17

– 18-21

信頼性フラグを選択します。

Clear Bits すべてのビットをクリアします。

Save File

ビットをファイルに保存します。Saveメ
ニュー・ツリーについては、「Saveメ
ニュー・ツリー」（ページ）447を参照し
てください。

Load File

ビットをファイルからロードします。
Recallメニュー・ツリーについては、
「Recallメニュー・ツリー」（ページ）448
を参照してください。

References Volts/FS

デジタル・フル・スケール（1 FS）への変
換時に使用される D/Aコンバータのアナ
ログ出力電圧（V）の V/FS基準を設定し
ます。

表 A-5 デジタル・ジェネレータのメニュー・ツリーの概要（続き）
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付録 A
付録 F： アナログ・アナライザのメニュー・ツリー

表 A-6 アナログ ・アナライザのメニュー・ツリーの概要

レベル 1 レベル 2 レベル 3 概要

Functions

Multi-Chn
– Off
– Phase
– X-Talk

マルチチャネル・モードを選択します。

Function No.

– 1
– 2
– 3
– 4

設定を行うアクティブ機能番号を選択します。

Meas. Func.

– None
– Frequency
– AC Voltage
– DC Voltage
– THD+N Ratio
– THD+N Level
– SINAD
– THD Ratio
– THD Level
– SMPTE IMD
– DFD 60268 2nd
– DFD 60268 3rd
– DFD 60118 2nd
– DFD 60118 3rd
– SNR
– SNR (Fast)
– J-Test

測定機能を選択します。
この設定は、マルチチャネル・モードが Offに設定されている
場合にのみ使用可能です。

Functions
(Frequency)

Unit
– Hz
– ΔHz

単位タイプを選択します。

Format
– Off
– Delta

測定機能の戻り値の読取りフォーマットを選択します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準周波数として保存します。

Ref. Freq 基準周波数値を設定します。　
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A 付録
Functions
(AC Voltage) Unit

– dBg
– dBm
– dBr
– dBu
– dBV
– W
– V
– ΔV
– dBSPL
– x

単位タイプを選択します。

Functions
(AC Voltage)

Format

– Off
– Logarithmic
– Linear
– Delta

測定機能の戻り値の読取りフォーマットを選択します。

Set to 0 dB 測定されたレベルを基準レベルとして保存し、測定読取り
フォーマットを Logarithmicに設定します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準周波数として保存します。

Ref. Level
基準レベル値を設定します。
基準レベルは各チャネルに対して 1つだけです。

Ref. Imp
基準インピーダンス値を設定します。
この設定は、単位が Wに設定されている場合にのみ使用可能
です。

Cal SPL
校正レベル値を設定します。
この設定は、単位が dBSPLに設定されている場合にのみ使用可
能です。

Detector
– RMS
– Pk-Pk

ACレベル検出タイプを選択します。

Functions
(DC Voltage)

Unit
– V
– ΔV
– x

単位タイプを選択します。

Format
– Off
– Linear
– Delta

測定機能の戻り値の読取りフォーマットを選択します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準周波数として保存します。

Ref. Level
基準レベル値を設定します。
基準レベルは各チャネルに対して 1つだけです。

表 A-6 アナログ ・アナライザのメニュー・ツリーの概要（続き）
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付録 A
Functions
(THD+N Ratio)

Unit

– dB
– ΔdB
– %
– x

単位タイプを選択します。

Format
– Off
– Linear
– Delta

測定機能の戻り値の読取りフォーマットを選択します。

Set to 0 dB 測定された比を基準比として保存し、測定読取りフォーマット
を Deltaに設定します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準比として保存します。

Ref. Ratio
基準比の値を設定します。
基準比は各チャネルに対して 1つだけです。

Freq Lock
– Auto
– Gen Lock
– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。
この設定は、周波数ロックが Customに設定されている場合に
のみ使用可能です。

Functions
(THD+N Level)

Unit

– dBg
– dBm
– dBr
– dBu
– dBV
– W
– V
– ΔV
– dBSPL
– x

単位タイプを選択します。

Format

– Off
– Logarithmic
– Linear
– Delta

測定機能の戻り値の読取りフォーマットを選択します。

Set to 0 dB 測定されたレベルを基準レベルとして保存し、測定読取り
フォーマットを Logarithmicに設定します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準周波数として保存します。

Ref. Level
基準レベル値を設定します。
基準レベルは各チャネルに対して 1つだけです。

Ref. Imp
基準インピーダンス値を設定します。
この設定は、単位が Wに設定されている場合にのみ使用可能
です。

Cal SPL
校正レベル値を設定します。
この設定は、単位が dBSPLに設定されている場合にのみ使用可
能です。
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A 付録
Functions
(THD+N Level)

Freq Lock
– Auto
– Gen Lock
– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。
この設定は、周波数ロックが Customに設定されている場合に
のみ使用可能です。

Functions
(SINAD)

Unit

– dB
– ΔdB
– %
– x

単位タイプを選択します。

Format
– Off
– Linear
– Delta

測定機能の戻り値の読取りフォーマットを選択します。

Set to 0 dB 測定された比を基準比として保存し、測定読取りフォーマット
を Deltaに設定します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準比として保存します。

Ref. Ratio
基準比の値を設定します。
基準比は各チャネルに対して 1つだけです。

Freq Lock
– Auto
– Gen Lock
– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。
この設定は、周波数ロックが Customに設定されている場合に
のみ使用可能です。

Functions
(THD Ratio)

Unit

– dB
– ΔdB
– %
– x

単位タイプを選択します。

Format
– Off
– Linear
– Delta

測定機能の戻り値の読取りフォーマットを選択します。

Set to 0 dB 測定された比を基準比として保存し、測定読取りフォーマット
を Deltaに設定します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準比として保存します。

Ref. Ratio
基準比の値を設定します。
基準比は各チャネルに対して 1つだけです。

Even Harmonic

– ALL
– 2
– 4
– 6
– 8

偶数次高調波の次数の選択を表示します。

表 A-6 アナログ ・アナライザのメニュー・ツリーの概要（続き）
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付録 A
Functions
(THD Ratio)

Odd Harmonic

– ALL
– 3
– 5
– 7
– 9

奇数次高調波の次数の選択を表示します。

Freq Lock
– Auto
– Gen Lock
– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。
この設定は、周波数ロックが Customに設定されている場合に
のみ使用可能です。

Functions
(THD Level)

Unit

– dBg
– dBm
– dBr
– dBu
– dBV
– W
– V
– ΔV
– dBSPL
– x

単位タイプを選択します。

Format

– Off
– Logarithmic
– Linear
– Delta

測定機能の戻り値の読取りフォーマットを選択します。

Set to 0 dB 測定されたレベルを基準レベルとして保存し、測定読取り
フォーマットを Logarithmicに設定します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準周波数として保存します。

Ref. Level
基準レベル値を設定します。
基準レベルは各チャネルに対して 1つだけです。

Ref. Imp
基準インピーダンス値を設定します。
この設定は、単位が Wに設定されている場合にのみ使用可能
です。

Cal SPL
校正レベル値を設定します。
この設定は、単位が dBSPLに設定されている場合にのみ使用可
能です。

Even Harmonic

– ALL
– 2
– 4
– 6
– 8

偶数次高調波の次数の値を選択します。

表 A-6 アナログ ・アナライザのメニュー・ツリーの概要（続き）
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A 付録
Functions
(THD Level)

Odd Harmonic

– ALL
– 3
– 5
– 7
– 9

奇数次高調波の次数の値を選択します。

Freq Lock
– Auto
– Gen Lock
– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。
この設定は、周波数ロックが Customに設定されている場合に
のみ使用可能です。

Functions
(SMPTE IMD)

Unit

– dB
– ΔdB
– %
– x

単位タイプを選択します。

Format
– Off
– Linear
– Delta

測定機能の戻り値の読取りフォーマットを選択します。

Set to 0 dB 測定された比を基準比として保存し、測定読取りフォーマット
を Deltaに設定します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準比として保存します。

Ref. Ratio
基準比の値を設定します。
基準比は各チャネルに対して 1つだけです。

Freq Lock
– Gen Lock
– Custom

上側周波数と下側周波数の探索方法を選択します。

Upper Freq
上側周波数値を設定します。
この設定は、周波数ロックが Customに設定されている場合に
のみ使用可能です。

Lower Freq
下側周波数値を設定します。
この設定は、周波数ロックが Customに設定されている場合に
のみ使用可能です。

表 A-6 アナログ ・アナライザのメニュー・ツリーの概要（続き）
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付録 A
Functions
(DFD60268 2nd/
DFD 60268 3rd/
DFD 60118 2nd/
DFD 60118 3rd)

Unit

– dB
– ΔdB
– %
– x

単位タイプを選択します。

Format
– Off
– Linear
– Delta

測定機能の戻り値の読取りフォーマットを選択します。

Set to 0 dB 測定された比を基準比として保存し、測定読取りフォーマット
を Deltaに設定します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準比として保存します。

Ref. Ratio
基準比の値を設定します。
基準比は各チャネルに対して 1つだけです。

Functions
(SNR)

Unit

– dB
– ΔdB
– %
– x

単位タイプを選択します。

Format
– Off
– Linear
– Delta

測定機能の戻り値の読取りフォーマットを選択します。

Set to 0 dB 測定された比を基準比として保存し、測定読取りフォーマット
を Deltaに設定します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準比として保存します。

Ref. Ratio
基準比の値を設定します。
基準比は各チャネルに対して 1つだけです。

SNR Delay SNR遅延値を設定します。

Functions
(SNR (Fast))

Unit

– dB
– ΔdB
– %
– x

単位タイプを選択します。

Format
– Off
– Linear
– Delta

測定機能の戻り値の読取りフォーマットを選択します。

Set to 0 dB 測定された比を基準比として保存し、測定読取りフォーマット
を Deltaに設定します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準周波数として保存します。

Ref. Ratio
基準比の値を設定します。
基準比は各チャネルに対して 1つだけです。

表 A-6 アナログ ・アナライザのメニュー・ツリーの概要（続き）

レベル 1 レベル 2 レベル 3 概要
Keysight U8903B ユーザーズ・ガイド 423



A 付録
Functions
(SNR (Fast))

Freq Lock
– Auto
– Gen Lock
– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。
この設定は、周波数ロックが Customに設定されている場合に
のみ使用可能です。

Harmonics 削除する高調波の次数を設定します。

Functions
(Phase)

Ref. Channel 基準チャネル番号を設定します。

Freq Lock
– Auto
– Gen Lock
– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。
この設定は、周波数ロックが Customに設定されている場合に
のみ使用可能です。

Functions
(X-Talk)

Ref. Channel ドライブ・チャネルを設定します。

Unit

– dB
– ΔdB
– %
– x

単位タイプを選択します。

Format
– Off
– Linear
– Delta

測定機能の戻り値の読取りフォーマットを選択します。

Set to 0 dB 測定された比を基準比として保存し、測定読取りフォーマット
を Deltaに設定します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準比として保存します。

Ref. Ratio
基準比の値を設定します。
基準比は各チャネルに対して 1つだけです。

Freq Lock
– Auto
– Gen Lock
– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。
この設定は、周波数ロックが Customに設定されている場合に
のみ使用可能です。

表 A-6 アナログ ・アナライザのメニュー・ツリーの概要（続き）
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付録 A
Filters Config

Clear Filters すべてのフィルタ設定をクリアします。

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

ローパス・フィルタを選択します。

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

ハイパス・フィルタを選択します。

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– C-Message
– CCITT
– Custom

評価雑音フィルタを選択します。

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

フィルタのディエンファシス値を選択します。

Notch Filter

State
ノッチ・フィルタをオン／オフします。
– Enable
– Disable

Center Freq 入力信号から除去する成分の周波数を設定します。
Bandwidth 除去する信号成分の帯域幅を設定します。

表 A-6 アナログ ・アナライザのメニュー・ツリーの概要（続き）
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A 付録
Meas Config

Auto Range
– On
– Off

オートレンジをオン／オフします。

Range

– 140 V
– 100 V
– 32 V
– 10 V
– 3.2 V
– 1 V
– 320 mV

入力電圧レンジの値を選択します。
この設定は、オートレンジがオフの場合にのみ使用可能です。

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

サンプル・サイズを選択します。

Average Points 1～ 50 移動平均計算に使用する測定値の個数を設定します。

Src Channel

以下の状況で使用する基準チャネルとして、内蔵ジェネレー
タ・チャネルを選択します。
dBg単位での結果の計算。
周波数ロックが Gen Lockに設定されている場合の周波数探索ア
ルゴリズム。

Trigger Source
– Free Run
– External

トリガ・ソースを選択します。

Trigger Edge
– Rising
– Falling

トリガ・エッジ・タイプを選択します。

Input Config

Connector
– UnBal
– Bal
– Loopback

入力コネクタ・タイプを選択します。

Impedance

– 100 kΩ 
(for UnBal)

– 200 kΩ 
(for Bal)

– 600 Ω
– 300 Ω

入力インピーダンス値を選択します。
この設定は、入力コネクタが UnBalまたは Balに設定されてい
る場合にのみ使用可能です。

Coupling
– DC
– AC

入力結合タイプを選択します。

表 A-6 アナログ ・アナライザのメニュー・ツリーの概要（続き）
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付録 A
Input Config
Bandwidth

– 90 kHz
– 1.5 MHz

入力帯域幅の値を選択します。
この設定は、オプション N3431Aでのみ使用可能です。詳細に
ついては、「U8903Bオプション」（ページ）33を参照してくだ
さい。

Ext. Gain 入力の外部利得値を設定します。

Wave File

Channel
– Left
– Right
– Stereo

波形ファイルのチャネル・タイプを選択します。

Bits/Sample
– 8
– 16
– 24

波形ファイルのサンプル当たりのビット数を選択します。

Duration 1 s～ 600 s 波形ファイルのレコーディング時間を設定します。

Record 記録を開始し、測定値を波形ファイルに保存します。

Statistics

Show Stats
– On
– Off

統計計算をオン／オフします。

No. of Reading 2～ 20 統計計算に使用する測定値の個数を設定します。

Stat 1
Stat2
Stat3

– Min
– Max
– Average
– Std Dev
– ΔMinMax

統計計算タイプを選択します。

Clear 現在のアナログ・アナライザの統計結果をリセットします。

表 A-6 アナログ ・アナライザのメニュー・ツリーの概要（続き）
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A 付録
付録 G： デジタル・アナライザのメニュー・ツリー

表 A-7 デジタル・アナライザのメニュー・ツリーの概要

レベル 1 レベル 2 レベル 3 レベル 4 概要

Meas Mode
– Standard
– Process Delay
– BERT

解析モードを選択します。

Unit
– Hex
– Dec

解析モードが BERTの場合にのみ使用可能
です。
BERT解析モードの単位を選択します。

Functions

Multi-Chn
– Off
– Phase
– X-Talk

マルチチャネル・モードを選択します。

Function No.

– 1
– 2
– 3
– 4

設定を行うアクティブ機能番号を選択し
ます。

Meas Func

– None
– Frequency
– AC Voltage
– DC Voltage
– THD+N Ratio
– THD+N Level
– SINAD
– THD Ratio
– THD Level
– SMPTE IMD
– DFD 60268 2nd
– DFD 60268 3rd
– DFD 60118 2nd
– DFD 60118 3rd
– Positive Peak
– Negative Peak

測定機能を選択します。
この設定は、マルチチャネル・モードが
Offに設定されている場合にのみ使用可能
です。

Functions
(Frequency)

Unit
– Hz
– ΔHz

単位タイプを選択します。

Format
– Off
– Delta

測定機能の戻り値の読取りフォーマット
を選択します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準周波
数として保存します。

Ref. Freq 基準周波数値を設定します。　
428 Keysight U8903B ユーザーズ・ガイド



付録 A
Functions
(AC Voltage)

Unit

– FFS
– dBFS
– ％FS
– V
– dB
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL

単位タイプを選択します。

Format
– Off
– Logarithmic
– Linear

測定機能の戻り値の読取りフォーマット
を選択します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準周波
数として保存します。

Ref. Level
基準レベル値を設定します。
基準レベルは各チャネルに対して 1つだ
けです。

Volt/FS V/FS基準値を設定します。

Detector
– RMS
– Pk-Pk

ACレベル検出タイプを選択します。

Functions
(DC Voltage)

Unit

– FFS
– V
– Hex
– x

単位タイプを選択します。

Format
– Off
– Linear

測定機能の戻り値の読取りフォーマット
を選択します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準周波
数として保存します。

Ref. Voltage
基準電圧値を設定します。
基準レベルは各チャネルに対して 1つだ
けです。

表 A-7 デジタル・アナライザのメニュー・ツリーの概要（続き）
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A 付録
Functions
(THD+N Ratio)

Unit

– dB
– ΔdB
– %
– x

単位タイプを選択します。

Format
– Off
– Linear
– Delta

測定機能の戻り値の読取りフォーマット
を選択します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準比と
して保存します。

Ref. Ratio
基準比の値を設定します。
基準比は各チャネルに対して 1つだけ
です。

Precision
– On
– Off

高精度モードをオン／オフします。

Freq Lock
– Auto
– Gen Lock
– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。
この設定は、周波数ロックが Customに設
定されている場合にのみ使用可能です。

Functions
(THD+N Level)

Unit

– FFS
– dBFS
– ％FS
– V
– dB
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL

単位タイプを選択します。

Format
– Off
– Logarithmic
– Linear

測定機能の戻り値の読取りフォーマット
を選択します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準周波
数として保存します。

Ref. Level
基準レベル値を設定します。
基準レベルは各チャネルに対して 1つだ
けです。

Volt/FS V/FS基準値を設定します。

Precision
– On
– Off

高精度モードをオン／オフします。

表 A-7 デジタル・アナライザのメニュー・ツリーの概要（続き）
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付録 A
Functions
(THD+N Level)

Freq Lock
– Auto
– Gen Lock
– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。
この設定は、周波数ロックが Customに設
定されている場合にのみ使用可能です。

Functions
(SINAD)

Unit

– dB
– ΔdB
– %
– x

単位タイプを選択します。

Format
– Off
– Linear
– Delta

測定機能の戻り値の読取りフォーマット
を選択します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準比と
して保存します。

Ref. Ratio
基準比の値を設定します。
基準比は各チャネルに対して 1つだけで
す。

Precision
– On
– Off

高精度モードをオン／オフします。

Freq Lock
– Auto
– Gen Lock
– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。
この設定は、周波数ロックが Customに設
定されている場合にのみ使用可能です。

Functions
(THD Ratio)

Unit

– dB
– ΔdB
– %
– x

単位タイプを選択します。

Format
– Off
– Linear
– Delta

測定機能の戻り値の読取りフォーマット
を選択します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準比と
して保存します。

Ref. Ratio
基準比の値を設定します。
基準比は各チャネルに対して 1つだけ
です。

Even Harmonic

– ALL
– 2
– 4
– 6
– 8

偶数次高調波の次数の選択を表示します。

表 A-7 デジタル・アナライザのメニュー・ツリーの概要（続き）
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A 付録
Functions
(THD Ratio) Odd Harmonic

– ALL
– 3
– 5
– 7
– 9

奇数次高調波の次数の選択を表示します。

Functions
(THD Level)

Unit

– FFS
– dBFS
– ％FS
– V
– dB
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL

単位タイプを選択します。

Format
– Off
– Logarithmic
– Linear

測定機能の戻り値の読取りフォーマット
を選択します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準周波
数として保存します。

Ref. Level
基準レベル値を設定します。
基準レベルは各チャネルに対して 1つだ
けです。

Volt/FS V/FS基準値を設定します。

Even Harmonic

– ALL
– 2
– 4
– 6
– 8

偶数次高調波の次数の値を選択します。

Odd Harmonic

– ALL
– 3
– 5
– 7
– 9

奇数次高調波の次数の値を選択します。

表 A-7 デジタル・アナライザのメニュー・ツリーの概要（続き）

レベル 1 レベル 2 レベル 3 レベル 4 概要
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付録 A
Functions
(SMPTE IMD)

Unit

– dB
– ΔdB
– %
– x

単位タイプを選択します。

Format
– Off
– Linear
– Delta

測定機能の戻り値の読取りフォーマット
を選択します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準比と
して保存します。

Ref. Ratio 基準比の値を設定します。

Functions
(DFD60268 2nd/
DFD 60268 3rd/
DFD 60118 2nd/
DFD 60118 3rd)

Unit

– dB
– ΔdB
– %
– x

単位タイプを選択します。

Format
– Off
– Linear
– Delta

測定機能の戻り値の読取りフォーマット
を選択します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準比と
して保存します。

Ref. Ratio
基準比の値を設定します。
基準比は各チャネルに対して 1つだけ
です。

Functions
(Positive peak)

Unit

– FFS
– dBFS
– ％FS
– V
– dB
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL

測定単位タイプを選択します。

Format
– Off
– Logarithmic
– Linear

測定機能の戻り値の読取りフォーマット
を選択します。

Functions
(Positive peak)

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準周波
数として保存します。

Ref. Level
基準レベル値を設定します。
基準レベルは各チャネルに対して 1つだ
けです。

Volt/FS V/FS基準値を設定します。

表 A-7 デジタル・アナライザのメニュー・ツリーの概要（続き）
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A 付録
Functions
(Negative peak)

Unit

– FFS
– dBFS
– ％FS
– V
– dB
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL

測定単位タイプを選択します。

Format
– Off
– Logarithmic
– Linear

測定機能の戻り値の読取りフォーマット
を選択します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準周波
数として保存します。

Ref. Level
基準レベル値を設定します。
基準レベルは各チャネルに対して 1つだ
けです。

Volt/FS V/FS基準値を設定します。

Functions
(Phase) Ref. Channel 基準チャネル番号を設定します。

Functions
(X-Talk)

Ref. Channel ドライブ・チャネルを設定します。

Unit

– dB
– ΔdB
– %
– x

単位タイプを選択します。

Format
– Off
– Linear
– Delta

測定機能の戻り値の読取りフォーマット
を選択します。

Set result as ref. from チャネル 1～ 8 選択したチャネルの測定結果を基準比と
して保存します。

Functions
(X-Talk)

Ref. Ratio
基準比の値を設定します。
基準比は各チャネルに対して 1つだけ
です。

Freq Lock
– Auto
– Gen Lock
– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。
この設定は、周波数ロックが Customに設
定されている場合にのみ使用可能です。

表 A-7 デジタル・アナライザのメニュー・ツリーの概要（続き）
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付録 A
Filters Config

Clear Filters すべてのフィルタ設定をクリアします。

LPF

– None
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– Custom

ローパス・フィルタを選択します。

HPF

– None
– 20 Hz
– 100 Hz
– 400 Hz
– Custom

ハイパス・フィルタを選択します。

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– C-Message
– CCITT
– Custom

評価雑音フィルタを選択します。

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

フィルタのディエンファシス値を選択し
ます。

Sample Rate

– 32 kHz
– 44.1 kHz
– 48 kHz
– 88.2 kHz
– 96 kHz
– 176.4 kHz
– 192 kHz

サンプリング・レートを選択します。

表 A-7 デジタル・アナライザのメニュー・ツリーの概要（続き）
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A 付録
Meas Config

Coupling
– DC
– AC

結合タイプを選択します。

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

サンプル・サイズを選択します。

Average Points 1～ 20 移動平均計算に使用する測定値の個数を
設定します。

Trigger

Trigger Source
– Free Run
– External
– Channel

トリガ・ソースを選択します。

Trigger Edge
– Rising
– Falling

トリガ・ソースが Externalまたは Channel
の場合にのみ使用可能です。
トリガ・エッジ・タイプを選択します。

Interface
– Analog
– Digital

トリガ・ソースが Channelの場合にのみ使
用可能です。
トリガ・インタフェースを選択します。

Channel
トリガ・ソースが Channelの場合にのみ使
用可能です。
チャネル番号を設定します。 

トリガ・レベル
トリガ・ソースが Channelの場合にのみ使
用可能です。
トリガ・レベルを設定します。 

表 A-7 デジタル・アナライザのメニュー・ツリーの概要（続き）
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付録 A
Input Config

Connector

– UnBal
– Bal
– Optical
– DSI

入力コネクタ・タイプを選択します。

Impedance

不平衡コネクタ・
タイプ
– 75 Ω
– HiZ
平衡コネクタ・タ
イプ
– 110 Ω
– HiZ

入力インピーダンスの値を選択します。

Freq Scaling
– MISR
– Custom

周波数スケーリング・タイプを選択し
ます。

Ref SR

周波数スケーリングが Customの場合にの
み使用可能です。
基準サンプリング・レートの値を設定し
ます。 

表 A-7 デジタル・アナライザのメニュー・ツリーの概要（続き）
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A 付録
DSI Config

Format

– Left
– Right
– I2S
– DSP

データ・フォーマットを選択します。

Fsync Polarity
– Rising
– Falling

フォーマットが Leftまたは Rightの場合に
のみ使用可能です。
フレーム・クロックのエッジ同期を選択
します。

Fsync Width
– One Bit Clock
– One Subframe
– 50% Duty Cycle

フォーマットが Leftまたは Rightの場合に
のみ使用可能です。
フレーム・クロックの同期幅を選択し
ます。 

Data Shift Cnt

フォーマットが Leftまたは Rightの場合に
のみ使用可能です。
データ・シフト・カウント値を設定し
ます。

Data Shift Dir
– Left
– Right

フォーマットが Leftまたは Rightの場合に
のみ使用可能です。
データ・シフト方向を選択します。

Word Length 8～ 32
ワード長の値を設定します。ワード長の
値は、オーディオ分解能以上である必要
があります。

Resolution 8～ 24 オーディオ分解能の値を設定します。

Decoding 
– Linear PCM
– A-Law
– μ-Law

デコード・フォーマットを選択します。

W/Bclk Dir
– In
– Out

ワード／ビット・クロック方向を選択し
ます。

Bit Clk Edge
– Rising
– Falling

ビット・クロック・エッジを選択します。

Voltage

– 1.2 Vpp
– 1.5 Vpp
– 1.8 Vpp
– 2.5 Vpp
– 3 Vpp
– 3.3 Vpp
– Custom

入力電圧値を選択します。

表 A-7 デジタル・アナライザのメニュー・ツリーの概要（続き）
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付録 A
AES Config

Decoding 
– Linear PCM
– A- Law
– μ- Law

デコード・フォーマットを選択します。

Resolution 8～ 24 オーディオ分解能の値を設定します。

Status Bits
– Channel
– User

ステータス・ビット・タイプを選択しま
す。

Save in Hex

ステータス・ビットを HEXファイルに保
存します。
Saveメニュー・ツリーについては、「Save
メニュー・ツリー」（ページ）447を参照
してください。

Save in Xml

ステータス・ビットを XMLファイルに保
存します。
Saveメニュー・ツリーについては、「Save
メニュー・ツリー」（ページ）447を参照
してください。

Bits Analysis

Refresh Rate リフレッシュ・レートを設定します。

Bit Types
– Data
– Active

ビット・タイプを選択します。

Statistics

Show Stats
– On
– Off

統計計算をオン／オフします。

No. of Reading 2～ 20 統計計算に使用する測定値の個数を設定
します。

Stat 1
Stat2
Stat3

– Min
– Max
– Average
– Std Dev
– ΔMinMax

統計計算タイプを選択します。

Clear 現在のアナログ・アナライザの統計結果
をリセットします。

表 A-7 デジタル・アナライザのメニュー・ツリーの概要（続き）
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A 付録
付録 H： Graph Analysisメニュー・ツリー

表 A-8 Graph Analysisメニュー・ツリーの概要

レベル 1 レベル 2 レベル 3 概要

Analysis Mode

– Frequency
– Phase
– Time
– PSD

現在の Graphパネルにプロットするグラフ解析モードを選択し
ます。
この設定は、グラフ解析の表示オプションが Harmonicsの場合
には使用できません。

Harm Settings

Active Channel AA1～ AA8

アクティブ・チャネルを選択します。 
この設定は、グラフ解析の表示オプションが Harmonicsの場合
にのみ使用可能です。
AA2: アナログ・アナライザ・チャネル 2

Odd Harmonic

– ALL
– 3
– 5
– 7
– 9

奇数次高調波の次数の値を選択します。 
この設定は、グラフ解析の表示オプションが Harmonicsの場合
にのみ使用可能です。

Even Harmonic

– ALL
– 2
– 4
– 6
– 8

偶数次高調波の次数の値を選択します。 
この設定は、グラフ解析の表示オプションが Harmonicsの場合
にのみ使用可能です。

Display
– Harmonics
– THD 

高調波の表示オプションを選択します。
この設定は、グラフ解析の表示オプションが Harmonicsの場合
にのみ使用可能です。

THD Unit
– dB
– %

THD測定の単位を選択します。
この設定は、グラフ解析の表示オプションが Harmonicsの場合
にのみ使用可能です。

Graph Settings

Active Channel AA1～ AA8
使用可能なアクティブ・チャネルを選択します。
AA2: アナログ・アナライザ・チャネル 2

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

グラフのサンプル・サイズの値を選択します。
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付録 A
Graph Settings

Window

– Rectangular
– Hanning
– Blackman
– Rife-Vincent 
– Rife-Vincent 3
– Hamming
– Flat Top
– Kaiser

FFT処理前にデータに適用するウィンドウ関数を選択します。

Sync Avg 1～ 64 FFT処理が実行される前に収集／アベレージングするサンプル
の数を設定します。

Hold

– None
– Average
– Min
– Max

FFT処理後に実行するホールドのタイプを選択します。

Axis Settings

Axis
– Primary
– Secondary

設定するアクティブ軸を選択します。

Enabled
– On
– Off

軸設定をオン／オフします。
この設定は、軸タイプが Secondaryの場合にのみ使用可能です。
軸タイプが Primaryの場合は、常に Onに設定されます。

Left 左軸のリミット値を設定します。

Right 右軸のリミット値を設定します。

Span グラフ内のモニタする全 X軸スパンまたは全範囲を設定し
ます。

Center グラフ内の X軸の中心点を設定します。

Top 上軸のリミット値を設定します。

Bottom 下軸のリミット値を設定します。

X-Scale
– Linear
– Log

X軸のスケール・タイプを選択します。

Y-Scale
– Linear
– Log

Y軸のスケール・タイプを選択します。

Trace Settings

Active Trace 1～ 8 アクティブ・トレース・チャネルを選択します。

Source 使用可能なチャネル、ファイル、メモリから、アクティブ・ト
レースのデータ・ソースを選択します。

Enabled
– On
– Off

アクティブ・トレース・データをオン／オフします。

Memory

Save To Memory アクティブ・トレースをメモリ・バッファに保存します。

Load From Memory トレースをメモリ・バッファからアクティブ・トレースにロー
ドします。

Clear Memory トレースをメモリ・バッファから消去します。

表 A-8 Graph Analysisメニュー・ツリーの概要（続き）
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A 付録
Trace Settings

Math

Apply Math

対応する演算関数をトレース・データに適用するか、オフにし
ます。
– On
– Off

Function

アクティブ・トレースに適用する演算関数を選択します。
– f(Source)
– f(Source) + x
– f(Source) - x
– f(Source) * x
– f(Source) / x

Variable 選択した演算関数の x値を設定します。

Unit

– V
– dBV
– dBu
– W
– dBm
– dBSPL

トレースの単位タイプを選択します。

Persistence

Persist アクティブ・トレースの残光表示をオン／オフします。

Persist Count

削除する前にグラフに表示する以前のトレース・データのセッ
ト数を設定します。
この設定は、残光表示をオンにしている場合にのみ使用可能で
す。

Axis
– Primary
– Secondary

アクティブ・トレースをプライマリ軸またはセカンダリ軸に配
置します。

Color

– Yellow
– Cyan
– White
– Pink
– Green
– Orange
– Red
– Purple

アクティブ・トレースの色を選択します。

Display Option

– Graph
– Data Table
– Marker Table
– Statistics
– Harmonics
– Signal Analysis

グラフ解析の表示オプションを選択します。

Running mode
Continuous
Single グラフ解析の実行モードを選択します。

表 A-8 Graph Analysisメニュー・ツリーの概要（続き）
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付録 A
Measurement

Enabled
– On
– Off

グラフの測定値をオン／オフします。

Measurement 1

Interface 測定のインタフェース・タイプを選択します。

Channel 測定を実行するために必要なチャネルを選択します。

Function No 機能番号（1～ 4）に基づいて表示する機能を選択します。

Measurement 2

Interface 測定のインタフェース・タイプを選択します。

Channel 測定を実行するために必要なチャネルを選択します。

Function No 機能番号（1～ 4）に基づいて表示する機能を選択します。

表 A-8 Graph Analysisメニュー・ツリーの概要（続き）
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A 付録
付録 I： 掃引機能のメニュー・ツリー

表 A-9 掃引機能のメニュー・ツリーの概要

レベル 1 レベル 2 レベル 3 レベル 4 概要

App.Type
– Sweep
– Group Delay

掃引のアプリケーション・タイプを選択
します。

Parameter

掃引のアプリケーション・タイプが Sweep
の場合にのみ使用可能です。
掃引パラメータ・タイプを選択します。
パラメータの選択は、アナログ・ジェネ
レータの波形タイプの設定に依存します。

Points Settings

Spacing
– Log
– Linear
– Custom

間隔タイプを選択します。

Unit

– Vrms
– dBV
– Vp
– Vpp
– dBm
– dBu
– dBSPL

掃引単位を選択します。
この設定は、掃引パラメータが振幅の場
合にのみ使用可能です。

Start
掃引スタート値を設定します。この設定
は、掃引間隔が Logまたは Linearの場合に
のみ使用可能です。

Stop
掃引ストップ値を設定します。この設定
は、掃引間隔が Logまたは Linearの場合に
のみ使用可能です。

Step
掃引ステップ値を設定します。この設定
は、掃引間隔が Logまたは Linearの場合に
のみ使用可能です。

Points
掃引ポイント数を設定します。この設定
は、掃引間隔が Logまたは Linearの場合に
のみ使用可能です。

Edit Points
ポイント編集のメニュー・ツリーについ
ては、「Edit points」（ページ）445を参照
してください。

Dwell Time ジェネレータの信号出力の遅延時間を ms
単位で設定します。

Sweep Mode
Continuous
Single 掃引モードを選択します。

Channels

Source 1～ 2 ソース・チャネルを選択します。

Measure 1～ 8

測定チャネルを選択します。
選択可能な数は、インストールされてい
るアナログ・アナライザ・カードの数に
よって異なります。
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付録 A
Plot View

Axis Settings

Left 左軸の値を設定します。

Right 右軸の値を設定します。

Top 上軸の値を設定します。

Bottom 下軸の値を設定します。

X-Scale
– Linear
– Log

X軸のスケール・タイプを選択します。

Y-Scale
– Linear
– Log

Y軸のスケール・タイプを選択します。

Plot Settings

Data Channel プロットするトレース・データ・チャネ
ル番号を選択します。

Y Data

– S:<掃引パラメ
ータ >

– F1: <掃引機能 1>
– F2: <掃引機能 2>
– F3: <掃引機能 3>
– F4: <掃引機能 4>

Y軸のトレース・データ・ソースを選択し
ます。

X Data

– S:<掃引パラメ
ータ >

– F1: <掃引機能 1>
– F2: <掃引機能 2>
– F3: <掃引機能 3>
– F4: <掃引機能 4>

X軸のトレース・データ・ソースを選択し
ます。

Hold Type

– None
– Average
– Max
– Min

グラフにプロットするデータ・タイプを
選択します。

Edit points

Data Channel プロットするトレース・データ・チャネ
ル番号を選択します。

Goto Point 移動先の掃引ポイント番号を設定します。

Point Value 現在選択されている掃引ポイントの値を
設定します。

Add Point 掃引ポイントを追加します。

Remove Point 選択した掃引ポイントを削除します。

Load Points

掃引ポイントをファイルからロードし
ます。
Recallメニュー・ツリーについては、
「Recallメニュー・ツリー」（ページ）448
を参照してください。

表 A-9 掃引機能のメニュー・ツリーの概要（続き）

レベル 1 レベル 2 レベル 3 レベル 4 概要
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A 付録
Plot View

Edit points Save Points

掃引ポイントをファイルに保存します。
Saveメニュー・ツリーについては、「Save
メニュー・ツリー」（ページ）447を参照
してください。

Save Pts

掃引ポイントをファイルに保存します。
Saveメニュー・ツリーについては、「Save
メニュー・ツリー」（ページ）447を参照
してください。

表 A-9 掃引機能のメニュー・ツリーの概要（続き）

レベル 1 レベル 2 レベル 3 レベル 4 概要
446 Keysight U8903B ユーザーズ・ガイド



付録 A
付録 J： Saveメニュー・ツリー

表 A-10 Saveメニュー・ツリーの概要

レベル 1 レベル 2 概要

Save ファイルに保存します。

Type 現在のディレクトリに表示するファイル・タイプを選択します。

Rename OK ファイル名を設定し、［OK］を選択してファイル名を変更します。

Copy or Move

Mark 選択したファイルにマークを付けます。

Copy Marked To Folder マークを付けたファイルを選択したフォルダにコピーします。

Move Marked To Folder マークを付けたファイルを選択したフォルダに移動します。

Delete 選択したファイルを削除します。

New Folder OK 新しいフォルダ名を設定し、［OK］を選択して新しいフォルダを作成し
ます。
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A 付録
付録 K： Recallメニュー・ツリー

表 A-11 Recallメニュー・ツリーの概要

レベル 1 レベル 2 概要

Recall 保存したファイルをリコールします。

Type 現在のディレクトリに表示するファイル・タイプを選択します。

Rename OK ファイル名を設定し、［OK］を選択してファイル名を変更します。

Copy or Move

Mark 選択したファイルにマークを付けます。

Copy Marked To Folder マークを付けたファイルを選択したフォルダにコピーします。

Move Marked To Folder マークを付けたファイルを選択したフォルダに移動します。

Delete 選択したファイルを削除します。

New Folder OK 新しいフォルダ名を設定し、［OK］を選択して新しいフォルダを作成し
ます。
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付録 A
付録 L： テスト・シーケンスのメニュー・ツリー

表 A-12 テスト・シーケンスのメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

Project

New Project 新規プロジェクトを作成します。

Open Project

プロジェクトをファイルからロードします。 
Recallメニュー・ツリーについては、「Recallメ
ニュー・ツリー」（ページ）448を参照してくだ
さい。

Save Project

プロジェクトをファイルに保存します。 
Saveメニュー・ツリーについては、「Saveメ
ニュー・ツリー」（ページ）447を参照してくだ
さい。

Properties

Prompt DUT ID
– On
– Off

テスト・シーケンスの開始時にデバイス ID（デ
バイスのシリアル番号）の入力を求めるプロン
プトの表示をオン／オフします。

Prompt Msg
プロンプト・メッセージを設定します。
この設定は、Prompt DUT IDがオンになっている
場合にのみ使用可能です。

Pass/Fail Msg
– On
– Off

テスト・シーケンスの終わりに表示されるオン
スクリーン・メッセージ・ダイアログ・ボック
スをオン／オフします。［Enter］を押すと、ダイ
アログ・ボックスが閉じます。

Pass Message
合格メッセージを編集します。
この設定は、Pass/Fail Msgがオンになっている場
合にのみ使用可能です。

Fail Message
不合格メッセージを編集します。
この設定は、Pass/Fail Msgがオンになっている場
合にのみ使用可能です。

Report

Clear すべてのレポート・データをクリアします。

Save

レポートを DOCXファイル・フォーマットに保存
します。
Saveメニュー・ツリーについては、「Saveメ
ニュー・ツリー」（ページ）447を参照してくだ
さい。

Properties

Auto Save
– Enable
– Disable

テスト・シーケンスの終了時のレポートの自動
保存をオン／オフします。

Format
– Docx
– Html

保存するレポートのファイル・フォーマットを
選択します。

Name Option
– Timestamp
– Numeric
– Prompt

自動保存するレポートのファイル名の命名規則
を選択します。

Prefix ファイル名のプレフィックスを設定します。

Location
Select 自動保存するレポートのフォルダを選択します。

New Folder 現在のディレクトリまたはフォルダに新しい
フォルダを作成します。
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A 付録
Test

Enable
– On
– Off

選択したテスト・シーケンスをオン／オフし
ます。

Add Test Sequence
New
Saved 新しいテスト・シーケンスを追加します。

Delete Test 
Sequence 選択したテスト・シーケンスを削除します。

Save

テスト・シーケンスをファイルに保存します。
Saveメニュー・ツリーについては、「Saveメ
ニュー・ツリー」（ページ）447を参照してくだ
さい。

Edit

Move 選択したテスト・シーケンスを移動します。
Copy 選択したテスト・シーケンスをコピーします。

Paste 選択したテスト・シーケンスの後にコピーした
テスト・シーケンスを貼り付けます。

Properties Name テスト・シーケンス名を設定します。

IO Configuration

Add Measurement

測定を選択したテスト・シーケンスに追加し
ます。 
テスト測定のリストについては、「Add 
Measurement」（ページ）453を参照してくだ
さい。

Edit Paste IO設定の後にコピーした測定を貼り付けます。
IO設定を移動／コピーすることはできません。

Settings: Output 
Configuration

Channels
– None (External)
– 1
– 2

使用する出力チャネル数を選択します。

Connector

– Bal
– UnBal
– Com
– IEC60268

出力コネクタ・タイプを選択します。

Impedance

– Bal、Com、
IEC60268の場
合

– 600 Ω
– 100 Ω
– 40 Ω
– UnBalの場合
– 600 Ω
– 50 Ω
– 20 Ω

出力インピーダンス値を選択します。

IEC60268
– Pin 2
– Pin 3

一般的な IEC 60268構成の XLRコネクタのピン 2
または 3に追加する 10 Ω出力直列抵抗を選択し
ます。
この設定は、出力コネクタ・タイプが IEC 60268
に設定されている場合にのみ使用可能です。

Ground
– Float
– Ground

グランド・タイプを選択します。

表 A-12 テスト・シーケンスのメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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付録 A
IO Configuration

Settings: Output 
Configuration

Max Voltage 最大電圧を設定します。

Reference Impedance dBm測定の単位変換の基準インピーダンス値を
設定します。

Settings: Input 
Configuration

Channels 使用する入力チャネル数を選択します。

Connector
– UnBal
– Bal
– Loopback

入力コネクタ・タイプを選択します。

Impedance

– 100 kΩ (for 
Unbalanced)

– 200 kΩ (for 
Balanced)

– 600 Ω
– 300 Ω

入力インピーダンスの値を選択します。
この設定は、Connectorが UnBalまたは Balに設定
されている場合にのみ使用可能です。

Coupling
– DC
– AC

入力結合タイプを選択します。

Bandwidth
– 90 kHz
– 1.5 MHz

入力帯域幅の値を選択します。
この設定は、オプション N3431Aでのみ使用可能
です。

Reference

Voltage 入力電圧の値を設定します。
Ratio 入力の比の値を設定します。
Frequency 入力周波数の値を設定します。
Impedance 入力インピーダンスの値を設定します。
Sound level 入力のサウンド・レベルの値を設定します。

Calibrator level 入力のキャリブレータ・レベルの値を設定し
ます。

Properties

Name IO設定の名前を変更します。

Sub-Steps: RunIO 
Configuration

Add Sub-Step

サブステップをリストに追加します。
– Delay
– Prompt
– Sent SCPI

Edit RunIO Configurationサブステップをリスト内で移
動します。

Sub-Steps: 
Delay

Enable
Delayサブステップをオン／オフします。
– On
– Off

Add Sub-Step

サブステップをリストに追加します。
– Delay
– Prompt
– Sent SCPI

Delete Sub-Step 選択したサブステップを削除します。

Edit
選択したサブステップを移動またはコピーする
か、選択したサブステップの後にコピーしたサ
ブステップを貼り付けます。

表 A-12 テスト・シーケンスのメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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A 付録
IO Configuration Properties

Sub-Steps:  
Delay

Settings
Delayサブステップの設定を行います。
– Delay
遅延時間を秒単位で設定します。

Properties Delayサブステップの名前を変更します。

Sub-Steps: 
Prompt

Enable Promptサブステップをオン／オフします。

Add Sub-Step

サブステップをリストに追加します。
– Delay
– Prompt
– Sent SCPI

Delete Sub-Step 選択したサブステップを削除します。

Edit
選択したサブステップを移動またはコピーする
か、選択したサブステップの後にコピーしたサ
ブステップを貼り付けます。

Settings

– Message
プロンプト・メッセージをメイン・ディスプ
レイの下半分に設定します。

– Prompt Icon
表示するプロンプト・アイコンを選択します。
– None
– Hand
– Question
– Exclamation
– Asterisk

– Dialog Settings
プロンプト・ウィンドウに設定を追加します。
– Timeout
– Cancel Button

– Timeout
プロンプトのタイムアウト値を秒単位で設定
します。

Properties Promptサブステップの名前を設定します。

Sub-Steps: 
Send SCPI

Enable Send SCPIサブステップをオン／オフします。

Add Sub-Step

サブステップをリストに追加します。
– Delay
– Prompt
– Sent SCPI

Delete Sub-Step 選択したサブステップを削除します。

Edit
選択したサブステップを移動またはコピーする
か、選択したサブステップの後にコピーしたサ
ブステップを貼り付けます。

表 A-12 テスト・シーケンスのメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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付録 A
IO Configuration Properties Sub-Steps: 
Send SCPI

Settings

– GPIB Address
目的の GPIBアドレスを選択します。

– SCPI Commands
– Edit

SCPIコマンドをメイン・ディスプレイの下
半分に設定します。

– Import
SCPIコマンドをファイルからロードします。
Recallメニュー・ツリーについては、
「Recallメニュー・ツリー」（ページ）448
を参照してください。

– Progress Msg
Delayで設定した時間の長さに対して、ダイア
ログ・ボックスに表示するオプションのテキ
スト・メッセージを設定します。

– Delay
SCPIコマンド発行後の遅延時間の長さを設定
します。

Properties Promptサブステップの名前を設定します。

Measurement

Enable 選択した測定をオン／オフします。

Add Measurement

– AC level
– Frequency
– Phase
– SNR
– THD＋ N
– DC level
– Crosstalk
– SMPTE IMD
– DFD IMD
– Multitone analyzer
– POLQA
– Stepped frequency sweep
– SMPTE frequency sweep
– DFD frequency sweep
– Stepped level sweep
– SMPTE level sweep
– DFD level sweep
– DC level sweep
– Receiver Sensitivity
– Measurement recorder

測定を追加します。

Delete 
Measurement 選択したテスト測定を削除します。

Edit 選択した測定を移動またはコピーするか、選択
した測定の後にコピーした測定を貼り付けます。

Settings
選択したテスト測定の設定を行います。
各測定の設定については、「測定設定」（ページ）
456を参照してください。

表 A-12 テスト・シーケンスのメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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A 付録
Measurement Properties

Name 選択した測定の名前を変更します。

Sub-Steps: RunIO 
Configuration

Add Sub-Step

サブステップをリストに追加します。
– Delay
– Prompt
– Sent SCPI

Edit RunIO Configurationサブステップをリスト内で移
動します。

Sub-Steps: 
Delay

Enable Delayサブステップをオン／オフします。

Add Sub-Step

サブステップをリストに追加します。
– Delay
– Prompt
– Sent SCPI

Delete Sub-Step 選択したサブステップを削除します。

Edit
選択したサブステップを移動またはコピーする
か、選択したサブステップの後にコピーしたサ
ブステップを貼り付けます。

Settings
Delayサブステップの設定を行います。
– Delay
遅延時間を秒単位で設定します。

Properties Delayサブステップの名前を変更します。

Sub-Steps: 
Prompt

Enable Promptサブステップをオン／オフします。

Add Sub-Step

サブステップをリストに追加します。
– Delay
– Prompt
– Sent SCPI

Delete Sub-Step 選択したサブステップを削除します。

Edit
選択したサブステップを移動またはコピーする
か、選択したサブステップの後にコピーしたサ
ブステップを貼り付けます。

Settings

– Message
プロンプト・メッセージをメイン・ディスプ
レイの下半分に設定します。

– Prompt Icon
表示するプロンプト・アイコンを選択します。
– None
– Hand
– Question
– Exclamation
– Asterisk

– Dialog Settings
プロンプト・ウィンドウに設定を追加します。
– Timeout
– Cancel Button

– Timeout
プロンプトのタイムアウト値を秒単位で設定
します。

表 A-12 テスト・シーケンスのメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
454 Keysight U8903B ユーザーズ・ガイド



付録 A
Measurement Properties

Sub-Steps: 
Prompt Properties Promptサブステップの名前を設定します。

Sub-Steps: 
Send SCPI

Enable Send SCPIサブステップをオン／オフします。

Add Sub-Step

サブステップをリストに追加します。
– Delay
– Prompt
– Sent SCPI

Delete Sub-Step 選択したサブステップを削除します。

Edit
選択したサブステップを移動またはコピーする
か、選択したサブステップの後にコピーしたサ
ブステップを貼り付けます。

Settings

– GPIB Address
目的の GPIBアドレスを選択します。

– SCPI Commands
– Edit

SCPIコマンドをメイン・ディスプレイの下
半分に設定します。

– Import
SCPIコマンドをファイルからロードします。
Recallメニュー・ツリーについては、
「Recallメニュー・ツリー」（ページ）448
を参照してください。

– Progress Msg
Delayで設定した時間の長さに対して、ダイア
ログ・ボックスに表示するオプションのテキ
スト・メッセージを設定します。

– Delay
SCPIコマンド実行後の遅延時間の長さを設定
します。

Properties Promptサブステップの名前を設定します。

Failure Handling
– Cancel Seq.
– Allow Retry
– Continue Seq.

選択した測定の失敗時の処理タイプを選択し
ます。

表 A-12 テスト・シーケンスのメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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A 付録
測定設定

ACレベル

表 A-13 Measurement settings > AC Levelメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

AC Level
(Signal Generation)

Waveform

Sine
Variable Phase
Square
Arbitrary

 波形タイプを選択します。

Output 出力チャネルを選択します。

Waveform Config

Track 1st Ch
– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

Frequency 周波数値を設定します。

Amplitude 振幅値を設定します。

DC Offset DCオフセット値を設定します。

Phase->1st Ch
位相値を設定します。この設定は、チャ
ネル 2が選択されている場合にのみ使用
可能です。

AC Level
(Signal Analysis)

Detector
– RMS

– Pk-Pk
ACレベル・ディテクタ・タイプを選択し
ます。 

LPF

– None

– 2 kHz

– 3 kHz

– 5 kHz

– 8 kHz

– 10 kHz

– 15 kHz

– 20 kHz

– 22 kHz

– 30 kHz

– 40 kHz

– 50 kHz

– 80 kHz

– Custom

ローパス・フィルタを選択します。
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付録 A
AC Level
(Signal Analysis)

Sample Size

– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

測定のために収集するサンプル数を選択
します。 

Input Range

Auto Range
– On

– Off
自動入力レンジをオン／オフします。

Track 1st Ch
– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

AC Level
Gain

棒グラフのメニュー・ツリーについては、
「棒グラフ」（ページ）502を参照してく
ださい。

表 A-13 Measurement settings > AC Levelメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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A 付録
周波数

表 A-14 Measurement settings > Frequencyメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

Frequency 
(Signal Generation)

Waveform

– Sine

– Variable Phase

– Square

– Arbitrary

波形タイプを選択します。

Output 出力チャネルを選択します。

Waveform Config

Track 1st Ch
Enable
Disable

最初のチャネルのトラッキングをオン／
オフします。

Frequency 周波数値を設定します。

Amplitude 振幅値を設定します。

Waveform Config

DC Offset DCオフセット値を設定します。

Phase->1st Ch
位相値を設定します。この設定は、チャ
ネル 2が選択されている場合にのみ使用
可能です。

Frequency 
(Signal Analysis)

Sample Size

– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

測定のために収集するサンプル数を選択
します。 

Input Range

Auto Range
– On

– Off
自動入力レンジをオン／オフします。

Track 1st Ch
– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

Frequency
棒グラフのメニュー・ツリーについては、
「棒グラフ」（ページ）502を参照してく
ださい。
458 Keysight U8903B ユーザーズ・ガイド



付録 A
位相

表 A-15 Measurement settings > Phaseメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

Phase
(Signal Generation)

Waveform

– Sine

– Variable Phase

– Square

– Arbitrary

波形タイプを選択します。

Output 出力チャネルを選択します。

Waveform Config Track 1st Ch
– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

Waveform Config

Frequency 周波数値を設定します。

Amplitude 振幅値を設定します。

DC Offset DCオフセット値を設定します。

Phase->1st Ch
位相値を設定します。この設定は、チャ
ネル 2が選択されている場合にのみ使用
可能です。

Phase
(Signal Analysis)

Ref Channel 基準チャネル番号を設定します。 

Sample Size

– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

測定のために収集するサンプル数を選択
します。 

Input Range
Track 1st Ch

– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

Phase
棒グラフのメニュー・ツリーについては、
「棒グラフ」（ページ）502を参照してく
ださい。
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A 付録
SNR

表 A-16 Measurement settings > SNRメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

SNR
(Signal Generation)

Waveform

– Sine

– Variable phase

– Square

– Arbitrary

波形タイプを選択します。

Output 出力チャネルを選択します。

Waveform Config

Track 1st Ch
– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

Frequency 周波数値を設定します。

Amplitude 振幅値を設定します。

DC Offset DCオフセット値を設定します。

Phase->1st Ch
位相値を設定します。この設定は、チャ
ネル 2が選択されている場合にのみ使用
可能です。

SNR
(Signal Analysis)

SNR Mode
– Fast

– Standard
SNR測定モードを選択します。

SNR Delay
SNR遅延を設定します。
この設定は、SNR Modeが Standardに設定
されている場合にのみ使用可能です。

Freq Lock

– Auto

– Gen Lock

– Custom

基本波周波数の探索方法を選択します。
この設定は、SNR Modeが Fastに設定され
ている場合にのみ使用可能です。

Fund Freq

基本波周波数値を設定します。
この設定は、SNR Modeが Fastに、Freq 
Lockが Customに設定されている場合にの
み使用可能です。

Harmonic Cnt
削除する高調波の次数を設定します。
この設定は、SNR Modeが Fastに設定され
ている場合にのみ使用可能です。
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付録 A
SNR
(Signal Analysis)

LPF

– None

– 2 kHz

– 3 kHz

– 5 kHz

– 8 kHz

– 10 kHz

– 15 kHz

– 20 kHz

– 22 kHz

– 30 kHz

– 40 kHz

– 50 kHz

– 80 kHz

– Custom

ローパス・フィルタを選択します。

HPF

– None

– 15 Hz

– 20 Hz

– 22 Hz

– 30 Hz

– 50 Hz

– 70 Hz

– 100 Hz

– 200 Hz

– 300 Hz

– 400 Hz

– Custom

ハイパス・フィルタを選択します。

Weighting

– None

– A

– CCIR 1k

– CCIR 2k

– CCITT

– C-Message

– Custom

評価雑音フィルタを選択します。

Deemphasis

– None
– 50 μs
– 75 μs

– Custom

ディエンファシス・フィルタを選択し
ます。

表 A-16 Measurement settings > SNRメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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A 付録
SNR
(Signal Analysis)

Sample Size

– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

測定のために収集するサンプル数を選択
します。 

Input Range

Auto Range
– On

– Off
自動入力レンジをオン／オフします。

Track 1st Ch
– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

SNR
棒グラフのメニュー・ツリーについては、
「棒グラフ」（ページ）502を参照してく
ださい。

表 A-16 Measurement settings > SNRメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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付録 A
THD＋ N

表 A-17 Measurement settings > THD+Nメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

THD+N
(Signal Generation)

Waveform

– Sine
– Variable phase
– Square
– Arbitrary

波形タイプを選択します。

Output 出力チャネルを選択します。

Waveform Config

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

Frequency 周波数値を設定します。

Amplitude 振幅値を設定します。

Waveform Config

DC Offset DCオフセット値を設定します。

Phase->1st Ch
位相値を設定します。この設定は、チャ
ネル 2が選択されている場合にのみ使用
可能です。

THD+N
(Signal Analysis)

Freq Lock
– Auto
– Gen Lock
– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。
この設定は、Freq Lockが Customに設定さ
れている場合にのみ使用可能です。

Harmonics
– All
– 2～ 9

THD比および THDレベルの結果に使用す
る高調波の数を選択します。

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

ローパス・フィルタを選択します。
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A 付録
THD+N
(Signal Analysis)

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

ハイパス・フィルタを選択します。

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

評価雑音フィルタを選択します。

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

ディエンファシス・フィルタを選択し
ます。

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

測定のために収集するサンプル数を選択
します。 

Input Range

Auto Range
– On
– Off

自動入力レンジをオン／オフします。

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

SINAD
THD Level
THD Ratio
THD+N Level
THD+N Ratio

棒グラフのメニュー・ツリーについては、
「棒グラフ」（ページ）502を参照してく
ださい。

表 A-17 Measurement settings > THD+Nメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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付録 A
DCレベル

表 A-18 Measurement settings > DC Levelメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

DC Level
(Signal Generation)

Waveform
– Sine

– Arbitrary
波形タイプを選択します。

Output 出力チャネルを選択します。

Waveform Config

Track 1st Ch
– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

Frequency 周波数値を設定します。

Amplitude 振幅値を設定します。

DC Offset DCオフセット値を設定します。

DC Level
(Signal Analysis)

Sample Size

– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

測定のために収集するサンプル数を選択
します。 

Input Range

Auto Range
– On

– Off
自動入力レンジをオン／オフします。

Track 1st Ch
– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

DCレベル
棒グラフのメニュー・ツリーについては、
「棒グラフ」（ページ）502を参照してく
ださい。
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A 付録
クロストーク

表 A-19 Measurement settings > Crosstalkメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

Crosstalk
(Signal Generation)

Waveform
– Sine

– Arbitrary
波形タイプを選択します。

Output 出力チャネルを選択します。

Waveform Config

Track 1st Ch
– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

Frequency 周波数値を設定します。

Amplitude 振幅値を設定します。

DC Offset DCオフセット値を設定します。

Crosstalk
(Signal Analysis)

Driven Ch ジェネレータのドライブ・チャネル番号
を選択します。

Freq Lock

– Auto

– Gen Lock

– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。
この設定は、Freq Lockが Customに設定さ
れている場合にのみ使用可能です。

Sample Size

– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

測定のために収集するサンプル数を選択
します。 

Input Range
Input Range

Auto Range
– On

– Off
自動入力レンジをオン／オフします。

Track 1st Ch
– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

Crosstalk
棒グラフのメニュー・ツリーについては、
「棒グラフ」（ページ）502を参照してく
ださい。
466 Keysight U8903B ユーザーズ・ガイド



付録 A
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SMPTE IMD

表 A-20 Measurement settings > SMPTE IMDメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

SMPTE IMD
(Signal Generation)

Waveform

– SMPTE 1:1

– SMPTE 4:1

– SMPTE 10:1

波形タイプを選択します。

Output 出力チャネルを選択します。

Waveform Config

Track 1st Ch
– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

Upper Freq 上側周波数値を設定します。

Lower Freq 下側周波数値を設定します。

Amplitude 振幅値を設定します。

DC Offset DCオフセット値を設定します。

SMPTE IMD
(Signal Analysis)

Freq Lock
Gen Lock
Custom

上側周波数と下側周波数の探索方法を選
択します。 

Upper Freq
上側基本波周波数値を設定します。
この設定は、Freq Lockが Customに設定さ
れている場合にのみ使用可能です。

Lower Freq
下側基本波周波数値を設定します。
この設定は、Freq Lockが Customに設定さ
れている場合にのみ使用可能です。

Sample Size

– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

測定のために収集するサンプル数を選択
します。 

Input Range

Auto Range
– On

– Off
自動入力レンジをオン／オフします。

Track 1st Ch
– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

SMPTE Ratio
棒グラフのメニュー・ツリーについては、
「棒グラフ」（ページ）502を参照してく
ださい。



A 付録
DFD IMD

表 A-21 Measurement settings > DFD IMDメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

DFD IMD
(Signal Generation)

Waveform
– IEC60118

– IEC60268
波形タイプを選択します。

Output 出力チャネルを選択します。

Waveform Config

Track 1st Ch
– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

Upper Freq 上側周波数値を設定します。

Center Freq 中心周波数値を設定します。

Diff Freq 差周波数値を設定します。

Amplitude 振幅値を設定します。

DC Offset DCオフセット値を設定します。

DFD IMD
(Signal Analysis)

DFD order
– 2nd

– 3rd
測定する歪みの次数を選択します。

Sample Size

– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

測定のために収集するサンプル数を選択
します。 

Input Range

Auto Range
– On

– Off
自動入力レンジをオン／オフします。

Track 1st Ch
– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

DFD Ratio
棒グラフのメニュー・ツリーについて
は、「棒グラフ」（ページ）502を参照し
てください。
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付録 A
マルチトーン・アナライザ

表 A-22 Measurement settings > Multitone Analyzerメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

Multitone
(Signal Generation)

Output 出力チャネルを選択します。

Waveform Config
Track 1st Ch

– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

Amplitude 全振幅値を設定します。

Tones Config

Start Freq マルチトーン波形の最低周波数（通常は
最初のトーンの周波数）を設定します。

Stop Freq マルチトーン波形の最高周波数（通常は
最後のトーンの周波数）を設定します。

Spacing
– Linear
– Log
– Custom

トーン間の周波数間隔を選択します。

Tones 信号の周波数成分の数を設定します。

Length

– 1024
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536

波形長の値を選択します。

Phase Dist
– Zero
– Random 
– Custom

各トーンの位相分布を選択します。

Ampl. Mode
– Zero
– Custom

各トーンの振幅比を選択します。

Optimization
– On
– Off

クレスト・ファクタの最適化をオン／オ
フします。

Edit Tones

Frequency 周波数値を設定します。
Amplitude 振幅値を設定します。
Phase 位相値を設定します。

Add Above 選択したトーンの上にトーンを追加し
ます。

Add Below 選択したトーンの下にトーンを追加し
ます。

Remove 選択したトーンを削除します。

Clear All リスト内のすべてのトーンを削除し
ます。

Apply Settings
Tones Configメニューの設定を変更するた
びに、マルチトーン信号のクレスト・
ファクタの計算に設定を適用します。

Multitone
(Signal Generation) Tones Config Active Channel 各トーンの絶対振幅をテーブルに表示す

るアクティブ・チャネルを設定します。
Keysight U8903B ユーザーズ・ガイド 469



A 付録
Multitone
(Signal Analysis) Input Range

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

– Spectrum
– Waveform
– Level
– Gain

Graphメニュー・ツリーについては、「グ
ラフ」（ページ）503を参照してくだ
さい。

– Max Tone Level
– Min Tone Level
– TD+N Level
– TD+N Ratio
– Tone Level

棒グラフのメニュー・ツリーについて
は、「棒グラフ」（ページ）502を参照し
てください。

表 A-22 Measurement settings > Multitone Analyzerメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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付録 A
ステップ周波数掃引

表 A-23 Measurement settings > Stepped Frequency Sweepメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

Stepped Frequency 
Sweep 
(Signal Generation)

Output 出力チャネルを選択します。

Sweep Config

Start 掃引パラメータのスタート値を設定しま
す。

Stop 掃引パラメータのストップ値を設定しま
す。

Spacing 掃引間隔として、Log、Linearまたは
Customを選択します。

Points 掃引ポイント数を設定します。

Step Size
リニア間隔のステップ幅を選択します。
この設定は、Spacingが Linearに設定され
ている場合にのみ使用可能です。

Dwell Time 掃引ポイント間の遅延を設定します。

Edit Points

Point No ポイント番号を設定します。

Point Value ポイント値を設定します。

Insert Point Above 選択したポイントの上にポイントを挿入
します。

Insert Point Below 選択したポイントの下にポイントを挿入
します。

Remove Point 選択したポイントを削除します。

Clear すべてのポイントをクリアします。

Reverse Order ポイントの順序を逆にします。

Sort ポイントを昇順で並べ替えます。

Load Points

ポイントをファイルからロードします。
Recallメニュー・ツリーについては、
「Recallメニュー・ツリー」（ページ）448
を参照してください。

Save Points

ポイントをファイルに保存します。 
Saveメニュー・ツリーについては、「Save
メニュー・ツリー」（ページ）447を参照
してください。

Waveform Config

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

Amplitude 振幅値を設定します。

DC Offset DCオフセット値を設定します。

Ref Channel 基準チャネル番号を設定します。 

Harmonics
– All
– 2～ 9

THD比および THDレベルの結果に使用す
る高調波の数を選択します。
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A 付録
Stepped Frequency 
Sweep 
(Signal Analysis)

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

ローパス・フィルタを選択します。

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

ハイパス・フィルタを選択します。

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

評価雑音フィルタを選択します。

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

ディエンファシス・フィルタを選択し
ます。

表 A-23 Measurement settings > Stepped Frequency Sweepメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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付録 A
Stepped Frequency 
Sweep 
(Signal Analysis)

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

測定のために収集するサンプル数を選択
します。 

Input Range

Auto Range
– On
– Off

自動入力レンジをオン／オフします。

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

– AC Level
– Gain
– Phase
– THD Ratio
– THD Level
– THD+N Ratio
– THD+N Level
– SINAD

Graphメニュー・ツリーについては、「グ
ラフ」（ページ）503を参照してくだ
さい。

表 A-23 Measurement settings > Stepped Frequency Sweepメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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A 付録
SMPTE frequency sweep

表 A-24 Measurement settings > SMPTE Frequency Sweepメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

SMPTE Frequency 
Sweep 
(Signal Generation)

Waveform
– SMPTE 1:1
– SMPTE 4:1
– SMPTE 10:1

 波形タイプを選択します。

Output 出力チャネルを選択します。

Sweep Config

Swept
– Upper Freq
– Lowe Freq

掃引パラメータを選択します。

Start 掃引パラメータのスタート値を設定し
ます。

Stop 掃引パラメータのストップ値を設定し
ます。

Spacing 掃引間隔として、Log、Linearまたは
Customを選択します。

Points 掃引ポイント数を設定します。

Step Size
リニア間隔のステップ幅を選択します。
この設定は、Spacingが Linearに設定され
ている場合にのみ使用可能です。

Dwell Time 掃引ポイント間の遅延を設定します。

Edit Points

Point No ポイント番号を設定します。
Point Value ポイント値を設定します。

Insert Point Above 選択したポイントの上にポイントを挿入
します。

Insert Point Below 選択したポイントの下にポイントを挿入
します。

Remove Point 選択したポイントを削除します。
Clear すべてのポイントをクリアします。
Reverse Order ポイントの順序を逆にします。
Sort ポイントを昇順で並べ替えます。

Edit Points

Load Points

ポイントをファイルからロードします。
Recallメニュー・ツリーについては、
「Recallメニュー・ツリー」（ページ）448
を参照してください。

Save Points

ポイントをファイルに保存します。 
Saveメニュー・ツリーについては、「Save
メニュー・ツリー」（ページ）447を参照
してください。

Waveform Config

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

Upper Freq 上側周波数値を設定します。
Lower Freq 下側周波数値を設定します。
Amplitude 振幅値を設定します。

DC Offset DCオフセット値を設定します。
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付録 A
SMPTE Frequency 
Sweep 
(Signal Analysis)

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

測定のために収集するサンプル数を選択
します。 

Input Range

Auto Range
– On
– Off

自動入力レンジをオン／オフします。

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

SMPTE Ratio
Graphメニュー・ツリーについては、「グ
ラフ」（ページ）503を参照してくださ
い。

表 A-24 Measurement settings > SMPTE Frequency Sweepメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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A 付録
DFD周波数掃引

表 A-25 Measurement settings > DFD Frequency Sweepメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

DFD Frequency Sweep 
(Signal Generation)

Waveform
– IEC60118
– IEC60268

波形タイプを選択します。

Output  出力チャネルを選択します。

Sweep Config

Swept
– Upper Freq
– Lowe Freq

掃引パラメータを選択します。

Start 掃引パラメータのスタート値を設定し
ます。

Stop 掃引パラメータのストップ値を設定し
ます。

Spacing 掃引間隔として、Log、Linearまたは
Customを選択します。

Points 掃引ポイント数を設定します。

Step Size
リニア間隔のステップ幅を選択します。
この設定は、Spacingが Linearに設定され
ている場合にのみ使用可能です。

Dwell Time 掃引ポイント間の遅延を設定します。

Edit Points

Point No ポイント番号を設定します。
Point Value ポイント値を設定します。

Insert Point Above 選択したポイントの上にポイントを挿入
します。

Insert Point Below 選択したポイントの下にポイントを挿入
します。

Remove Point 選択したポイントを削除します。
Clear すべてのポイントをクリアします。
Reverse Order ポイントの順序を逆にします。
Sort ポイントを昇順で並べ替えます。

Load Points

ポイントをファイルからロードします。
Recallメニュー・ツリーについては、
「Recallメニュー・ツリー」（ページ）448
を参照してください。

Sweep Config Edit Points Save Points

ポイントをファイルに保存します。 
Saveメニュー・ツリーについては、「Save
メニュー・ツリー」（ページ）447を参照
してください。

Waveform Config

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

Upper Freq 上側周波数値を設定します。
Diff Freq 差周波数値を設定します。
Amplitude 振幅値を設定します。

DC Offset DCオフセット値を設定します。
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付録 A
DFD Frequency Sweep 
(Signal Analysis)

DFD order
– 2nd
– 3rd

測定する歪み成分の次数を選択します。

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

測定のために収集するサンプル数を選択
します。 

Input Range

Auto Range
– On
– Off

自動入力レンジをオン／オフします。

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

DFD Ratio
Graphメニュー・ツリーについては、「グ
ラフ」（ページ）503を参照してくだ
さい。

表 A-25 Measurement settings > DFD Frequency Sweepメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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A 付録
外部周波数掃引

表 A-26 Measurement settings > External Frequency Sweepメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

External Frequency 
Sweep 
(Signal Generation)

Instrument

– Keysight 33220A
– Keysight 33250A
– Keysight 33500A
– Keysight 33600A
– Other

測定器モデルを選択します。

GPIB Address – 0～ 30 GPIBアドレスを選択します。

Init Instrument
– On
– Off

U8903Bによる接続信号発生器を初期化するため
の SCPIコマンドの送信をオン／オフします。

Init SCPI
– Edit
– Import

接続測定器を初期化する SCPIコマンドを設定し
ます。SCPIコマンドは、直接設定することも、
ファイルからロードすることもできます。

Sweep SCPI
– Edit
– Import

接続測定器を初期化する掃引用 SCPIコマンドを
設定します。SCPIコマンドは、直接設定するこ
とも、ファイルからロードすることもできます。

Sweep Config

Start 掃引パラメータのスタート値を設定します。
Stop 掃引パラメータのストップ値を設定します。

Spacing 掃引間隔として、Log、Linearまたは Customを選
択します。

Points 掃引ポイント数を設定します。

Step Size
リニア間隔のステップ幅を選択します。この設定
は、Spacingが Linearに設定されている場合にの
み使用可能です。

Dwell Time 掃引ポイント間の遅延を設定します。

Edit Points

Point No ポイント番号を設定します。
Point Value ポイント値を設定します。
Insert Point Above 選択したポイントの上にポイントを挿入します。
Insert Point Below 選択したポイントの下にポイントを挿入します。
Remove Point 選択したポイントを削除します。
Clear すべてのポイントをクリアします。
Reverse Order ポイントの順序を逆にします。
Sort ポイントを昇順で並べ替えます。

Load Points

ポイントをファイルからロードします。
Recallメニュー・ツリーについては、「Recallメ
ニュー・ツリー」（ページ）448を参照してくだ
さい。

Save Points

ポイントをファイルに保存します。 
Saveメニュー・ツリーについては、「Saveメ
ニュー・ツリー」（ページ）447を参照してくだ
さい。
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付録 A
External Frequency 
Sweep 
(Signal Analysis)

Ref Channel – CH1～ CH8
基準チャネル番号を選択します。各チャネルの基
準チャネルに対する位相を測定します。基準チャ
ネルの位相結果は常にゼロと表示されます。

Harmonics
– All
– 2～ 9

THD比および THDレベルの結果に使用する高調波
の数を選択します。

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

ローパス・フィルタを選択します。

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

ハイパス・フィルタを選択します。

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

評価雑音フィルタを選択します。

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

ディエンファシス・フィルタを選択します。

表 A-26 Measurement settings > External Frequency Sweepメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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A 付録
Stepped Frequency 
Sweep 
(Signal Analysis)

Notch Filter

HP 8903B
– On
– Off

HP8903Bモードをオン／オフします。

Custom Notch
– On
– Off

カスタム・ノッチをオン／オフします。

Center Freq 中心周波数値を設定します。カスタム・ノッチが
オンになっている場合にのみ適用可能です。

Bandwidth 帯域幅値を設定します。カスタム・ノッチがオン
になっている場合にのみ適用可能です。

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

測定のために収集するサンプル数を選択します。 

Input Range

Auto Range
– On
– Off

自動入力レンジをオン／オフします。

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／オフし
ます。

 Voltage Range 入力電圧レンジを設定します。

– AC Level
– Gain
– Phase
– THD Ratio
– THD Level
– THD+N Ratio
– THD+N Level
– SINAD

Graphメニュー・ツリーについては、「グラフ」
（ページ）503を参照してください。

表 A-26 Measurement settings > External Frequency Sweepメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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付録 A
ステップ・レベル掃引

表 A-27 Measurement settings > Stepped Level Sweepメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

Stepped Level Sweep 
(Signal Generation)

Waveform
– Sine
– Arbitrary

波形タイプを選択します。

Output  出力チャネルを選択します。

Sweep Config

Start 掃引パラメータのスタート値を設定し
ます。

Stop 掃引パラメータのストップ値を設定し
ます。

Spacing 掃引間隔として、Log、Linearまたは
Customを選択します。

Points 掃引ポイント数を設定します。

Step Size
リニア間隔のステップ幅を選択します。
この設定は、Spacingが Linearに設定され
ている場合にのみ使用可能です。

Dwell Time 掃引ポイント間の遅延を設定します。

Edit Points

Point No ポイント番号を設定します。

Point Value ポイント値を設定します。

Insert Point Above 選択したポイントの上にポイントを挿入
します。

Insert Point Below 選択したポイントの下にポイントを挿入
します。

Remove Point 選択したポイントを削除します。

Clear すべてのポイントをクリアします。

Reverse Order ポイントの順序を逆にします。

Sort ポイントを昇順で並べ替えます。

Load Points

ポイントをファイルからロードします。
Recallメニュー・ツリーについては、
「Recallメニュー・ツリー」（ページ）448
を参照してください。

Sweep Config Edit Points Save Points

ポイントをファイルに保存します。 
Saveメニュー・ツリーについては、「Save
メニュー・ツリー」（ページ）447を参照
してください。

Waveform Config

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

Frequency 周波数値を設定します。

DC Offset DCオフセット値を設定します。
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A 付録
Stepped Level Sweep 
(Signal Analysis)

Freq Lock
– Auto
– Gen Lock
– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。この設定
は、Freq Lockが Customに設定されている
場合にのみ使用可能です。

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

ローパス・フィルタを選択します。

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

ハイパス・フィルタを選択します。

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

評価雑音フィルタを選択します。

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

ディエンファシス・フィルタを選択し
ます。

表 A-27 Measurement settings > Stepped Level Sweepメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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付録 A
Stepped Level Sweep 
(Signal Analysis)

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

測定のために収集するサンプル数を選択
します。 

Input Range

Auto Range
– On
– Off

自動入力レンジをオン／オフします。

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

– AC Level
– Gain
– THD Ratio
– THD Level
– THD Ratio Vs Measured Amplitude
– THD Level Vs Measured Amplitude
– THD+N ratio
– THD+N Level
– THD+N Ratio Vs Measured Amplitude
– THD+N Level Vs Measured Amplitude
– SINAD

Graphメニュー・ツリーについては、「グ
ラフ」（ページ）503を参照してくだ
さい。

表 A-27 Measurement settings > Stepped Level Sweepメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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A 付録
SMPTEレベル掃引

表 A-28 Measurement settings > SMPTE Level Sweepメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

SMPTE Level Sweep 
(Signal Generation)

Waveform
– SMPTE 1:1
– SMPTE 4:1
– SMPTE 10:1

波形タイプを選択します。

Output 出力チャネルを選択します。

Sweep Config

Start 掃引パラメータのスタート値を設定し
ます。

Stop 掃引パラメータのストップ値を設定し
ます。

Spacing 掃引間隔として、Log、Linearまたは
Customを選択します。

Points 掃引ポイント数を設定します。

Sweep Config

Step Size
リニア間隔のステップ幅を選択します。
この設定は、Spacingが Linearに設定され
ている場合にのみ使用可能です。

Dwell Time 掃引ポイント間の遅延を設定します。

Edit Points

Point No ポイント番号を設定します。
Point Value ポイント値を設定します。

Insert Point Above 選択したポイントの上にポイントを挿入
します。

Insert Point Below 選択したポイントの下にポイントを挿入
します。

Remove Point 選択したポイントを削除します。
Clear すべてのポイントをクリアします。
Reverse Order ポイントの順序を逆にします。
Sort ポイントを昇順で並べ替えます。

Load Points

ポイントをファイルからロードします。
Recallメニュー・ツリーについては、
「Recallメニュー・ツリー」（ページ）448
を参照してください。

Save Points

ポイントをファイルに保存します。 
Saveメニュー・ツリーについては、「Save
メニュー・ツリー」（ページ）447を参照
してください。

Waveform Config

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

Upper Freq 上側周波数値を設定します。
Lower Freq 下側周波数値を設定します。

DC Offset DCオフセット値を設定します。
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付録 A
SMPTE Level Sweep 
(Signal Analysis)

Freq Lock
– Gen Lock
– Custom

上側周波数と下側周波数の探索方法を選
択します。 

Upper Freq
上側基本波周波数値を設定します。この
設定は、Freq Lockが Customに設定されて
いる場合にのみ使用可能です。

Lower Freq
下側基本波周波数値を設定します。この
設定は、Freq Lockが Customに設定されて
いる場合にのみ使用可能です。

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

測定のために収集するサンプル数を選択
します。 

Input Range

Auto Range
– On
– Off

自動入力レンジをオン／オフします。

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

– SMPTE Ratio
– SMPTE Ratio Vs Measured Amplitude

Graphメニュー・ツリーについては、「グ
ラフ」（ページ）503を参照してくだ
さい。

表 A-28 Measurement settings > SMPTE Level Sweepメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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A 付録
DFDレベル掃引

表 A-29 Measurement settings > DFD Level Sweepメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

DFD Level Sweep 
(Signal Generation)

Waveform
– IEC60118
– IEC60268

波形タイプを選択します。

Output  出力チャネルを選択します。

Sweep Config Start 掃引パラメータのスタート値を設定し
ます。

Sweep Config

Stop 掃引パラメータのストップ値を設定し
ます。

Spacing 掃引間隔として、Log、Linearまたは
Customを選択します。

Points 掃引ポイント数を設定します。

Step Size
リニア間隔のステップ幅を選択します。
この設定は、Spacingが Linearに設定され
ている場合にのみ使用可能です。

Dwell Time 掃引ポイント間の遅延を設定します。

Edit Points

Point No ポイント番号を設定します。

Point Value ポイント値を設定します。

Insert Point Above 選択したポイントの上にポイントを挿入
します。

Insert Point Below 選択したポイントの下にポイントを挿入
します。

Remove Point 選択したポイントを削除します。

Clear すべてのポイントをクリアします。

Reverse Order ポイントの順序を逆にします。

Sort ポイントを昇順で並べ替えます。

Load Points

ポイントをファイルからロードします。
Recallメニュー・ツリーについては、
「Recallメニュー・ツリー」（ページ）448
を参照してください。

Save Points

ポイントをファイルに保存します。 
Saveメニュー・ツリーについては、「Save
メニュー・ツリー」（ページ）447を参照
してください。

Waveform Config

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

Upper Freq 上側周波数値を設定します。

Diff Freq 差周波数値を設定します。

DC Offset DCオフセット値を設定します。
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付録 A
DFD Level Sweep 
(Signal Analysis)

DFD order
– 2nd
– 3rd

測定する歪み成分の次数を選択します。

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

測定のために収集するサンプル数を選択
します。 

Input Range

Auto Range
– On
– Off

自動入力レンジをオン／オフします。

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

– DFD Ratio
– DFD Ratio Vs Measured Amplitude

Graphメニュー・ツリーについては、「グ
ラフ」（ページ）503を参照してくだ
さい。

表 A-29 Measurement settings > DFD Level Sweepメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
Keysight U8903B ユーザーズ・ガイド 487



A 付録
DCレベル掃引

表 A-30 Measurement settings > DC Level Sweepメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

DC Level Sweep 
(Signal Generation)

Output 出力チャネルを選択します。

Sweep Config

Start 掃引パラメータのスタート値を設定します。
Stop 掃引パラメータのストップ値を設定します。

Spacing 掃引間隔として、Log、Linearまたは Customを選
択します。

Sweep Config

Points 掃引ポイント数を設定します。

Step Size
リニア間隔のステップ幅を選択します。この設
定は、Spacingが Linearに設定されている場合に
のみ使用可能です。

Dwell Time 掃引ポイント間の遅延を設定します。

Edit Points

Point No ポイント番号を設定します。
Point Value ポイント値を設定します。
Insert Point Above 選択したポイントの上にポイントを挿入します。
Insert Point Below 選択したポイントの下にポイントを挿入します。
Remove Point 選択したポイントを削除します。
Clear すべてのポイントをクリアします。
Reverse Order ポイントの順序を逆にします。
Sort ポイントを昇順で並べ替えます。

Load Points

ポイントをファイルからロードします。
Recallメニュー・ツリーについては、「Recallメ
ニュー・ツリー」（ページ）448を参照してくだ
さい。

Save Points

ポイントをファイルに保存します。 
Saveメニュー・ツリーについては、「Saveメ
ニュー・ツリー」（ページ）447を参照してくだ
さい。

DC Level Sweep 
(Signal Analysis) LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

ローパス・フィルタを選択します。
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付録 A
DC Level Sweep 
(Signal Analysis)

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

ハイパス・フィルタを選択します。

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

評価雑音フィルタを選択します。

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

ディエンファシス・フィルタを選択します。

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

測定のために収集するサンプル数を選択します。 

Input Range

Auto Range
– On
– Off

自動入力レンジをオン／オフします。

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／オフし
ます。

 Voltage Range 入力電圧レンジを設定します。

DC Level Graphメニュー・ツリーについては、「グラフ」
（ページ）503を参照してください。

表 A-30 Measurement settings > DC Level Sweepメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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A 付録
レシーバ感度

表 A-31 Measurement settings > Receiver Sensitivityメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

Receiver Sensitivity 
(Signal Generation)

Instrument
– KeysightE4438C
– Other

信号発生器モデルを選択します。

GPIB address 接続信号発生器の GPIBアドレスを設定し
ます。

Start Power 掃引開始時の RFパワーを設定します。

Stop Power 掃引停止時の RFパワーを設定します。

Step Size ステップ幅を設定します。 

Dwell Time 各 SINAD測定値間の遅延を秒単位で設定
します。

Init Instrument
– On
– Off

U8903Bによる接続信号発生器を初期化す
るための SCPIコマンドの送信をオン／オ
フします。

FM Frequency

RF信号の出力周波数を設定します。 
この設定は、Instrumentが Keysight E4438C
に設定され、Init Instrumentがオンになって
いる場合にのみ使用可能です。

FM Deviation

RF信号の周波数変調偏移を設定します。 
この設定は、Instrumentが Keysight E4438C
に設定され、Init Instrumentがオンになって
いる場合にのみ使用可能です。

FM Rate

RF信号の内部周波数変調レートを設定し
ます。 
この設定は、Instrumentが Keysight E4438C
に設定され、Init Instrumentがオンになって
いる場合にのみ使用可能です。

Init SCPI
– Edit
– Import

接続信号発生器を初期化する SCPIコマン
ドを設定します。SCPIコマンドは、直接
設定することも、ファイルからロードす
ることもできます。
この設定は、Instrumentが Otherに設定さ
れ、Init Instrumentがオンになっている場合
にのみ使用可能です。

Output Power SCPI 接続信号発生器の RFパワーを調整する
SCPIコマンドを設定します。

Receiver Sensitivity 
(Signal Analysis)

Meas Channel 測定チャネル番号を設定します。

Target SINAD Meas Channelから測定するターゲットの
SINAD値を設定します。

Min 1st Value 最初の値の最小値を設定します。

Stop Condition
– Until End
– On Target

ストップ条件を選択します。

Freq Lock
– Auto
– Custom

基本波周波数の探索方法を選択します。
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付録 A
Receiver Sensitivity 
(Signal Analysis)

Fund Freq
基本波周波数値を設定します。
この設定は、Freq Lockが Customに設定さ
れている場合にのみ使用可能です。

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

ローパス・フィルタを選択します。

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

ハイパス・フィルタを選択します。

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

評価雑音フィルタを選択します。

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

ディエンファシス・フィルタを選択し
ます。

表 A-31 Measurement settings > Receiver Sensitivityメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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A 付録
Receiver Sensitivity 
(Signal Analysis)

Notch Filter

HP 8903B
– On
– Off

HP8903Bノッチ・フィルタ・モードをオ
ン／オフします。

Custom Notch
– On
– Off

カスタム・ノッチ・フィルタをオン／オ
フします。

Center Freq
中心周波数値を設定します。Custom Notch
がオンになっている場合にのみ使用可能
です。

Bandwidth 帯域幅値を設定します。Custom Notchがオ
ンになっている場合にのみ使用可能です。

Average Points 平均値計算に使用する測定値の個数を設
定します。 

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

測定のために収集するサンプル数を選択
します。 

Input Range

Auto Range
– On
– Off

自動入力レンジをオン／オフします。

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

SINAD Vs RF Power
Graphメニュー・ツリーについては、「グ
ラフ」（ページ）503を参照してくだ
さい。

表 A-31 Measurement settings > Receiver Sensitivityメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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付録 A
外部レベル掃引

表 A-32 Measurement settings > External Level Sweepメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

Stepped Level Sweep 
(Signal Generation)

Instrument

– Keysight 33220A
– Keysight 33250A
– Keysight 33500A
– Keysight 33600A
– Other

測定器モデルを選択します。

GPIB Address – 0～ 30 GPIBアドレスを選択します。

Init Instrument
– On
– Off

接続信号発生器を初期化するための U8903Bに
よる SCPIコマンドの送信をオン／オフします。

Init SCPI
– Edit
– Import

接続測定器を初期化する SCPIコマンドを設定し
ます。SCPIコマンドは、直接設定することも、
ファイルからロードすることもできます。

Sweep SCPI
– Edit
– Import

接続測定器を初期化する掃引用 SCPIコマンドを
設定します。SCPIコマンドは、直接設定するこ
とも、ファイルからロードすることもできます。

Sweep Config

Start 掃引パラメータのスタート値を設定します。
Stop 掃引パラメータのストップ値を設定します。

Spacing 掃引間隔として、Log、Linearまたは Customを選
択します。

Points 掃引ポイント数を設定します。

Step Size
リニア間隔のステップ幅を選択します。この設
定は、Spacingが Linearに設定されている場合に
のみ使用可能です。

Dwell Time 掃引ポイント間の遅延を設定します。

Edit Points

Point No ポイント番号を設定します。
Point Value ポイント値を設定します。
Insert Point Above 選択したポイントの上にポイントを挿入します。
Insert Point Below 選択したポイントの下にポイントを挿入します。
Remove Point 選択したポイントを削除します。
Clear すべてのポイントをクリアします。
Reverse Order ポイントの順序を逆にします。
Sort ポイントを昇順で並べ替えます。

Load Points

ポイントをファイルからロードします。
Recallメニュー・ツリーについては、「Recallメ
ニュー・ツリー」（ページ）448を参照してくだ
さい。

Edit Points Save Points

ポイントをファイルに保存します。 
Saveメニュー・ツリーについては、「Saveメ
ニュー・ツリー」（ページ）447を参照してくだ
さい。
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A 付録
Stepped Level Sweep 
(Signal Analysis)

Freq Lock
– Auto
– Gen Lock
– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。この設定は、
Freq Lockが Customに設定されている場合にのみ
使用可能です。

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

ローパス・フィルタを選択します。

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

ハイパス・フィルタを選択します。

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

評価雑音フィルタを選択します。

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

ディエンファシス・フィルタを選択します。

表 A-32 Measurement settings > External Level Sweepメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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付録 A
Stepped Level Sweep 
(Signal Analysis)

Notch Filter

HP 8903B
– On
– Off

HP8903Bモードをオン／オフします。

Custom Notch
– On
– Off

カスタム・ノッチをオン／オフします。

Center Freq 中心周波数値を設定します。カスタム・ノッチ
がオンになっている場合にのみ適用可能です。

Bandwidth 帯域幅値を設定します。カスタム・ノッチがオ
ンになっている場合にのみ適用可能です。

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

測定のために収集するサンプル数を選択し
ます。 

Input Range

Auto Range
– On
– Off

自動入力レンジをオン／オフします。

Track 1st Ch
– Enable
– Disable

最初のチャネルのトラッキングをオン／オフし
ます。

 Voltage Range 入力電圧レンジを設定します。

– AC Level
– Gain
– THD Ratio
– THD Level
– THD Ratio Vs Measured Amplitude
– THD Level Vs Measured Amplitude
– THD＋ N比
– THD+N Level
– THD+N Ratio Vs Measured Amplitude
– THD+N Level Vs Measured Amplitude
– SINAD

Graphメニュー・ツリーについては、「グラフ」
（ページ）503を参照してください。

表 A-32 Measurement settings > External Level Sweepメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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A 付録
測定レコーダ

表 A-33 Measurement settings > Measurement Recorderメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

Measurement 
Recorder
(Signal Generation)

Waveform

– Sine

– Variable Phase

– Square

– Arbitrary

波形タイプを選択します。

Output 出力チャネルを選択します。

Waveform Config

Track 1st Ch
– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

Frequency 周波数値を設定します。

Amplitude 振幅値を設定します。

DC Offset DCオフセット値を設定します。

Measurement 
Recorder
(Signal Analysis)

Duration 測定レコード長を設定します。 

Ref Channel 基準チャネル番号を設定します。 

Freq Lock

– Auto

– Gen Lock

– Custom

基本波周波数の探索方法を選択します。

Fund Freq
基本波周波数値を設定します。
この設定は、Freq Lockが Customに設定さ
れている場合にのみ使用可能です。

LPF

– None

– 2 kHz

– 3 kHz

– 5 kHz

– 8 kHz

– 10 kHz

– 15 kHz

– 20 kHz

– 22 kHz

– 30 kHz

– 40 kHz

– 50 kHz

– 80 kHz

– Custom

ローパス・フィルタを選択します。
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付録 A
Measurement 
Recorder
(Signal Analysis)

HPF

– None

– 15 Hz

– 20 Hz

– 22 Hz

– 30 Hz

– 50 Hz

– 70 Hz

– 100 Hz

– 200 Hz

– 300 Hz

– 400 Hz

– Custom

ハイパス・フィルタを選択します。

Weighting

– None

– A

– CCIR 1k

– CCIR 2k

– CCITT

– C-Message

– Custom

評価雑音フィルタを選択します。

Deemphasis

– None
– 50 μs
– 75 μs

– Custom

ディエンファシス・フィルタを選択し
ます。

Sample Size

– 2048

– 4096

– 8192

– 16384

– 32768

– 65536

– 131072

– 262144

– 524288

– 1M

– 2M

測定のために収集するサンプル数を選択
します。

Input Range

Auto Range
– On

– Off
自動入力レンジをオン／オフします。

Track 1st Ch
– Enable

– Disable
最初のチャネルのトラッキングをオン／
オフします。

 Voltage Range 入力電圧レンジを設定します。

表 A-33 Measurement settings > Measurement Recorderメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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A 付録
– AC Level

– Gain, Phase

– THD+N Ratio

– THD+N Level

– DC Level

– Frequency

– SINAD

Graphメニュー・ツリーについては、「グ
ラフ」（ページ）503を参照してくだ
さい。

表 A-33 Measurement settings > Measurement Recorderメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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付録 A
音声品質

表 A-34 Measurement settings > Voice Qualityメニュー・ツリーの概要

タブ レベル 1 レベル 2 レベル 3 概要

Voice Quality

Test Config
(POLQA)

Test Standard
– POLQA
– PESQ

テスト標準を選択します。

Analysis Mode
– Basic
– Advanced

POLQA解析モードを選択します。ベー
シック・モードでは、信号劣化の量がわ
かっている基準波形ファイルをダウン
ロードして、解析を自動的に実行するこ
とができます。アドバンスド・モードで
は、波形ファイルの再生／記録、解析を
自動的に実行することができます。

Bandwidth
– Narrowband
– Super WIdeband

帯域幅タイプを選択します。

Auto Lvl Align 自動レベル調整をオン／オフします。

Auto Fs

入力信号の適切なサンプリング・レート
へのリサンプリングをオン／オフします。
すべての狭帯域モード入力ファイルと
スーパーワイドバンド入力ファイルのサ
ンプリング・レートが、それぞれ 8 kHzと
48 kHzにリサンプリングされます。

Target Fs
– 8 kHz
– 16 kHz
– 48 kHz

狭帯域のサンプリング・レートを選択し
ます。この設定は、Bandwidthが
Narrowbandの場合にのみ適用可能です。

Test Config
(PESQ)

Test Standard
– POLQA
– PESQ

テスト標準を選択します。

Analysis Mode
– Basic
– Advanced

PESQ解析モードを選択します。ベーシッ
ク・モードでは、信号劣化の量がわかっ
ている基準波形ファイルをダウンロード
して、解析を自動的に実行することがで
きます。アドバンスド・モードでは、波
形ファイルの再生／記録、解析を自動的
に実行することができます。

Bandwidth
– Narrowband
– WIdeband

帯域幅タイプを選択します。

Target Fs
– 8 kHz
– 16 kHz

狭帯域のサンプリング・レートを選択し
ます。この設定は、Bandwidthが
Narrowbandの場合にのみ適用可能です。

Playback File Path

使用する再生波形ファイル・ソースを選
択します。
Recallメニュー・ツリーについては、
「Recallメニュー・ツリー」（ページ）448
を参照してください。
この設定は、Analysis Modeが Basicに設定
されている場合にのみ使用可能です。

Degraded File Path

使用する劣化済み波形ファイル・ソース
を選択します。
Recallメニュー・ツリーについては、
「Recallメニュー・ツリー」（ページ）448
を参照してください。
この設定は、Analysis Modeが Basicに設定
されている場合にのみ使用可能です。
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A 付録
Voice Quality

Reference Source
（この設定は、

Analysis Modeが
Advancedに設定さ
れている場合にの
み使用可能）

Source
– File
– Generator

基準ソースとして、ファイルまたはジェ
ネレータを選択します。

Playback File

使用する波形ファイル・ソースを選択し
ます。
この設定は、Sourceが Fileに設定されてい
る場合にのみ使用可能です。

Playback Ch 基準ファイルまたは波形を再生するジェ
ネレータ・チャネルを選択します。

Use PB as Ref
– Yes
– No

基準ファイルとしての再生をオン／オフ
します。

Ref File from AA アナログ・アナライザの基準ファイルを
オン／オフします。

Ref File 基準ファイルを選択します。

Save Rec File
– Yes
– No

レコード・ファイルの保存をオン／オフ
します。この設定は、Ref File from AAがオ
ンになっている場合にのみ使用可能です。

Record File
レコード・ファイルを選択します。この
設定は、Save Rec Fileがオンになっている
場合にのみ使用可能です。

Recording Ch
アナライザ・チャネルの再生ファイルま
たは記録された波形ファイルを基準ファ
イルとして選択します。

Rec Duration

アナライザ・チャネルの再生波形ファイ
ルのレコーディング時間を設定します。
この設定は、Recording Chがアナライザ・
チャネルに設定されている場合にのみ使
用可能です。

Auto Start Rec
– Yes
– No

記録の自動開始をオン／オフします。
この設定は、Save Rec Fileがオンになって
いる場合にのみ使用可能です。

Delay

ジェネレータをオンにしてから記録を実
行するまでの遅延を秒単位で設定します。
この設定は、Recording Chがアナライザ・
チャネルに設定されている場合にのみ使
用可能です。

Save to File
– Yes
– No

基準ファイルの自動保存をオン／オフし
ます。
この設定は、Recording Chがアナライザ・
チャネルに設定されている場合にのみ使
用可能です。

Save File Path
基準ファイルの保存場所を設定します。
この設定は、Save to Fileがオンになってい
る場合にのみ使用可能です。

表 A-34 Measurement settings > Voice Qualityメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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付録 A
Voice Quality

Degraded Source
（この設定は、

Analysis Modeが
Advancedに設定さ
れている場合にの
み使用可能）

Source
– File
– AA1～ AA8

劣化済み波形ファイル（記録する既存の
ファイル）を選択します。

Save Rec File
– Yes
– No

レコード・ファイルの保存をオン／オフ
します。 
この設定は、Sourceがアナライザ・チャ
ネルに設定されている場合にのみ使用可
能です。

Rec Duration

劣化済み波形ファイルのレコーディング
時間を設定します。
この設定は、Sourceがアナライザ・チャ
ネルに設定されている場合にのみ使用可
能です。

Auto Start Rec
– Yes
– No

記録の自動開始をオン／オフします。
この設定は、Sourceがアナライザ・チャ
ネルに設定されている場合にのみ使用可
能です。

Delay

ジェネレータをオンにしてから記録を実
行するまでの遅延を秒単位で設定します。
この設定は、Sourceがアナライザ・チャ
ネルに設定されている場合にのみ使用可
能です。

Degraded File

使用する劣化済み波形ファイル・ソース
を選択します。
この設定は、Sourceが Fileに設定されてい
る場合にのみ使用可能です。

IO Config
Output Level 出力レベル値を設定します。
Input Range 入力レンジの値を選択します。

Show/Hide POLQA License POLQAライセンス情報を表示したり、非
表示にします。

– MOS- LQO
– Levels

棒グラフのメニュー・ツリーについては、
「棒グラフ」（ページ）502を参照してく
ださい。

表 A-34 Measurement settings > Voice Qualityメニュー・ツリーの概要（続き）

タブ レベル 1 レベル 2 レベル 3 概要
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A 付録
測定結果

棒グラフ

表 A-35 Measurement Results > Bar chartメニュー・ツリーの概要

レベル 1 レベル 2 レベル 3 概要

Enable 選択した結果タブをオン／オフします。

Add Result 新しい結果タブを測定に追加します。

Delete Result 選択した結果タブを測定から削除します。

Save Data

選択した結果データを、内部ストレージまたは外部 USBフラッ
シュ・メモリの CSVファイル・フォーマットに保存します。
Saveメニュー・ツリーについては、「Saveメニュー・ツリー」
（ページ）447を参照してください。

Edit Limits

Track 1st
– Enable

– Disable
最初のトレースのトラッキングをオン／オフします。

Lower limit
– Enable

– Disable
下限値をオン／オフします。

Upper limit
– Enable

– Disable
上限値をオン／オフします。

Lower limit 下限値を設定します。

Upper limit 上限値を設定します。

Graph Properties

Title 棒グラフのタイトルを編集します。

X-axis

Auto Scale
X軸のオートスケールをオン／オフします。
On
Off

Unit X軸の単位タイプを選択します。

Left
X軸の左側値を設定します。
この設定は、Autoscaleがオンになっている場合にのみ使用可能
です。

Right
X軸の右側値を設定します。
この設定は、Autoscaleがオンになっている場合にのみ使用可能
です。
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付録 A
グラフ

表 A-36 Measurement results > Graphメニュー・ツリーの概要

レベル 1 レベル 2 レベル 3 概要
Enable 選択した結果タブをオン／オフします。
Add Result 新しい結果タブを測定に追加します。
Delete Result  選択した結果タブを測定から削除します。

Save Data

選択した結果データを、内部ストレージまたは外部 USBフラッ
シュ・メモリの CSVファイル・フォーマットに保存します。
Save メニュー・ツリーについては、「Saveメニュー・ツリー」
（ページ）447を参照してください。

Edit Limits

Trace

– CH1～ CH8

– POLQA

– Reference

– Degraded

– Error

トレース・チャネル番号またはトレース・タイプ（POLQA）を
選択します。

Limit Type
– Upper

– Lower
リミット・タイプを選択します。

Track 1st
– Enable

– Disable
最初のトレースのトラッキングをオン／オフします。

Limit
– Enable

– Disable
リミット値をオン／オフします。

Points

Point No ポイント番号を設定します。
X 選択したポイント番号の X軸の値を設定します。

Y 選択したポイント番号の Y軸の値を設定します。
Add Point リミット・ポイントを追加します。
Remove Point 選択したリミット・ポイントを削除します。
Clear Points すべてのリミット・ポイントをクリアします。

Load Points

リミット・ポイントをファイルからロードします。
Recall
メニュー・ツリーについては、「Recallメニュー・ツリー」
（ページ）448を参照してください。

Edit Limits Points Save Points
選択したリミット・ポイントをファイルに保存します。
Save メニュー・ツリーについては、「Saveメニュー・ツリー」
（ページ）447を参照してください。
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Graph Properties

Title グラフのタイトルを編集します。

X-axis

Auto Scale
X軸のオートスケールをオン／オフします。
– On
– Off

Spacing
X軸の間隔タイプを選択します。
– ログ
– リニア

Unit X軸の単位タイプを選択します。

Left
X軸の左側値を設定します。
この設定は、X軸のオートスケールがオンになっている場合に
のみ使用可能です。

Right
X軸の右側値を設定します。
この設定は、X軸のオートスケールがオンになっている場合に
のみ使用可能です。

Center
X軸の中央値を設定します。
この設定は、X軸のオートスケールがオンになっている場合に
のみ使用可能です。

Span
X軸のスパン値を設定します。
この設定は、X軸のオートスケールがオンになっている場合に
のみ使用可能です。

Y-axis

Auto Scale
Y軸のオートスケールをオン／オフします。
– On
– Off

Spacing
Y軸の間隔タイプを選択します。
– Log
– Linear

Unit Y軸の単位タイプを選択します。

Y-axis

Top
Y軸の下側値を設定します。
この設定は、Y軸のオートスケールがオンになっている場合に
のみ使用可能です。

Bottom
Y軸の上側値を設定します。
この設定は、Y軸のオートスケールがオンになっている場合に
のみ使用可能です。

Trace

Trace アナライザのトレース・チャネルを選択します。
– CH1～ CH8

State
トレースをオン／オフします。
– On
– Off

Color

トレースの色を選択します。
– Yellow
– Cyan
– White
– Pink
– Green
– Orange
– Red
– Purple

表 A-36 Measurement results > Graphメニュー・ツリーの概要（続き）

レベル 1 レベル 2 レベル 3 概要
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付録 A
Graph Properties

（POLQA測定の
MOS-LQOおよび
Delayの結果にのみ
適用可能）

Title グラフのタイトルを編集します。

Auto Scale
– On

– Off
X軸のオートスケールをオン／オフします。

Left
X軸の左側エッジの値を設定します。
この設定は、Autoscaleがオンになっている場合にのみ使用可能
です。

Right
X軸の右側エッジの値を設定します。
この設定は、Autoscaleがオンになっている場合にのみ使用可能
です。

Top
Y軸の上側エッジの値を設定します。
この設定は、Autoscaleがオンになっている場合にのみ使用可能
です。

Bottom
Y軸の下側エッジの値を設定します。
この設定は、Autoscaleがオンになっている場合にのみ使用可能
です。

表 A-36 Measurement results > Graphメニュー・ツリーの概要（続き）

レベル 1 レベル 2 レベル 3 概要
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A 付録
付録 M： HP8903Bのメニュー・ツリー

表 A-37 HP8903Bのメニュー・ツリーの概要

レベル 1 レベル 2 レベル 3 概要

Measurement

Function

– AC LEVEL
– SINAD
– DISTN
– DC LEVEL
– SIG / NOISE
– DISTN LEVEL

HP8903Bの測定モードを選択します。

LP Filter
– None
– 30 kHz
– 80 kHz

HP8903B測定のローパス・フィルタの値を選択します。

HP/W Filter
HP8903Bハイパス／評価雑音フィルタの値を選択します。
フィルタの選択は、HP8903B Configで設定した左フィルタと
右フィルタに依存します。

Reference
比モードの測定値と比較する基準値を設定します。
 
基準値を変更すると、比測定モードがオンになります。

Ratio
– On
– Off

HP8903B測定の比モードをオン／オフします。

Format
– Log
– Lin

HP8903B測定のフォーマット・タイプを選択します。

Generator

Frequency
HP8903Bジェネレータの周波数値を設定します。 
周波数値を変更すると、ステップ・パラメータも周波数に設定
されます。

Amplitude
HP8903Bジェネレータの振幅値を設定します。
振幅値を変更すると、ステップ・パラメータも振幅に設定され
ます。

Step Param
– Frequency
– Amplitude

HP8903Bジェネレータのステップ・パラメータ・タイプを選択
します。

Generator

Freq. Step
HP8903Bジェネレータの周波数のステップ値を設定します。 
この設定は、ステップ・パラメータが周波数に設定されている
場合にのみ使用可能です。

Amp. Step
HP8903Bジェネレータの振幅のステップ値を設定します。 
この設定は、ステップ・パラメータが振幅に設定されている場
合にのみ使用可能です。

× 10 現在のパラメータ・ステップ値に 10を乗算します。

÷ 10 現在のパラメータ・ステップ値を 10で除算します。

Sweep

Freq. Start HP8903Bの掃引周波数のスタート値を設定します。

Freq. Stop HP8903Bの掃引周波数のストップ値を設定します。

Sweep Status
– On
– Off

HP8903Bモードでの掃引を開始／中断します。
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付録 A
Code List

– None
– Input Level Range (except DC Level)
– Input Level Range (DC Level only)
– Post Notch Detector Response (except in 

SINAD)
– Display Source Settings
– Re-enter Ratio Mode
– Signal-to-Noise Measurement Delay
– SINAD and Signal-to-Noise Display 

Resolution
– Sweep Resolution (maximum 255 points/

sweep)
– Display Level in Watts
– Read Display to SCPI
– GPIB Address (SCPI only)
– GPIB Service Request Condition (SCPI only)
– Source Output Impedance (Instrument 

powers up at 600 Ω)

表示する HP8903Bスペシャル・ファンクション・コードを選択
します。

SPCL
HP8903Bスペシャル・ファンクション・コード（SCPI onlyと示
されているコードを除く）を設定し、スペシャル・ファンク
ションを実行します。

表 A-37 HP8903Bのメニュー・ツリーの概要（続き）

レベル 1 レベル 2 レベル 3 概要
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A 付録
付録 N： 測定機能の戻り値の単位

アナログ・アナライザ

表 A-38 アナログ・アナライザの測定機能の戻り値の単位

測定機能 単位 デフォルト

Frequency
– Hz
– ΔHz

Hz

AC電圧
THD+Nレベル
THDレベル

– dBg

– dBm

– dBr

– dBu

– dBV

– W

– V
– ΔV

– dBSPL

– x

V

DC電圧
– V
– ΔV

– x

V

THD+N比
SINAD
THD ratio
SMPTE IMD
DFD IEC 60118（2次）
DFD IEC 60118（3次）
DFD IEC 60268（2次）
DFD IEC 60268（3次）
SNR
S/N比（高速）
クロストーク

– dB
– ΔdB

– %

– x

dB

Phase ° °
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付録 A
デジタル・アナライザ

表 A-39 デジタル・アナライザの測定機能の戻り値の単位

測定機能 単位 デフォルト

Frequency
– Hz
– ΔHz

Hz

AC電圧
最大ピーク値
最小ピーク値

– V

– dBFS

– dBr

– dBu

– dBV

– FFS

– x

– pctFS 

– LSB

– Hex

– Dec

FFS

DC電圧

– FFS

– V

– Hex

– x

FFS

THD+Nレベル
THDレベル

– V

– dBFS

– dBr

– dBu

– dBV

– FFS

– x

– pctFS 

– LSB

– Hex

– Dec

dBFS

THD+N比
SINAD
SMPTE IMD
DFD IEC 60118（2次）
DFD IEC 60118（3次）
DFD IEC 60268（2次）
DFD IEC 60268（3次）
クロストーク（ドライブ・チャネル）

– dB
– ΔdB

– %

– x

dB

Phase ° °
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A 付録
次の式を使用して単位を計算できます。

表 A-40 単位変換式

単位 公式 概要

ΔHz f – fref fref＝基準周波数

dB 20 × log10 (ratio) -

ΔdB (ratio) – Rref Rref＝基準比

dBg Vgen＝対応するチャネルのジェネレータ信号の振幅

dBm Zref＝基準インピーダンス

dBr Vref＝基準レベル

dBu -

dBv 20 × log10(Vrms) -

W Zref＝基準インピーダンス[a]

ΔV V – Vref Vref＝基準レベル[b]

x

Vref＝基準レベル [b]

Rref＝基準比

% 100 × (ratio) -

[a] Vrms測定単位を Wまたは dBmに変更する場合は、パワー ・レベルの計算に基準インピーダンスの設定値が使用されます。
基準インピーダンスとは、 パワー・レベルを計算する際の、アナライザに接続された回路インピーダンスまたは負荷イン
ピーダンスです。負荷インピーダンスがないループバック・テストでは、測定された電圧値は、電圧ディバイダが存在しな
いので期待される値の 2倍になります。これにより、負荷が存在すると、6.02 dBより大きなパワー測定値が返されます。

[b] 基準レベルは、ユーザ入力値または、次の測定値の読み取りのための相対レベルとして現在の読み値から収集した値です。
これは、差、リニア、または対数スケールに設定できます。

20 log10
 Vrms

2

Vgen
------------------
 
 
 
 

×

10 log10
1000  Vrms

2

Zref
-------------------------------
 
 
 
 

×

20 log10
 Vrms

2

Vref
------------------
 
 
 
 

×

20 log10
Vrms

0.6
-------------
 
 
 

×

V
Zref
----------

V
Vref
----------

or
Ratio (in %)
Rref (in %)
-----------------------------
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付録 A
デジタル・オーディオ測定の単位

表 A-41 デジタル・オーディオ測定の単位

単位 概要

FFS フル・スケールに対する割合

%FS フル・スケールの％

dBFS フル・スケールに対する dB

LSB 最下位ビット

FS/Vrms クロスドメイン入力レベル測定と出力レベル測定（アナログ入力とデジタル出力）との比

Vrms/FS クロスドメイン入力レベル測定と出力レベル測定（デジタル入力とアナログ出力）との比
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付録 O： 任意波形ファイルのフォーマット
U8903B任意波形モードでは、任意波形ファイルまたは波形ファイルをロードすること
ができます。アナログ任意波形の波形ファイルをロードするには、［Waveform Config］ > 
［Recall］ソフトキーを押します。［Recall］メニュー・ページが表示され、ロードする
ファイルを選択できます。波形ファイルをロードしたら、［Waveform Config］メ
ニュー・ページで［Info］ソフトキーを押して、任意波形の情報を表示します（図 A-1
を参照）。

図 A-1 Analog Generator > Waveform Config > Infoメニュー・ページ（任意波形）

任意波形ファイルのフォーマットは、以下に示すパラメータを使って設定できます。

#Vpeak: 2
#DC Offset: 0
#Points:
0
-0.2
-0.4
…

任意波形ファイル・パラメータの値の許容範囲については、表 A-42を参照してくだ
さい。

表 A-42 任意波形ファイル・パラメータの許容範囲

パラメータ 範囲

Vpeak
– 0～ 22.6 Vp（平衡出力接続）
– 0～ 11.3 Vp（不平衡またはコモン出力接続）

DC Offset － 11.3 V～ 11.3 V

Points 32～ 32768ポイント
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付録 A
任意波形のサンプリング・レートは 312.5 kHzに固定されています。したがって、サン
プル間のインターバルは 3.2 μs（1/312.5）です。

以下の任意波形ファイルの例では、サンプル・ポイントの番号の最大値（すなわち、6）
が Vpeakとして出力されます。他のサンプルは、その最大値に対する比に基づいてレ
ベル制御されます。

#Vpeak: 2
#DC offset: –3
#Points:
0
–1
–1.5
–1
0
2
4
6
4
2
…

以下の条件のいずれかが発生した場合は、エラーまたは警告メッセージが表示されるこ
とがあります。

– サンプル・ポイントが有効な浮動小数点数でないためにロードできない場合。

– Vpeakと DCオフセットの和が、現在の出力接続タイプの最大電圧を超える場合。

– Vpeakおよび DCオフセットの値が無効な場合。

– サンプル・ポイントの合計が 32未満の場合。

– 任意波形ファイルが存在しない場合。

注 DCオフセットと振幅の和は、現在の出力接続タイプの最大電圧を超えないようにする
必要があります。

– 平衡出力接続の場合は、（Vpeak + |DCオフセット |）は 0 V～ 22.6 Vの範囲内にあ
る必要があります。

– 不平衡およびコモン・モード出力接続の場合は、（Vpeak＋ |DCオフセット |）は 0 
V～ 11.3 Vの範囲内にある必要があります。
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A 付録
付録 P： ユーザ定義フィルタ・ファイルのフォーマット
ローパス、ハイパス、評価雑音のいずれかのフィルタ・メニューで［Custom］を選択
すると、ユーザ定義のフィルタ・ファイルをロードできます。

使用可能なユーザ定義フィルタ・タイプは、IIR（Infinite Impulse Response）と FIR
（Finite Impulse Response）です。それぞれのフィルタ・タイプに対して、係数またはセ
クションと、群遅延を指定する必要があります。フィルタ・ファイルのフォーマットを
設定するには、以下の例を使用します。ファイルは *.jufフォーマットで保存されます。

FIRフィルタ・ファイル・フォーマットの例を以下に示します。

#Type: FIR
#Delay: 250
#Coefficients:
0.00023394
-1.69E-05
-1.61E-05
-1.57E-05
…

FIRフィルタの係数は以下のように記述します。

0.00023394 //A[0]
-1.69E-05 //A[1]
-1.61E-05 //A[2]
-1.57E-05 //A[3]

注 FIRフィルタの伝達関数 H(z)は以下のように定義されます。

H(z)＝ A[0]＋ A[1]z－ 1＋ A[2]z－ 2＋ A[3]z－ 3＋ ...

ここで z＝複素変数
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付録 A
IIRフィルタ・ファイル・フォーマットの例を以下に示します。

#Type: IIR
#Delay: 250
#Sections:
0.02188812
1
-1.852219
0.9397715
1
2
1
0.02067037
1
-1.749171
0.8318526
1
2
1
…

IIRフィルタの係数は以下のように記述します。

0.02188812 //セクション 1:  利得 1

1 //セクション 1:  A1[0]

–1.852219 //セクション 1:  A1[1]

0.9397715 //セクション 1:  A1[2]

1 //セクション 1:  B1[0]

2 //セクション 1:  B1[1]

1 //セクション 1:  B1[2]

[0.02067037 //セクション 2:  利得 2

1 //セクション 2: A2[0]

–1.749171 //セクション 2: A2[1]

0.8318526 //セクション 2: A2[2]

1 //セクション 2: B2[0]

2 //セクション 2: B2[1]

1 //セクション 2: B2[2]

ここで Ax＝分母、Bx＝分子
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A 付録
FIRフィルタの係数は最大 256個、IIRフィルタのセクションは最大 36個設定できま
す。FIRフィルタの係数は 4個以上でなければならず、IIRフィルタのセクション数の
最小値は 1（係数は 7個）です。遅延はサンプル数で指定され、範囲は 0～ 65535
です。

注 IIRフィルタの伝達関数 H(z)は以下のように定義されます。

ここで z＝複素変数、N＝セクション数、x＝セクション番号

H(z) Gainx

Bx 0[ ] Bx 1[ ]z–1
Bx 2[ ]z–1

+ +

Ax 0[ ] Ax 1[ ]z
–1

Ax 2[ ]z–1
+ +

-------------------------------------------------------------------------------
 
 
 
 

x =  1

N

∏=
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付録 A
付録 Q： DSI入力および出力インタフェース

DSI入力および出力インタフェースは、25ピン D-SUB（メス）コネクタを使用します。
コネクタのピン割り当てを図 A-2および表 A-43に示します。

図 A-2 25ピン D-SUB（メス）コネクタ

1 2 3 4 5 6 7 8 9 10 11 12 13

14 15 16 17 18 19 20 21 22 23 24 25

表 A-43 25ピン D-SUB（メス）コネクタのピン割り当て

ピン番号 ラベル 方向 概要

1 Master Clk Out 出力 デジタル・オーディオのマスタ・クロック出力

2 GND – デジタル・グランド

3 DSI Gen Data-Out 出力 デジタル・ジェネレータの DSIデータ出力

4 DSI Gen FS-InOut 入力／出力 DSIジェネレータの DSIフレーム同期

5 DSI Gen CLK-InOut 入力／出力 DSIジェネレータの DSIビット・クロック

6 – – 未使用

7 +5.0V – 過電流保護付きの＋ 5.0 V電源

8 ＋ 3.3V – 過電流保護付きの＋ 3.3 V電源

9 DSI Ana Data-In 入力 デジタル・アナログの DSIデータ入力

10 DSI Ana FS-InOut 入力／出力 デジタル・アナログの DSIフレーム同期

11 DSI Ana Clk-InOut 入力／出力 デジタル・アナログの DSIビット・クロック

12 GND – デジタル・グランド

13 Sync Clock Out 出力 AES3/SPDIFおよび DSIの同期クロック出力

14 – 25 GND – デジタル・グランド
Keysight U8903B ユーザーズ・ガイド 517



A 付録
付録 R： デジタル・システムのクロック分配ブロック図
デジタル・システムのクロック分配ブロック図を図 A-3に示します。

図 A-3 デジタル・システムのクロック分配ブロック図

PLL

AESレシーバ

PLL

PLL

PLL

内部クロック

リカバリされたマスタ・
クロック

マスタ・クロック／フレー
ム同期入力

DSIジェネレータ・フレー
ム同期

ジェネレータ基準クロック

ビット・
クロック

マスタ・
クロック

同期ク
ロック

PLL＝フェーズ・ロック・ループ

DSIジェネレータ・
ビット・クロック
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付録 A
付録 S： 代表的な DSIテスト構成

以下の各セクションでは、シリアル・オーディオ入力／出力構成の例を示します。

構成 1

この構成では、DUTは U8903B内部基準クロック・ソースを基準クロックとして使用
します。DUTは U8903Bからクロック基準とデータを受信します。

［FUNCTION］パネルの を押してオーディオ・ジェネレータ・モードとオーディ

オ・アナライザ・モードの間を切り替え、［FUNCTION］パネルの を押してデジ
タル・インタフェースに切り替えます。

図 A-4 DSIテスト構成 1

1 デジタル・ジェネレータで［DSI Config］ > ［Master Clock］を押し、［On］を選択して
マスタ・クロックをオンにします。

2 デジタル・ジェネレータで［DSI Config］ > ［Sample Rate］をオシロスコープ、サンプ
リング・レートを設定します。

3 デジタル・ジェネレータで［DSI Config］ > ［Word Length］をオシロスコープ、ワード
長を設定します。ビット・クロック・レートは、サンプリング・レートとワード長
とチャネル数の積から求まります。

4 デジタル・ジェネレータで［DSI Config］ > ［Multiplier］を押し、乗数を選択します。
マスタ・クロック・レートは、サンプリング・レートと乗数の積から求まります。

5 デジタル・ジェネレータで［DSI Config］ > ［Fsync Polarity］を押し、［Rising］または
［Fall ing］ を選択して、フレーム・クロックの立ち上がりエッジへのエッジ同期を指
定します。

注 ピン割り当ての詳細については、「DSI入力および出力インタフェース」（ページ）517
を参照してください。
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Analyzer
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DUT

ビット・クロック

フレーム同期

データ ピン 3

ピン 4

ピン 5

ピン 1マスタ・クロック

U8903B
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構成 2

この構成では、DUTは外部マスタ・クロックを基準クロックとして使用します。
U8903Bは、データ、フレーム同期、ビット・クロックを DUTから受信します。この構
成の代表的なアプリケーションは、A/Dコンバータ（ADC）の評価です。

［FUNCTION］パネルの を押してオーディオ・ジェネレータ・モードとオーディ

オ・アナライザ・モードの間を切り替え、［FUNCTION］パネルの を押してデジ

タル・インタフェースに切り替えます。

図 A-5 DSIテスト構成 2

1 デジタル・アナライザで［Input Config］ > ［Connector］を押し、デジタル・アナライ
ザの入力タイプとして［DSI］を選択します。

2 デジタル・ジェネレータで［DSI Config］ > ［Master Clock］を押し、［Off］を選択して
マスタ・クロックをオフにします。

3 デジタル・アナライザで［DSI Config］ > ［W/Bclk Dir］を押し、ワードおよびビット・
クロック方向として［In］を選択します。

Generator
Analyzer

Interface

U8903B
DUT

外部マスタ・クロック

ピン 9

ピン 10

ピン 11ビット・クロック

フレーム同期

データ
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付録 A
構成 3

この構成では、外部マスタ・クロックを使用して DUTと U8903Bを同期します。
U8903B内のフェーズ・ロック・ループ（PLL）によって、入力マスタ・クロックが
ロックされ、フレーム同期とビット・クロックが再生成されます。データのクロックは
各ビット・クロックで発生します。

［FUNCTION］パネルの を押してオーディオ・ジェネレータ・モードとオーディ

オ・アナライザ・モードの間を切り替え、［FUNCTION］パネルの を押してデジ

タル・インタフェースに切り替えます。

図 A-6 DSIテスト構成 3

1 デジタル・アナライザで［Input Config］ > ［Connector］を押し、デジタル・アナライ
ザの入力タイプとして［DSI］を選択します。

2 デジタル・ジェネレータで［DSI Config］ > ［Master Clock］を押し、［Off］を選択して
マスタ・クロックをオフにします。

3 デジタル・アナライザで［DSI Config］ > ［W/Bclk Dir］を押し、ワードおよびビット・
クロック方向として［Out］を選択します。

4 デジタル・ジェネレータで［DSI Config］ > ［Multiplier］を押し、サンプリング・レー
トを決定する乗数を設定します。

Generator
Analyzer

Interface

U8903B
DUT

外部マスタ・クロック
同期入力

ピン 9

ピン 10

ピン 11ビット・クロック

フレーム同

データ
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構成 4

この構成は、構成 2に似ていますが、DUTが U8903B内部基準クロック・ソースを基
準クロックとして使用する点が異なります。

［FUNCTION］パネルの を押してオーディオ・ジェネレータ・モードとオーディ

オ・アナライザ・モードの間を切り替え、［FUNCTION］パネルの を押してデジ

タル・インタフェースに切り替えます。

図 A-7 DSIテスト構成 4

1 デジタル・アナライザで［Input Config］ > ［Connector］を押し、デジタル・アナライ
ザの入力タイプとして［DSI］を選択します。

2 デジタル・ジェネレータで［DSI Config］ > ［Master Clock］を押し、［On］を選択して
マスタ・クロックをオンにします。

3 デジタル・アナライザで［DSI Config］ > ［W/Bclk Dir］を押し、ワードおよびビット・
クロック方向として［In］を選択します。

4 デジタル・ジェネレータで［DSI Config］ > ［Sample Rate］をオシロスコープ、サンプ
リング・レートを設定します。

5 デジタル・ジェネレータで［DSI Config］ > ［Multipl ier］を押し、マスタ・クロック・
レートを決定する乗数を設定します。

Generator
Analyzer

Interface

U8903B
DUT

ピン 9

ピン 10

ピン 11

ピン 1

ビット・クロック

フレーム同期

データ

マスタ・クロック
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付録 A
構成 5

この構成は、構成 3に似ていますが、DUTが U8903B内部基準クロック・ソースを基
準クロックとして使用する点が異なります。

［FUNCTION］パネルの を押してオーディオ・ジェネレータ・モードとオーディ

オ・アナライザ・モードの間を切り替え、［FUNCTION］パネルの を押してデジ

タル・インタフェースに切り替えます。

図 A-8 DSIテスト構成 5

1 ［Input Config］ > ［Connector］を押し、デジタル・アナライザの入力タイプとして
［DSI］を選択します。

2 デジタル・ジェネレータで［DSI Config］ > ［Master Clock］を押し、［On］を選択して
マスタ・クロックをオンにします。

3 ［DSI Config］ > ［W/Bclk Dir］を押し、ワードおよびビット・クロック方向として
［Out］を選択します。
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U8903B
DUT
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ピン 11

ピン 1

ビット・クロック
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データ
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付録 T： U8903B構成の例

例 1:デジタル・ジェネレータで正弦波波形を作成し、デジタル・アナラ
イザでその電圧を測定

この例では、U8903Bデジタル・ジェネレータから単純な正弦波波形を作成し、
U8903Bデジタル・アナライザでその電圧を測定します。

周波数 1 kHz、振幅 1 FFSの正弦波波形をデジタル不平衡出力から作成するために、次
の手順を実行します。

1 デジタル・ジェネレータの不平衡出力を、リア・パネルにあるデジタル・アナライ
ザの不平衡入力チャネルに、BNCケーブルで接続します。

2 ［FUNCTION］パネルの を押してオーディオ・ジェネレータ・モードに切り替

え、［FUNCTION］パネルの を押してデジタル・インタフェースに切り替え
ます。

3 ［Waveform］を押し、波形タイプとして［Sine］を選択します。

4 ［Output Config］ > ［Connector］を押し、デジタル・ジェネレータの出力タイプとして
［Unbalanced］を選択します。

5 ［Output Config］ > ［AES Output］を押し、AES出力をオンにします。

6 ［Waveform Config］ > ［Frequency］を押し、周波数を 1 kHzに設定します。

7 ［Waveform Config］ > ［Amplitude］を押し、振幅を 1 FFSに設定します。

8 を押して、デジタル・ジェネレータのチャネル 1で信号発生を開始し

ます。

9 上記の手順を実行すると、U8903Bのディスプレイは次のようになります。

図 A-9 デジタル・ジェネレータでの正弦波波形の作成
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Interface
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Off



付録 A
正弦波波形の電圧を測定するために、次の手順を実行します。

1 ［FUNCTION］パネルの を押してオーディオ・アナライザ・モードに切り替

え、［FUNCTION］パネルの を押してデジタル・インタフェースに切り替え

ます。

2 ［Analysis Mode］を押し、デジタル・アナライザの解析モードとして［Standard］を
選択します。

3 ［Input Config］ > ［Connector］を押し、デジタル・アナライザの入力タイプとして
［Unbalanced］を選択します。

4 ［Functions］ > ［Function No.］を押し、［1］を選択します。

5 ［Functions］ > ［Function 1］を押し、1つめの測定機能として［Frequency］を選択し
ます。

6 ［Functions］ > ［Function No.］を押し、［2］を選択します。

7 ［Functions］ > ［Function 2］を押し、2つめの測定機能として［AC Vol tage］を選択し
ます。

8 を押して、デジタル・アナライザのチャネル 1で信号測定を開始し

ます。

作成した正弦波波形の AC電圧として、「仕様」（ページ）371に記された許容値の範囲
内で 1 FFSの読み値が得られるはずです。U8903Bのディスプレイは以下のようになる
はずです。

図 A-10 デジタル・アナライザでの電圧測定
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例 2:システム・クロック基準設定の指定

この例では、U8903Bのシステム・クロック基準設定を指定する方法を説明します。

システム・クロック基準ソースを外部マスタ・クロック入力にし、ワード長を 24、乗
数を 192に設定するために、次の手順を実行します。

1 外部マスタ・クロック信号を、リア・パネルの Sync Inコネクタに BNCケーブルで
接続します。

2 ［FUNCTION］パネルの を押してオーディオ・ジェネレータ・モードに切り替

え、［FUNCTION］パネルの を押してデジタル・インタフェースに切り替え

ます。

3 ［Output Config］ > ［Ref Clock］ > ［Source］を押し、基準クロック・ソースとして
［External］を選択します。

4 ［Output Config］ > ［Ref Clock］ > ［Type］を押し、［MCLK］を選択して、外部クロッ
ク・ソース・タイプをマスタ・クロックに設定します。.

5 ［Output Config］ > ［Ref Clock］ > ［Word Length］を押し、マスタ・クロックのワード長
を 24に設定します。[1][2]

6 ［Output Config］ > ［Ref Clock］ > ［Multiplier］を押し、マスタ・クロックの乗数を 192

に設定します。[3]

[1] サンプリング・レートは、マスタ・クロックのワード長の値を制約します。さまざまなサンプリン
グ・レートで設定可能なワード長の範囲については、「マスタ・クロック入力のワード長、サンプリ
ング・レート、乗数」（ページ）536を参照してください。

[2] ワード長を設定する際に、エラー・メッセージ –221,”Settings conflict...”が発生する場合があります。
このエラー・メッセージは無視してもかまいません。設定の衝突により、ワード長または乗数が最
も近い許容される値に自動的に調整されているからです。

[3] サンプリング・レートとワード長により、乗数の値が制約されます。マスタ・クロックのさまざま
なワード長とサンプリング・レートで設定可能な乗数の範囲については、「マスタ・クロック入力の
ワード長、サンプリング・レート、乗数」（ページ）536を参照してください。
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例 3:デジタル・ジェネレータの DSI出力設定の指定

この例では、U8903Bデジタル・ジェネレータの DSI出力設定を指定する方法を説明し
ます。

デジタル・ジェネレータの DSI出力設定を、DSPフォーマット、サンプリング・レー
ト 192 kHz、ワード長 24、乗数 192に設定するために、次の手順を実行します。

1 ［FUNCTION］パネルの を押してオーディオ・ジェネレータ・モードに切り替

え、［FUNCTION］パネルの を押してデジタル・インタフェースに切り替え

ます。

2 ［DSI Config］ > ［Format］を押し、DSI出力フォーマットとして［DSP］を選択し
ます。

3 ［DSI Config］ > ［Sample Rate］を押し、サンプリング・レートを［192 kHz］に設定し
ます。

4 ［DSI Config］ > ［Word Length］を押し、DSIワード長を 24に設定します。[1][2]

5 ［DSI Config］ > ［Multiplier］を押し、DSI乗数を 192に設定します。[3]

[1] サンプリング・レートにより DSIのワード長の値が制約されます。さまざまなサンプリング・レー
トで設定可能なワード長の範囲については、「DSIのワード長、サンプリング・レート、乗数」（ペー
ジ）530を参照してください。

[2] ワード長を設定する際に、エラー・メッセージ –221,”Settings conflict...”が発生する場合があります。
このエラー・メッセージは無視してもかまいません。設定の衝突により、ワード長または乗数が最
も近い許容される値に自動的に調整されているからです。

[3] サンプリング・レートとワード長により、乗数の値が制約されます。DSIのさまざまなワード長とサ
ンプリング・レートで設定可能な乗数の範囲については、「DSIのワード長、サンプリング・レート、
乗数」（ページ）530を参照してください。
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付録 U： デジタル波形パラメータとチャネルの関係

表 A-44 デジタル波形パラメータとチャネルの関係

波形 パラメータ チャネル

正弦波
Frequency
Amplitude
DC Offset

チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は異なる
チャネル 1とチャネル 2は同じ

ステレオ
Frequency
Amplitude
DC Offset

チャネル 1とチャネル 2は異なる
チャネル 1とチャネル 2は異なる
チャネル 1とチャネル 2は同じ

方形波
Frequency
Amplitude
DC Offset

チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は異なる
チャネル 1とチャネル 2は同じ

正弦波バースト

Frequency
Amplitude
Burst On
Period
Low Level

チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は異なる
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ

可変位相
Frequency
Amplitude
Phase → 1

チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は異なる
チャネル 1とチャネル 2は同じ

デュアル

Frequency 1
Frequency 2
Amplitude
Ratio
DC Offset

チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ

SMPTE IMD 1:1/ 4:1/ 10:1

Lower Frequency
Upper Frequency
Amplitude
DC Offset

チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ

DFD IEC 60118

Difference Frequency
Upper Frequency
Amplitude
DC Offset

チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ

DFD IEC 60268

Difference Frequency
Center Frequency
Amplitude
DC Offset

チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ

ガウシアン／方形／三角／
ピンク

Amplitude
DC Offset

チャネル 1とチャネル 2は異なる
チャネル 1とチャネル 2は同じ
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一定値 Amplitude チャネル 1とチャネル 2は同じ

マルチトーン

Amplitude
Start Frequency
Stop Frequency
Frequency Spacing
Count

クレスト・ファクタ
Tone Frequency
Tone Amplitude
Tone Phase

チャネル 1とチャネル 2は異なる
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は異なる
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ
チャネル 1とチャネル 2は同じ

任意波形
Amplitude
DC Offset

チャネル 1とチャネル 2は異なる
チャネル 1とチャネル 2は同じ

表 A-44 デジタル波形パラメータとチャネルの関係（続き）

波形 パラメータ チャネル
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A 付録
付録 V： DSIのワード長、サンプリング・レート、乗数

表 A-45 DSIのワード長、サンプリング・レート、乗数

≤ サンプリング・レート（kHz）[a] ワード長 乗数

400 8 128

400 9 72、144

400 10 80、160

400 11 88、176

400 12 96、192

400 13 104、208

400 14 112、224

400 15 120、240

400 16 64、128

400 17 68、136

400 18 72、144

400 19 76、152

400 20 80、160

400 21 84、168

400 22 88、176

400 23 92、184

400 24 96、192

400 25 100、200

400 26 104、208

400 27 108、216

400 28 112、224

400 29 116、232

400 30 120、240

400 31 124、248

400 32 128

200 8 128、256

200 9 72、144、288

200 10 80、160、320

200 11 88、176、352
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付録 A
200 12 96、192、384

200 13 104、208、416

200 14 112、224、448

200 15 120、240、480

200 16 64、128、256

200 17 68、136、272

200 18 72、144、288

200 19 76、152、304

200 20 80、160、320

200 21 84、168、336

200 22 88、176、352

200 23 92、184、368

200 24 96、192、384

200 25 100、200、400

200 26 104、208、416

200 27 108、216、432

200 28 112、224、448

200 29 116、232、464

200 30 120、240、480

200 31 124、248、496

200 32 128、256

100 8 128、256、512

100 9 72、144、288、576

100 10 80、160、320、640

100 11 88、176、352、704

100 12 96、192、384、768

100 13 104、208、416、832

100 14 112、224、448、896

100 15 120、240、480、960

100 16 64、128、256、512

100 17 68、136、272、544

表 A-45 DSIのワード長、サンプリング・レート、乗数（続き）

≤ サンプリング・レート（kHz）[a] ワード長 乗数
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A 付録
100 18 72、144、288、576

100 19 76、152、304、608

100 20 80、160、320、640

100 21 84、168、336、672

100 22 88、176、352、704

100 23 92、184、368、736

100 24 96、192、384、768

100 25 100、200、400、800

100 26 104、208、416、832

100 27 108、216、432、864

100 28 112、224、448、896

100 29 116、232、464、928

100 30 120、240、480、960

100 31 124、248、496、992

100 32 128、256、512

50 8 128、256、512、1024

50 9 72、144、288、576

50 10 80、160、320、640

50 11 88、176、352、704

50 12 96、192、384、768

50 13 104、208、416、832

50 14 112、224、448、896

50 15 120、240、480、960

50 16 64、128、256、512

50 17 68、136、272、544

50 18 72、144、288、576

50 19 76、152、304、608

50 20 80、160、320、640

50 21 84、168、336、672

50 22 88、176、352、704

50 23 92、184、368、736

表 A-45 DSIのワード長、サンプリング・レート、乗数（続き）

≤ サンプリング・レート（kHz）[a] ワード長 乗数
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付録 A
50 24 96、192、384、768

50 25 100、200、400、800

50 26 104、208、416、832

50 27 108、216、432、864

50 28 112、224、448、896

50 29 116、232、464、928

50 30 120、240、480、960

50 31 124、248、496、992

50 32 128、256、512、1024

25 8 128、256、512、1024

25 9 72、144、288、576

25 10 80、160、320、640

25 11 88、176、352、704

25 12 96、192、384、768

25 13 104、208、416、832

25 14 112、224、448、896

25 15 120、240、480、960

25 16 64、128、256、512

25 17 68、136、272、544

25 18 72、144、288、576

25 19 76、152、304、608

25 20 80、160、320、640

25 21 84、168、336、672

25 22 88、176、352、704

25 23 92、184、368、736

25 24 96、192、384、768

25 25 100、200、400、800

25 26 104、208、416、832

25 27 108、216、432、864

25 28 112、224、448、896

25 29 116、232、464、928

表 A-45 DSIのワード長、サンプリング・レート、乗数（続き）

≤ サンプリング・レート（kHz）[a] ワード長 乗数
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A 付録
25 30 120、240、480、960

25 31 124、248、496、992

25 32 128、256、512、1024

12.5 8 128、256、512、1024

12.5 9 72、144、288、576

12.5 10 80、160、320、640

12.5 11 88、176、352、704

12.5 12 96、192、384、768

12.5 13 104、208、416、832

12.5 14 112、224、448、896

12.5 15 120、240、480、960

12.5 16 64、128、256、512

12.5 17 68、136、272、544

12.5 18 72、144、288、576

12.5 19 76、152、304、608

12.5 20 80、160、320、640

12.5 21 84、168、336、672

12.5 22 88、176、352、704

12.5 23 92、184、368、736

12.5 24 96、192、384、768

12.5 25 100、200、400、800

12.5 26 104、208、416、832

12.5 27 108、216、432、864

12.5 28 112、224、448、896

12.5 29 116、232、464、928

12.5 30 120、240、480、960

12.5 31 124、248、496、992

12.5 32 128、256、512、1024

6.75 8 128、256、512、1024

6.75 9 72、144、288、576

6.75 10 80、160、320、640

表 A-45 DSIのワード長、サンプリング・レート、乗数（続き）

≤ サンプリング・レート（kHz）[a] ワード長 乗数
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付録 A
6.75 11 88、176、352、704

6.75 12 96、192、384、768

6.75 13 104、208、416、832

6.75 14 112、224、448、896

6.75 15 120、240、480、960

6.75 16 128、256、512

6.75 17 136、272、544

6.75 18 144、288、576

6.75 19 152、304、608

6.75 20 160、320、640

6.75 21 168、336、672

6.75 22 176、352、704

6.75 23 184、368、736

6.75 24 192、384、768

6.75 25 200、400、800

6.75 26 208、416、832

6.75 27 216、432、864

6.75 28 224、448、896

6.75 29 116、232、464、928

6.75 30 120、240、480、960

6.75 31 124、248、496、992

6.75 32 128、256、512、1024

[a]サンプリング・レートがこの値以下の場合。

表 A-45 DSIのワード長、サンプリング・レート、乗数（続き）

≤ サンプリング・レート（kHz）[a] ワード長 乗数
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A 付録
付録W： マスタ・クロック入力のワード長、サンプリング・
レート、乗数

表 A-46 マスタ・クロック入力のワード長、サンプリング・レート、乗数

≤ サンプリング・レート（kHz）[a] ワード長 乗数

400 8 64、128

400 9 72、144

400 10 80、160

400 11 88

400 12 96

400 13 104

400 14 112

400 15 120

400 16 64、128

400 17 68、136

400 18 72、144

400 19 76

400 20 80

400 21 84

400 22 88

400 23 92

400 24 96、192

400 25 100

400 26 104

400 27 108

400 28 112

400 29 116

400 30 120

400 31 124

400 32 128

200 8 64、128、256

200 9 72、144、288

200 10 80、160

200 11 88、176
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付録 A
200 12 96、192

200 13 104、208

200 14 112、224

200 15 120、240

200 16 64、128、256

200 17 68、136、272

200 18 72、144、288

200 19 76、152

200 20 80、160

200 21 84、168

200 22 88、176

200 23 92、184

200 24 96、192

200 25 100、200

200 26 104、208

200 27 108、216

200 28 112、224

200 29 116、232

200 30 120、240

200 31 124、248

200 32 128、256

100 8 64、128、256、512

100 9 72、144、288、576

100 10 80、160、320

100 11 88、176、352

100 12 96、192、384

100 13 104、208、416

100 14 112、224、448

100 15 120、240、480

100 16 64、128、256、512

100 17 68、136、272、544

表 A-46 マスタ・クロック入力のワード長、サンプリング・レート、乗数（続き）

≤ サンプリング・レート（kHz）[a] ワード長 乗数
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A 付録
100 18 72、144、288、576

100 19 76、152、304

100 20 80、160、320

100 21 84、168、336

100 22 88、176、352

100 23 92、184、368

100 24 96、192、384

100 25 100、200、400

100 26 104、208、416

100 27 108、216、432

100 28 112、224、448

100 29 116、232、464

100 30 120、240、480

100 31 124、248、496

100 32 128、256、512

50 8 64、128、256、512

50 9 72、144、288、576

50 10 80、160、320、640

50 11 88、176、352、704

50 12 95、192、384、768

50 13 104、208、416、832

50 14 112、224、448、896

50 15 120、240、480、960

50 16 64、128、256、512

50 17 68、136、272、544

50 18 72、144、288、576

50 19 76、152、304、608

50 20 80、160、320、640

50 21 84、168、336、672

50 22 88、176、352、704

50 23 92、184、368、736

表 A-46 マスタ・クロック入力のワード長、サンプリング・レート、乗数（続き）

≤ サンプリング・レート（kHz）[a] ワード長 乗数
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付録 A
50 24 96、192、384、768

50 25 100、200、400、800

50 26 104、208、416、832

50 27 108、216、432、864

50 28 112、224、448、896

50 29 116、232、464、928

50 30 120、240、480、960

50 31 124、248、496、992

50 32 128、256、512

25 8 64、128、256、512

25 9 72、144、288、576

25 10 80、160、320、640

25 11 88、176、352、704

25 12 96、192、384、768

25 13 104、208、416、832

25 14 112、224、448、896

25 15 120、240、480、960

25 16 64、128、256、512

25 17 136、272、544

25 18 72、144、288、576

25 19 152、304、608

25 20 80、160、320、640

25 21 168、336、672

25 22 88、176、352、704

25 23 184、368、736

25 24 96、192、384、768

25 25 200、400、800

25 26 104、208、416、832

25 27 216、432、864

25 28 112、224、448、896

25 29 232、464、928

表 A-46 マスタ・クロック入力のワード長、サンプリング・レート、乗数（続き）

≤ サンプリング・レート（kHz）[a] ワード長 乗数
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A 付録
25 30 120、240、480、960

25 31 248、496、992

25 32 128、256、512

12.5 8 64、128、256、512

12.5 9 144、288、576

12.5 10 80、160、320、640

12.5 11 176、352、704

12.5 12 96、192、384、768

12.5 13 208、416、832

12.5 14 112、224、448、896

12.5 15 240、480、960

12.5 16 64、128、256、512

12.5 17 272、544

12.5 18 144、288、576

12.5 19 304、608

12.5 20 160、320、640

12.5 21 336、672

12.5 22 176、352、704

12.5 23 368、736

12.5 24 192、384、768

12.5 25 400、800

12.5 26 208、416、832

12.5 27 432、864

12.5 28 224、448、896

12.5 29 464、928

12.5 30 240、480、960

12.5 31 496、992

12.5 32 128、256、512

6.75 8 64、128、256、512

6.75 9 288、576

6.75 10 160、320、640

表 A-46 マスタ・クロック入力のワード長、サンプリング・レート、乗数（続き）

≤ サンプリング・レート（kHz）[a] ワード長 乗数
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付録 A
6.75 11 352、704

6.75 12 192、384、768

6.75 13 416、832

6.75 14 224、448、896

6.75 15 480、960

6.75 16 64、128、256、512

6.75 17 544

6.75 18 288、576

6.75 19 608

6.75 20 320、640

6.75 21 672

6.75 22 352、704

6.75 23 736

6.75 24 384、768

6.75 25 800

6.75 26 416、832

6.75 27 864

6.75 28 448、896

6.75 29 928

6.75 30 480、960

6.75 31 992

6.75 32 128、256、512

[a]サンプリング・レートがこの値以下の場合。

表 A-46 マスタ・クロック入力のワード長、サンプリング・レート、乗数（続き）

≤ サンプリング・レート（kHz）[a] ワード長 乗数
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A 付録
付録 X： U8903Bデフォルト設定

アナログ・ジェネレータ

表 A-47 アナログ・ジェネレータのデフォルト設定

レベル 1 レベル 2 レベル 3 デフォルト

Waveform Sine

Waveform Config

Amplitude 0 Vrms

Frequency 1 kHz

DC Offset 0 V

Phase -> 1 0°

Frequency 2 2 kHz

Ratio 100%

Lower Feq 60 Hz

Upper Freq 
(SMPTE 1:1/4:1/10:1)

7 kHz

Upper Freq (IEC 60118) 10 kHz

Diff Freq 80 Hz

Center Freq 10 kHz

Voltage 0 V

Start Freq 1001.35803222656

Stop Freq 4997.25341796875

Freq Spacing Linear

Tones 2

Length 1024

Dial (DTMF) Mode Single

Amplitude (DTMF) –4.5 dBu

Ratio (DTMF) 2 dB

Tone Duration (DTMF) 90 ms

Tone Delay (DTMF) 90 ms

Pause Time (DTMF) 90 ms

Repeat (DTMF) Off
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付録 A
アナログ・アナライザ

Output Config

Connector UnBal

Impedance 600 Ω

IEC60268 10 Ω Pin 2

Ground Float

Max Voltage 22.6 Vrms

References Ref Impedance 600 Ω

表 A-47 アナログ・ジェネレータのデフォルト設定（続き）

レベル 1 レベル 2 レベル 3 デフォルト

表 A-48 アナログ・アナライザのデフォルト設定

レベル 1 レベル 2 レベル 3 デフォルト

Functions

Multi-Chn Mode Off

Function No. 1

Meas. Func. (Function 1) AC Voltage

Meas. Func. (Function 2) Frequency

Meas. Func. (Function 3) None

Meas. Func. (Function 4) None

Functions 
(Frequency)

Unit Hz

Format Off

Functions 
(AC Voltage)

Unit V

Format Off

Detector RMS

Functions 
(DC Voltage)

Unit V

Format Off

Functions
(THD+N Ratio/SINAD)

Unit dB

Format Off

Freq Lock Auto

Fund Freq 1000

Functions
(THD+N Level)

Unit V

Format Off

Freq Lock Auto

Fund Freq 1000
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A 付録
Functions 
(THD Ratio)

Unit dB

Format Off

Even Harmonic 2, 4, 6, 8

Odd Harmonic 3, 5, 7, 9

Freq Lock Auto

Fund Freq 1000

Functions 
(THD Level)

Unit V

Format Off

Even Harmonic 2, 4, 6, 8

Odd Harmonic 3, 5, 7, 9

Freq Lock Auto

Fund Freq 1000

Functions
(DFD60268 2nd/
DFD 60268 3rd/
DFD 60118 2nd/
DFD 60118 3rd)

Unit dB

Format Off

Functions 
(SMPTE IMD)

Unit dB

Format Off

Freq Lock Gen Lock

Upper Freq 60

Lower Freq 7000

Functions 
(SNR)

Unit dB

Format Off

SNR Delay 0 ms

Functions
(SNR (Fast))

Unit dB

Format Off

Freq Lock Auto

Fund Freq 1000

Harmonics 5

Functions
(Phase)

Ref. Channel 1

Freq Lock Auto

Fund Freq 1000

表 A-48 アナログ・アナライザのデフォルト設定（続き）

レベル 1 レベル 2 レベル 3 デフォルト
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付録 A
Functions
(X-Talk)

Ref. Channel 1

Unit dB

Format Off

Freq Lock Auto

Fund Freq 1000

Filters Config

LPF None

HPF None

Weighting None

Deemphasis None

Notch Filter

State Disabled

Center Freq 1000 Hz

Bandwidth 500 Hz

Meas Config

Auto Range On

Range 1 V

Sample Size 32768

Average Points 1

Src Channel 1

Trigger Source Free Run

Trigger Edge Rising

Input Config

Connector UnBal

Impedance
100 kΩ (Unbal)
200 kΩ (Bal)

Coupling AC

Bandwidth 90 kHz

Ext. Gain 0 dB

Wave File

Channel Left

Bits/Sample 8

Duration 10 s

Statistics

Show Stats Off

No. of Reading 10

Stat 1 Min

Stat 2 Max

Stat 3 Average

表 A-48 アナログ・アナライザのデフォルト設定（続き）

レベル 1 レベル 2 レベル 3 デフォルト
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A 付録
Sweep

表 A-49 Sweepデフォルト設定

レベル 1 レベル 2 デフォルト

Legacy Status Off

Parameter Frequency

Points Settings

Spacing Log

Unit Hz

Start 20

Stop 2000

Step 1.268961003

Points 30

Points Settings
(Parameter = Amplitude)

Spacing Linear

Unit Vrms

Start 0.1

Stop 1

Step 0.031034483

Points 30

Points Settings
(Parameter = Phase)

Spacing Linear

Unit °

Start 0

Stop 90

Step 3.103448276

Points 30

Dwell Time 0

Sweep Mode Continuous

Channels
Source 1

Measure 1
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付録 A
HP 8903B

System

表 A-50 HP8903Bデフォルト設定

レベル 1 レベル 2 デフォルト

Measurement

Function AC level

LP Filter 80 kHz

HP/W Filter None

Ratio Off

Format Lin

Generator

Frequency 1 kHz

Amplitude 0 V

Step Param Frequency

Freq. Step 1 kHz

Amp. Step 100 mVrms

Sweep
Freq. Start 20 Hz

Freq. Stop 20 kHz

表 A-51 Systemデフォルト設定

キー レベル 1 レベル 2 デフォルト

System HP8903B Config

Active Channel 1

Left Filter None

Right Filter None

Default LPF 80 kHz
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A 付録
付録 Y： ファイルの名前変更、コピー、移動、削除手順

ファイル名の変更

1 ファイル・ビューで、名前を変更するファイルを選択します。

2 ［Rename］ソフトキーを押します。

3 ［New name］テキスト・ボックスに新しいファイル名を入力します。

4 完了したら、［OK］ソフトキーを押します。

5 選択したファイルの名前が変更されます。

ファイルのコピー

1 ファイル・ビューで、コピーするファイルが保存されているフォルダに移動し
ます。

2 ［Copy or Move］ソフトキーを押します。

3 ［Mark］ソフトキーを押して、コピーするファイルにマークを付けます。 

4 ファイルのコピー先のフォルダに移動します。

5 ［Copy Marked To Folder］ソフトキーを押します。

6 マークを付けたファイルが指定したフォルダにコピーされます。完了したら、
［Return］ソフトキーを押します。

7 コピー先のフォルダ内に同じ名前のファイル名がすでに存在している場合は、ファ
イル名を Copy of [ファイル名 ]に変更してコピーされます。

ファイルの移動

1 ファイル・ビューで、移動するファイルが保存されているフォルダに移動します。

2 ［Copy or Move］ソフトキーを押します。

3 ［Mark］ソフトキーを押して、移動するファイルにマークを付けます。

4 ファイルの移動先のフォルダに移動します。

5 ［Move Marked To Folder］ソフトキーを押します。

6 マークを付けたファイルが指定したフォルダに移動されます。完了したら、［Return］
ソフトキーを押します。

ファイルの削除

1 ファイル・ビューで、削除するファイルを選択します。

2 ［Delete］ソフトキーを押します。

3 ファイルを削除するかどうか確認を求めるダイアログ・ボックスがポップアップ表
示されます。ファイルを削除するには、［Yes］を選択して［Enter］を押します。 中
止するには、［No］を選択して［Enter］を押します。
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